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Includes advanced treatmenr of these topics:

+ Invoking the commencemenr of NC 120V electric power tO the CPU unit

+ On-screen text generation via the activation of digit-sensor switches
+

Insertion of laser-readable data storage media

Look, we use the word Dummies on the cover with
affection and a twinkle in the eye. Still, we
understand if you're not thrilled about leaving a
book on your desk called The iBook For Dummies.
We hear you. And we've got the perfect solution:
Just rip off the real cover of the book! This phony
cover will be all that's left. Leave it on your desk
in plain sight, so everybody will know what a
computer whiz you are.
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What 1cJe You Got There!
To find out how much memory your iBook has and what
system-software version, choose About This Computer
from the• menu (see Chapter 1). Write the answers
down here.
Your iBook OS version: ::-:--<f....,....,_0_1___ ____

Built-in memory:_,..l~l.~1_/if
~6_ _ _ _ _ __

Workin9 with Icons
Findin9 a file
Each file you create is represented by an icon and is
usually stored inside an electronic folder, whic h looks
like a file folder on your screen. Everyone sometimes
misplaces a file. Here's what to do.

Turnin9 the iBook on and off

1. Choose Sherlock from the File menu (or the • menu I.
2. Type a few letters of the missi ng fil e's name.
You don't have to type the whole name ... only enough
to distinguish it; type Wonk to find the file called Willy
Wonka Eamings. Capitalization doesn't matter.
3. Press the Return key or clic k the Find button.
The iBook roots through you r files. When it shows you a
list of all icons that match, click one (to see whe re it isl
or double-click (to open itl.

When you first get your iBook, turn it on by pressing the
On/Off button. It's the round button at the upper-right
corner of your keyboard (see Chapter 11.

1. Click an icon (oncel and press Return.

SurcJicJin9 the First Half Hour
You may need this information only at the very beginning
of your iBook career - but you'll really need it.

After that, don't bother shutting the machine down.
Instead, when you're finished working, put the iBook to
sleep by simply closing the lid. Wake it again by opening
it. (Carrying the machine around asleep can't hurt it.
Neither can x-ray machines.)
If you don't plan to use the iBook for two weeks or
more, only then you should fully shut it down by (11
pressing the On/Off button and then (21 clicking the Shut
Down button. (Turn it on with the On/Off button.)

Renamin9 a file
2. Type a new name; then press Return.
A file's name can be up to 31 letters long. If you make a
mistake, backspace by pressing the Delete key.

To insert a CD-ROM
1. Hold the CD by its edges (or the hole I. Press the button

on the iBook's CD-ROM panel (right front side I to make
the tray pop out an inch. Pull the tray out all the way.
2. Gently snap the CD-ROM onto the center spindle, label
side up.
3. Push the tray closed until it snaps shut.

Troubteshootin9 Kel}.strokes

Ejectin9 a CD or other disk

See Chapters 16 and 17 for details.

Drag the disk's icon onto the Trash can. Or click the disk
icon (oncel and choose Eject Disk from the Special menu.

The iBook is frozen, but the cursor moves: Press 3€0ption-Esc and then click the Force Quit button. Save
your work in each program; then restart the iBook.
(Works about half the time. Other times, read on.I
The iBook has frozen: While holding down the 3C and
Ctrl keys, press the On/Off button. Doing so restarts the
iBook when it has otherwise locked up.
A weird problem keeps recurring: As the iBook starts
up, press Shift until you see "Extensions Off." Only
basic functions work now (no faxing, no lnternetl, but
the iBook runs clean and pure. See Chapter 17 to finish
the troubleshooting; this trick at least gets you into
your iBook.

Cop1J.in9 a file onto a disk
You can't drag icons onto a CD. If you've bought a floppy
drive, Zip drive, SuperDisk, or other disk drive for your
iBook, however, just drag any file's icon (below, left) onto
the disk's icon (below, right) and let go.
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You're panicking: Call Apple's hotline: 800-500-7078.
Alternatively, you can drag the file into the disk's window,
instead of on top of the disk's icon.
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They call this box a dialog box because the iBook is
asking questions it needs answered. Here are the
elements of a typical dialog box.

Radio buttons
0

Print Quality:

Best

~Normal

Workin9 with Several Pro9rams
The iBook lets you run more than one program at once .
If you keep launching programs, eventually you'll be told
you're out of memory. Until then, here are some pointers.

0

Draft

Nam ed after the pushbuttons on a car radio, where
only one can be pushed in at a time. Likewise, only
on e iBook radio button can be selected at a time.

Determinin<J. what pro9rams are runnin<J.
Put the cursor on the icon in the upper-right of your
screen; hold down the clicker button.
The Application menu drops down, listing all the
programs you've launch ed. The frontmost one, the one
you're working in now, is indicated by a check mark.
(This frontmost program is also named in the menu bar,
as you can see here.)

o America Onlme

6:01 PM

Hide America onnne
Hide others

Check boxes
lit Clean ink cartridge before printing
Used to ind icate whether an option is on or off. Click
once t o place the X in the box; click again to remove
the X (and turn off the option).

$.._ America onllne
~ Finder

· W Microsoft Word

Quittin<J. pro9rams to free up memorlJ

Text fields
O From:

D

To:

1. Use your Appl ication menu, as illustrated above, to

D

choose the program's nam e.

You 're supposed to type into these blanks. To move
from one blank to another, either click with the clicker
or press the Tab key.

Pop~up

Show AU
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2. From the File menu, choose Quit.

Workin9 with i8ook Windows
Openin<J. or cfosin9 a window

When you see this, you're seeing a pop-up menu.
Point to the text, hold down the mouse button, and
make a selection from the minimenu that drops down.

Every window was once an icon that you double-clicked to
see what was inside.

Buttons

1. Double-click any icon to open its window.
2. To get rid of a window, click the close box in the upper-left corner.

I Cancel I

iLE6J

Every dialog box has a clea rly marked button or two
(usually OK and Cancel) that make the box go away- your
escape route.
Click OK (or Print, or Proc eed, or whatever the button says)
to proceed with the command you originally chose from the
menu. Click Cancel if you wa nt to back out of the dialog
box, as though you'd never issued the command.
See the thick black outline around the Print button above? You
don't have to use the clicker to click that button; you can press
either the Return or Enter key on your keyboard instead.
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Life on BatterlJ Power
The screen lighting is the primary consumer of your iBook's
battery juice. When trying to conserve power, turn the
brightness down as much as you can stand (by pressing the
Fl key at the top of your keyboard).
Keep your iBook plug ged into a power outlet whenever
possible. The battery charges whenever it's plugged in, even
if you're using the machine. (The power-cord socket on the
iBook glows orange when the battery's charging, green
when it's full.) The battery is good for about 500 rechargings.
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Are you intimidated and confused by computers? Do you find
that traditional manuals are overloaded with technical details
you'll never use? Do your friends and family always call you to
fix simple problems on their PCs? Then the ...For Dummies9
computer book series from IDG Books Worldwide is for you .

. . .For Dummies books are written for those frustrated computer users who know they
aren't really dumb but find that PC hardware, software, and indeed the unique vocabulary of
computing make them feel helpless.. ..For Dummies books use a lighthearted approach,
a down-to-earth style, and even cartoons and humorous icons to dispel computer novices'
fears and build their confidence. Lighthearted but not lightweight these books are a perfect
survival guide for anyone forced to use a computer.

"/like my copy so much I told
friends; now they bought copies.

11

- Irene C., Orwell, Ohio

"Uuick, concise, nontechnical,
and humorous.
11

-Jay A., £/bum, Illinois
'7banks, I needed this book. Now I
can sleep at night.
11

- Robin f, British Columbia, Canada
Already, millions of satisfied readers agree. They have
made ...For Dummies books the #1 introductory level
computer book series and have written asking for more.
So, if you're looking for the most fun and easy way to
learn about computers, look to .. .For Dummies books to
give you a helping hand.
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Introduction
•••••••••••••••••••••••••••••••••••••••••••••••••

~art

with Apple's smash-hit, fruit-colored iMac computer, drive over it
.;) ~arefully with a steamroller, and you know what you get?
Right: An expensive pile of ground glass and plastic.
Ah, but take the spirit of the iMac - fast , inexpensive, all-in-one, sensuously
designed, see-through - and incorporate it into a portable computer, and the
result is an iBook.
How does this laptop differ from all the others that came before it? Let us
count the ways:
,,.,, It's not black. Until the iBook, every laptop in history was boring black.
When it comes to laptops, we've been stuck with Model T's for 20 years.
People have accused the iBook of looking like a LifeSaver, a makeup
compact, or a toilet seat, but nobody says it looks boring.

,,.,, It's not square. Every previous laptop was sculpted to resemble a brick.
The iBook, on the other hand, doesn't have any straight edges. Not only
does its curvy shape make you want to run your hands over it, but you're
less likely to sever your spinal cord if you carry the thing in a backpack.
,,.,, It's not fragile. Okay, it's more fragile than a Styrofoam peanut. But the
iBook's thick rubber coating protects the hard shell from nicks and
scratches - and the hard shell is Lexan, also known as the plastic used
in bullet-proof vests. (Now you know why the iBook is such a hit with
the Secret Service.) The iBook is heavy, but it's made like a Sherman tank.
,,.,, It has no flaps. Until the iBook, you had to pop open a ridiculous flap, a
plastic door, to get at the jacks and connectors on the side of a laptop.
Such a design guaranteed two things: First, the flap will eventually break
off. Second, when the laptop is home on your desk, the goofy flap is
open all the time, making it harder to plug things into those jacks.
,,.,, It has no latch. I've owned six laptops in my life, and the front latch on
every single one opened a different way. You pushed the latch on one
laptop; you slid one to the left; you needed both thumbs for another
one. If I kept expensive silverware inside the laptop, that'd be one
thing - but why should I encounter unnecessary security when I just
want to type something?
The iBook's halves are held together the same way a cell-phone halves
are held together, or a jewelry box: by a magnetic-feeling friction hinge.

I-'

It's got everything built in. When you buy a laptop from any other manufacturer, you usually pay extra for a modem, which lets you get onto
the Internet, and an Ethernet card, which lets you connect to other computers. And you certainly pay extra for software, like a word processor,
calendar, or phone-book program. The iBook has all of this stuff built in.

I-'

It's fast and cheap. In fact, at this writing, the iBook is the second-fastest
laptop you can buy. (Apple's more expensive PowerBook is the fastest.)
And yet it's also among the cheapest - if you hadn't noticed, laptops of
this speed usually cost between $2,500 and $5,000.

I-'

It's filled with delightful surprises. For example: The iBook turns on
when you open the lid, turns off when you close it. Or this: The power
cord wraps around its own built-in yo-yo, which spares you from the
heartbreak of Laptop Power-Cord Suitcase Tangle. Or how about Wait a minute. If I tell you all the surprises, they won't be surprises.

Anyway, if your iBook is your first laptop, or even your first computer, you
don't know how lucky you are. You've neatly eliminated most of the hassle,
frustration, and annoyance that normally comes with owning a laptop.

Who Needs an iBook BookJ
If the iBook is so simple, then who needs a book about it?

Well, despite all the free goodies you get with the iBook, a manual isn't among
them. You need somewhere to turn when things go wrong, when you'd like to
know what the add-on software does, or when you want to stumble onto the
Internet for the first time.
By the way, of course you're not a dummy. Two pieces of evidence tell me so:
for one thing, you're learning the iBook, and for another, you're reading this
book! But I've taught hundreds of people how to use their computers, and an
awful lot of them start out saying they feel like dummies when it comes to
computers. Society surrounds us with fast-talking teenagers who grew up
learning English from their Nintendo sets; no wonder the rest of us sometimes feel left out.
But you're no more a dummy for not knowing the iBook than you were before
you knew how to drive. Learning a Macintosh is like learning to drive: After a
lesson or two, you can go anywhere your heart desires.
So when we say Dummies, we're saying it with an affectionate wink. Still, if the
cover bothers you even a little - I'll admit it, you wouldn't be the first- please
rip it right off. The inner cover, we hope, will make you proud to have the book
out on your desk.

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ Introduction

Jeon lntlentorlJ.
So that we'll be eligible for some of the more prestigious book-design awards,
I've marked some topics with these icons:
Nerdy stuff that's okay to skip but will fascinate the kind of people who read
Tom Clancy novels.

The iBook is the greatest laptop on earth, but it's still a laptop. Now and then
it does unexplainable stuff, which I'll explain.

A shortcut so you can show off.

Denotes an actual You-Try-It Experience. Hold the book open with a nearby
cinder block, put your hands on the computer, and do as I say.

Tips for people who plan to carry the iBook around - a task it was born to do.

®
Apple and Obsolescence

Tells you what's featured in the newest Mac operating system.

One more thing before you delve in: Apple is the gigantic Silicon Valley computer company that started out as a couple of grungy teenagers in a garage.
Each time Apple introduces a new Macintosh model, it's faster, more powerful, and less expensive than the model you already bought. People love Apple
for coming up with such great products - but they also feel cheated at
having paid so much for a suddenly outdated machine.
Feel whatever you want, of course. But if you're going to buy a computer,
accept the fact that your investment is going to devalue faster than real
estate in Chernobyl.

3

Here's a promise: No matter how carefully you shop or how good a deal you
got on your iBook today, it will be replaced by a less expensive or souped-up
iBook vers ion within a year. (Yours will still work just fine, and be more or
less up-to-date, for about five years.)
With that quick and inevitable computer death looming, how can people
psych themselves into spending $1,600 for a laptop? Simple: They believe
that in those few s hort years, the computer will speed them up enough, and
enhance their productivity enough, to cover the costs easily.
That's the theory, anyway.

Part I

For the Absolute
Computer Virgin
The 5th Wave
~N~T

BI Rich Tennant

In this part ...

~ere

are three ways to learn how to use a new computer. You can consult the manual; unfortunately, your
iBook didn't come with one. You can take a course (like
you've got time for that?). Or you can read a book like
this one.
In these opening chapters, you'll learn, as kindly and
gently as possible, how to get up and running on your
iBook - and nothing else.

Chapter 1

Your Very First See-Through
Fruit-Flavored Laptop
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
.... How to turn the iBook on (and off)
.... Adjusting the screen, the keyboard, and your expectations
..,. Confronting weird new words such as trackpad, menu, and system
..,. Doing windows
..,. Mindlessly opening and closing folders

•••••••••••••••••••••••••••••••••••••••••••••••••

L

et's face it: Your new iBook laptop is a work of art. It's sleek, curvy, and

made of bulletproof plastic in colors not found in nature. You could get a
lot of mileage out of your iBook, socially speaking, by simply parking it on
your coffee table during parties.
If you're like most people, however, you probably bought your iBook with the
intention of using it as a computer. To turn the laptop on, you must fulfill

three requirements. First, you must open the lid. Second, you must make sure
that the laptop has power. Finally, you must press the On button. In the following paragraphs, all three steps will be made clear.

Drunk with Power
Opening the iBook is the easy part. Unlike the thousands of laptop models
before it, this one requires no 30-second period of fiddling with the latch,
trying to figure out whether to push it, pull it, slide it, or go at it with a crowbar. This laptop, in fact, has no latch. It's held shut by some kind of
spring-loaded hinge doohickey, exactly like the little velvet box a wedding
ring comes in. To open the iBook, just pull its halves apart like a giant plastic
fruit-colored clam.
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The iBook can get its electricity either directly from a wall socket or from its
built-in battery, which runs for about five hours on a charge. (You may distinctly remember Apple's advertising saying that the battery lasts for six
hours per charge - but that's with the screen brightness turned all the way
down and without performing any battery-depleting activity, such as actually
using the computer.)
When you first take the iBook out of its box, you'll be delighted to discover
that the laptop's battery comes from the factory fully charged. Even so, you
should plug it into the wall whenever you're not en route someplace.
(Keeping it plugged in keeps the battery fully charged.) The power cord
comes in two pieces, only one of which looks like a power cord. The other
piece, a silvery, yo-yo-like disk, resembles a flying saucer from "Plan 9 from
Outer Space." Here's how you put it all together:
1. Plug the extension cord into the center of the yo-yo.

2. Plug the other end
into a wall socket

3. Plug the yo-yo cord into the iBook
(on the right side, near the back).

If your wall outlet is indeed working, the power socket on the side of the

iBook begins to glow with a reassuring orange light. That's your indication
that the laptop is getting power and the battery is charging. When the battery
is full, the iBook power-cord socket glows green instead.

Switching on the iBook
In this ve ry first lesson, you'll be asked to locate the On button. It's in the
upper-right corner of your keyboard. It's round, and it bears the universal
symbol for iBook On-Turning, which looks like this:
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On/Off

Try pressing this button now. If the iBook responds in some way - a sound
plays, the screen lights up, missiles are launched from the Arizona desert then your machine is working.
If pressing that key didn't do anything, your iBook is n't plugged into a work-

ing power outlet, or its battery needs charging.

The startup slide show
If your On-button experiment was successful, you hear a chord, and after a

few seconds, an image appears on the screen. Now you get to witness the
iBook Startup Slide Show, revered by millions. First, you see a quick glimpse
of the smiling Macintosh. (Deep down inside, your !Book is actually a
Macintosh computer.) The smiling Mac looks like this:

( In the rare event that your smiling Macintosh looks like this -

- your iBook's screen was installed upside-down.)
Next slide: You see the famous Mac logo, looking like Picasso's portrait of a
schizophrenic:
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Mac™OS
During this time, the bottom of your screen fills with little inch-tall pictures.
In Macintosh lingo, the term for "little inch-tall pictures" is icons. These particular icons represent the different features of your iBook, each turning itself
on and preparing for action: One represents your CD-ROM drive, another's
for dialing the Internet, and so on. Much, much, much more information
about these startup-item doodads is in Chapter 12.
At last, the colored full-screen pattern, called the desktop, appears.
Congratulations! You've arrived. (If you're wondering about the box that
appears on your screen the very first time you turn on the laptop, see the
sidebar box called "The Mac Setup Assistant.")
If you saw anything else during the startup process - such as a blinking
question-mark icon, a strange error message, or thick black smoke -you've
just met your first computer problem. Proceed directly to Chapter 16. This
problem and many others are solved for you there.

The Mac Setup Assistant
The first time you turn on your iBook, you're
treated to a special window called the Mac OS
Setup Assistant, which looks like this:
D .E""

-

Mac OS Setup Asslstllnt

~
. If'

latroolucllon

8

Welcome to the Mac OS Setup Aooiolont I
Sa3ed on your enS'w'ers 10 a fev questions, thi s esslstont mekes

••lo

,.me boole oett1090 on your computer ond
It up ,. thot you con
print documents and share files over a local netvork.
Thi• • .,10tont otorto "Ith ,.me queotiono obout yourool r. 'olhero
you are, and hcN you plan to use your computer.
Click the rloht orrw to conti nuo.

]Jill]

_______ Chapter 1: Your Very First See-Through Fruit-Flavored Laptop

This program is designed to conduct an interview with you. On one screen after another, it
asks about your current time zone, what printer
you have, and so on.

Finder Preferences: This screen asks if you'd
like the Simple Finder mode turned on (see the
end of Chapter 13). You don't. Click No.

Trouble is, most of the questions it asks probably don't apply to you, 0 Nomad with Laptop. For
example, several of the Assistant's screens
have to do with the office network you're connected to - and most iBook owners aren't
connected to one.

Computer Name and Password: This information is relevant only if your iBook is connected
to an office (or school) network. But here's the
silly part- even if you're not attached to a network, you're still forced to fill in these blanks.
Don't worry about remembering this password;
you'll never need it again.

Therefore, the quickest way to get rid of this
intrusive little program is to press 3C-Q - that
is, while pressing the 3C key (just to the left of
the space bar on the keyboard), type the letter
Q. Then release both keys.

Shared Folder: This option, too, is for people on
networks. It lets you create a special "folder,"
into which you can put files that anyone else on
the network can open. Most of the time, the
answer here is No.

If the Setup Assistant intrigues you, however,
here's how to use it. Using the trackpad and
clicker, as described in this chapter, you're supposed to advance from one question to the next
by clicking the right-pointing triangle button at
the bottom of each screen. You'll be walked
through these settings:

Printer Connection: If you have an inkjet printer,
such as an Epson - or any printer connected
directly to your iBook, for that matter - choose
Direct Connection. If you don't have a printer,
and you're not on a network, click right on past
this screen.

Regional Preferences: Click your country's
name.
Name and Company: Type your name; a company name is optional.
Date &Time: These controls, which you manipulate with your trackpad and clicker, set your
iBook's menu-bar clock. (You can adjust these
settings later, using the Date & Time control
panel. See Chapter 12.) You're also supposed to
indicate whether or not your area observes
Daylight Savings Time.
Geographic Location: Click a city in the same
time zone as yours. This laptop is rea//yhung up
on time and place, ain't it?

Printer Type: You probably don't have any of the
(long discontinued) printers listed here. Click
past this screen.
When it's all over, click the Go Ahead button.
Now you're taken straight into the Internet
Setup Assistant; jump to Chapter 6 if you want
to get on the Internet right now.
If you'd rather wait until you've got your bearings, click the No button. You can always set up
this account later.
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Your First Moments Alone To9ether
As any gadget lover can tell you, the most exciting period of appliance ownership comes at the very beginning. You're gonna love this stuff.

StrokiniJ the trackpad
The first time you examined your open iBook, you probably noticed the flat,
silver, two-inch-square square pad just below the keyboard. You probably
assumed that this Mylar pad was designed for some kind of high-tech indoor
grilling, such as making very tiny pancakes. No such luck: That silver square
is called the trackpad, and you'll be touching it more than almost any other
part of the laptop.
Using your index finger, make short stroking motions on the trackpad. See
how the arrow pointer moves across the screen? For the rest of your life,
you'll hear that pointer called the cursor. And for the rest of your life, you'll
hear stroking the trackpad called stroking the trackpad.
Try lifting your finger off the pad, as though to scratch your nose. Nothing
happens on the screen, right? The trackpad moves the cursor only when
your finger is touching it.

Mouse hunt
When you use a laptop like the iBook, you move
the pointer on the screen by dragging your
finger across the trackpad. You have a right to
wonder, however, why all books, software manuals, and fellow computer fans talk about using
a mouse to control the pointer.
A mouse is the little, rounded, plastic box
attached to every non-laptop computer on
earth. Such desktop computers don't have
trackpads; instead, you move the pointer by slid-

ing the mouse around on the desk.
You can attach a mouse to your iBook, if you find
a trackpad difficult to use. (See Appendix C for
some examples.) When space is at a premium,
however, the built-in trackpad is the way to go.
Studies have shown that dragging a little plastic
box across the thigh of the guy next you on the
airplane can have unpleasant social consequences.
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What's on the menu?
Let's try some real computing here. Move the cursor up to the light-gray strip
at the top of the screen. It's called the menu bar, named after a delightful little
pub in Silicon Valley. Touch the arrow on the word Special. (The tip of the
iBook's arrow is the part you need to worry about. Same thing with real-life
arrows, come to think of it.)
r- ~

Ale

Edit View Special Help

Pointing to something on the screen in this way has a technical term:
pointing. (Think you're going to be able to handle this?)

Now look down at the rectangular plastic button below the trackpad. (It's
orange or blue, to match your iBook's color.) Its official name is the trackpad
button or the mouse button, but most people just call it the clicker. Put your
thumb on the clicker and briefly, quickly, press down (and then release), producing a satisfying click. If all went well, you should see a list of commands
drop down from the word Special, as shown here:

Em~rash_.

Eject
E
Erase Disk...
Sleep

Restart
Shut Down

Congratulations -you've learned how to click the mouse (by pressing the
clicker), and you've also learned to open a menu (the list of commands) . Try
clicking anywhere on the colored backdrop of your screen (or just waiting 15
seconds); the menu disappears.

The machine IJ.OU net/er turn off
Before we get into 3-D color graphs, space-vehicle trajectories, and DNA
analysis, you'd probably like to know how to turn the iBook off
The funny thing is, most iBook owners never turn the machine off. Instead,
whenever they're not using it, they put the iBook to sleep - just by closing
the lid. When the iBook is asleep, the screen is dark, the components inside
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stop whirring, and all activity stops. When you open the lid again later, the
iBook wakes up automatically. Whatever was on the screen when you closed
the machine is still there, instantly ready for you to begin working again.
Memorize this: Open the machine to use it, close it when you're finished.
Come to think of it, that's pretty much the same way you use a refrigerator.
Putting your laptop asleep whenever you're not usi ng it is an incredibly convenient, simple, and easy-to-remember technique, especially when you're
travelling. There's only one time, in fact, when you'll ever want to shut the
iBook down completely- and that's when you're going to store it, unpluggedJor two weeks or more. (When the iBook is asleep, the battery sips
power incredibly slowly, but it still sips power. After several weeks, it's theoretically possible that the battery will run dry inside your closet; at that
point, the machine shuts down completely.)
Shutting the iBook down, however, is a drag: The next time you turn the
machine on, you'll have to sit there for a full minute while the machine warms
up, loads its little startup icons, and gets going. Life's too short.
Whether you decide to put your machine to sleep or shut down completely,
however, you can do so in a number of different ways (in addition to closing
the lid):
Y'

The keyboard way: Press the power button (the same one you used to
turn the iBook on) for a couple of seconds. This box appears:

Are. you sure you want to shut down your
computer now?

I

Re.start

I Ii

Sleep

I1
1

Cancel

I ij Shut. Down I

If you've had enough for one session, use the clicker to click either the
Sleep button or the Shut Down button. (The computer obediently goes
to sleep or turns itself off.) If you're ready to read on, though, click the
Cancel button instead.
Y'

The trackpad way: Click the word Special ( hereafter known as the
Special menu) again. When the list of commands appears, stroke the
trackpad toward you so that each successive command turns dark.
When each me nu command turns dark, it's said to be highlighted.
(The only commands that don't get highlighted are the ones that are
dimmed, or grayed out. They're dimmed because they don't make any
sense at the moment. For example, if no disc is in the CD-ROM drive,
choosing Eject Disk wouldn't make any sense. So the iBook makes that
command gray, which means it's unavailable to you.)
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Roll the mouse all the way down to the Sleep or Shut Down command, so
that it's highlighted.
If you do, in fact, want to turn the iBook off for now, click the appropriate command. If you'd rather proceed with this chapter's teachings,

however, don't click yet. Instead, slide the cursor off the menu in any
direction and then click the clicker button. The menu snaps back up like
a window shade, and nothing else happens. (A menu command only gets
activated when you click the clicker while the cursor's on a command.)
Hey, you've only read a few pages, and already you can turn your iBook on
and off! See? This thing's no harder than a toaster.
If you want to slog ahead with this lesson, read on.

MofJin9 thin9s around on the desktop
Take a look around the screen. You've already encountered menus (those
words File, Edit, View, and so on at the top of the screen). Near the upperright corner of the screen, you see an icon. (Remember? - a small symbolic
picture.) Unless you've changed it, that icon is called Macintosh HD.
Icons represent everything in the iBook world. They all look different: One
represents a letter you wrote, another represents the Trash can, another represents a CD you've inserted. Here are some examples of icons you'll
probably be seeing before long:

You can move an icon by dragging it. Try this:
1. Point to the Trash icon.

2. Press and hold down the clicker - and, while it's down, move the
arrow to a new position on the screen.
This sophisticated technique is called, by the way, dragging. You're dragging the Trash icon now.
3. Let go of the clicker.
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Other than the fact that there's a Trash can, nobody's really sure why they
call this "home-base" screen the desktop. It has another name, too: the Finder.
It's where you file all your work into little electronic on-screen file folders so
that you can find them again later. The word Finder even appears at the top of
the screen, as shown in the next illustration.
Used in a sentence, you might hear it like this: "Well, no wonder you don't see
the Trash can. You're not in the Finder!"

Icons, windows, and iBook SIJ.ntax
Point to the hard-disk icon (a rectangular box, usually called Macintosh HDfor Hard Disk) in the upper-right corner of the screen.

This particular icon represents the giant disk inside your iBook, known as the
hard drive or hard disk, that serves as your filing cabinet. It's where the computer stores all your work, all your files, and all your software.
So how do you see what's in your hard drive? Where do you get to see its
table of contents?
It turns out that you can open any icon into a window, where you'll see every
item inside listed individually. The window has the same name as the icon
you opened.
Before we proceed, though, it's time for a lesson in Macintosh syntax. Fear
not; it's nothing like English syntax. In fact, everything that you do on the
iBook has this format: noun-verb. Shakespeare it ain't, but it's sure easy to
remember.
Let's try a noun-verb command, shall we?
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I. Click the hard-disk icon in the upper-right corner of the screen.

The icon turns black, indicating that it's selected. Good job -you've just
identified the noun.
2. Click the File menu, and then click Open.

Print

XP

Move To Trash jg(l]
Oose Window 81lW

Get Info

3CI

You guessed it - Open is the verb. And, sure enough, your hard disk
opens into a window, where you can see its contents.
Did any of that make sense? In the world of iBook and Macintosh, you always
specify what you want to change (using the clicker) and then you use a menu
command to specify how you want it changed. You'll see this pattern over
and over again: Select something on the screen and then apply a menu command to it.

The complete list of window doodads
Look over the contents of your hard-drive window, as shown in the following
figure. (Everybody's got different stuff, so what you see on your screen won't
exactly match the illustration.)
Better yet, look over the various controls and gadgets around the edges of
this window. Using these controls and buttons, you can do all kinds of neat
things to a window: stretch it, move it, or make it go away. (You'll find much
more patient descriptions of these controls in Chapter 13.) These various
gadgets are worth learning about - you're going to run into windows everywhere after you start working.

'

1]
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CLOSE BOX- Click here to close the window, just
as though you had chosen Close from the File menu.
TITLE BAR - Drag anywhere in this striped area to move the entire window.
TITLE BAR ICON - Drag this little icon to move the entire
window to the Trash, to another disk, or to another window.
ZOOM BOX - Click here to make the window large enough to show all its contents.

~

Ap plications

Ap ple Extras

~

Inter net

Systam folda r

c •

~

COLLAPSE BOX- Click here to roll the window up like
a windowshade so that only the title bar is showing.
Click here again to re-expand the window.
VERTICAL SCROLL BAR - It's white, indicating that
you're seeing everything in the window (top to bottom).
SIZE BOX - Drag in any direction to
make the window bigger or smaller.

WINDOW EDGES- You can move the entire window by dragging this
narrow, puffy strip that runs all the way around.
HORIZONTAL SCROLL BAR - It's gray, indicating that you're not seeing everything in the
window (there's something off to the side). You can drag the little square from side to side
to adjust your view of the window.

Go ahead and try out some of the little boxes and scroll bars. Click them. Tug
on them. Open the window and close it again. No matter what you do, you
can never hurt the machine by doing "the wrong thing." That's the wonderful
thing about the iBook: It's the Nerf appliance.

Double-clickin9 in theorlJ. and practice
All right, back to the lesson in progress. Make sure your hard-drive window
is open.
So far, all of your work in the Finder (the desktop) has involved using the
trackpad and clicker. But your keyboard is useful, too. For example, do you
see the System Folder? Even if you don't, here's a quick way to find it: Quickly
type sy on your keyboard.
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Presto: the iBook finds the System Folder (which happens to be the first thing
that begins with those letters) and highlights it, in effect dropping it in front
of you, wagging its tail.
Now try pressing the arrow keys on your keyboard; they're in a cluster by
themselves at the lower-right corner. Right, left, up, down ... the iBook highlights neighboring icons as you do so.
Suppose you want to see what's in the System Folder. Of course, using your
newfound noun-verb method, you could (1) click the System Folder to select
it and then (2) choose Open from the File menu.
But that's the sissy way. Try this power shortcut: Point to the System Folder
icon so that the tip of the arrow cursor is squarely inside the picture of the
folder. After removing your finger from the trackpad, click the clicker twice in
rapid succession. With stunning originality, the Committee for the Invention
of Computer Terminology calls this advanced computing technique doubleclicking.

If all went well, your double-click opened a new window, showing you the
contents of the System Folder. (If it didn't work, you probably need to

double-click faster.)
Remember this juicy golden rule: Double-click means "open. "
In your iBook life, you'll be asked (or tempted) to click many an item onscreen: buttons that say "OK;" tools that look like paint brushes; all manner
of multiple-choice buttons. In every one of these cases, you're supposed to
click once.
The only time you ever double-dick something is when you want to open it.
Got it?

Multiple windows
Now you should have two windows open on the screen: the hard-disk
window and the System Folder window. (The System Folder window may be
covering the first one; they're like overlapping pieces of paper on a desk.)
Try this: Click the title bar of the System Folder window (just one click). Drag
the title bar downward - that is, keep the clicker pressed with one thumb as
you stroke the trackpad - until you can see the hard-drive window behind it,
as shown here.
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You cantell that this window is in back,
because its title bar is solid light gray.
Just click anywhere in the window to
bring it to the front

O Mllclntosh HO

Take a s tress-free moment to experiment with these two windows: Click the
back one to bring it forward; then click the one that was in front to bring it to
the front again.

Invasion of the little triangles
When you view a window's contents in a list,
each folder within the window is marked by a
tiny triangle. The triangle points to the right
You can open one of these folders-within-thefolder in the usual way, if you wish - by
double-clicking. But it's much more satisfying
for neat frea ks to click the triangle instead. In
the following figure, the before-and-after view
of the Control Panels folder (inside the System
Folder) shows how much more organized you
can be.

When you click the triangle, in other words, your
window contents look like an outline. The contents of that subfolder are indented. To
"collapse," or close, the folder, click the downward-pointing triangle.
One more trick: See the words Name, Date
Modified, and so on (at the top of the window)?
Click any of these words. Instantly the iBook resorts everything in the window, based on the
word you clicked. Example: click Size, if it's visible, and you'll see the largest files listed first
System folder - = E!l 8

System fold er
2 1 ittms, 987.6 MB nalloblt
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Usin9 a list fliew
There's one more aspect of windows that will probably make Type A personalities wriggle with delight. Until now, you've been viewing the contents of
our disk as a bunch of icons. Nice, but wouldn't it be neat to see things
alphabet1ca y?
1. Make sure the System Folder is the active window (the one in front;
"A." in the following figure).

We're going to use the System Folder because it's got a lot of stuff in it.
Next, you're going to use a menu. Remember how to choose a menu command? Click the menu's name and then click the command you want in
the dro~own list.
2. Locate the View menu at the top of the screen; from it, choose "as Ust"
(see "B." in the following picture).
Suddenly, the big icons are replaced by a neat alphabetical list of the
window's contents ( labeled here as "C.").

Applt Menu lttms

~

Applic•tlon Support

~

E><ttnskms

, ontl"ol Strip Modulu

~

ti1.

.; 11sWlndow
as Pop-up Window
aean Up
Arrange
.,
View Options-
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The easiest homework 1J.OU 1fle efler had
To reinforce your budding mouse skills, here's a pathetically easy assignment: Read the iBook's own version of the lessons in this chapter.
To try out this self-help program, cancel your appointments for the next 20
minutes and turn off your phone's ringer. Now click the Help menu at the top
of the s creen and then click the Mac Help command. A window opens that's
filled with useful how-to lessons; you should probably start by clicking the
one called Basics, and then reading the sub-topics called Opening Files and
Working with Windows.

How to 9et help
Now that you've discovered the Help center, by the way, make a mental note
for later. The iBook's Help command stands ready to answer any other questions that may arise. Here's how it works:
When you need answers, click the Help menu at the top of your screen. This
time, click the Help command. You get a window that looks like this.

o.
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•
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] [I Search IJ
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You can use this Help Cente r in two ways. First, you can type a Help topic
into the blank at the top of the window (such as naming files or dialing the
Internet) - and then click the Search button. If you're having a good night,
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the window will then show you a list of Help pages that might contain the
answer you're looking for; click the name of the topic that seems to hold
some promise.
Second, you can click your way through this little Help program. In the previous illustration, see all the topics written in blue underlined type?
Of course not. This is a black-and-white book. How silly of me.
But on your screen, all those underlined phrases show up in blue lettering.
That blueness, and that underlining, means click me to jump to a different
page. By clicking on successive blue underlined phrases, you can often hone
in on the precise Help article you're interested in.

Pit stop
Close the iBook for now, which puts it to sleep. Chapter IMis something of a
chalk-talk to help you understand what's really happening inside the computer's puny brain. If you're eager to start doing actual typing, skip to
Chapter 3; if you'd like to know what all those alien-looking keys on your keyboard do, hit Chapter 13.

Top Ten Similarities between
You and Your i8ook
Before you move boldly forward to the next chapter, ponder the following
frightening similarities between you and your computer:
1. Both are pulled out of a very special container on Day One.

2. Both have more curves than straight edges.
3. Both have slots to provide adequate ventilation.
4. Both spend much of their time asleep.
5. Both sometimes crash when asked to do too much at once.
6. Both have a button on the front.
7. Both light up when turned on.
8. Both occasionally enjoy a good CD.
9. Both may be connected to a phone line for days at a time.
10. With considerable effort, both may be made to work with Microsoft
Windows computers.
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Chapter 1%

High-Tech Made Easy
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
..,.. Why memory and disks aren't the same thing
..,.. Why you'll never lose work to a computer glitch
..,.. What to remember about memory

•••••••••••••••••••••••••••••••••••••••••••••••••

How an iBook Works
I'm a little worried about sticking this chapter so close to the front of the
book. Plenty of people firmly believe that the iBook has a personality - that
when something goes wrong, the iBook is being cranky; and when a funny
message appears on the screen, the iBook is being friendly. Don't let the following discussion of cold, metal, impersonal circuitry ruin that image for you;
the iBook does have a personality, no matter what the wireheads say.
For the first time, you're going to have to roll up your brain's sleeves and
chew on some actual computer jargon. Don't worry-you'll feel coolly in
control by the time it's over. Besides, it's a short chapter.

Storin9 thin9s with disks
Human beings, for the most part, store information in one of two places.
Either we retain something in our memory, or we write it down on the back of
an envelope.
Computers work pretty much the same way. They can either store what they
know in their relatively pea-brained memory, which I'll cover in a moment, or
they can write it down. A computer writes stuff down on a computer disk.
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Conceptualizin9 the hard disk
Every iBook has a gigantic disk built inside it - a hard disk. The concept of a
hard disk confuses people because it's hidden ins ide the iBook's case. Since
you can't see it or touch it, it's sort of conceptual - like beta-carotene or
God, I guess. But it's there, spinning quietly away, and a hefty chunk of your
iBook's purchase price paid for it.
Why all this talk of disks? Because a hard disk is where your life's work is
going to live when the computer is shut off. You will, like it or not, become
intensely interested in the overall health of your computer's hard disk.
The hard disk isn't the only one you'll encounter in your lifetime, by the way.
You may one day decide to buy an external disk drive that plugs into the side
of the iBook; into such a disk drive, you can insert removable disks like
floppy disks, Zip disks, and so on. (Unlike most laptops, the iBook doesn't
have a built-in floppy-disk s lot.) Copying your important work onto a pocketable disk is a handy way to back up, or make a safety copy of, whatever
you've been working on. Details on floppy-disk attachments, Zip drives, and
other such removable disks in Chapter 19.

Understandin9 memorlJ.
Okay. Now we get to the good stuff: how a computer really works. I know
you'd just as soon not know what's going on in there, but this info is mental
broccoli: It's good for you, and later in life, you'll be glad you were forced to
digest it. If, at this point, your brain is beginning to hemorrhage, skip this section and find serenity in Chapter 2.
There's actually a significant difference between an iBook's memory and your
memory (besides the fact that yours is probably much more interesting).
When you shut down the iBook (not just put it to s leep), it forgets everything.
It becomes a dumb, metal-and-plastic doorstop. That's because a computer's
memory, just like yours , is kept alive by electrical impulses. When you turn
off an iBook, the electricity stops.
Therefore, each time you turn on an iBook, it has to relearn everything it ever
knew, including the fact that it's a computer, what kind of computer it is, how
to display text, how many days until your warranty expires, and so on. Now
we arrive at the purpose of those disks we've been droning on about; that's
where the computer's knowledge lives when the juice is off. Without a disk,
the iBook is like someone with a completely hollow skull (and we've all met
that type). If you're ever unlucky e nough to experience a broken hard drive,
you'll see how exciting an iBook can be without a disk: It shows a completely
gray screen with a small blinking question mark in the middle. (I've met a few
people like that, too.)
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When you turn on a completely shut-down iBook, there's whirring and blinking. The hard disk inside begins to spin. When it hits about 4,500 rpm, the
iBook starts reading the hard disk - it "plays" the disk like a CD player. It
finds out: "Hey, I'm an iBook! And this is how I display text!" and so on. The
iBook is reading the disk and copying everything it reads into memory.
(That's why the computer takes a minute or so to start up.)
Memory is really neat. After something's in memory, it's instantaneous ly
available to the computer. The iBook no longer has to read the disk to learn
something. Memory is also expensive (at least compared to disks); memory
is a bunch of complicated circuits etched onto a piece of silicon the size of a
piece of Trident by people in white lab coats.
Because it's more expensive, computers have far less memory than disk
space. For example, even if your hard disk holds every issue of National
Geographic ever published, you're probably only going to read one article at a
time. So the iBook reads "The Nocturnal Nubian Gnat: Nature's Tiniest
Vampire" from your hard disk, loads it into memory, and displays it on the
screen. So it doesn't matter that your iBook's memory doesn't hold as much
as your entire hard disk; the iBook uses the hard disk for long-term, permanent storage of lots of things, and it uses memory for temporary storage while
you work on one thing at a time.

You often hear computer jocks talk about megs. Only rarely are they referring
to Meg Ryan and Meg Tilly. Meg is short for m egabyte. So is the abbreviation
MB. (Mega = 1,000,000, and byte= an iota of information so small it can only
specify a single letter of the alphabet.)
What's highly confusing to most beginners is that you measure memory (fast,
expensive, temporary) and hard-disk space (permanent, slower) in the same
units: megabytes. A typical !Book has 32_meg_s of memory (silicon chips) but
]J.QOmegs of hard-disk space (spinning platters).
(Free bonus fact: If a hard drive's size reaches 1,000 megs, it gets a new measurement name - its size is said to be one gigabyte. The abbreviation for one
gigabyte is lGB. Your iBook's hard drive may hold, for example, 3.2 GB.
Computer nerds sometimes use shorthand for this measurement - "My
iBook's hard drive has three gigs" -which absolutely bewilders jazz-club
musicians.)

With these vital facts in mind, see if you can answer the following paradoxical
dinner party question:
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"How many megs does your iBook have?"

The novice's answer: "Um ... say, have you tried those little cocktail weenies?"
The partly initiated's reply: "I ... I think 32?"
The truly enlightened response: "What do you mean, how many megs? Are
you referring to memory or to hard-disk storage space? Here, have a cocktail
weenie."

Understandin9 RAM
Let's add another term to your quickly growing nerd vocabulary list. It pains
me to teach you this word, because it's one of those really meaningless terms
that was invented purely to intimidate people. Trouble is, you're going to
hear it a lot. You may as well be prepared.
It's RAM. You pronounce it like the sheep. RAM is memory. A typical iBook
has 32 megs of RAM (in other words, of memory).
Incidentally, this might be a good time to find out how much RAM you have.
Here's how to find out.
Wake up, or turn on, your iBook.
See the ti logo in the upper-left corner of the screen? It's no ordinary logo.
It's actually a menu, just like the ones you've already experienced. Point
your arrow cursor tip on the apple, click the clicker button, and watch what
happens.
As with any menu, a list drops down. This one, however, includes an
extremely useful command. This command is so important that it's separated
by a dotted line from the mere mortal list items after it. It's About This
Computer.

~ Apple System Profiler
S AppleCDAudlo Player
Automated T11sks
._
Colcul otor

Cl
EJ
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Why they call it RAM
You know what an acronym is, right? It's a bunch
of initials that, together, spell out an actual word,
such as M.A.D.D. or SALT Treaty ... or RAM.

probably stood for Random Abbreviation for
Memory. Today, it supposedly stands for
Random Access Memory.

When the Committee for Arbitrary Acronyms
(the CAA) ratified the abbreviation RAM, it

Whatever that means.

Slide the pointer down until About This Computer turns black, and then click
the mouse button. A window appears:
[J
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Aboutlhl• Computer

~

~

Mac ·OS computer

-- "~ .... . ~

SJ I MocOS 8 .6

~

~

11ac OS ROM 2.3.1
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The number labeled Built-in Memory (which I've circled in the picture) is
how much actual RAM your iBook has. It's some multiple of eight. (The total
amount of usable memory, as listed on the second line, may be higher, thanks
to tricks such as RAM Doubler and virtual memory. Chapter 16 explains those
memory stunts in painstaking detail.)
In any case, your iBook's RAM endowment is a statistic you'll enjoy reviewing
again and again. Therefore, take this opportunity to write this number onto
your yellow cardboard Cheat Sheet at the front of the book. There's a little
blank for this information.
When you're finished with this little piece of homework, close the About This
Computer window by clicking the little square in the upper-left corner - the
Close box - to make the window go away.
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Puttin9 it all to9ether
Now that you know where a computer's information lives, let me take you on
a tour of the computer's guts. Let's get into our little imaginary Disney World
tram. Keep hands and feet inside the car at all times.
When you turn on the iBook, as I noted earlier, the hard disk spins, and the
iBook copies certain critical information into its memory. So far, the iBook
knows only that it's a computer. It doesn't know anything else that's stored
on your hard disk. It doesn't yet know about Nocturnal Nubian Gnats, your
new screenplay, or how much you owe on your credit card.

Mac OS What?
The About This Computer window (see the picture in this chapter) shows more than how much
memory your iBook has. It also reveals what
version of the System software you have.
And what, you may understandably be shrieking, is system software?
Long story. Every year, Apple Computer piles
neat new features onto the behind-the-scenes
software that runs your computer. This backstage software was once called the operating
system. But because everyone's in such a hurry
these days, people now just call it the OS. (Say
it "0-S," not "OS.")
The original, fall 1999 iBook models came
equipped with Mac OS 8.6- at the time, the
newest, trendiest OS around. But newer versions with more features will always be coming
down the pike; indeed, Mac OS 9 went on sale
only a few weeks later. (See the end of
Chapter 13 for more on this topic.)

I bring up this point here because certain iBook
features behave differently depending on which
version you have. For example, the Sherlock
command described in Chapter 4 looks completely different in Mac OS 9. The things on the
screen are pretty much the same; they've just
had a makeover on Oprah.
Finding out which OS version youriBook uses is
easy. Start by finding a pencil. If the About This
Computer window isn't already open, choose its
name from your ti menu. Note, in the upperright corner of the resulting window, the Mac
OS version you have.
The version is a number you'll need to know
later in this book and later in your life. Therefore,
take this opportunity to write it onto your Cheat
Sheet (the yellow cardboard page inside the
front cover of this book). You'll find a little blank
for this information in the upper-left corner of
your card, where it says, "Your System version."
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To get any practical work done, you now have to transfer the article (or
screenplay or spreadsheet) into memory; in Macintosh terminology, you
have to open a file. In Chapter 2, you'll find out how easy and idiot-proof this
process is. Anyway, after you open a file, it appears on-screen. (It's in
memory now.)
While your document is on the screen, you can make changes to it. This, of
course, is why you bought a computer in the first place. You can delete a sentence from your novel or move a steamy scene to a different chapter. (The
term for this process is word processing.) If you're working on your finances,
you can add a couple zeros to your checking-account balance. (The term for
this process is wishful thinking.) All without any eraser crumbs or whiteout.
Perceptive readers who haven't already gotten bored and gone off to watch
TV will recognize that you're making all these changes to what's in memory.
The more you change the screenplay that's up on the screen, the more it's
different from that permanent copy that's still on your disk, safe and sound.
At this point, you're actually in a pretty precarious position. Remember that
memory is sustained by electricity. In other words, if your four-year-old mistakes the iBook's power cord for a handy suckable plaything and jerks it out
of the wall, and removes the iBook's battery as an afterthought, then the electricity stops. The screen goes blank, and all the changes you've made
disappear forever. You're left with the original copy on the disk, of course,
but any work you've done on it vanishes, along with anything else in the
iBook's memory.
However, every software program has a simple command, called Save, that
saves your work back onto the hard disk. That is, the computer updates the
original copy that's still on the hard disk, and you're safe. Even if a sun storm
wipes out all power plants in the Northern Hemisphere and your iBook goes
dark, your novel or letter or spreadsheet is safe on the disk. Most people use .....__J
the Save command every five or ten minutes so that their work is always up / to date and preserved on the d isk. (You'll learn how to use the Save command in Chapter 4.)

+

"I lost all mlJ workf11
So that you'll quit worrying about it, the precariousness of memory accounts
for the horror stories you sometimes hear from people who claim that they
lost their work to a computer. "I was on volume Y of the encyclopedia I've
been writing," they'll say, "and I lost all of it because of a computer glitch!"
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Now you can cry crocodile tears and then skip back to your office with a
smirk. You know what happened. They probably worked for hours with some
document on the screen but forgot to use the Save command. Then the
unthinkable happened - someone tripped on the power cord - and, sure
enough, all the changes they'd made got wiped out. A simple Save command
would have stored everything neatly on the hard disk.

Top Ten Differences between Memor~
and a Hard Disk
May you never confuse memory with a hard disk again.
1. You usually buy memory 32 or 64 megs at a time. Hard disks come in
sizes like 2 gigs, 4 gigs, and on up. (A gigabyte is 1,000 megabytes.)

2. Memory comes on a little minicircuit board. A hard disk is a metal-cased
box with cables hanging out of it.
3. You can install memory only inside the computer (something Chapter 16
shows you how to do). A hard disk may be either inside the iBook (an
internal drive) or in a separate box you plug into the side (an external
drive).
4. Memory delivers information to the iBook's brain almost instantly. The
hard disk sometimes seems to take forever.
5. Some disks are removable. When one fills up, you can insert a different
one. (Some examples: floppy disks, Zip disks, and SuperDisk disks.)
Removing RAM is a more serious proposition, generally involving a
knowledgeable geek's assistance.
6. Not every computer on earth has a hard disk. (The earliest Macs used
nothing but floppy disks, and pocket organizers such as the PalmPilot
have no disks at all.) But every computer ever made has memory.
7. If you listen carefully, you can hear when the iBook is reading information off a hard disk; it makes tiny frantic scraping noises. You can't tell
when the iBook is getting information from RAM.
8. As a very general rule, RAM costs about $3 per meg, and hard drive
space averages about 15 cents per meg.
9. Memory's contents disappear when you shut down the computer. A
disk's contents stay there until you deliberately throw them away.
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10. To find out how much hard-disk space you have left, look at the top of a
window on your desktop, as shown here:
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But to see how much RAM you have left, you must choose About This
Computer from your S menu to see the window shown a few pages
back.
The number where it reads Largest Unused Block is roughly how much RAM
you're not using at the moment. Details are in Chapter 16.
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Chapter 2

Windows, Icons, and Trashes
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
..,. All about windows, folders, and icons
.... Learning keyboard shortcuts
.... Tips on using windows and disks to raise your social status

•••••••••••••••••••••••••••••••••••••••••••••••••

Becomin9 Manipulatitle

A

II the clicking and dragging and window-shoving you learned in Chapter I
is, in fact, leading up to something useful.

Foldermania
I've said that your hard disk is like the world's biggest filing cabinet. It's
where you store all your stuff. But a filing cabinet without filing folders would
be about as convenient to handle as an egg without a shell.
The folders on the iBook screen don't occupy any space on your hard drive.
They're electronic fictions whose sole purpose is to help you organize your
stuff.

Mr. Folder

The iBook provides an infinite supply of folders. Want a folder? Do this:
From the File menu, choose New Folder.
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1180
agp
Move To Tr11sh 1!8<iil
Close Window l!8W

Ooh, tricky, this machine! A new folder appears. Notice that the iBook gracefully proposes "untitled folder" as its name.

Notice something else, though: The name is highlighted (shaded - usually
light blue). Remember our earlier lesson? Highlighted= selected= ready for
you to do something. When text is highlighted, the iBook is ready for you to
replace it with anything you type. In other words, you don't even have to
backspace over the text. Just type away:
I. Type USA Folder and press the Return key.
The Return key tells the iBook that your naming spurt is over.
Now, to see how folders work, create another one.
2. From the File menu, once again choose New Folder.
Another new folder appears, once more waiting for a title.
3. Type Ohio and press Return.
You're going to create one more empty folder. But by this time, your trackpad
fingertip is probably weary from the forlorn trek back and forth to the File
menu. Don't you wish you could make a folder faster?
You can.

Ke1J.board shortcuts
Open the File menu, but don't select any of the commands in it yet. See those
weird notations to the right of some commands?
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fjgp

Move To Tr;ss
OoseWlndo

Get Info
Label
Sharing_
011plicate
Make Alias
Put Away

at@
'#IN(
(jg j

~

fll O
fllM

Find-.
Show Original

Get used to 'em. They're keyboard shortcuts, and they appear in almost every
menu you'll ever see. Keyboard shortcuts let you select certain menu items
without using the trackpad.
Some people love keyboard shortcuts, claiming that if you're in a hurry,
pressing keys is faster than using the trackpad. Other people loathe keyboard
shortcuts, pointing out that using the trackpad doesn't require any memorization. In either case, here's how keyboard shortcuts work.
When you type on a typewriter, you press the Shift key to make a capital letter,
right? They call the Shift key a modifier key because it turns ordinary, wellbehaved citizen keys like 3 and 4 into madcap symbols like# and $. Welcome
to the world of computers, where everything is four times more complicated.
Instead of having only one modifier key, the iBook has five of them! Look down
next to your spacebar. There they are: In addition to the Shift key, one says Fn,
one says Option, one says Ctr!, and another has a littl~symbol on it.

~ymbol

It's that little cloverleaf - .tile command
appears in the
File menu. Next to the New Folder command, you see 3€-N. That means:
1. While pressing the :IC key, press the N key and then release everything.

Barn! You've got yourself another folder.
2. Type Michigan and press Return.

You've just named your third folder. So why have you been wasting a
perfectly good afternoon (or whatever it is in your time zone) making
empty folders? So you can pretend you're getting organized.
3. Drag the Ohio folder on top of the USA Folder.
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Unimportant sidebar about other menu symbols
Besides the little keyboard-shortcut symbols at
the right side of a menu, you'll occasionally run
into a little downward-pointing arrow, like this:

Ruant Garde
Bookmon
Chicogo
Courier
Futura
Garamond
Geneuo
Hortel
Heluetic11
Monoco
P11l11tino
S mbol

That arrow tells you that the menu is so long, it
doesn't even fit on the screen. The arrow is
implying that still more commands are in the

menu that you're not seeing. To get to those
additional commands, carefully roll the pointer
down the menu all the way to that down-pointing
triangle. Don't let the sudden jumping scare
you: The menu commands will jump upward,
bringing the hidden ones into view.
And then there are the little black triangles
pointing to the right(left side of the illustration).
These triangles indicate that, when selected,
the menu command won't do anything except
offer you several other commands, which pop
out to the side (at right in the figure):

Re-sod ...
Dry Out .. .
Trample

Re-sod ...
Dry Out .••
Trample

Michigan

Make sure that the tip of the arrow actually hits the center of the USA
Folder so that the folder becomes highlighted. The instant it turns black,
let go of the Ohio folder - and watch it disappear into the USA Folder.
(If your aim wasn't good, you'll now see the Ohio folder sitting next to
the USA Folder; try the last step again.)
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4. Put the Michigan folder into the USA Folder in the same way - by
dragging it on top of the USA Folder.
As far as you know, though, those state folders have disappeared. How
can you trust me that they're now neatly filed away?
5. Double-click the USA Folder.
Yep. Opens right up into a window, and there are your two darling
states, nestled sweetly where they belong.
If you were to double-click one of the state folders, you'd open another

window. ( Having a million windows open at once is nothing to be afraid
of. If you're a neatness freak, you might feel threatened, but closing them
is easy enough - remember the close box in the upper-left corner of
each one?)
Okay, so how do you get these inner folders out again? Do you have to
drag them individually? That would certainly be a bummer if you had all
50 folders in the USA Folder.
Turns out there are several ways to select more than one icon at a time.

God never closes a window
When you opened the USA Folder, did you
notice how its icon changed texture? After you
double-clicked it, the icon turned dark and sort
of grainy.
It's supposed to do that. When you double-click
any icon to make its window appear, the icon
itself turns into...a grainy silhouette. That's your
..11.isual clue that it's been openeiL.
The icon won't collapse back into its normal,
more attractive state until you close the corresponding window. (Can't find it? Then
double-click the already-opened icon again. Its
window will pop to the fore.)

Yet to be opened

Already opened

USA Folder

~

USA Fol der

~

A CD- ROM disc

A CD-ROM disc

B

Macintosh HD

a

Macintosh HD
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6. Click above and to the left of the Ohio folder (Step I in the upcoming
picture) and, without releasing the clicker, drag down and to the right
so that you enclose both folders with a dotted rectangle (Steps 2 and 3).
2

~

tt tl
Ohio

Michigan

3

[j] MSlo
~

'

Sn
~

Release the clicker button when you've got both icons enclosed.
Now that you have several folders selected, you can move them en
masse to another location.
7. Drag the Ohio folder outside of the USA Folder window.
The Michigan folder goes along for the ride.
This was a somewhat unproductive exercise, of course, because we were
only working with empty folders. It gets much more exciting when you start
working with your own documents. All of these techniques work equally well
with folders and with documents.

How to trash somethin9
Here's one more icon-manipulation trick you'll probably find valuable:
I. Close the USA Folder by clicking its close box.
USA folder~

2. Drag the folder on top of the Trash can in the lower-right corner of
the screen.
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Don't let go until the Trash can actually turns black (when the tip of the
arrow cursor is on it). When you do let go, notice how the Trash can overflows, a subtle reinforcement of how important it thinks your stuff is.
Anyway, that's how you throw things out on the iBook: Just drag them on tolh
of the Trash can. (There's even a keystroke for this: l::!!_ghlight an icon and ~
then press :Jg-Delet&,. The chosen icon goes flying into ffleTrash as thougfi it's
just been drop-kicked.)

Bonus technique for extra credit
The method of selecting several icons by dragging a rectangle around them is fine if all the icons
are next to each other. But how would you select only the icons that begin with the letter A in this
picture?
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You can't very well enclose each A by dragging on the trackpad - you'd also get all the other icons
ithin the same rectangle.
The power-user's secret ·
ach icon while pressin the hift e . s long as you're pressing
Shift, you continually add additional, non a iacent icons to the selection. (And if you Shift-click one
by accident, you can deselect it by Shift-clicking again. Try itl)
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What's really hilarious is how hard Apple made it for you to get rid of something. Just putting something into the Trash doesn't actually get rid of it;
technically, you've really only put it into the Oblivion Waiting Room. It'll sit
there forever, in an overflowing trash can. To rescue something, you just
double-click the Trash can to open its window; then drag whatever-it-was
right back onto the screen.
So if putting something into the Trash doesn't really delete it, how do you
really delete it? You choose Empty Trash from the Special menu.
But even then your stuff isn't really gone; you get a message like this:

The Trilsh contains 4 Items, which use 176K
of disk spilce.Are you sure you want to
r emove these Items permanently?

C§!lCill (I

OK

Click OK, and your file is finally gone.
Actually, don't tell anybody, but even after you've emptied the Trash, your file
still isn't really gone forever. Programs like Norton Utilities can unerase a file
that's been trashed, as long as you haven't used your iBook much since you
threw away the file. That's useful to remember in case (1) you ever trash
something by mistake, or (2) you're a spy.

Your basic CD-ROM crash course
You won't get far in life without knowing how to
use your iBook's built-in CD-ROM drive. For
example, whenever you buy new software to
install onto your iBook, you'll get it in the form of
a CD-ROM disc.
To insert a CD, locate the CD-ROM drawer. This
drawer, almost invisible when it's closed, constitutes most of the right side of the iBook. To
open the drawer, press the capsule-shaped
button in the middle of the panel. After a
moment, the CD tray pops out about an inch.
With your finger, pull it out all the way. Place a
CD into it- label side up - and snap the
center ring down over the little sprocket in the

center of the tray. (Avoid touching the underside
of a CD.) Finally, push the tray shut In about 10
seconds, the CD's icon shows up at the right
side of your iBook screen.
To get the CD out again, don't try pressing that
CD-drawer button again - it won't work. (It
makes the tray pop out only when the CD tray is
empty.) Instead, click the CD's icon on the
screen and, from the Special menu, choose
Eject Disk. (Or - shortcut time - drag the CD's
icon onto the Trash icon.)
The tray pops open so that you can remove
the CD.
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Now you can understand why you never hear iBook owners complain of
having thrown away some important document by accident - an iBook
won't let you get rid of anything without fighting your way through four
layers of warnings and red tape.
Pretty cool computer, huh?

Top Ten Window, Icon, and Trash Tips
Staggering through the basics of using your iBook unattended is one thing.
Shoving around those on-screen windows and icons with grace is quite
another. Master the following, and then invite your friends over to watch
some evening.
l. To rename an icon, click carefully on its name. Wait for a second or so,

until a rectangle appears around the name. That's your cue to type away,
giving it a new name. Press Return when you're done.
1.

2.

3.

2. Don't forget that you can look at a window's contents in a neat list
(choose "as List" from the View menu). Once in a list view, when a folder
is highlighted, you can press 3€~ to expand it (as though you'd clicked
the triangle to view its contents) and 3€+- to collapse it again.
3. Every time you choose Empty Trash from the Special menu, the iBook
asks you if you're absolutely sure. If you'd prefer to simply vaporize the
Trash contents without being asked for confirmation, select the Trash
icon. From the File menu, choose Get Info and then click the "Warn
before emptying" check box so that the check mark disappears.
4. If you have a very important document, you can prevent it from getting
thrown away by accident. Click its icon. From the File menu, choose Get
Info. Turn on the Locked check box. Now, even if you put it in the Trash
and try to empty the Trash, the iBook will simply tell you that there's a
locked item in the Trash, which it won't get rid of.
5. To make a copy of a file, click the icon and then choose Duplicate from
the File menu. Or, while pressing the Option key, drag the icon into a
new window or folder.
6. Isn't it frustrating to open a window that's too small to show you all its
contents (shown below at left)?
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Of course, you could spend a weekend fussing with the scroll bars,
trying to crank the other icons into view. Or, by using trial-and-error, you
could drag the lower-right handle (the resize box) to make the window
bigger.
There's a much quicker solution. Click the zoom box in the upper-right
corner of the window (shown below at right by the cursor). The iBook
automatically makes the window exactly large enough to show all of the
icons.
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7. You don't have to be content to leave the Trash stranded way down
there at the bottom of your screen. You can move it anywhere you want,
just by dragging it.
8. Try this sneaky shortcut: ~hile pressing the Control (Ctr!) key, point the
cursor tip on an icon, disk, or the inside of a window. Keep the Control
key pressed; if you now hold down the clicker button, a pop-up menu
appears at your cursor tip, listing commands that pertain only to that
icon, disk, or window.
LJ}-===> Chcipters~ E!liBT
Help
Open
l;Ject

Open
Move To Trash

Get Info
Label
..
Sharing_.
Make Alias

Get Info
Label
..
Sharing._
Duplicate
MakeAllns

4

ilert\$, 246.4 MB •v111

[!

03.00C

~
05.doc

•]

~Help
New Folder
aoseWlndow
Get Info
Sharing_

..
..

View
Clean Up
Arrange
View Options-

For example, if you Control-click a disk or CD, you'll be offered commands like Eject, Help, and Open. If you Control-click an icon, you get
commands like Get Info, Duplicate, and Move To Trash. And if you
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Control-die a
here inside a window - but not directly on an icon you're offered New Fo er, ort List, an
ose m ow.
e
for this phenomenon is contextual menus - because the menu is different depending on the context of your click.)
9. When your life overwhelms you with chaos and random events, at least
your iBook can give you a sense of control and order.
Want proof? Open a window, such as your Macintosh HD window. From
the View menu, choose "as Icons." Note how messy, crude, and slovenly
your icons look!
Now, from the View menu, choose View Options. In the window that
appears, click Keep Arranged, like this:
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And then click OK. Now, no matter how many icons you add to this
window, and no matter what size you make the window, your icons will
"-always remain in neat alignment.
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10. You don't have to clean up your windows before you shut down the
computer. The windows will be right where you left them the next time
you tum on the iBook.
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Chapter 3

Actually Accomplishing
Something
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
.... What software is, for those who care
.... Copying and pasting
.... Desk accessories and the fruit-shaped menu they're listed in
.... The pure, unalloyed joy of control panels

•••••••••••••••••••••••••••••••••••••••••••••••••

~e iBook is like a VCR. The software programs you install on the iBook

~re like the tapes you slip into your VCR. Without tapes (software) , the
VCR (iBook) is worthless. But with tapes (software), your VCR (iBook) can
take on any personality.

f

A VCR might let you watch a Western one night, home movies another, and a
60 Minutes expose about a corrupt Good Humor man another night. In the
same way, your iBook can be a typing instructor, a checkbook balancer, or a
movie-editing machine, depending on the software you buy. Each piece of
software - usually called a program, but sometimes known as an
application - is like a different GameBoy cartridge: It makes the iBook look,
feel, and behave differently. The average iBook user winds up using about six
or seven different programs regularly.

Obsolescence TheraplJ.
Your relationship with a software company doesn't end when you buy the
program. First, the company provides a technical help staff for you to call
when things get rocky. Some firms are great about this relationship - they
give you a toll-free number that's answered immediately by a smart, helpful,
customer-oriented technician. More often, though, sending out an SOS is a
long-distance call ... and a long-distance five- or ten-minute wait before
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somebody can help you. How can you find out.]:w.w.ggod a company's

bel~

Jine.i&? B askin around and readingJhe reviews in Mac magazines (such as
_Macworld, MacHome Journa , or

acAddict).

Like the computers themselves, software programs are continually being
improved and enhanced by their manufacturers. Just as in owning a computer,
owning a software program isn't a one-time cash outlay; each time the software company comes out with a new version of the program, you'll be offered
the chance to get it for a small "upgrade fee" of $25 or $99, for example.
You'd think people would get fed up with this endless treadmill of expenses
and just stick with the version they've got, refusing to upgrade to successive
versions. Some manage it. Most people, however, succumb to the fear that
somehow they'll be left behind by the march of technology and wind up forking over the upgrade fees once a year or so. Let your budget and sense of
independence be your guide.

Credit Card Workout #2:
8u1J.in9 So~u/are
(Credit Card Workout #1, by the way, was buying the computer.)
The iBook comes with a handsome bonus gift of software preinstalled on the
hard disk. That's fortunate, because software, for the most part, is expensive.
If you decide to explore the world of Mac software beyond what came with
your iBook, for example, you'll discover that the popular word-processing
program called Microsoft Word sells for about $300. If you plan to do number
crunching, more than 90 percent of Mac users use the Microsoft Excel
spreadsheet (another $300). Want a database for handling order forms, tracking phone calls, and creating form letters? Check out the fantastic FileMaker
Pro (around $200). (Try, try not to focus on the fact that what you get for that
money is a 50-cent CD.)

But all that's for later; for now, revel in the fact that you own one of the greats:
an integrated program calleq,.Ap J.eWor.ks. This single program is actually several programs mashed into one: word processor, database, spreadsheet,
drawing program, and so on. (See Chapter 9, "Putting AppleWorks to Work.")
Your iBook also came with a program called Palm Desktop, which is a combination calendar and address book. If your computer has never beeped at you
when it's time to leave for a meeting, you haven't lived. (Chapter 10 covers Palm
Desktop in thrilling detail.) Actually, your iBook also came with two games,
an encyclopedia on CD-ROM, and a program that shields young eyes from the
Internet's dark side; Chapter 10 offers instruction in these programs, too.
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Where to tJet it
There are two places to buy software: via mail order and at a store.
Unfortunately, as you'll quickly discover, today's computer stores generally
offer a pathetically small selection of Macintosh software. On the other hand,
mail-order companies offer thousands of choices; give much bigger discounts; take returns after you've opened the box; and don't charge sales tax.
And, of course, you don't have to fire up the old Volvo. You get your stuff
delivered to your door by the next day. (The overnight shipping charge is
usually $5 per order.)
The mail-order companies are called things like Outpost.com, Mac
Connection, Mac Zone, and Mac Warehouse. They all have toll-free phone
numbers and Web pages (see Appendix A, "The Resource Resource," for a
listing). Overnight mail-order companies like these are truly one of the bright
spots in the computer world. You can call Mac Connection, for example, until
2:45 a.m. and get your new programs by midmorning (seven hours later).
After ordering from these companies, you'll start to wish there were
overnight mail-order grocery stores, gas stations, and dentists.
All right, maybe not dentists.

In the next chapter, you're going to do some~ord processing. As a warm-up,
however, let me show you some of the basic principles of using programs on
the iBook. To make sure you've got the same thing on your screen that I do,
we'll start off by using the built-in programs that came with your !Book.

El cheapo software
Once you've read Chapter 6, and you've decided
it might be fun to plug your iBook into the telephone line to dial up faraway computers, you
may stumble onto another kind of software:
These are programs written by individuals, not software companies, who make
their programs freely available on the Internet
You can grab them, via telephone, and bring
them to your own iBook. And get this: Only the

wacawace.

honor system, for heaven's sake, compels you to
pay the authors the $15 or $20 they' re asking for.
Sure, shareware often has a homemade feel to
it On the other hand, some of it's really terrific.
You can search for the kind of shareware program you want (and also for acres of sounds,
pictures, clip art, and games) on America Online
and on the Internet (such as at www.mac
download.com or ~shareware.com).
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Your flerlJ first so~ware
There are several m enus across the top of the screen (remember these?). As
you get to know the iBook, you'll discover that their wording changes from
program to program. Right now, they say, for example, File, Edit, View, and
Special; in a word processor they might say File, Edit, Font, Size, Format, and
so on. The menu names (and the commands listed in those menus) are tailored
to the function of the software.
There's one menu that's always on your screen, though: our friend the Apple
menu (the S at the left edge of the menu bar). Among other things, this menu
provides immediate access to some useful miniprograms known as desk
accessories. Desk accessories are surefire, nonthreatening, and fun - perfect
for your first baby steps into the world of software.

Desk Accessories

®

Let's start simple. Move your cursor up to the S menu and choose
Calculator. The Calculator pops up in a tiny window of its own.

The Calculator
Using the mouse, you can click the little Calculator buttons. The iBook gives
you the correct mathematical answer, making you the owner of the world's
biggest pocket calculator.
What's neat is that you can also type the number keys on your keyboard. As
you press these real keys, you can watch the on-screen keys in the Calculator
window get punched accordingly. Try it out!
Take a moment to reinforce your love of windows: By dragging the title bar
(where it says "Calculator"), move the Calculator window into a new position.
If you were tired of looking at it, you could also make the Calculator go away
by clicking its close box (in the upper-left corner, like on all windows).
But don't close the Calculator just yet. Leave it open on the screen.
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The Note Pad
Now open the ti menu again. Do you see a command called Note Pad? If so,
click its name.
If not, your iBook may have the upgraded operating software called Mac OS 9

(read all about it at the end of Chapter 13). In that case, skip the ti menu;
your Note Pad has moved to a new address. Double-dick your hard drive
icon ("Macintosh HD"); then double-click the Apple Extras folder; then
double-click the Note Pad to open it.
Either way, the world's most frill-free word processor should now be on the
screen.
You'll learn more about word processing in the next section. For now, we're
just going to do some informative goofing around. With the Note Pad open on
your screen, type a math problem, like this:
37+8+19*3-100

(In the computer world, the asterisk[*] means "times," or multiply.) If you
make a mistake, press the big Delete key at the upper-right corner of your
keyboard. This key means "Backspace."
Now, by dragging the Note Pad's title bar, move it so that you can see the
Calculator window, too.
NotePad ~ li!IB

C11lculator

You're going to use two programs at once, making them cooperate with each
other - one of the most remarkable features of the iBook.
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Selectin9 text
This is about to get interesting.
Using the trackpad, position the pointer at the left side of your equation
(below, top). Press the clicker button and drag, perfectly horizontally, to the
right (middle). Release the mouse after you've highlighted the entire equation (bottom).
!37+6+ 19*3- 100

I
You've just selected some text. Remember in Chapter 1, when you selected an
icon - and then used a menu command? Struggling, as always, to come up
with a decent analogy, I likened this select-then-operate sequence to building a
noun-verb sentence.
Well, it works just as well with text as It does with icons. You've now highlighted, or selected, some text. The iBook now knows what the noun is what it's supposed to pay attention to. All you have to do is select a verb
from one of the menus. And the verb du jour is Copy.

The cornerstone of human endeaflor:
CoplJ and Paste
Choose Copy from the Edit menu.

Thunder rolls, lightning flashes, the audience holds its breath ... and
absolutely nothing happens.
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Behind the scenes, though, something awesomely useful occurred. The iBook
looked at the selected equation and memorized it, socking it away into an
invisible storage window called the Clipboard. The Clipboard is how you
transfer stuff from one window into another and from one program into
another. (Some programs even have a Show Clipboard command, in which
case I take back the part about the Clipboard being invisible.)
Now then. You can't see the Clipboard at this point, but in a powerful act of
faith, you put your trust in me and you believe that it contains the highlighted material (the equation).

The Application menu
See the tiny Note Pad icon at the right end of your menu bar, helpfully identified by the words Note Pad?
The Application menu

4:22PM

+

~

This icon actually represents a menu - the Application menu, of course. It
lists all the programs that you have running at once. At this moment, you
have three programs running at once: the Note Pad, the Calculator, and the
famous Finder (or desktop).
You multitasking maniac, you.
Choose Calculator from the Application menu.
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The Calculator window moves to the front, and the icon in the upper-right
changes to look like a Calculator.
Those of you still awake will, of course, object to using the Application menu
to bring the Calculator forward. You remember all too plainly from Chapter 1
that simply clicking in a window brings it to the front, which would have
required less muscular effort.
Absolutely right! You may now advance to the semifinals. However, learning
to use the Application menu was a good exercise. Many times in your upcoming life, the program in front will be covering up the entire screen. So then
how will you bring another program forward, big shot? That's right. You can't
see any other windows, so you can't click one to make it active. You'll have to
use the Application menu.
In any case, the Calculator is now the active application. (Active just means
it's in front.) Now then: Remember that intricate equation that's still on the
iBook Clipboard? Instead of having to type an equation into the Calculator by
punching keys, let's just paste it in:
1. Press the letter C key on your iBook keyboard, or click the C button

on the Calculator.
You just cleared the display. We wouldn't want your previous diddlings
to interfere with this tightly controlled experiment.
2. From the Edit menu, choose Paste - and watch the Calculator!
If you looked in time, you saw the number keys flashing like Las Vegas at mid-

night. And with a triumphant modesty, the iBook displays the answer to your
math problem. (It should be 92.)
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Did you get what just happened? You typed out a math problem in a word
processor (the Note Pad), copied it to the Clipboard, and pasted it into a
number-cruncher (the Calculator). Much of the miracle of the Macintosh
stems from its capability to mix and match information among multiple programs in this way.
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It's a two-way street, too. You can paste this number back into the word
processor:
I . From the Edit menu, choose Copy.
But wait! Something was already on the Clipboard. Where is the iBook
supposed to put this new copied info?
On the Clipboard, of course. And whatever was there before (your equation) gets nuked. The Clipboard contains exactly one thing at a time whatever you copied most recently.
2. From the Application menu, choose Note Pad (or just click the Note
Pad window).
The Note Pad is now the active application.
3. Type the following:

Dear son: You owe me $
Stop after the $ sign. Move the mouse up to the Edit menu.
4. From the Edit menu, choose Paste.
Bingo! The iBook pastes in the result from the Calculator (which it had
ready on the Clipboard).
Incidentally, whatever's on the Clipboard stays there until you copy
something new or until you turn off the machine. In other words, you
can paste it over and over again.
5. For a second time, choose Paste from the Edit menu.
Another 92 pops into the window.

-

NoteP11d

Dear son: Vou owe me $9292

You don't have to use the menu to issue a command like Copy or Paste. If you
wish, you can use a keyboard shortcut to do the same thing. You may remember having used the 3€ key in Chapter 2 to issue commands without using the
mouse.
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Memo to NASA scientists
Don't rely on the little Calculator program for
calculating launch times or impact statistics, at
least not without understanding how its math
differs from yours.
The Calculator processes equations from left to
right It does not solve the multiplication and
division components before the addition and
subtraction, as is standard in math classes
worldwide.

For example, consider this equation: 3+2*4=.
(The *means "times" in computertand.) The scientific answer is 11, because you multiply
before you add when solving such puzzles. But
the Mac's answer is 20, because it processes
the numbers from left to right

And how are you supposed to remember which letter key corresponds to
which command? Well, usually it's mnemonic: 3€-P means Print, 3€-0 means
Open, and so on. But you can cheat; try it right now. Click the Edit menu.
r

~

File
Un do

Cut
Copy
Past e 'l!f.V

Cle<1r

There's your crib sheet, carefully listed down the right side of the menu.
Notice that the keyboard shortcuts for all four of these important commands
(Undo, Cut, Copy, Paste) are adjacent on the keyboard: Z, X, C, V.
C is Copy. And V, right next to it, is Paste. (I know, I know: Why doesn't P
stand for Paste? Answer: Because P stands for Print! And anyway, V is right
next to C-for-Copy on your keyboard, so it kind of makes sense.)
Click anywhere else on the screen (to ditch the menu) and let's try it:
I. While holding down the 3€ key, type a V.

Bingo! Another copy of the Clipboard stuff (92) appears in your Note Pad.
(Jn the future, I'll just refer to a keyboard shortcut like this as "3€-V.")
2. Press 3€-V again.
Yep, that kid's debt is really piling up. He now owes you $92,929,292.
But after all, he's your son. Why not just let him pay 1 percent down
on the amount he owes you? In other words, why not undo that last 92
pasting?
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3. From the Edit menu, choose Undo.
The most recent thing you did - in this case, pasting the fourth 92 gets undone.
Rewriting history is addicting, ain't it?
Remember, though, that Undo only reverses your most recent action. Suppose
you (1) copy something, (2) paste it somewhere else, and then (3) type some
more. If you choose Undo, only the typing will be undone (Step 3), not the
pasting (Step 2).

Control Panels
One item in your ti menu isn 't a desk accessory. It says Control Panels, and
all it does is open up your Control Panels folder. So what exactly is your
Control Panels folder? It's a folder that lives inside your System Folder. It contains a bunch of icons, each of which controls some aspect of your iBook.
Choose Control Panels from the ti menu to make the Control Panel window
appear.
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I'll show you around one control panel; then you can take it from there:
I. Quickly type DA on your keyboard.

Remember this handy trick? You can select one icon in a folder just by
typing the first couple of letters of its name. In this case, you get the
Date & Time icon.
2. Double<lick the Date & Time icon.
The Date & Time control-panel window opens. This is where you set the
clock - as displayed, for example, at the top right of your screen. To
change the time, click a number and then type the correct number in
its place.
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.Date &Time - r Current Date - - - - - - . r current Time - - - - - , , .
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All right - close the Date & Time window by clicking the close box in the
upper-left corner.

Top Ten Control Panel E~planations
Dozens of control panels are kicking around in your Control Panels folder.
Here are a few national favorites. (Some have different names depending on
when you bought your iBook.) For much more detail about all the stuff in
your System Folder, see Chapter 12.
I. Monitors - lets you switch your monitor among various color settings
(such as grayscale, like a black-and-white TV, or various degrees of rich-

ness of color). Some games, for example, require that you change your
iBook screen to its 256 Colors setting; when viewing photos, however,
you'll want the Thousands or Millions option.
2. Trackpad - controls how sensitive the pointer movement is.
Incidentally, the pointer on the screen always moves slowly if you move
your finger slowly on the trackpad. This control panel enables you to
adjust how quickly the arrow moves if you move your finger quickly.
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This control panel also offers an intriguing set of checkboxes, as s hown
in the illustration above. They all pertain to a single little-known feature
of the iBook: If you're not so crazy about using your thumbs on the
clicker to "click the mouse button," you can opt instead to ~ click" by tapping directly on the trackpad itself, using your favorite finger. You can
click a menu name to open the menu, a Cancel button on the screen,
icons on the desktop, and so on. This feature doesn't work until you turn
on the Clicking check box.
Once you've done so, however, you're offered two further choices:
Dragging and Drag Lock. If you turn on Dragging, then you can not only
click items on the screen by tapping the trackpad, but you can also drag
them around. To do so, tap an object on the screen twice - but leave
your finger on the pad on the second tap. Now you can stroke the trackpad repeatedly to drag the object. You don't "let go" of the object until
you lift your finger for more than one second or so.
Unless you turn on the Drag Lock check box too, that is - in which case
you can lift your finger as long as you like between trackpad-strokes. You
keep dragging the object until you tap the trackpad again. (AH of this is
much easier to do than to describe.)
3. Keyboard - lets you decide whether holding down a key should type
its letter repeatedly - for example, XXXXXXXXXXX - and how fast it
repeats. Also lets you assign duties to your function keys (F7, F8, and so
on), as described in Chapter 13.
4. Appearance - The various tabs at the top of this massively entertaining
control panel let you control the way your iBook's screen looks, feels,
and sounds. For a blow-by-blow description of the options here, see
"The Control Panels Folder" in Chapter 12. For now, just note that the
Appearance control panel is the one that Jets you hang a favorite photograph as your on-screen background wallpaper.
5. Map - tells what time it is anywhere in the world. Either click to specify
a location or type the name of a major city or country and click the Find
button. (Funny thing is, this control panel isn 't in your Control Panels
folder, although you're free to put it there. It comes instead in the Apple
Extras folder in your main hard drive window.)
6. Speech - lets you choose a voice for the iBook to use when talking to
you (see Chapter 20).
7. Ftle Exchange - lets your iBook use floppy disks from Windows computers (but only if you buy a floppy drive or SuperDisk drive for your iBook).
8. Energy Saver - lets you establish automatic shutoff times (or automatic sleep times) for your iBook, in the name of saving electricity. For
example, mine is set to go to s leep if 1haven't used the computer in 30
minutes.
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9. General Controls- offers a slew of handy customizing features: how
fast your cursor blinks when you're word processing, whether or not
you want your System Folder protected against marauding children, and
so on. Also holds the on/off switches for three of the iBook's most useful
features: the Launcher (see Chapter 4), the Documents folder (Chapter 4
again), and self-hiding programs (see Chapter 12, under "General
Controls").
10. Sound - In this control panel, you can tell the iBook which beep sound
you'd like it to use when it wants your attention: the sonar-y burble of
Submarine, the glassy Temple bell, the curt humanity of "Uh-oh," or
whatever. You can even record your own sounds to use for this purpose,
as described near the end of Chapter 20.

Chapter4

Typing, Saving, and Finding Again
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
..,_ Unlearning years of typewriter lessons
..,_ Copying and pasting
..,_ How to save your files so they're not lost forever
..,.. You -yes, you - the desktop publisher

•••••••••••••••••••••••••••••••••••••••••••••••••
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et's not kid ourselves. Yeah, I know, you're gonna use your iBook to do
photo retouching, to create 3-D animations, Of' to compose symphonies.
But with the possible exception of e-mail and Web exploits, what you'll probably do the most of is.!ood old word pr.ocessing. 1

But just because everybody does it doesn't mean word processing isn't the
single most magical, amazing, time-saving invention since the microwave
dinner. Master word processing, and you've essentially mastered your
computer.

Your f/erlJ. First Bestseller
Lucky for you, your iBook comes with a superb word-processing program. It's
called AppleWorks, and you can read about it in Chapter 9.
For this quick and dirty typing lesson, though, you may as well use a quick
and dirty program: the super-budget word processor known as the Note Pad.
Choose its name from the ti menu to make it appear.

ti menu, then your iBook probably has Mac OS 9,
which is described at the end of Chapter IM. You still have the Note Pad, but
it's not in the ti menu. Instead, you'll have to do some double-clicking to find
it: Open your hard drive icon. Open the Apple Extras folder. Double-click
Note Pad.

If you don't see it in your
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All about big fat Launcher buttons
Do you recognize this thing?
0

launcher ~~

- --

11

Or.....los

JI

lat.r.tstllff

I Ii

"'-

E:I

Appllc.tiGns

I

I

~ ~ ~ [i]

AmKlc• Onllno

CIKI< Homt Poq•
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If you don't see it, you can make it appear by
choosing Launcher from the Control Panels
command of your ti menu.
The Launcher is supposed to make getting into
your programs easier. It keeps your favorite programs conveniently collected in a central
location. Under the assumption that you generally don't want to waste time launching these
programs, Apple designed the Launcher so that
one click, not the usual two, opens any icon on
the Launcher.
The rules for using the Launcher are simple:
1. If there's some program - or document, or
folder - whose icon isn't on the Launcher
window but should be, simply drag its icon
into the Launcher window and release. A
copy of that icon appears automatically,
ready for subsequent one-click launching.

Microsoft

Microsoft Outlook

lntornot Explonr

Expr•ss

I•I
get rid of it While pressing the Option key,
drag that sucker right to the trash. (You
aren't trashing the actual program, wherever it may reside on your computer. You're
just getting its icon off the Launcher
window.)
3. If you'd like to have the Launcher window
welcome you every morning, choose
Control Panels from the ti menu. Open the
control panel called General Controls. Click
the check box called "Show Launcher at
system startup" to turn it on.
4. You can make the buttons in the Launcher
window bigger or smaller like this: While
pressing the 3C key, click any white space
in the Launcher. A miniature menu pops out.
offering you Large, Medium, or Small buttons. Click your choice.

2. If there's some program on the Launcher
window that you don't really use, you can

Top three rules of word processin9
The first rules of typing on a computer are going to be tough to learn, especially if you've been typing for years. But they're crucial:

v

I

Don't press the Return key at the end of each line. I'm dead s erious
here. When you type your way to the end of a line, the next word will
automatically jump down to the next line. If you press Return in the
middle of a sentence, you'll mess everything up.

_ _ _ _ _ _ _ _ _ _ _ _ Chapter 4: Typing, Saving, and Finding Again

v

Put only one space after a period. From now on, everything you write
will come out looking like it was professionally published instead of
being cranked out on some noisy Selectric with a bad ribbon. A quick
glance at any published book, magazine, or newspaper will make you
realize that the two-spaces-after-a-period thing is strictly for typewriters.

v

Don't use the L key to make the number 1. Your iBook, unlike the typewriter you may have grown up with, actually has a key dedicated to
making the number 1. If you use a lowercase L instead, the 1 will look
funny, and your spelling checker will think you've gone nuts.

If those statements give you uncontrollable muscular facial spasms, I don't

blame you. After all, I'm telling you to do things that you were explicitly
taught not to do by that high-school typing teacher with the horn-rimmed
glasses.
There are a few other rules, too, but breaking them isn't serious enough to
get you fired. So let's dig in. Make sure you have a blank piece of electronic
typing paper open in front of you - a clean, fresh Note Pad screen.

The excitement be9ins
You should see a short, blinking, vertical line at the beginning of the typing
area. They call this the insertion point. It s hows you where the letters will
appear when you start to type.
Type the upcoming passage. If you make a typo, press Delete, just as you
would Backspace on a typewriter. (For a rundown of the iBook's other
unusual keys, see Chapter 13.) Don 't press Return when you get to the edge
of the window. Just keep typing, and the iBook will create a second line for
you. Believe. Believe.
The screams of the lions burst Rod's eardrums as the motorboat, out of control, exploded through the froth.

See how the words automatically wrapped around to the second line? They
call this feature, with astonishing originality, word wrap.
But suppose,"---as your novel. is going to press, you decide that this s leepy passage really needs some spicing up. You decide to insert the word speeding
before the word motorboat.
Remember the blinking cursor - the insertion point? It's on the screen even
now, blinking calmly away at the end of the sentence. If you want to insert
text, you have to move the insertion point.
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The point of no returns
Why aren't you supposed to hit Return at the
end of each line?
First time in print! An actual example of the kind
of mess you can get into by pressing Return
after each line of text
Im'!::

::I Note Pod

W 11?

;D.i:a=ml Not e Pod.E"'=ll=

for"" f~;ulSon

clotld hit f\IH agolnat lht
tllnglrtg rain

!!!

Struggling
Poulson

tor hit grtnodt,

J:roseo hll tyu ogaln1t lht
slinging reln

knows what kind of guy he is (left). But suppose
you'd been foolish enough to press Return after
each line of text; if you remove those three highlighted words, the word Paulson flops back to
the left side of the line, but the rest of the sentence stays where it is, looking dumb (right).
On the other hand, if you hadn'tput Returns into
your text, you'd get the figure below, where
everything looks peachy.
~- Note Pad

Struggling for his grenea1,
Poulson closed his eyes agetnst

the slinging rein

At left above: the original passage. Suppose you
decide to remove Paulson's title, " Chief
Executive Officer," since everybody already

You can move the insertion point in two ways. First, try pressing the arrow
keys in the lower-right cluster of your keyboard. You can see that the up- and
down-arrow keys move the insertion point from line to line, and the right- and
left-arrow keys move the insertion point across the line. Practice moving the
insertion point by pressing the arrow keys.
If the passage you want to edit is far away, though (on another page, for

example), using the arrow keys to move the cursor is inefficient. Your fingers
would be bloody stumps by the time you finished. Instead, use this fingersaving technique:
I. Using the trackpad, move the cursor (which, when it's near text, looks
like this: I ) just before the word motorboat, and then click the clicker.

The I-beam changes to the insertion point.
This is as confusing as word processing ever gets - there are two little
cursors, right? There's the blinking insertion point, and there's this one
I, which is called an I-beam cursor.

_ _ _ _ _ _ _ _ _ _ _ _ Chapter 4: Typing, Saving, and Finding Again
In fact, the two little cursors are quite different. The blinking insertion
point is only a marker, not a pointer. It always shows you where the next
typing will appear. The I-beam, on the other hand, is how you move the
insertion point; when you click with the I-beam, you set down the insertion point.
In other words, editing stuff you've already typed is a matter of click and
then type.

2. Type the word speeding.

The insertion point does its deed, and the iBook makes room on the line
for the new word. A word or two probably got pushed onto the next line.
Isn't word wrap wondrous?

Editin9 for the fin9uisticall1J, blessed
So much for inserting text: You click the trackpad clicker (to show the iBook
where) and then type away. But what if you need to delete a bunch of text?
What if you decide to cut out the first half of our sample text?
Well, unless you typed the challenging excerpt with no errors, you already
know one way to erase text - by pressing the Delete key. Delete takes out
one letter at a time, just to the left of the insertion point.
Deleting one letter at a time isn't much help in this situation, though.
Suppose you decide to take out the first part of the sentence. It wouldn't be
horribly efficient to backspace over the entire passage just so you could work
on the beginning.
No, instead you need a way to edit any part of your work, at any time, without disturbing the stuff you want to leave. Once again, the Macintosh
method, noun-then-verb, saves the day. Try this:
I. Using the trackpad and its clicker, position the I-beam cursor at the

beginning of the sentence.

This takes a steady hand; stay calm.
2. Clickjust to the left of the first word and, keeping the trackpad
clicker pressed down, drag the I-beam cursor - perfectly horizontally, if possible - to the end of the word as.

As you drag, the text gets highlighted, or selected. You've done this once
before, in your copy-and-paste lesson.
he
speeding motorboet, out or control, exploded through
the rroth.
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If you accidentally drag up or down into the next line of text, the high-

lighting jumps to include a big chunk of that additional line. Don't panic;
without releasing the trackpad clicker button, simply move the cursor
back onto the original line you were selecting. This time, try to drag
more horizontally.
If you're especially clever and forward-thinking, you'll also have selected the

blank space after the word as. Take a look at the previous illustration.
All right, in typical Mac syntax, you've just s pecified what you want to edit by
selecting it (and making it turn black to show it's selected). Now for the verb:
I. Press the Delete key.

Barn! The selected text is gone. The sentence looks pretty odd, though,
since it doesn't begin with a capital letter.
2. Using the trackpad clicker, position the cursor just before (or after)
the letter t that begins the sentence. Drag the cursor sideways across
the letter so that it's highlighted.
"itie speeding motorboat, out of control, exploded
through the froth.

Here comes another ground rule of word processing. See how you've
just selected, or highlighted, the letter t? The idea here is to capitalize it.
Of course, using the methods for wiping out (and inserting) text that you
learned earlier, you could simply remove the t and type a T. But since
you've selected the t by dragging through it, replacing it is much easier.
3. Type a capital T.
The selected text gets replaced by the new stuff you type. That, in fact, is the
fourth ground rule: Selected text gets replaced by the new stuff you type. As
your iBook life proceeds, keep that handy fact in mind; it can save you a lot of
backspacing. In fact, you can select 40 pages of text so that it's all highlighted
and then type one single letter to replace all of it. Or you could select only one
letter but replace it with 40 pages of typing.
Take a moment now for some unsupervised free play. Try clicking anywhere
in the text (to plant the insertion point). Try dragging through some text: If
you drag perfectly horizontally, you select text just on one line (below, left).
If you drag diagonally, you get everything between your cursor and the original click (below, right).

_ _ _ _ _ _ _ _ _ _ _ _ Chapter 4: Typing, Saving, and Finding Again
liil ~ NotePod

Breothlessly, he plunged Into
the Icy, surging woters. His
rnusc1es fro:e as ttie p1en-ing
cold cut him to the core.

~Iii

-

Note Pod

Breathlessly, he plunged Into
t he icy, surging woters. His

I

Only when he sow the shorks did
his pulse return to

You deselect (or, equally poetically, unhighlight) text by clicking the trackpad
clicker. Anywhere at all (within the typing area).
Here's about the most fabulous word-processing shortcut ever devised: Try
pointing to a word and then double-clicking the trackpad clicker! You've
easily selected exactly that word without having to do any dragging.
As you experiment, do anything you want with any combination of drags,
clicks, double-clicks, and menu selections. It's nice to know - and you might
want to prepare a fine mahogany wall plaque to this effect - that nothing you
do using the trackpad or keyboard can physically harm the computer. Oh, sure,
it's possible to erase a disk or wreck one of your documents or something,
but none of that requires a visit to a repair shop. You can't break the computer by playing around.

You kids today, with your long music and loud hair! You don't know how
lucky you are! Why, when I was your age, if I wanted to rearrange a couple of
words, I'd have to copy and paste them!
But not anymore. Nowadays, you can move text around on the screen just
by pointing to it! This profoundly handy feature is known as Macintosh
drag-and-drop.
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A word processing rule-ette
You know, by now, that your trackpad pointer
looks like this - I - whenever ifs near text
And you know, by now, that you use this cursor
to click wherever you wantto type next.

luck; the blinking insertion-point cursor simply
jumps back up to the end of what you've already
typed. In its ornery way, the iBook enforces its
own rule of writing: No jumping ahead, bub.

But suppose you want to add some words way
down the page, like this:

Of course, you can skip down the page if you
want some words to appear there. But you have
to type your way down the page first That's why
God invented the Return key. Press it over and
over again until your little insertion-point cursor
is blinking merrily away at the bottom of the
page - or wherever you tell it to go - and
now start typing.

~l.!i'~ NotePed

He stmd at the yavnln( expanse of
vhite paper. His hends trombled on
the keys. Sveatin&:, he finelly rolltd
the paper 1hro1Jih the ancient
typevriler and vro1e:

~

~~

I

~

'oi
~

You'll discover pretty quickly thatthe Macintosh
won't let you type there. The rule is: You can
click your cursor anywhere on the page that
already has typing on it But if you try to click
down below, in the white space, you're out of

Return
Return
Return
Return
Return
Return

Note Ped -

He slal!d at the yavning expanst of
Vblle paper. His hands trombled on
the keys. Sveatin&:, he fwlly ro:Jed
the paper lhroUih the 8IICient
typevrl1er anti vrote:
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Unfortunately, drag-and-drop doesn't work in every program, but it works in
most of the biggies: the Note Pad; AppleWorks; Microsoft anything; Outlook
Express; Palm Desktop; SimpleText; America Online; FileMaker; and so on.
I. Launch a program that offers drag-and-drop.

If you've been following along with the chapter already in progress, just

remain in the Note Pad where you've already been. Press the Return key
a couple of times to move into an empty part of the page.

_ _ _ _ _ _ _ _____ Chapter 4: Typing, Saving, and Finding Again
2. Type up two phrases, as shown here:
Note Ped

~Ia-

Eyes of blue, Five foot t woj

0

3. Highlight Eyes of blue.
You've done this before: Position the insertion-point cursor just to the
left of the word Eyes and carefully slide directly to the right, highlighting
the sentence (below, left).
-

~ NotePed

liMllNJ.F1 ve foot two,

i:!.IB~ Note Ped ~lit

iiiMllQI? Five foot two, <ii
r:::::~~J-

~

- /

4. Now position the arrow cursor right smack in the middle of the highlighted phrase - hold down the trackpad button - and drag the
arrow to the end of the line (above, right).
When your arrow is correctly positioned at the end of the line, you'll see
the new insertion point appear there.
5. Release the trackpad clicker!
;;

Note Ped

~Gil"

F1ve foot t wo, li!ldlllilllW -0-

As you can see, you've just dragged the first phrase into position after
the second phrase! Cole Porter would be very grateful for your correcting his lyrics.
Now how much would you pay? But wait- there's more! Once you've mastered the art of dragging text around your screen, the sky's the limit! To wit:
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~

If you press the Option key while you drag some highlighted text, instead
of moving that phrase, you actually make a copy of it, as shown here:
Ill~ Note

Pod

~li!I

Eyes of blue, Five root two,
Eyes of blue.
•

0

~

You can actually drag text clear out of the window and into another program - for example, from AppleWorks into the waiting Note Pad.

~

You can also drag text clear out of the window and onto the desktop.
When you release the trackpad clicker, you'll see that your little dragand-dropped blurb has turned into a text clipping, as shown here:

Where do babies come
rom?" asked little Timmy
. artho slopped frozen In her
rocks. She knew 1t would
rush h1s little he11rt If she •-1-11--- ~
old him about the

l

a

t•xt cl!PP.lng

.............................,..... r
}

2

Next time you need that blob of text, you can point to the text clipping
and drag it back into your word-processing program, and - presto! the text appears there, exactly as though you'd typed it again.
Now if they'd only work it out so we could edit our printouts using drag-anddrop ....

Form and Format
For your next trick, it's time to graduate from the Note Pad to a true word
processor. Close the Note Pad window. Open your hard drive; open the
Applications folder; open the AppleWorks folder; and double-click the
AppleWorks icon.

_ _ _ _ _ _ _ _ _ _ _ _ Chapter 4: Typing, Saving, and Finding Again
After a moment, the AppleWorks welcome screen appears, listing six kinds of
work you might want to do: Database, Spreadsheet, and so on. (You'll find
out what all these things are in Chapter 9.) Double-click the one called Word
Processing to open up a new, blank sheet of electronic typing paper. Now
you're ready for the lesson.
One of the most important differences between a typewriter and its replacement - the computer - is the sequence of events. When you use a
typewriter, you set up all the formatting characteristics before you type: the
margins, the tab stops, and (for typewriters with interchangeable type heads)
the type style.
But the whole point of a word processor is that you can change anything at
any time. Many people type the text of an entire letter (or proposal, or
memo) into the iBook and then format it. When you use a typewriter, you
might discover, after typing the entire first page, that it's slightly too long to

fit, and your signature will have to sit awkwardly on a page by itself. With an
iBook, you'd see the problem and nudge the text a little bit higher on the
page to compensate.
Word processing has other great advantages: no crossouts; easy corrections
that involve no whiteout and no retyping; a permanent record of your correspondence that's electronic, not paper, and so it's always easy to find; a
selection of striking typefaces - at any size; paste-in graphics; and so on. It's
safe to say that once you try processing words, you'll never look back.

The return of Return
With all the subtlety of a Mack truck, I've taught you that you're forbidden to
use the Return key at the end of a line. Still, that rectangular Return key on
your keyboard is important. You press Return at the end of a paragraph, and
only there.
To the computer, the Return key works just like a letter key - it inserts a
Return character into the text. It's just like rolling the paper in a typewriter

forward by one notch. Hit Return twice, and you leave a blank line.
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Seeing the unseen
I said that Returns are usually invisible.
However, every time you press the Return key,
the iBook actually does plop down a symbol
onto your screen. Same thing with the space
bar. Same with the Tab key.
Virtually every word processor lets you see
these markings. In AppleWorks, choose

Preferences from the Edit menu to access the
Show Invisibles option. In any case, the result
looks something like this:
•

"Alison-my god,-not that! Anylhing but thatr'GI

•

But it-was-too late. She had a lready disappeared.<i

The point of Return, then, is to move text higher or lower on the page. Check
out this example, for instance.

Dea rcst-Todd,<il
'IJ
1-have-never-loved-so-much-as-1-did-lastnight.- Imaginc-my-joy·as-l-walched-youplunch-your-shiningscimitar-into-thegreasy-flesh-of.that-tha t-hidcous-thing
from -thc-decp.<lf
qr
Unfortunately,-the-IRS.has-determinedtha t-you-failed-to-file-rclums-for-thc-years1982-1986.- They-have.asked-tha t-1-notifyyou-of. 'IJ

GI
Dearest-Todd.GI
GI
I-have-never-loved-so-much-as- 1-did-lastnight.-lmagine-my-joy-as-I-watch ed-youplunch-your-shiningscimitar-into-thegreasy-flesh-of-that-tha t-hideous-thingfrom-the-deep.GI
GI
Unfortunately,.the-IRS-has-determinedthat-you-fuiled- to-file-retums-for-the-years1982-198b.- They-h ave-asked-th at-1-notifyyou-of-GI

Return characters move text down on the page. So, if you want to move text
up on the page, drag through the blank space so that it's highlighted (above,
left); of course, what you've really done is select the usually invisible Return
characters. If you delete them, the text slides up the page (right). .
Combine this knowledge with your advanced degree in Inserting Text
(remember? you click and then type), and you can see how you'd make more
space between paragraphs or push all the text of a letter down on the page.

Appealin9 characters
Another big-time difference between word processing and typing is all the great
character formatting you can do. You can make any piece of text bold, italic,
underlined, all of these, and more. You also get a selection of great-looking typefaces - only a few of which look like a typewriter. By combining all these styles
and fonts randomly, you can make any document look absolutely hideous.

_ _ _ _ __ _ _ _ _ _ _ Chapter 4: Typing, Saving, and Finding Again
Here's the scheme for changing some text to one of those character formats:
noun-verb. Sound familiar? Go for it:
1. Select some text by dragging through it.

Remember you can select a single word by double-clicking it; to select a
bunch of text, drag the cursor through it so that it turns black. You've
just identified what you want to change.
Each word processor keeps its Bold, Italic, and Underline commands in
its own specially named menu; in AppleWorks, they're in the Style menu.
(AppleWorks and Microsoft programs also offer a floating rack of buttons at the top of the screen, containing B, I, and U buttons. They do the
same thing as using the menu commands.)
2. From the Style menu, choose Bold.

You've just specified how you want to affect the selected text.
You can apply several of these formats to the same text, too, although you
won't win any awards for typographical excellence. Try changing the typeface
also; the various fonts are called things like Chicago, Geneva, Times, and so
on. Changing fonts works the same way: Select text and then choose the font.
And sizes - same deal: Select some text and then choose a type size from the
AppleWorks Size menu. The font sizes are measured in points, of which there
are 72 per inch. Works out nicely, too - a typical iBook monitor has 72 screen
dots per inch, meaning that 12-point type on the screen really is 12-point.
~ ~

File Edit Format Font
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Before you know it, you'll have whipped your document into handsome shape.

Formattin9 para9raphs
Whereas type styles and sizes can be applied to any amount of text, even a
single letter, paragraph formatting affects a whole paragraph at once. Usually
these styles are easy to apply. To select a paragraph, you don't have to
"
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highlight all the text in it. Instead, you can just click once, anywhere within a
paragraph, to plant the insertion point. Then, as before, choose the menu
command that you want to apply to that entire paragraph.
This figure shows some of the different options every word processor provides for paragraph formatting - left-justified, right-justified, fully justified,
and centered:
Her heart pounding, she looked loward lhe door. 11 swung
open wi1h a creak. The s1cnch hil her firs1-an acrid,
rOlting swamp smclI. She covered her mou1h wi1h the
blood-soaked handkerchief and sleppcd backward. her
naked back pressed hard agains1 1he fourpos1er.

Her heart pounding, she looked 1oward lhe door. h swung
open with a creak. The stench hit her firs1-an acrid,
ro11.ing swamp smell. She covered her moulh with the
blood-soaked handkerchief and slepped backward, her
naked back pressed hard agains1 lhe fourposler.

Left-justified

Right-justified

Her hcan pounding, she looked loward 1hc door. h swung
open wi1h a creak. The s1ench hil her firs1- an acrid,
rolling swamp smell. She covered her moulh with 1he
blood-soaked handkerchief and s1epped backward, her
naked back pressed hard agains1 1he fourpos1er.

Her hean pounding, she looked 1oward 1he door. h swung
open wi1h a creak. The slench hil her firsl- an acrid,
rolling swamp smell. She covered her mou1h with lhe
blood-soaked handkerchief and slepped backward, her
naked back pressed hard against the fourposler.

Fully justified

Centered

(In AppleWorks, you get these effects by clicking a paragraph, and then clicking one of the four square buttons just above the ruler at the top of the
window. You can see these buttons in the previous illustration. If you don't
see the ruler, choose Show Rulers from the Window menu.)

The efficiency zealot's guide to power typing
Because you canformattext after you've typed it doesn't mean you have to. Most power-users get
used to the keyboard shortcuts for the common style changes, like bold and italic. They're pretty
easy to remember: In nearly every word-processing program, you get bold by pressing 00-B and
italic withJ§.;J.
What's handy is that you can hit this key combo justbefore you type the word. For example, without ever taking your hands off the keyboard, you could typBlhe following:
He stared at the Delinquent Birds folder. No: it was not happening!

i

i

i

i

00-B

00-B

00-1

00-1

In other words, you hit 00-B once to turn bold on for the next burst of typing, and 00-B again tot~
it off - all without ever having to use a menu. (You do the same wmi Ml-I.)

-
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You can control paragraphs in other ways, too. Remember in high school
when you were supposed to turn in a 20-page paper, and you'd try to pad
your much-too-short assignment by making it two-and-a-half spaced? Well, if
you'd had an iBook, you could have been much more sneaky about it. You
can make your word-processed document single-spacedJ!ouble-spaced,
quadruple-spaced, or any itty-bitty fraction thereof. You can even control
how tightly together the letters are placed, making it easy to stretch or compress your writing into more or fewer pages.
Take this opportunity to toy with your word processor. Go ahead, really muck
things up. Make it look like a ransom note with a million different type styles
and sizes. Then, when you've got a real masterpiece on the screen, read on.

Workin9 with Documents
It might terrify you - and it should - to find out that you've been working
on an imaginary document. Only a thin thread of streaming electrical current
preserves it. Your typing doesn't exist yet, to be perfectly accurate, except in
your iBook's memory.
You may recall from the notes you took on Chapter lMthat memory is fleeting. (Specifically, I mean computer memory, but if you find a more universal
truth in my words, interpret away.) In fact, the memory is wiped away when
you shut the iBook down - or when a system crash, a rare but inevitable
event for any computer, turns it off for you. At that moment, anything that
exists on the screen is gone forever.
-

Therefore, almost ever rogram has a Save command. It's alwa s in the File
menu, and its keyboard shor cu s
When you save your work, the iBook transfers it from transient, fleeting, electronic memory onto the good, solid, permanent disk. There your work will
remain, safely saved. It will still be there tomorrow. It will still be there next
week. It will still be there ten years from now, when your computer is so
obsolete that it's valuable again.
Therefore, let's try an experiment with your ransom note document on the
screen. From the File menu, choose Save.
Uh-oh. Something weird just happened: The iBook presented you with a box
full of options. It's called a dialog box, because the computer needs to have a
little chat with you before proceeding.
When you see this box, what the iBook mainly wants to know is: "Under what
name would you like me to file this precious document, Massssster?"
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And how do you know this? Because in the blank where it says "Save as," a
proposed title is highlighted (selected already). And what do you know about
highlighted text? Anything you start typing will instantly replace it.
The iBook, in its cute, limited way, is trying to tell you that it needs you to
type a title. Go ahead, do it: Type Ransom Note.
At this point, you could just click the Save button. The iBook would take
everything in perilous , fleeting memory and transfer it to the staid, safe hard
disk, where it would remain until you're ready to work on it some more.
However, a bunch of other stuff lurks in this dialog box. Especially since this
is the Numero Uno source of confus ion to beginners, I think a tour of the Save
File box is in order.

Nafli9atin9 the Saf/e File
(and Open File) box
You've already learned about the way your computer organizes files : with
folders and with folders in folders. Remember this little exercise from
Chapter 2, where you put s tate-named folders inside the USA Folder?
(J. World
I Item, 315.6 MB oveiloble

0 ~l:l USAfolder

l),
Aloolca

Cel l for ni e

l),
Conne<ticut

Havel!

...

Well, all the complicated-looking stuff in the Save File box is a miniature version of that same folder-filing system. Suppose you see this when you're
trying to save your file:
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I 13 USA Folder I ¢ I
~-==:::::=::::::=====--~~
!l,Alaska
~

=Macintosh If>
~ect

ll. California

Desktop

!l, Connecticut
!l, Hawall

~

'-------- - - - --'---'
Save As:
lc1arisWorks ,..I
._lu_nt_it_
1e_d_ _ _ _ _ _ __.I

fl

Cancel

)

Save

I)

fl~ o@
Doeumtnt

Stj\lontry

Look at the open-folder "menu" (in a rectangle above the list) . It tells you that
you're viewing the contents of the USA Folder. In other words, if you click the
Save button, you'll file your new Ransom Note document in the USA Folder,
mixed in among the state folders.
But suppose that you want to file the Ransom Note document in one of the
state folders. You already know how you open a folder - by double-clicking
it - so you'd point to Alaska, for example, and double-click.

IQ

Alask11

l¢ I

~-~========~~~
@ interview
!l, Juneau
!l,Nome
~ Politic s
~ Popul ation

= Macintosh If>
Eject
Desktop
Cancel

Now the open-folder "menu" above the list says Alaska, and you can see the
stuff inside the Alaska folder. Some names are dimmed because they're all
documents; the only things whose names are black in this dialog box are folders. (The iBook wants to know where you want to put your new document.
Because you can't very well store one document inside another document,
the names are grayed out and unavailable, and only the folder names are
black and available.)
Okay. So now you're viewing the contents of the Alaska folder. What if you
change your mind? What if you decide that the ransom note should really go
in the World folder - the one that contains the USA Folder?
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You must retrace your steps. That's what the little folder menu is all about
(where it now says Alaska). They call this doohickey a pop-up menu: It's a
menu, but it's not at the top of the screen. The small black triangles beside
the name Alaska tell you: "Click me!"
t2

Alaska

I !!!Wor1d I ; I

~ USAFolder

i:l

e

ii

I

Macintosh HD
Desktop

Cl Africa

=Macintosh fl>

H
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0. USA Folder

r.

iject
Desktop

J

Cancel

]

Sure enough, when you click the word Alaska, you see the list of all the
nested folders you had to travel through to get here. This is where things get
a little weird: The list is upside-down from the path you took!
In other words, if you were in the Finder instead of in this Save File dialog
box, you'd have started at the desktop level (the colored background). You'd
have double-clicked the hard-disk icon (probably called Macintosh HD) to
open its window. Then you'd have double-clicked the World folder to open
that, and the USA Folder inside of that, and finally the Alaska folder. If you
look at the preceding menu picture, you'll see that, sure enough, your entire
folder path is listed. You can view the entire hierarchy of folders - as long as
you get used to the fact that the list is upside-down, and the outer levels (the
hard disk and the desktop) are listed at the bottom.
Therefore, if you wanted to file the ransom note in the World folder (below,
right), you'd simply slide down the pop-up menu list and choose World
(below, left).
Then, at long last, when you're viewing the contents of the folder you want to
save the file in, you can name your file and click the Save button.
~ Alaska

[ ~ Wor1d

~ USAFolder

13
a

I

Macintosh HD
Iii Desktop
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!. ; J

=Macintosh ti)
;_

( l Antoctica
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13
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fject

I

11 Desktop
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Cancel
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For the purposes of following along with this exercise, double-click a folder any folder - to store your file in. Type a name for your file, such as Ransom
Note, in the blank where it probably now says "untitled." And then click Save.
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Two easy ways to avoid losing stuff
This business about the "Save Where?" dialog
box is, as anybody will tell you, the most confusing thing about the Macintosh. After years of
experience, a few professional beginners have
adopted one of the following cheats - and they
never lose another file.
Cheat1:

Whenever you save a file, and you're faced with
the Save dialog box, click the Desktop button
first Only then should you click the Save button.

Controls. In the lower-right corner of the resulting window, select Documents folder (to turn it
on) or one of the other choices (to turn it off).
Close all the windows you've just opened.
The next time you save a file - or try to open
one - the iBook automatically creates this
special folder called Documents. It sits in your
Macintosh HD window. From now on, everytime
you save a file (or try to open one), you'll always
be shown the contents ofthe Documents folder,
like this:

Go ahead, ask it. "What's the point?"
~_.::ICi
=D=o=cu=m=e=nt::::
s::::
I ¢=._
l _

Easy: When you're done working for the day,
and you return to the desktop, you won't have to
wonder what folder your document's icon fell
into. Your new file will be sitting right there, on
the desktop, in plain sight.

'rn Dogs
~ Fi sh
~Gold

Save this document as:

!Goats

Cheat2:

To make yours appear, choose Control Panels
from your S menu. Double-click General

Macintosh ...
f;ject

~Emera l ds

Atthis point, it's child's play to drag the icon into
the folder you want it in.

So many people complained that they couldn't
find their saved documents that Apple invented
the Documents folder.

9

Desktop

I

New ~

I

Cancel

I

Save

I

The contents of this special magnet folder will
be in your face at all times. You'll never wonder
where some file went - it'll always be right in
your Documents folder.

Your file gets snugly tucked away into the folder whose contents you're viewing. Want proof, 0 Cynic? All you have to do is choose Finder from the
Application menu. Remember, the Application menu is the icon at the upperright s ide of the s creen. It lists all the programs that are running at once .

•.

.
Hide AppleWorl<s
Hide others
Show All

./ 121 AppleWorks

d

Internet Explorer4.S
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When you choose Finder, our friends the folders, windows, and Trash can
pop up. If you wanted to make sure your file really exists, and it really got put
where you wanted it, you could now double-click your hard drive icon
(Macintosh HD) and then double-click your way through folders until you
found it. In our example, your ransom note would be in the World folder:

Cl World
6 Items, 31 5.4 MB avella ble

Antactlca

Why are we kicking this absolutely deceased horse? Because the same foldernavigation scheme (where you see an upside-down list of nested folders) is
used for retrieving files you've already created. You need to know how to
climb up and down your folder tree, as you'll see in a moment, if you ever
want to see your files again.

Closin9 a file, with a si9h
You've created a ransom note. It's got all kinds of text and formatting. You've
saved it onto the disk so that it'll be there tomorrow. In a moment, you'll get a
chance to prove it to yourself.
Switch back into AppleWorks by choosing its name from the upper-right application menu. Click the close box in the upper-left corner of the window. Once.
In the iBook's unive rsal language of love, clicking the small square up there
means close the window, as you'll recall. If all went well, the window
disappears.

How to find out what's 9oin9 on
This gets sort of metaphysical. Hold onto your brain.
Just because you closed your document doesn't mean you've left the program.
In fact, if you pull down the Application menu at the right side of the s creen,
you'll see that the word-processing program is, in fact, still running. (It's the
one with a check mark beside it - such as AppleWorks or Note Pad.)

_ _ _ _ _ _ _ _ _ _ _ _ Chapter 4: Typing, Saving, and Finding Again

VVorryvvarts'corner
From the way I've described the terrifyingly delicate condition of a document that's on the screen
(that you haven't saved to disk yet) - that is, precariously close to oblivion, kept alive only by electric current-you might think that closing a window is a dangerous act After all, what if you forgot
to save some work? Wouldn't closing the window mean losing that critical memo?
Not really- if you try to close a document, the iBook won't Jetyou proceed until it asks you whether
you're sure you want to lose all the work you've done. It will say something like:

Save changes to the document "untltled"
before closing?

Don't Save

Cancel

Save

II

Click Save if you do want to save your work. Click Don't Save if you were only goofing around and
don't want to preserve your labors.
Click Cancel if you change your mind completely about closing the document and want to keep
working on it

You could bring the Finder to the front by choosing its name from the
Application menu - without exiting the word processor. They both can be
running at the same time, but only one can be in front.
In fact, that's the amazing thing about a Macintosh. You can have a bunch of
programs all open and running at once. The more memory your iBook has,
the more programs you can run simultaneously.
What gets confusing is that one program (say, AppleWorks) may be active,
but you'll think you're in the Finder. After all, you'll see your familiar icons,
Trash, folders , and so on. You need to unders tand that all this is simply shining through the emptiness left by AppleWorks, which has no windows open at
the moment. If a window were open, it would cover up the desktop behind it.
Right now, for instance, I realize that it's hard for you to believe that you're
using a word processor, when there are no words on the screen. But you have
several clues as to what program you're using.
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CLUE 1: The first command in the Appl e menu always identifies the program you're in.

i

CLUE 2: The menu titles are different in each program.

File

Edit

BIG CLUE 3: The program you're in is named here I

fonnat font Size

Style

Outline

Help

5:30PM .
Hlde AppleWorks
Hide Others
Show All

I

l;] Ander
Note Pad
....__,.______,

CLUE 4: The check mark in the Application menu also identifies the program you're in.

For the moment, stay in AppleWorks.

Gettin9 It All Back A(/ain
Okay. You've typed a ransom note. Using the Save command, you turned that
typing on your screen into an icon on your hard disk. Now it's time for a concept break.

CrazlJ. relationships: Parents and kids
Two kinds of files are lying on your hard disk right now: programs (sometimes
called applications) and documents. A program never changes; it's like a
Cuisinart on your kitchen counter, sitting there day after day. Documents are
what you create with a program - they're the coleslaw, crushed nuts, and guacamole dip that come out of the Cuisinart. You pay money to buy a program.
After you own it, you can create as many documents as you want for free.

~

Vor-d Pl"'oo-S-R1H

Q

D
Memo

Q

D
Lt ttt r to

Q

O~d

D
Picnic

E'.l
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Mtnthol boon dip Potm fOf" Arno;
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For example, you could use the Word Proc-S-R program (above, top) to create
all the different word-processing documents below it and thousands more
like them. If you love analogies as much as I do, you can think of the application as the mommy and the documents as the kiddies.
Here's what their family relationships are like:

, ,-

Double-click the program icon when you want to open a brand-new, untitled, clean-slate document.

,,,- Double-click a document icon to open that document. Unbeknownst to
you, double-clicking a document simultaneously opens the program you
used to create the document.

1

Double-click a
document to
open it ...

i

Q

D

Ht mo

... and the Mac automatically
launches the corresponding program
that gave it birth, even if it's buried
in a folder somewhere.

Fetch: How to retriefle a document
Let's pretend it's tomorrow. Yawn, stretch, fluff your hair (if any). You find out
that the person you've kidnapped actually comes from a wealthy Rhode Island
family, and so you can demand much more ransom money. Fortunately, you
created your ransom note on the iBook, so you don't have to retype anything;
you can just change the amount you're demanding and print it out again.
But if you've been following the steps in this chapter, then there's no document on the screen. You're still in your word-processing program, though (or
should be; check the name of the program displayed at the upper-right
corner of your screen, or look for a checkmark in the Application menu). So
how do you get your ransom note file back?
Like this:
I. From the File menu, choose Open.

A dialog box appears. You probably remember dialog boxes - in fact,
you probably remember this one. It looks just like the Save dialog box,
where you were asked to give your document a title. This one, navigationally speaking, works exactly the same way:
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Cancel
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Unfortunately for my efforts to make this as instructional as possible, if
you've been following these steps, your ransom note is staring you in
the face right now. It's in whichever folder you saved it into. The iBook is
nice that way- it remembers the most recent folder you stashed something in and shows you that location the next time you try to save or
open something.
If you want to emerge from this experience a better person, pretend that

you can't find your ransom note. Pull down the pop-up menu and jump
to your hard-disk level (below, left). Now the display changes to show
you the contents of your hard disk (below, right).
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•
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Internet
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world
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~

I
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And from here, you know how to get back into the World folder, don't
you? Correct - double-click the World folder, and you're right back
where you started.
2. Double-dick the ransom note.
This is what you've been working up to all this time. The ransom note
appears on your screen in its entirety. Now, at last, you can edit it to
your heart's content.

To continue this experiment, make some changes to your document. Once
again, you have to worry about the fact that your precious work only exists

_ _ _ _ _ _ _ _ _ _ _ _ Chapter 4: Typing, Saving, and Finding Again
in a fragile world of bouncing electrons. Once again, turning the iBook off
right now means you'll lose the new work you've done. (The original ransom
note, without changes, is still safe on your disk.)
Therefore, you have to use that trusty Save command each time you make
changes that are worth keeping. (For you desk potatoes out there, remember
that 31:-S is the keyboard shortcut, which saves you an exhausting trip to the
menu.) The Save dialog box will not appear on the screen each time you use
the Save command (as it did the first time). Only the very first time you save
a document does the iBook ask for a title (and a folder location).
As mentioned in Chapter IM,you've probably heard horror stories about
people who've lost hours of work when some glitch made their computers
crash. Well, usually it's their own darned fault for ignoring the two most
important rules of computing:

Rule 1. Save your work often.
Rule 2. See Rule I.
"Often" may mean every five minutes. It may mean after every paragraph.
The point is to do it a lot. Get to know that 31:-S shortcut, and type it reflexively after every tiny burst of inspiration.
Now you know how to start a new document, edit it, save it onto the disk,
reopen it later, and save your additional changes. You know how to launch
(open or run) a program - by double-clicking its icon. But now you have to
learn to get out of a program when you're finished for the day. It's not terribly
difficult:
Choose Quit from the File menu.

If AppleWorks was the only program you were running, then you return to the
Finder. If you were running some other programs, then you just drop down

into the next program. It's as though the programs are stacked on top of each
other; take away the top one, and you drop into the next one down.

How to Back Up iBook Files
Duty compels me to keep this chapter going just long enough to preach one
other famous word of advice to you: Back up.
To back up, or to make a backup, means to make a safety copy of your work.

85

86

Part I: For the Absolute Computer Virgin _ _ _ _ _ _ _ _ _ _ _ __

The importance of bein9 backed up
When you're in the Finder, the documents you've worked on appear as icons
on the hard disk. Like any of us, hard disks occasionally have bad hair days,
go through moody spells, or die. On days like those, you'll wish you had
made a copy of the stuff on the hard disk so your life won't grind to a halt
while the hard disk is being repaired.
You know the cruel gods that make it rain when you forget your umbrella?
Those same deities have equal powers over your hard disk and an equal taste
for irony. That is, if you don't back up, your hard disk will certainly croak. On
the other hand, if you back up your work at the end of every day or every
week, nothing will ever go wrong with your hard disk, and you'll mumble to
yourself that you're wasting your time.
Life's just like that.

Where 1s the flopplJ dricleJ
Many computer users back up their work by copying their important icons
onto floppy disks. Unless your computer-store salesman was a fast-talking
slimeball, however, it should be no surprise to you by now that your iBook
doesn't have a built-in floppy-disk drive.
There are three reasons the iBook doesn't have a floppy drive. All of them
have to do with the changing times (and making the iBook inexpensive):
Y"

In the olden days, newly purchased software came on floppy disks.
Today, all new software comes on a CD instead. And your iBook does
have a CD player.

Y"

In the olden days, you needed floppy disks so that you could transfer
files to a friend or coworker. These days, you'd probably just send your
file by e-mail, over a network cable, or through the air using the iBook's
wireless network feature. (See Chapters 8, 14, and 15, respectively, for
instructions.)

Y"

In the olden days, you'd use floppy disks to make a safety copy of your
work. These days, a floppy's too small to hold much more than a chapter's worth.

Still, you're going to need to make safety copies of your work somehow. Some
iBook fans use the Internet as a giant backup disk, a trick described in
Chapter 8. Others make safety copies of their work by copying them to
another computer, a scheme described in Chapters 14 and 15.
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But many break down and buy a disk drive for the iBook. You can buy a
doodad that accepts floppy disks, Zip disks, SuperDisks, or other kinds of
disks. (All these gizmos are described in Chapter 19.)
If you've bought and connected such a disk drive, the next section is for you.
If not, skim the following with a look of detached bemusement.

How to insert a disk
Take your first disk (floppy, SuperDisk, Zip, or whatever). You're going to slip
it into your extra-purchase disk drive metal side first, label side up. Put the
disk into the disk drive slot. Keep pushing the disk in until the disk drive
gulps it in with a satisfying kachunk.
If it's a brand new floppy disk, or not a Macintosh disk, you'll probably see

this message:

This disk Is unreadable by this Macintosh.
Do you want to Initialize the disk?

Format: Macintosh 1.4 MB

I

Eject

I I Initialize I

Go ahead. Click Initialize. You're then asked to name the disk; type a name,
click OK, and then wait about 45 seconds while the iBook prepares the disk
for its new life as your data receptacle.
If it's not a new disk, its icon shows up on the right side, just beneath your

hard-disk icon.
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To see what's on the disk, double-click the icon. As you've no doubt tired of
hearing repeated, a double-click on a disk icon opens its contents window.

How to coplJ. stuff onto a disk
Here's how you copy files onto a disk - floppy, Zip, SuperDisk, or whatever.
We'll assume that you've already inserted a disk.
1. Double-dick your hard-disk icon to open its window.

2. Drag your document icons on top of the icon of the disk you've
inserted.
That's it. On a Macintosh, making a copy of something is as easy as dragging
it to the disk you want it copied onto. You can also drag something into the
disk's window (instead of onto its icon).
You can also, incidentally, drag things from a floppy (or other kind of disk) to
your hard drive .
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You can make as many copies of a file as you want without ever experiencing
a loss of quality. You're digital now, kids .

How to 9et a disk or CD out a9ain
Okay, so you've made a backup copy of your fourth-quarter report, or you've
just copied a new program onto your hard disk. Now what? How do you get
the disk out? And if you've inserted a CD-ROM disc into your iBook, how do
you get it out again?
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When the disk is too shy to come out
Every now and then, you'll be stuck with a disk
or CD that won't come out of the drive, even if
you've tried the usual ways of ejecting it.

the paper-clip trick fails, you may find that you
can pop the drawer open by prying the corner
of the drawer gentlywith a butter knife.

In that case, shut down the iBook. While pressing the trackpad clicker continuously, turn the
iBook on again. Keep the trackpad button
pressed until the Trash can appears.

If you're weak of stomach, or a lawyer, do not
attempt this procedure. Prying too hard will
wreck your drive and require a repair.

If that trick doesn't pop the disk out, straighten
a paper clip. Push it slowly but firmly into the tiny
pinhole on the CO-ROM drawer.
If even that radical procedure doesn't force the
stuck disk out, here's one last resort. This one
applies to stuck CDs only. If a disc is stuck in
your iBook, the CD drawer won't open, and even

On the other hand, when the paper-clip trick
won't open the CD drawer, your only other alternative to the prying procedure is to send the
laptop in for repair - and you know what the
technicians at Apple will do once they get your
machine, don't you?
Right Pry open the drawer with a butter knife.

Just click the disk icon on the screen - and then, from the Special menu,
choose Eject Disk. The disk - floppy, Zip, CD-ROM, whatever - pops out of
the iBook (or its disk drive) automatically.
Want a more exciting method? Try this: Drag a disk's icon to the Trash can!
Yes, yes, I know it looks like you're erasing the entire disk. It looks that way to
every first-time Mac user. But you're not - instead, the disk just pops out of
the slot.

When What Was Found Is Now Lost
Okay. You've practiced saving and retrieving files. Yet still it happens: You
can't find some file you were working on.
This is nothing to be ashamed of! Thousands of people lose files every day.
But through the intervention of caring self-help groups, they often go on to
lead productive, "normal" lives.
Here's what to do: Sit up straight, think positive thoughts, and press 3€-F. Or
do it the long way: Choose Sherlock from your S menu.
On the screen, you see the Sherlock box: your personal electronic butler
who's prepared to spend the next few seconds rummaging through the attics,
garages, and basement of your iBook.
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Type a few letters of the missing file's name. (Capitals don't matter, but
spaces do!) Then click the Find button (or press Return).
A new window appears, listing everything on your hard drive whose name
contains what you looked for. At this point, you can perform any of the following stunts.
Double-click an icon to open it Or drag it someplace - onto the desktop,
maybe, or even directly to the Trash. To open the window a file's in, click
the icon and press 3€-E.
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This area shows you where the file is, no matter how many folders deep it's
buried. You can double-click a folder, too, to open it.

When you're finished playing with the Sherlock thing, choose Quit from its
File menu (or press 3C-Q).
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Seeking wisdom in IJ.OUr own
words - and on the Net
In the illustration of the Sherlock window on the previous page, you may
notice two other interesting-looking places to click: a tab that says Find by
Content and one that says Search Internet.
See, the trouble with the traditional Find command is that it searches only the
names of your files. If you wrote a 253-page thesis on Wombat Worship
Societies, but you accidentally named that file uGift Ideas for Marge," you could
search for uwombat" from now until doomsday without turning up the file.
It would be different, however, if the Sherlock command were smart enough
to search for words inside your documents. That's exactly what the Find by
Content thing does.
But before you can use this feature, the iBook must be allowed to create its
own private card-catalog of your hard drive. This process is called
indexing- spending a couple of hours analyzing every single document
you've got. To make this happen, click the "Search by Content" tab of the
Find window; click the Index Volumes button, click the name of your hard
drive, click Create Index, and then go out to see a nice long movie (such as
Titanic IL The Return). (If you're really into your computer, you could teach
yourself to use the Schedule button, which makes your iBook do this kind of
thing in the middle of the night, unattended.)
When it's over, you'll be able to use the Find by Content thing to look for
words inside your files. (You'll need to let the iBook update that index from
time to time to keep it current; fortunately, each index-updating takes only 10
minutes or so.)
The final tab of the Sherlock program, Search Internet, isn't nearly as complicated. It lets you search the entire World Wide Web for a particular
plain-English phrase (such as "Wombat Worship Societies"). Details in
Chapter 7.

Sherlock goes silfler
Got Mac OS 9? (Check Chapter lYz for details.) If so, your Sherlock program
looks dramatically different than the preceding illustrations. It's big and silvery, for one thing:
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@) Fiie Names
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Edit...

I
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Volume Indexed Sat, Sep 18 , 1999, 6:34 PM

Moreover, the three tabs at the top (Find File, Find by Content, and Search
Internet) are missing. You can still perform those three kinds of searches, but
the buttons are different: When you want to look for a file by its name, click
the File Names button; to look for words inside your files, click Contents; and
to search the Internet, click one of the picture buttons at the very top of the
window.
I can almost hear you asking: But which picture button? And you can almost
hear me answering: see in Chapter 8 under the heading "Not just Sherlock new, improved Sherlock!"

Top Ten Word-Processin9 Tips
1. Select a word by double-clicking - and then, if you keep the trackpad
clicker down on the second click and drag sideways, you select additional text in complete one-word increments.
2. Never, never, never line up text using the space bar. It may have worked
in the typewriter days, but not any more. For example, you may get
things lined up like this on the screen.

1963
Born

1992
2001
E lee te d President Graduated college

Yet, sure as death or taxes, you'll get this when you print.

1963
Born

1992
2001
Elected President
Graduated college

So instead of using spaces to line up columns, use tab stops instead.
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3. You can select all the text in your document at once by using the Select
All command (to change the font for the whole thing, for example). Its
keyboard equivalent is almost always 3€-A.
4. Don't use more than two fonts within a document. (Bold, italic, and
normal versions of a font only count as one.) Talk about ransom notes!
5. Don't use underlining for emphasis. You're a typesetter now, babe.
You've got italics! Underlining is a cop-out for typewriter people.
6. The box in the scroll bar at the right side of the window tells you, at a
glance, where you are in your document.
By dragging that box, you can jump anywhere in the document.
The position of
the box in the
scroll bar tells
you whether you
are at the
beginning ...

... in the middle . .. "

You can move around in two other ways, too:

Click in the gray part to
jump one screenful up
or down.

Click (or hold down)
the arrows to scroll
one line at a time.

7. You've already learned how to copy some text to the Clipboard, ready to
paste into another place. Another useful technique is to cut text to the
Clipboard. Cut works just like Copy, except it snips the selected text out
of the original document. (Cut-and-paste is how you move text from one
place to another.)
8. It's considered uncouth to use "straight quotes" and 'straight apostrophes.' They hearken back to the days of your typewriter. Instead, use
"curly double quotes" and 'curly single quotes' like these.
You can produce curly double quotes by pressing Option-[ (left bracket)
and Shift-Option-[ for the left and right ones, respectively. The single
quotes (or apostrophes) are Option-] (right bracket) and Shift-Option-],
for the left and right single quotes, respectively. But who can remember
all that? That's why every word processor (AppleWorks, Microsoft Word,
and so on) has an automatic curly quote feature, which is a much better
solution.
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(On the other hand, don't type curly quotes into an e-mail message; they
come out as bizarre little boxes and random letters at the other end.)
9. If there's an element you want to appear at the top of every page, like
the page number, don't try to type it onto each page. The minute you
add or delete text from somewhere else, this top-of-the-page information
will become middle-of-the-page information. Instead, use your word
processor's running header feature - it's a little window into which you
can type whatever you want. The program automatically displays this
info at the top of each page, no matter how much text you add or take
away. (There's also such a thing as a running footer, which appears at
the bottom of the page.)
10. You know how to select one word (double-click it). You know how to
select a line (drag horizontally). You know how to select a block of text
(drag diagonally through it). By now, you're probably about to reach
Selection-Method Overload.
But none of those techniques will help when you want to select a lot of
text. What if you want to change the font size for ten pages' worth?
Instead, try this two-part tip: First, click at the beginning of the stuff you
want to highlight so that the insertion point is blinking there.
Now scroll to the end of what you want to highlight. Hold down the
Shift key with one hand and click the trackpad clicker with the other.
Magically, everything between your original click and your Shift-click
gets highlighted!

Chapter 5

AQuiet Talk about Printers,
Printing, and Fonts
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
~ The

different kinds of printers and how much they cost
How to hook up and start printing
~ The truth about fonts
~

•••••••••••••••••••••••••••••••••••••••••••••••••

I Jou,

gentle reader, are fortunate that you waited until now to get into the
¥LMac. You completely missed the era of dot-matrix printers, whose printouts were so jagged that they looked like Dante's Inferno written in Braille.
The purchase of a printer for your iBook constitutes Credit Card Workout #3,
and it probably falls into one of two categories: laser printers and inkjet printers.

Inkjet Printers
The least expensive kind of printer is called an inkjet. Hewlett-Packard ( HP)
makes a line called Desk.Jets; Epson makes some terrific color-printing
models known as the Stylus Color series, which looks like this:
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Inkjet printouts are so good that they almost match a laser printer's. The
printers are small, lightweight, and almost silent. You can feed all kinds of
nonliving things through them: tagboard, envelopes, sheet metal, whatever.
And they cost less than $250, even for ones that can print in color. (If you
have a color inkjet, and you want to print out photographs, you can buy
fancy shiny paper for this - correction: expensive fancy shiny paper - that
make the printouts look almost like actual photos.) Some HP and Epson
inkjets have USB connectors (see Chapter 14) that plug directly into the
iBook; if you have a printer designed for older Mac models, you can plug it
into the iBook with an adapter, such as a Farallon iPrint (see Appendix B).
So what's the catch? Well, they're inkjet printers. They work by spraying a
mist of ink. Therefore, the printing isn't laser-crisp if your stationery is even
slightly absorbent, and you have to replace the ink cartridges fairly often.
Note, too, that inkjet-printed pages smear if they ever get the least bit damp,
making them poor candidates for use during yacht races.
Still, inkjet printers are so compact, quiet, and inexpensive that they're hard
to resist, especially if you want to print in color.

How to hook up a USB inkjet printer
The term USB refers to the kind of connector a printer has - and in the
iBook world, USB means U Should B thrilled. Anything you plug into your
iBook's USB jack works the first time, every time, with no hassle, no figuring
out, and no turning the computer on or off. (And if that sounds perfectly
normal to you, then you obviously weren't using computers in the 1980s.)
Many Epson and Hewlett-Packard inkjet printers have USB connectors - and
that's exactly what you want. In most cases, however, you also need to buy
the USB cable (printer-to-iBook), too. Then you're ready to set things up:
1. Plug the printer into a power outlet. Turn the printer on.
2. Connect one end of the USB printer cable to the printer. Connect the
other end to the iBook's USB jack.

The USB jack is on the left side of the laptop, marked by a little threeforked tree icon.
3. Find the software CD that crone with your printer. Place it into the
iBook's CD-ROM drive, and run the installation program on the CD.

If you have any trouble with this step, call the printer company. When
the software-installation process is complete, you'll probably be told to
restart the iBook.
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Now you're wired, but not yet ready to print. When you first plug a
printer into the iBook, it's not smart enough to notice that it's got a new
friend ; you have to tell it.
4. From the ti menu, choose Chooser. It looks something like this:
0
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The icons that appear in the left half of the window depend on which
printer drivers are in your System Folder. A printer driver is a little piece
of software that teaches the iBook how to communicate with a specific
printer. Its name and its icon match the printer itself, as you can tell,
sort of, from the preceding figure. (The highlighted icon corresponds to
the popular Epson Stylus 740.)
5. Click the icon that corresponds to your printer.
You've just introduced the iBook to its new printer. All this is a one-time operation, by the way. Close the Chooser window, click OK to dismiss the warning
message, and proceed to "After All That: How You Actually Print," later in this
chapter.
Unless you have to switch printers or something, you'll never have to touch
the Chooser again.

How to hook up an older inkjet printer
In the best of all possible worlds, you bought a USB printer and your iBook at
about the same time. A few troublemakers, however, attempt to connect a
new iBook with an older printer that doesn't have a USB jack, such as an old
Apple StyleWriter.
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Tales of dpi
Why have America's scientific geniuses
invented all these different kinds of printers?
In a word, they're on a quest for higher dpi. That
stands for "dots per inch," and it measures the
quality of a printout. We're talking about tiny
dots, mind you - there are about 100 of them
clumped together to form the period at the end
of this sentence. Clearly, the more of these dots
there are per inch, the sharper quality your
printouts will have.

Old laser printers manage 300 dpi, and today's
generally do 600 dpi. A typical inkjet printer,
such as a DeskJet, sprays 720 or even 1,440 dpi
onto your paper. Photos printed by a 1,440 dpi
printer look like photos, let me tell you.
Pretty good, you say? Yeah, well, so's yer ol'
man - this book was printed on a 2,400dpi professiona l printer!

In such a case, you must buy one more component: an adapter. (The $99
Farallon iPrint SL is a good bet, as described in Appe ndix B.) It connects to
your iBook's Ethernet or USB jack (on the left side of the laptop) and provides an old-style round connector, into which you can plug your printer's
existing cable.
To use the Farallon iPrint, start by installing the software that came with it
(on the included CD disc). When the installation is complete, choose Control
Panels from your ti menu. Open the AppleTalk control panel. From the popup menu, chose Ethernet; when you're asked if you want AppleTalk turned
on, say yes.
Now return to the Chooser. Click the icon of the kind of printer you want;
when your printer shows up on the right side of the window, close the
Chooser window, click OK, smile, and jump down to "After All That: How You
Actually Print."

Laser Printers
If you can afford to pay something like $600 for a printer, some real magic
awaits you: PostScript laser printers. Don't worry about the word PostScript for

now. Just look for the word PostScript in the printer's description, as though
it's some kind of seal of approval.
A PostScript printer, like HP's LaserJet series or Apple's discontinued ( but
ubiquitous) LaserWriters, can print any text, in any style, at any size, and at
any angle, and everything looks terrific. The printouts are created much like
photocopies: they're crisp and black, heat-fused to white paper. These laser
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printers can also print phenomenal-looking graphics, like all the diagrams in
Macintosh magazines and the weather maps in USA Today. They're quick,
quiet, and hassle-free; most can print envelopes, mailing labels, and paper up
to legal-size ( but not tagboard). They're also much bigger and bulkier than
inkjets, as you can see by this example.

If you can afford a PostScript printer, get it. If you're a small-time operation -

a home business, for example - get the cheapest PostScript laser printer you
can find.
Just remember that laser printers, while superior to inkjets for b/ack-andwhite quality, aren't what to buy if you want color. Sure, you can buy a color
laser printer - for several thousand dollars - but the printouts aren't even
as realistic as color inkjet printers' printouts.

How to hook up a modern laser printer
Most modern laser printers include an Ethernet jack. That's handy- so does
your iBook. Laser printers usually don't come equipped with cables, however. After having collected hundreds of dollars from you, printer companies
have charitably recognized that this machine may wind up being shared
among several different computers. Therefore, laser printers are designed to
be networked, and therefore printer companies assume your office has a local
guru who knows what cables to buy.
If you work in an office, then you probably don't care; ask whatever geek is in

charge of your office network to connect your iBook to the existing Ethernet
wiring system.
If you are the geek in charge of all the equipment, life's a little more compli-

cated. Chapter 14 tells you how to set up an Ethernet wiring network by
yourself; all you need to know here is that your laser printer should connect
to your Ethernet hub (which you'll read about in Chapter 14) exactly like any
other Mac.
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1. Connect your laser printer to the Ethernet hub (see Chapter 14).

Connect your iBook to it, too.
Again, Ethernet isn 't for dummies - people get advanced degrees in figuring this stuff out - but Chapter 14 should make this step at least as
transparent as the iBook's plastic case.
2. From the ti menu, choose Control Panels. Open the AppleTalk control
pane l. From the pop-up menu, choose Ethernet; when you're asked if
you want AppleTalk turned on, say yes. Close the control panel
window.
You've just told your laptop which connector it should pay attention to.
3. From the ti menu, choose Chooser. If you see a printer driver icon in
the Chooser window that matches your printer, you're in luck! Click it.
If you don't see your specific model named, try the LaserWriter 8 icon.
Either way, if your printer is turned on, you should s ee its actual name
s how up in the right s ide of the Chooser window, as shown here; click
the printer's name.
ii
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If the names of several printe rs show up on the right, you're eithe r part

of an office network with several printers or you're an unexpectedly
wealthy individual. Congratulations . Click the one you want to print on.
Close the Chooser window, click OK, and read on.

A~er All

That: How You Actuall1J Print

Suppose that your printer is finally plugged in and, via the Chooser, has been
introduced to the iBook. The moment has arrived: You'd actually like to print
something.
Make sure whatever you want to print (an AppleWorks document, for example) is on the screen. From the File menu, choose Print. A dialog box appears;
it looks different depending on your printer, but this one is typical of what
you see if you have an Epson color printer.
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For 95 percent of your life's printouts, you'll completely ignore the choices in
this box and simply click the Print button.
For the other 5 percent of the time, the main thing you do in this dialog box is
tell the iBook which pages of your document you want it to print. If you just
want page 1, type a 1 into both the From and To boxes. If you want page 2 to
the end, type 2 into the From box and leave the To box empty. (The From:
and To: blanks in the Epson dialog box don't have From: and To: labels, but
they're there. They're the two unlabeled boxes, in the preceding illustration,
where 3s have been typed in.)
Specify how many copies you want by clicking and typing a number in the
Copies box.

Usin9 the Tab kelJ. in diaf09 boxes
Now would be a good time, I suppose, to mention what the Tab key does in
dialog boxes. Suppose you want to print two copies of page 3. Instead of
using the mouse to click in each number box on the screen, you can just
press Tab to jump from box to box.
Therefore, you'd just type 2 (in the Copies box); press Tab and type 3 (in the
From box) and press Tab and type 3 again (in the To box), as shown in the
previous illustration. And the trackpad just sits there gathering dust.
Anyway, after you're done filling out the options in this box, you can either
click the Print button or press the Return key. (Pressing Return is always the
same as clicking the outlined button.) The iBook should whir for a moment,
and pretty soon the printout will come slithering out of your printer.
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This handy shortcut - using the Tab key to move around the blanks and
pressing the Return key to "click" the OK or Print button - works in any
dialog box. In fact, any time you ever see a button with a double-thickness
outline, as shown in the preceding illustration, you can press the Return key
instead of using the mouse.

8ack9round printin9
In the Dark Ages of the 1980s, when you printed something, the printer's soul
took over your Mac's body. You couldn't type; you couldn't work; you couldn't do anything but stare at the sign on the screen that said, "Now printing." It
was a dark and stormy era, a time of wild and rampant coffee breaks. Only
when the paper came out of the printer were you allowed to use your computer again.
Since then, some clever engineer at Apple figured out how to allow background printing. When you use this handy feature, the iBook sends all the
printing information, at a million miles per hour, into a file on your hard disk.
It then immediately returns its attention to you and your personal needs.
Then, quietly, behind the scenes, the iBook shoots a little bit of that file to
your printer at a time. It all happens during the microseconds between your
keystrokes and mouse clicks, making it seem as though the iBook is printing
in the background. In time, the printer receives all the information it needs to
print, the paper comes gliding out, and you've been able to keep working the
whole time. This simultaneous-processing bit can slow down your iBook, but
it's a great feature to remember when it's 1:55 P.M. and the meeting starts at
2:00 and you haven't printed your outline yet.
The location of the on/off switch for Background Printing is different for
every printer, but I'll do my best. When you choose Print from an iBook program's File menu, you get a dialog box like the one shown in the previous
section. If it's an Epson printer, click the tiny second-from-right icon, which
I've circled in the previous illustration. If it's some other printer, look for a
pop-up menu that contains a Background Printing command.
Either way, you'll wind up with an on/off switch for Background Printing.
Click accordingly.

Cancelin9 printin9
If you want to interrupt the printing process, :!€-period does the trick - that

is, while pressing the 3€ key, type a period. Several times, actually. Even then,
your printer will take a moment (or page) or two to respond.
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A shortcut for multiple-printer owners
As often happens in democracies, the rich
sometimes carry special influence. In the case
of the Mac, the early 1990s saw the uprising of
the powerful People With More Than One
Printer lobby (the PWMTOP, as it's known in
insider circles). These people - usually people
in an office where several different printers are
hooked up - resented having to lumber off to
the Chooser each time they wanted to redirect
their printouts from one printer to another. They
asked Apple to come up with some easier
method of switching.
Apple complied. When you first turned on your
iBook, you may have noticed an icon that
matches your printer sitting out on the desktop,
as shown below. (Such icons generally appear
only if you have an Apple brand printer, not
Epson, HP, or anything else.)
To create more of these, the PWMTOP members
simply select corresponding icons in the
Chooser; each time they do so, another printer's
icon shows up on the desktop. Thereafter, these
lucky folk can direct a printout to a particular
printer just by dragging the document's icon
onto the appropriate printer icon, like this:

If, on the other hand, you use only one printer,
this desktop printing thing is a waste of your
memory, disk space, and screen space.
Here's how you can turn it off:
1. From the ti menu, choose Control Panels.

2. Double-click the one called Extensions
Manager (if you see something called
Conflict Catcher, open that instead).
You should now see a list of a million computer-looking control panels and extensions,
as they're called. (More about these in
Chapter 12.) Click all the ones with the word
Desktop Printing or Desktop Printer in them
to turn them off (so that they're no longer
highlighted or checked off).
3. Restart your iBook.
Now you can throw away any printer icons that
still appear on your desktop (which now probably have a big X through them).
Now that's what I call a grass-roots campaign
against the rich!
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Whv. This Entire Chapter
Is Probahlv. lrreleflant
All of this proud prose and valorous verbiage is fine if you plan to sit at home
and make printouts there. But you bought a laptop, dude. You travel. What're
you gonna do? Drag your printer along behind your suitcase like a clanking
plastic poodle?
Forget about it. When you travel, do what the pros do when they need a
printout: Leave the printer at home, and fax stuff to yourself. From the comfort of your own hotel room, just fax whatever you've typed up to the hotel's
front desk. There it arrives, on crisp clean paper, looking gorgeous, without
costing you a penny. Sometimes it's even delivered to your hotel-room doorway by a natty-looking porter in a red uniform.
Faxing from your iBook is easy; you'll find step-by-step instructions in
Chapter 20. As for saving you the $250 you would have spent on a printer you're welcome.

Top Ten Free Fun Font Factoids
The various fonts (typefaces) listed in the Font menus of your programs
(such as AppleWorks) are amazing. They look terrific on the screen and even
better when printed, and they're never jagged-looking like the computer fonts
of the early days. You may not realize it, but your fonts are a special kind of
idiot-proof, jaggy-free, self-smoothing font that looks great on any printer at
any size: TrueType fonts.
If you work in the professional printing or graphic design industry, by the
way, you may hear about a competing kind of font known as PostScript fonts.
If you're truly interested in learning about the differences and history of
these warring font types, check out a book like Macworld Mac Secrets; for
now, let's just say that TrueType fonts - the kind that came on your iBook are easier to manage, handle, and install.
Here are ten examples of the kind of fun you can have with your fonts:
1. Want more fonts? You can, of course, buy them. Your friendly neighbor-

hood mail-order joint, like those listed in Appendix A, are only too happy
to sell you CD-ROMs crammed with new fonts.
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Those on a budget, however, can still get tons of great fonts. Dial up
America Online or the Internet (see Chapter 6), for example, and help
yourself to as many fonts as your typographical taste buds can tolerate.
(On America Online, use keyword filesearch; on the Internet, try
www.shareware.com; either way, search the resulting page for "fonts.")
2. To install a new font, quit all your programs (if you're running any). Drag
the font-file icon (shaped like a suitcase) on top of the System Folder
icon. (Do not drag it into the open System Folder window. Do not drag it
to the Trash can. Do not collect $200.)

~...

'Q

...,

~~

System folder H:til;ft5ttilifemttm

You'll see a message alerting you that the iBook is going to install the
font for you. Just smile, wave, and click OK.
3. Want to see where your fonts live? Open your System Folder and then
open the Fonts folder therein. You'll see a list of your fonts in a window.
To see what a font looks like, double-dick its suitcase icon. You'll get a
window showing the individual font sizes, like Times 10 and Times 18;
double-click one. A little window opens, displaying a few words to live
by (such as: "Cozy lummox gives smart squid who asks for job pen"),
displayed in the font you're investigating.
4. To remove a font, quit any programs you're running. Open your Fonts
folder (as described in the previous paragraph). Then just drag the
offending font - or its entire suitcase - out of the window. Put it onto the
desktop. Or put it into some other folder - or right into the Trash can.
5. There are two kinds of people: those who place everything into two categories and those who don't. Among fonts , there are two basic types:
proportional fonts, where every letter gets exactly as much width as it
needs, and monospaced fonts, where every letter is exactly the same
width, as on a typewriter. What you're reading now is a proportional
font; notice that a W is much wider than an I.
Your iBook comes with two monospaced fonts: Courier and Monaco. All
the others are proportional.
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And who the heck cares? You will - the moment somebody sends you,
perhaps by e-mail, some text that's supposed to line up, but doesn't. For
example, this table that arrived by e-mail:
Fzom:
Toi

IntllnseDud e
pog.,.@lol.com

Hello, David! Hue aH the p1icu you aJked a.bout:
!lam

Fe1.tu:u

P,lct

S.infeld stat110tta
RAmovable IW!pi tct
!115.00
&rywalc:h digital walc:h Suzfboud nwtp·•tcond hand $34~
•66 Minutes• bowtie
Mike W*1lace autoguph
165.75
E.R. lle.ndAid PlJ<IM
100 pt l boM
$ 9.85

All you have to do is highlight this text and change it to, say, Courier,
and everything looks good again!
From :
To :

In tenseOude
pogue4>oo I •COii

Hello , Oavtd! He re a re the pr ices you asked about :
Price

Item

Fea tur~s

Seinfeld Statuette
Boywatch dt g ttol vo tch
"60 Minutes" route
E. R. BandAtd PakN

Removable hai rpi ece
$25 .00
Surfboard sweep -second hond $34.58
Mt ke l allace au tograph
$65.75
100 per bo1
$ 9 .85

6. For laser-printer users only: From the File menu, choose Page Setup. The
Page Setup dialog box offers a handful of useful options - whether you
want the paper to print lengthwise or the short way, for example, or how
much you want your document enlarged or reduced.
The Paper pop-up menu near the middle, however, offers one of the
most useful controls. If yours says "US Letter Small," your laser printe r
leaves a half-inch margin all the way around the page, chopping off any
part of your printout that extends into it. If that bothers you, choose US
Letter from that pop-up menu (and to make your change permanent,
hold down Option as you click OK). From now on, your laser can print to
within a q uarter-inch of the edge of the paper.
7. From your ti menu, choose Control Panels. Double-click the one called
Appearance, and click the tab that says Fonts. Turn on the option called
"Smooth all fonts on screen."
Now revisit your word processor (or any other program, for that
matter) . Notice that the edges of your typed letters are drawn with
softer and smoother edges, making your entire computer look as though
it's an elegantly designed ad.

_ _ _ _ _ _ _ _ Chapter 5: A Quiet Talk about Printers, Printing, and Fonts
Before

After

The Staten Island Fairy

The Staten Island Fairy
A true story in run< drapte,.

Once upon a time there was a water sprite named
Tia. She lived in N ew York, near the hubor where

Qrv,e upon a lime there w.u a water :pnte named
Tia. She lived in New York. near the harbor where

8. In AppleWorks, Word 98, and some other word-processing programs,
you can actually see the names of the fonts in your font menu in those
typefaces, like this:

Arial

Arial MT Condensed liQhl
.Anal Narrow
Arial Rounded MT Bold
Avert Garde

nau11ow•n
BodoniMT UID'a Bold
BookAntiqua
Book man
Boolanan Old Style
Bookman Old Style Bold

Problem is, how are you supposed to read the names of symbol fonts fonts where every "letter" is actually a symbol or little picture (such as
Zapf Dingbats)? Easy. Hold down the Shift key as you pull down the Font
menu. Now every font doesn't show up in its own typeface - they're all
in the usual menu font now.
9. Want to look good the next time you're hanging out with a bunch of type
geeks? Then learn to bandy about the terms serif(pronounced SAJR-iff)
and sans serif(SANNZ sair-iff).
A serif is the little protruding line built onto the edges of the letters in
certain typefaces. In the serif font pictured in the top example here, I've
drawn little circles around some of the serifs.

Te~if c$erifs

Sans-serif
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A sans serif font, on the other hand, has no little protuberances, as you
can see by their absence in the little square (in the lower example
above). Times, Palatino, and the font you're reading are all serif fonts.
Helvetica, Geneva, and the headlines in most newspapers are sans serif
fonts. And that information, plus 33 cents, will buy you a first-class U.S.
postage stamp.
10. This one's techy, but it's good.
When the iBook prints, it matches the placement of each word exactly
according to its position on the screen. Trouble is, the iBook's screen
resolution isn't that good - it's only 72 dots per inch instead of 600 or
1400 dpi (the usual for printers). As a result, you sometimes get weird
spacing between words, especially between boldface words (see the
bottom-left printout on the following page).
The solution: When you print, turn on the Fractional Character Widths
feature. This makes words look a little bit cramped on the screen (top
right in the figure on the next page) but makes your printouts look awesomely professional (bottom right).
Fractional Widths OFF

On the screen:

Bullvinkle"s Little Secret

In the printout:

Bullwinkle's Little Secret

Fractional Widths ON

Bullwinkle's Little Secret

So how do you find this magical feature? In AppleWorks, Fractional Widths is
one of the Preferences (Edit menu). In Word 98, choose Preferences from the
Tools menu and click the Print tab. Try keeping it off when you're typing and
on when you print.

Part II

The Internet
Defanged
The 5th Wave
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BY. Rich Tennant
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In this part ...
"i" in iBook stands for Internet.

I know, I know: If you hear one more person start droning
on about the Internet, the Web, or the Information
Superhighway, you'll tie them to a chair to watch 18 hours
of the Home Shopping Network.
Actually, though, despite the overwhelming abundance of
ridiculous, time-wasting chaff in cyberspace, there's also a
lot of useful stuff, plus Dilbert cartoons for free. The next
few chapters tell you how to get it.

Chapter6

Faking Your Way onto America
Online and the Internet
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
Ill> The Internet: What and why it is
Ill> America Online, the grocery store; Internet, the farmer's market
Ill> How to hang up - and how to get over downloaded-file hang-ups

•••••••••••••••••••••••••••••••••••••••••••••••••

J

f you haven't heard of America Online or the Internet by now, you must've
spent the last ten years in some Antarctic ice cave. These days, you can't
make a move without seeing an e-mail address on someone's business card, a
World Wide Web address (like www.moneygrub.com) on a magazine ad, or the
glazed raccoon look of the all-night Internetter on a friend's face.

Going online gains you endless acres of features: the ability to send e-mail,
instantly and for free, to anyone else who's online; incredible savings when
you buy stuff (no middleman!); vast amounts of reading and research material (Time magazine, The New York Times, and so on, free); discussion bulletin
boards on 29,000 topics (left-handed banjo-playing nuns, unite!); live, typed
"chat rooms" that bring you together with similarly bored people from all
over the world; and much more.
Before you begin this adventure, though, a grave warning: Going online is
every bit as addictive as heroin, crack, or Presidential sex scandals, but even
more dangerous. As you explore this endless, yawning new world, filled with
surprises at every turn, you're likely to lose track of things - s uch as time,
sleep, and your family. Take it slow, take it in small chunks, and use these services always in moderation.
Above all, remember that the Internet wasn't designed by Apple. It existed
long before the Macintosh. It was invented by a bunch of military scientists in
the '60s whose idea of a good conversation was debating things like TCP/ IP,
FTP, and ftp.ucs. ubc.ca. As a result, going online is all quite a bit more complicated and awkward than everyday iBook activities.
In other words, if you can't figure out what's going on, it 's not your fault.
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The birth of the Confusion Superhighway
The Internet began as a gigantic communications network for the U.S. military. The idea was
to build a vast web of computer connections all
over the country so that, if an enemy bomb
destroyed one city, the government's electronic
messages could still reach their destinations.
(Gee, thats reassuring. Yeah, okay, New York is
in cinders - but hey!, at least the company
picnic memo got delivered.) As a result, you
might send an e-mail message to your next-door
neighbor - but it might reach him only after
traveling from your iBook to Omaha, bouncing
down to Orlando, returning to Toronto, and
finally reaching the house next door.

it; nobody even knows how many computers are
connected to it It's impossible to measure and
impossible to control - which is why American
teenagers love it, and governments try to ban it.
Anyway, when the U.S. government threw open
the lnternetto the public, it triggered an incredible explosion of interest, commerce, and
nauseating buzzwords like information superhighway. There's a lot of useful stuff out on the
Internet - and, as a pure time-killer, there's
nothing like it But there's also a lot of chaff to
wade through. Let this chapter and the next be
your guides to finding your way.

There's no central location for the Internet; it's
everywhere and nowhere. Nobody can control

First, the Modem
Your iBook came with a built-in modem, the little glob of circuitry that connects your computer to the phone jack on the wall. Fortunately, it's the
fastest one money can buy- a so-called 56K modem, which you can think of
as "56 miles per hour."
Now then: When the iBook makes a call, it dials the phone many times faster
than, say, a teenager, but ties up the phone line just as effectively. When your
iBook is using the modem, nobody else can use the phone. Therefore, you
need to figure out how you're going to plug in your modem:
Y"

Share a single line with the modem. You can visit your local Radio
Shack to buy a splitter, a Y-jack, a little plastic thing that makes your wall
phone jack split into two identical phone jacks - one for your phone
and the other for your iBook. This arrangement lets you talk on the telephone whenever you aren't using the modem and vice versa.

Y"

Install a second phone line. This is clearly the power user's method:
Give the modem a phone line unto itself.

_ _ _ _ _ Chapter 6: Faking Your Way onto America Online and the Internet
Pros: (1) Your main family phone number is no longer tied up every time
your modem dials up the latest sports scores. (2) You can talk to a
human on one line while you're modeming on the other. (3) If you're in
an office with one of those PBX or Merlin-type multiline telephone systems, you have to install a new, separate jack for the modem anyway.
Cons: (1) This option is expensive. (2) It involves calling up the phone
company, which is about as much fun as eating sand. (3) You run a
greater risk of becoming a serious modem nerd.
V'

Don't use a phone line at all. If you live in one of a few very lucky cities,
your local cable TV or phone company may offer a special way to connect to the Internet, known as cable modems or DSLs (digital subscriber
lines). These services cost around $35 or $45 per month, and require a
visit (and a bill) from a service technician to install. But the results are
worth slobbering over: Your iBook is online constantly, without even
using its built-in modem, and without tying up your phone line. Your
iBook gets its own direct umbilical to the Net, at speeds several times
faster than even the fastest standard phone-line modem.
I'll let you and your checkbook mull that one over. For now, it's worth
noting that cable modems, DSL, and similar high-speed connections are
the wave of the future. (On the other hand, a fancy high-speed Internet
connection at home doesn't do you much good when you're traveling
with your iBook.)

For the rest of this chapter, I'll assume that you plan to go online the way
most of the world does it: by connecting to a telephone line. Plug the
included telephone wire into the iBook's modem jack, which is the connector
on the left side of the laptop, closest to the hinge. Plug the other end into a
telephone wall jack. (If you've bought an AirPort base station, the setup is
slightly different; see Chapter 15.)

America Online or Direct to the Internet?
When it comes to visiting the vast, seething world of cyberspace, you have
two on-ramps. You can become an America Online member, or you can sign
up for a direct Internet account with a company like EarthLink. The geeks call
Internet-access companies (like EarthLink) ISPs, short for Internet Service
Providers.
I find the term Internet Service Provider - let alone ISP - overly nerdy, like
calling a writer a "Literature Service Provider." Unfortunately, you can't crack
open a magazine or visit a computer club without hearing people talk about
ISPs. ("My ISP only charges $15 a month!" "Really? Maybe I'll change ISPs
then.") So, with your permission, I'll refer to the companies who rent you
time on the Internet as JSPs, just like everyone else does.
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In this chapter, I'll show you both methods of getting online. Each route has
significant pros and cons, however, which you'll find in the following table.
Photocopy, distribute to your family members, and discuss over dinner.
America Online

Internet Service Provider (ISP)

$22 per month, unlimited access.

$20 per month, unlimited access.

Frequent busy signals between 6 p.m.
and midnight.

Busy signals are rare.

Hangs up on you after several minutes
of your not doing anything.

Doesn't hang up on you.

Long hold times for help,..Q.ut.fai.dlJ
Macintosh-savvy agents are ayajlable

Help agents are sometimes clueless
aboutthe iBook.

The one program on your hard drive the America Online program - does
everything: e-mail, World Wide Web
surfing, chat rooms, and so on.

You need a separate program for
each Internet feature: e-mail, Web
surfing, and so on.

Generally safe for kids; no pornography
on America Online itself.

Adult supervision required.

Very simple, sometimes frustrating;
the geeks look down on people
with AOL accounts.

More complex, less limiting; nerds
admire you for having a " real"
Internet account.

America Online (often called AOL) is an online service. That is, its offerings
are hand-selected by the company's steering committee and sanitized for
your protection. Contrast with the Internet itself, where the offerings constantly change, nobody's in charge, and it's every iBook for itself.
Going onto AOL is like going to a grocery store, where every product is neatly
organized, packaged, and labeled. Going onto the Internet, by contrast, is like
going to a huge farmer's market that fills a football stadium, filled with
whichever vendors happened to show up with their pickup trucks. At the
farmer's market, wonderful bargains may await - but it's hard to find anything
particular, the turnips may be rancid, and there's no clerk to ask for help.
On the other hand, don't forget that America Online also gives you the actual
Internet, in addition to its own hand-picked goodies. That is, the AOL grocery
store has a back door into the farmer's market.

_ _ _ _ _ Chapter 6: Faking Your Way onto America Online and the Internet

America Online (AOL),
the C1j.ber-Grocer1J.
Your iBook came with the America Online (AOL) folder already on the hard
disk (inside the Internet folder). Inside this folder is the America Online program whose icon you double-click to get started.
The first time you double-click this icon, you'll be guided through a series of
setup steps. You'll be asked:
V"

For your name, address, and credit-card number. Remember, though,
that you get 100 hours of time online (during the first month) for free.
Cancel within the first month, and your card is never charged.

V"

To choose a local access number from a list (and a backup number).
Fortunately, AOL has worked out a clever scheme that lets you, as one of
90 percent of Americans living near metropolitan centers, make a local
call to America Online. Somehow, this system carries your call all the
way to Virginia for free. (That's where the actual gigantic AOL computers live.)

V"

To make up a "screen name" and a password.

The screen name can be ten letters long, but you can't use punctuation. You
can use a variation of your name (A Lincoln, MTMoore, Mr Rourke) or some
clever CB radio-type handle (FoxyBabe, Ski Jock, NoLifeGuy). Do understand,
however, that America Online has over 17 million members, and each of them
(including you) can choose up to five different names, one for each family
member. In other words, you can pretty much bet that names like Helen,
Hotshot, and Mac Guy were claimed some time in the Mesozoic Era.
If you pick a name that someone has already claimed, the program will make
you keep trying until you come up with a name that hasn't been used before.

When all this setup information is complete, your modem begins screaming
and making a hideous racket, and you see an AOL logo screen that says
things like "Checking Password." Finally, if everything goes well, you're
brought to this screen:
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NY Nighllile; Pete H.,,... on politics.

You also get to hear a recording of the famous Mr. Cheerful, the man who
says "Welcome!" as though you're just the person he's been waiting for all
day. If you've got e-mail waiting, he also says "You've got mail!," which he's
really happy about. (To read the mail, click the "You have mail" icon.)

ExploriniJ. hlJ. icon
AOL, you'll quickly discover, is a collection of hundreds of individual screens,
each of which represents a different service or company. Each day, several of
them (one of which is always News) are advertised on the welcome screen.
To jump directly to the advertised feature, click the corresponding icon.
The broader America Online table of contents, however, appears when you
click the AOL Channels button on the opening screen. Each of these buttons
takes you to yet another screen, where you can visit related services - for
example:
Y' The Research & Learn (called Reference Desk in some versions) button

lets you consult a dictionary, a national phone book, or a choice of encyclopedias.
Y' The Personal Finance page is stock-market city: You can check quotes,

actually buy and sell, get mutual-fund stats, read tax and investing
advice, and so on.
Y' If you click the Travel button, you can actually look up plane fares and

even make reservations .

_ _ _ _ _ Chapter 6: Faking Your Way onto America Online and the Internet

Nafli9atin9 hi}. ke1J.ulord
If you poked around enough, clicking icons and opening screen after screen,

you'd eventually uncover everything America Online has to offer. In the
meantime, however, you'd run up your phone bill, develop trackpad elbow,
and watch four Presidential administrations pass.
A much faster navigational trick is the keyword feature. A keyword is like an
elevator button that takes you directly to any of the hundreds of features on
AOL, making no stops along the way. Just type the keyword of your choice
into th~ strip at the top of the screen (where it says "Type Keyword/Web
address"). When you press Return, you're teleported directly to that service.
Here are a few typical AOL services, along with their keywords. Arm yourself
with this list so that you make the most of your free month-long trial.
Keyword

Where It Takes You

Access

A list of local phone numbers for America Online. Use this
before a trip to another city.
Check your accounts, pay bills, and so on (certain
banks only).

Beginners

A collection of help topics for Mac newcomers.

Billing

Current billing info, disputes, and so on.

Encyclopedia

Your choice of several different published encyclopedias.
You just saved $900!

Help

Assistance about America Online itself.

Homework

A place for students to get live, interactive help with
homework and research.

Macgame

Files, messages, and discussions of Mac games.

Star Trek

Star Trek.

Stocks

Check the current price of any stock. You can even see
your current portfolio value.

And how, you may well ask, do you find out what the keyword is for something you're looking for? Easy- just type in keyword: keyword! You'll get a
screen that offers a complete list of keywords.
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How to find IJ.OUr U'alJ. back
to the 9ood stuff
With several hundred places worth visiting on AOL - and several million
places worth visiting on the Internet - it'd be nice if there were a way to
mark your place. Suppose you stumble onto this great English Cocker Spaniel
Owners' area, for example, but you've already forgotten which buttons you
clicked to get there.
Simple solution: When you're looking at a screen (or Web page) you might
someday like to return to, choose Add to Favorite Places from the Window
menu. Thereafter, whenever you want to revisit one of your thus-marked
Favorite Places, choose its name from the Favorite Places icon/menu, like this:

Eloolrlc Ll>rory Busintts Edition

To delete something from this list, choose the very first command (Favorite
Places) from the Favorite Places icon/menu. In the resulting window, just
click a place's name once and then choose Clear from the Edit menu.

The e-mail connection
One of the best things about AOL is the e-mail - mainly the sheer, ego-boosting
joy of getting some.
If, in fact, anybody has bothered to write to you (which you'll hear

announced by Mr. "You've got mail!"), click the YOU HAVE MAIL button on
the welcome screen to see your messages.
After you've read the message, you can (a) reply to it (by clicking the Reply
button); (b) send it on to somebody else (by clicking the Forward button);
(c) save it on your hard disk (by choosing Save from the File menu); (d) print
it (by choosing Print from the File menu); or (e) close its window without
saving it. If you do that, the message hangs around in your Old Mail folder for
about a week and then disappears forever.
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To send a message to somebody, click Write on the toolbar. Type your lucky
recipient's e-mail address, a subject, and your message in the appropriate
blanks. (Don't forget to press the Tab key to move from blank to blank.)
When you're done typing, just press Enter (or click the Send Now button).
If you need to look up somebody's screen name, use this keyword: members.

The partlJ line
By far the most mind-blowing aspect of AOL is , of course, the chat rooms. In a
chat room, you'll find up to 23 people chatting away (by typing). The nutty
thing is that everybody's talking at once, so the conversation threads overlap, and hilarious results sometimes ensue.
Nonetheless, the chat rooms are an unusual social opportunity: For the first
time, you can be the total belle of the ball (or stud of the studio) - the wittiest, charmingest, best-liked person - without so much as combing your hair.
To get to the chat rooms, choose Chat Now from the People menu/icon on
your toolbar. If you click the button called "Find a Chat," you'll discover that
dozens of parties are transpiring simultaneously, each founded on a different
topic. Double-click a room's name to go there.

Talkin9 behind their backs
What makes the live chats even more fun is that you can whisper directly
into the ear of anybody there - and nobody else can hear you. This kind of
behind-the-scenes direct communication is called an Instant Message. To send
one, choose Send Instant Message from the Members menu (or press 3€-1). You
get a box like this:

Things to know before entering the Party Zone
If it's your first time in a chat room, you may be
nonplused by the gross excesses of punctuation
that seem to go on there. Every five minutes, it
seems that somebody types {{{{{{{{
Jennifer! 11}}}}}}}} or ****BabyBones!****

Actually, there's nothing wrong with these
people's keyboards. The braces are the cyberspace equivalent of hugging the enclosed
person; the asterisks are kisses. That's how you
greet friends who enter the room - online,
anyway.
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E!l8

Send Instant Mess11ge

To: ILobslerGuy
I

I

P•i>t r...

....

1

c::J:a l!IZNl IA0100T.DOO~

Can you believe this bozo? He's h itting on all the women here! Let's both gang up and m ake fun of his spelling.

•••,,bl.

As soon as you type your whispered message and click Send (or press Enter),
the window disappears from your screen - and reappears on the recipient's
screen! That person can then whisper back to you.

Meanwhile, s omebody else in the room may have been InstantMessaging you.

F"'IZI"'
Hey. do you know if LobsterGuy is
actually a guy? I was thinking of asking her out. but

•

I want to m ake sure.

If you try to maintain your presence in the main window and keep your end of
all these whispered conversations in their little windows, the hilarity builds.
Nothing makes a better typist out of you than the AOL chat rooms.
P.S. You can also carry on Instant-Message chats with people who aren't
America Online members - that is, people who have standard Internet ( ISP)
accounts instead , as described later in this chapter. They, however, must first
download and install a free program onto their computers. For details, use
keyword: aim.

How to find- and 9et - free so~uJare
For many people, the best part of AOL is the free software. Heck, for many
people, that's the only part of AOL. Just use keyword: filesearch; click
Shareware; in the Find What? blank, type the name of the file, or kind of file,
you're looking for; and click Search.
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In a moment, you're shown a complete listing of all files in the AOL data banks
that match your search criteria. Keep in mind that roughly 500,000 files hang
out on those computers in Virginia, so choose your search words with care.
If you think a file sounds good, double-dick its name to read a description. If
it still sounds good, click Download Now. The iBook asks where you want the
downloaded item stashed. If you click the Desktop button before clicking Save,

you'll avoid the crisis of "Where did my downloaded goodies go?" syndrome
suffered by 1 in 6 American adults. When you finish using America Online,
you'll see the file you received sitting right on the colored backdrop of your
iBook (or, as we say in the biz, on the Desktop).
Your modem then begins the task of downloading (transferring) the file to
your hard drive. (Make sure that you read the section "When You Can't Open
Your Downloaded Goodies," later in this chapter, for a follow-up discussion
on downloading stuff.)

Si9nin9 Up for an Internet
Account (ISP)
If you've decided to sign up for a direct Internet connection (instead of going

the AOL route), send a thank-you note to Apple; signing up for such an
account on an iBook is as easy as signing up for AOL.
Locate and open the program called Internet Setup Assistant; it's in the
Internet folder on your hard drive. The Internet Setup Assistant asks you if
you want to set up your iBook for Internet use; yes, you do. Then it asks if
you already have an Internet account; no, you don't.
D

__

Internet Setup Assistant .

Internet Access

Would you Ilka to set up your iBook to use the Internet?

~

U Yes

I

121

12 2

Part II: The Internet Defanged _ _ _ _ _ _ _ _ _ _ _ _ _ _ __
Now the EarthLink Total Access sign-up program takes over, showing you a
series of screens, asking for your name, address, credit-card number, and so
on. (Start by clicking the I Agree button, and then the Setup button.)
While this goes on, a voice starts explaining what's happening. (Scared the
bejeezus out of me the first time I heard it.) Your modem dials an 800 number
a couple of times. Along the way, you'll be asked to make up a cybername for
yourself (such as SeinfeldNut83) and a password that protects your account.
When it's all over, you'll be an official, card-carrying member of the Internet.
Now you, too, can have an e-mail address with an @ sign on your business
card. Now you, too, can banter at cocktail parties about the ghastly new
color scheme on the Microsoft Web site. Now you, too, can slowly drift away
from family, job, and reality as you recede into cyberhermitdom.

What's on the Internet
In the following pages, you'll read about the various things that you can do
on the Internet. The most useful of these features are called e-mail, newsgroups, and the World Wide Web. As you read, keep in mind that all these
features are available to you regardless of whether you have an AOL account
or a real Internet (ISP) account.

E-mail
If you have America Online, see 'The e-mail connection" earlier in this chapter.
lf you've signed up for an ISP like EarthLink instead, see Chapter 8. Either way,

get psyched for a feature that'll change your life; as a technology, e-mail ranks
right up there with cable TV, frequent-flyer miles, and microwave popcorn.

News9roups
The next important Internet feature is called newsgroups. Don't be fooled:
They have nothing to do with news, and they're not groups. That's the
Internet for ya.
Instead, newsgroups are electronic bulletin boards. I post a message; anyone
else on the Internet can read it and post a response for all to see. Then somebody else responds to that message, and so on.
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Th e little > symbols mean that this portion of the message is being quoted from
a previous message, so everyone will know what this guy is respond ing to.

ubject: Madonna
rom: kcmoe~ol.com
ate: 11 May199720:17:47GMT
essage·ID: < 19970512001700.UAA06944~1adderll2.news.aol.com>

0

I truly believe that Madonna is a new art form unto herself,
>that she has reinvented the musical form as we know it,
>that neither music nor film will ever be the same.
Well, that's just the kind of pathetic balderdash we might expect from a
brainless moron like you. Why is it that nobody under the age of30 has
the least idea of what good art is anymore? I think you Madonna fans
should go stick your heads into the microwave and hit Defrost.

It's typical for Internet weenies to sign their names with some kind of
whimsical quotation. Don't ask me why; personally, it drives me crazy.

By the way: You might notice, in the previous illustration, that the writer is
somewhat nastier online than he might have been in your living room. That's
an interesting Internet lesson - people tend to be ruder than they would in
person. There are two reasons: First, you're anonymous - nobody can see
you, so it does n't seem to matter as much if you're a jerk. Second, millions of
messages appear here every day; some people think they need to be extradramatic just to be noticed.
There are about 29,000 different newsgroups, ongoing discussions on every
topic - chemists who like bowling, left-handed oboists, Mickey Mouse fans
who live in Bali - anything. Here's how you reach these discussion areas:
J.-'

On America Online: Use keyword newsgroups. If you then click Read
My Newsgroups, you see a starter list of topics; just keep double-clicking
topics that interest you until you're reading the actual messages. (To
add newsgroup topics to your starter list, use the Search All
Newsgroups button.)
After you've read a message, you can either respond to it (click the Send
New Message button) or just keep reading (click the Next» button).
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,,,- With an ISP: Use Outlook Express, which came with your iBook. (It's the
same program you use to read e-mail, as described in Chapter 8.)
Once you're online and running Outlook Express, click the Microsoft
News Server icon on the screen. You'll be shown a new window containing dozens of newsgroups that all pertain to Microsoft software.
Now, I'll be the first to admit that reading about Microsoft products all
day is not what you'd call, er, realizing the full potential of the Internet.
Therefore, if you think you're up for the full list of 29,000 discussion
topics, try this:
From Outlook Express's Edit menu, choose Preferences, click the News
icon, click New Server, type Newsgroup List (or something similar to
that), click OK, tab to the Server Address blank, and type out the your
ISP's news server address. (For EarthLink, it's news.earth/ink.net. If you
have another ISP, call it up and ask what the news-server address is.)
Click the Make Default button and then click OK.
From now on, whenever you feel like reading several million bulletinboard notes, launch Outlook Express. You'll see an icon called Newsgroup
List (or whatever you called it) at the left side of the screen; double-click
it. Finally, from the View menu, choose Get Complete Newsgroup List.
Wait five minutes for the full list of thousands to arrive on your screen and then, at last, you can begin reading the messages on the world's
largest bulletin board. Just double-click a topic name; choose Refresh
Message List from the View menu; and then double-click a message name
to read it. (Click the Reply icon at the top of the window if you'd like to
respond to something somebody has written. But be nice.)
I realize that this process involves 500 steps, but as I said, nobody ever
called the Internet easy.

The World Wide Web
Except for e-mail, by far the most popular and useful Internet feature is the
World Wide Web. In fact , it gets a chapter all to itself (the next chapter). For
now, all you need to know is this:
,,,- On America Online: A Web browser is built right into your AOL software. In many cases, you wind up on the Web just by innocently clicking
some button within AOL - that's how tightly the Web is integrated with
America Online these days. (You can tell when you're visiting a Web
page, not an AOL page, when the address in the white strip at the top of
the window begins with the letters http.)
,,,- With an ISP account: You have your choice of two free Web-browsers:
Netscape Navigator and Microsoft Internet Explorer, both described in
the next chapter.
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How to use the Internet as a giant backup disk
As described in Chapter 4, backing up means
making a safety copy of your work. Some iBook
fans buy disk drives for this purpose (see
Chapter 19). Others send files to themselves as
e-mail attachments (see Chapter 8). But one of
the cheapest and most convenient ways to back
up your iBook is to use an Internet-based service like Freeback.com or MyDocsOnline.com.
These special Web pages are easy to use and
don't cost a penny.

transfer was complete, you can repeat the
process until all your important files are safely
copied onto your own private Internet backup
page. A File List screen shows you the list of
stuff you've backed up, and special buttons let
you retrieve them or delete them.

Here's how these free services work. Using your
Web browser (see the next chapter), visit the
service's Web page (http.//freeback.com or
www.mydocsonline.com, respectively). Click
the Register button; you'll be asked to make up
a name and password, and to type in your e-mail
address. (Freeback asks for a lot of other information, too, and offers you only 10 megabytes of
free storage. The easier-to-use MyDocsOnline
offers twice as much storage, and requires less
personal information.)

The 20MB of free storage offered by
MyDocsOnline is plenty if you mostly write,
crunch numbers, or work in AppleWorks. If you
scan huge photos, however, 20MB may not be
enough. In that case, you can pay for additional
Web storage at a Web site like BackJack.com
or iMacBackup.com. These Internet storage
services aren't cheap - BackJack.com is
$17.50 per month, for example. But they offer
two advantages: First, you can set these programs to run automatically, backing up specified
folders on your hard drive at specified times.
And second, there's no limit to the amount of
stuff you can back up in this way, although you
pay more if you store more.

Now, when you want to back up some files from
your iBook, just click the Upload File button on
the same Web page. Click the Browse button to
view a list of everything on your hard drive;
double-click the file you want backed up. When
the screen changes to indicate that the file

Whether you use the free Internet backup systems or the pricey ones, you sleep well at night
because your backup files are off-site; even if
your office is hit by fire, burglar, or plague of
locusts, your backup copies are safely somewhere else.

How to Han9 Up
When you're finished with an AOL session, hanging up is no big deal; just
choose Quit from the File menu, making your phone line available once again
to the other members of your family.
Getting off the Internet if you have a direct Internet account (ISP), however, is
trickier. Allow me to propose an analogy: Imagine that you call another
branch of your family tree on New Year's Day. You yourself place the call, but
then you hand the phone off to various other family members. "And now
here's little Timmy! Timmy, talk to Grandma.... "
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Using the Internet works the same way. Your iBook places the call. But aside
from tying up the phone line, your iBook doesn't actually do anything until
you now launch one of the programs you read about in this chapter: an e-mail
program or a Web browser, for example. Each of these Internet programs is
like one of your family members, chatting with the Big Internet Grandma for a
few minutes apiece.
The point here: When you quit your e-mail or Web program, the phone line is
still tied up, just as though Timmy, when finished talking to Grandma, put the
phone on the couch and wandered out to play. When you're finished
Internetting, therefore, end the phone call by doing one of the following:
V"

Choose Remote Access Status from your S menu; in the status window,
click Disconnect.

V"

Choose Disconnect from the Remote Access tile on your Control Strip
(see Chapter 8), like this:
lllflwfl' Ac<."11:t;<:C.w1t•cflltl

Open Remote~
Stotus Dl spl~•..
DereuIt
• l bm.net

V"

Wait. After about 15 minutes of your not doing anything online (or whatever time you've specified in the Remote Access control panel), your
iBook hangs up automatically.

When You Can 1t Open Your
Downloaded Goodies
It's easy to download software - either from AOL or the Internet. Maybe you
find something on a Web page worth downloading (see the next chapter).
Maybe somebody sends you a family picture as a file that's attached to an
e-mail. Unfortunately, the first word out of the beginning downloader's
mouth, on examining the freshly downloaded loot, is generally this:
"Wha- ?"
First of all, people often can't find whatever-it-was that they downloaded.
Hint: Downloaded stuff usually winds up in a special folder, which you can
find like this:
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v

America Online: Open the hard drive icon. Open the Internet folder.
Open the America Online folder. Open the Online Downloads folder.
There's whatever you've downloaded.

v

Files attached to Outlook Express e-mails: Double-click, in sequence:
the hard drive icon, the Internet folder, the Internet Applications folder,
the Outlook Express folder, and finally the Outlook Express Temp folder.
There are your downloaded files. (See Chapter 8 for details on Outlook
Express, e-mail, and file attachments.)

Further hint: When downloading stuff from the Web, you can avoid all this
folder-burrowing looking if, every time you download something, you click
the Desktop button before saving the file onto your hard drive, as mentioned
earlier in this chapter. That way, the freshly arrived files will always be waiting for you on your desktop when you get offline.

Second of all, the first thing many people read when they double-click a file
they've just downloaded is this: "The application is busy or missing."
And that's because of compression. As you sit there waiting for your Santa Claus
graphic to arrive on your iBook, you're tying up the phone line and drumming
your fingers. Therefore, almost everything on America Online and the Internet
arrives in a compact, encoded format that takes less time to transfer.
Full size: 480K

+

II

Armadillo'w'orks

Compressed: 275K

g+
ArmadilloWorks.sit

Which is terrific, except for one thing: How are you supposed to expand your
downloaded file back into usable form?
Any file whose format is indicated by the suffix .sit has been "stuffed" using a
program called Stufflt. As an added convenience, the America Online software unstuffs these files automatically when you log off the service.
But what if (a) you're getting your goodies straight from the Internet, not
AOL, or (b) the letters at the end of your precious loot's name aren't .sit?

StuffIt Expander: Free and easlJ
The solution to all of these problems is the set-it-and-forget-it answer to the
downloader's prayers: Stufflt Expander. It's free, thank heaven, and already
on board your iBook. (Open these icons, in sequence: your hard drive; the
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Internet folder; the Internet Utilities folder; the Aladdin folder; the Stufflt
Expander folder. There it is: the Stufflt Expander program. Want to stash it in
a more convenient place? Just drag the Stufflt Expander icon to your desktop,
where you'll be able to find it again more easily.)

..
This little program can gracefully re-expand just about any geeky Internet file,
from .sit to .cpt and .hqx, along with such all-time favorites as .gz, .z, .ARC,
.ZIP, and .uu files.
After you've Stufflt Expander conveniently placed on your desktop, here's the
handy two-step scheme for expanding something you downloaded from
cyberspace:

1. Drag the downloaded mystery item
on top of the Stuffit Expander icon.

2. Your downloaded mystery item is
automatically restored to human form.

Files IJ.OU still can't open
Bill Gates, as you may have heard, is the wealthiest human being in the history of everything. He got that way by foisting something called Windows
onto all the office computers of the world.
Fortunately, you've got something that works better: an iBook. Unfortunately,
sooner or later, you'll encounter files on the Internet intended for Windows
people - or files that are meant to be used by both Macintosh and Windows.
In both cases, you may be befuddled .
The giveaway is the three-letter suffix at the end of a downloaded file's name.
As described in the previous section, suffixes like .sit, .hqx, .zip, .uu, and
others mean that the file is compressed, and can be opened using Stufflt
Expander. But sometimes, even after being decompressed, a three-letter suffix
remains, such as the common ones revealed in this table:
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Suffix

How to Open It

.exe

An executable fi le - in other words, a Windows program. By itself,
your iBook can't run Windows programs, just as Windows computers
can't run Macintosh programs. All is not lost, however: If you buy and
install a program like SoftWindows www.insignia.com) Virtual PC
(www.c
·
~un
in ows programs .

or

.jpg or .git

You've downloaded yourself a photograph! When you double-click it,
you'll probably get a strange list box like this one:

&

Could not find the appllcatlon program that created
the document named "6-6Jpg".
To open the document, select an alternate program,
with or without translation:

di, MoviePlayerwith Quicklime translation
@ Olympus utility

h

Iii Photoshop
!!!lo PlctureVlewer
~ SlmpleSound with Quicklime translation

~ Simplelextwith Quicklime translation

0

I-

i!

Show only recommended choices

I Cancel J [[ ()pe_n J)

To look at the picture, double-click Picture Viewer in the list If you
want to make changes to the photo, you need a photo-editing program
like Photoshop or Photo Deluxe; if you see such a program in the list,
double-click its name .
.pdf

This downloaded item is probably a manual or brochure. It came to
you as a portable document formatfile, better known as an Adobe
Acrobat file. To open it, you need a free program called Acrobat
Reader. The installer for Acrobat Reader is probably on your hard drive
already; use the Sherlock command in your .S menu to locate it
(search tor the word Acrobat). If Sherlock comes up empty-handed,
visit www.adobe.com to download a fresh copy of the free Acrobat
Reader Installer. (This computing stuffs a full-time job, isn't it?)
When the installation is complete, you'll be able to double-click any
.pdf file to open and read it automatically.

.html

A file whose name ends in .html or .htm is a Web page. In general,
Web pages hang out only on the Internet. Every now and then, however, you may find that you've downloaded one to your iBook's hard
drive. To view it, launch your favorite Web browser, such as Internet
Explorer or Netscape Navigator. From the File menu, choose Open;
locate the .htmlfile; and double-click it to open.
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Gettin9 Online from the Road
The beauty of the Internet is that it's accessible from anywhere in America and in many other popular countries . And the beauty of the iBook is that you
can carry it with you. Leaving home, in other words, doesn't mean giving up
your favorite Web sites or e-mail correspondents. It does, however, require
some planning.

What to pack and how to set up
Whenever you pack your iBook, remember to remember the piece of telephone wire that connects it to a telephone wall jack. If you forget, you can
generally borrow such a wire from a hotel's front desk - but then you have
to tip the maintenance staffer who delivers it to you.
Once you're safely ensconced in your hotel room, don't plug the iBook's
phone wire into the actual wall telephone jack; there's a small risk that doing
so could turn your modem into a shiny molten puddle. (This advice applies
primarily to big, modern, hotels equipped with digital phone systems.)
Instead, connect the telephone wire to the jack labeled Data or Dataport on
the side of the telephone in your room. If your room (or the office you're visiting) has a fax machine, you can also plug your iBook's modem wire into the
fax machine's telephone jack, which is also perfectly safe.
If your bedside phone doesn't have a Dataport jack, call the front desk to ask
if it's safe to hook up your modem to the wall phone jack. (Hint: If it's an
analog phone system, you're safe, and you've also got a great conversation

starter for the cocktail hour.)
Once the iBook is plugged into some phone jack somehow, you're ready for
cyberness.

How to 9et the local access number
The phone number your iBook must dial to connect to America Online or the
Internet is called the local access number, and it's different in every city.
That's not a bad thing - it's a good thing, because it means you ' II rarely have
to rack up long-distance charges when you want to connect.

Lookin9 up the local America Online access number
You can look up a new city's local America Online number either before you
leave home or after. In this example, let's assume that you've just arrived at a
hotel room in East Murdoch, MA. In other words, the only thing you set up
before lea\ring home was the neighborhood kid who waters your plants.
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I. Launch the America Online program. On the welcome screen, click

Setup. When the America Online Setup window appears, click Next.

Now you're asked to tell the program what area code you're in, as shown
here:
AOL Setup

Search for AOL Access Phone Numbers
r you'll be connecting to the AOL service rrom within the United States, type yo tr
area code in the box below, then click Next
~you'll be connecting to the AOL service rrom another country, select the country
In the Country box. Provide any lrlormatlon thar s requested, then cllck Next.

Note: Members may inc tr charges on ther telephone bill, depending on ther
location and calling plan.

l

Courtry: united States

j ~J

Area Code: ~ Example: 703

""'

2. Type your current area code and then click Next.

Now you see this window:
AOL Setup .

Search for AOL Access Phone Numbers
• To select an a<:cess phone number, click the number, then click Add. Select as many ntrnbers as
you like, but please select at leasttw:>.
• To view numbers ror a ditferentarea, click Back.
• When dOne, click Done.
AOL Access Nurrbers
VAT.. Codt (~08) - MA
Att~o

Y90/X2 431- 0700

Bfockton

\/90/k:i6 894-2401

Brockton

\/90/k:i6 895-8000

Chvlton

V'30/X2 248-2500

Fall Rive r

33.6
730·3500
V'30 /X2 495-3000

Falmouth

3. From the pop-up menu at the upper-right, choose Make New Location.
Type the name of your away-from-home city.
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While you're here, look over the dialing options. For example, if you
need to dial 9 to make local calls, turn on the corresponding check box.
4. Click OK. Fmally, double-click the closest phone number in the list at
the left side of the window.
If you see two different numbers that are both local, double-click the
second one, too, so that two numbers are listed on the right side of the
screen.
5. Click Done.
You return to the Sign On screen, where the new city's name shows up in the
Select Location pop-up menu. Click the Sign On button - it's time to surf!
As you travel the world, adding each city's local AOL number as you go, this
Select Location pop-up menu will fill with the names of the cities you visit.
Just choose a city name to switch phone numbers. For example, when you
return home, choose Home from the Select Location pop-up menu, so that
your iBook will dial America Online using your original phone numbers.

Lookin9 up the local ISP access number
Which Internet service provider (ISP) did you sign up with? As your faithful
author, I have no clue; you may have signed up with any of 500 different companies. Each ISP offers a different set of local access numbers - and a
different means of looking them up. In general, however, you can find out
your ISP's local access phone number by either (a) calling the ISP's help line
or (b) visiting its Web site.
Suppose you've signed up with EarthLink, for example. You could go to its
Web page (www.earthlink.com), click Service & Support, and then click Access
Numbers - and presto, there's the complete list of all EarthLink numbers.
Once you've determined the local phone number for your new city, here's
how you tell your iBook about it:
1. From your S menu, choose Control Panels; in the list of control

panels, open the one called Remote Access.
The Remote Access control panel window opens.
2. From the File menu, choose Configurations.
You see this window:
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Configurations
Active configuration: Default
Import_
Default

Export...
Q.upllcate ...

I. Rename.M

__________

~ [
___.___.

.____

Done

C11nce1

J ij

Delete ...
Make Active

I

3. Click Default.
If you see an item in the list that's obviously your home dialing

number - say, one called ELN (which stands for EarthLink Network) click that instead.
4. Click the Duplicate button.

A new window opens, in which you can type the name of your new city.
5. Type the name of your new city. Click OK, and then click Make Active.

Now you see this window:
8
f> Rt9lsttrtd Uur 0

Guut

I

N>m0: SttVtn p . Job~

Password : !._
•_••_
.._

_ _ __ _ ____,

[if Save pHl'Word

[

St~tus
ldl•.

[ Options-

I H Connect

H
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6. In the Number blank, type the new local access number for your
new city.

Add an 8 or 9 at the beginning, followed by a comma, if your hotel
requires that for an outside line.
7. Close the window, save the changes when the iBook asks you to, and
grin proudly.

You're ready to go online, using your regularly scheduled e-mail or Web
browser programs.
When you return home, you'll have to re-select your original, home-based
local access number. To do so, repeat Steps 1, 2, and 3; click Make Active; and
then follow Step 7.

Traveling the world
If you're a world traveler, want to know why you
were so smart to wait until the 1990s were over
before buying an iBook? Because it took that
long for the Internet to get ready for you. Today,
an amazing number of countries around the
world offer Internet access - and if you've
signed up with a major Internet company, such
as America Online, IBM.net, or Earthlink, you'll
be able to connect overseas by placing a local
phone call, just as you would in the United
States. (Read the fine print, however: Special
surcharges usually apply, and not every country has access numbers for every ISP.)
Before you leave on your overseas journey,
follow the steps provided in this chapter for
looking up, and typing in, the local access
number for the cities you plan to visit.
Then take one more step: Call TeleAdapt
(877-895-9898, or 877-TELEADAPT), or visit the
company's Web page at www.teleadapt.com.
TeleAdapt is a company dedicated to helping

laptops connect to AOL or the Internet in every
country on earth. Sometimes doing so requires
a phone-line adapter, which TeleAdapt is happy
to sell you. Sometimes doing so requires some
sneaky software workarounds, which TeleAdapt
can tell you or fax to you. In any case, connecting to the Net overseas is never as easy as it is
in the U.S.; location-specific preparation and
advice are invaluable.
Even if you don't plan to go online, by the way,
you may also need a power-cord adapter for
your iBook. (Not every country's wall jacks look
like American ones, as you know if you've ever
been to Disney World's Power Outlets of Many
Lands exhibit)
You don'tneed a voltage converter - the iBook
can handle any voltage in the world - just a
prong adapter to make your power cord fit nonAmerican sockets. TeleAdapt, Radio Shack, and
other companies sell such adapter kits.

Chapter 7

The Weird Wild Web
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
.... The who, where, what, and why of the World Wide Web
.... A warm welcome to the wiles of World Wide Web software
.... Netscape Navigator and Microsoft Internet Explorer

•••••••••••••••••••••••••••••••••••••••••••••••••

~e

most popular part of the Internet is the World Wide Web - you can't
help hearing about this thing. Fourth graders run around urging schoolmates to "check out their Web pages." Web "addresses" show up
everywhere - on business cards, in newspaper ads, on TV. (Have you
noticed www.sonycom or www.spam.com flashing by at the end of movie ads
and car commercials? Those are Web addresses.)
The We b has become incredibly popular for one simple reason: It isn't geeky
and user-hostile, like the rest of the Internet. It looks friendly and familiar to
actual humans. When you connect to the Web, you don't encounter streams
of computer codes. Instead, information is displayed attractively, with nice
typesetting, color pictures, and interactive buttons.

Internet Made Jdiotproof: Link-Clickin9
Navigating the Web requires little more than clicking buttons and those
underlined blue phrases, which you can sort of see in the following figure:
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D

IBookWorld Home Page

(iBook World)

Featured Stories:

iMac News
We're Num11er Three
PC Data reports that the iMac was the
third best selling computer or
September, trailing two HP models.
Click for more.
HP overcharging for USB cable ktt?

George Cole oftheiMac.com finds that
Hewlett-Packard 's cable kit for its
Desk.Jet printers is unreasonably
overpriced. Click for more.
Conspiracy Theory
According to an article in The Regi ster,
Microson re solved its QuickTime
dispute with Apple with a $150 million
payotr. Click for more.
.
Entrega USB Card Review

Bondi Beach Boards
Games are just one of the many
things that the IMac does well.
Come to The Game Room to tell
us about your IMac gaming
expertences and to find out how to
make your iMac an even better
game machine. ~llJlmm.

.!lWt1
PageMilt 3.0 Review
eMediaweekly looks at the newest
iteration of Adobe's web authoring
app for home and small business

CH Products ls going full
tilt with devtlopment of
new use products for th•

Mao, such u tht

Gam tstick 3-0 pictured
.iibon. Ciiek ht!t for mof!

,calB!illa.:i:f11!.)Aaf,).l!lkas.;uiilicisJflll"'""ll....-~.........~""·- - - - -.......- - - , , - - - - Gamea Homa Olflctil Education Oat Connected Gadget• Hobby Shop

iMacworld

When you click an underlined phrase, called a link, you're automatically
transported from one "page" (screen) to another, without having to type in
the usual bunch of Internet codes. One page may be a glorified advertisement; another may contain critical information about a bill in Congress;
another might have been created by a nine-year-old in Dallas, to document
what her dog had for lunch.
Unfortunately, all of this amazing online multimedia stuff stresses your
modem nearly to the breaking point. Even with your iBook's 56 Kbps modem,
the fastest standard modem there is, you still wait five or ten seconds for
each Web page to float onto your screen.

Gettin9 to the Web tlia America Online
To get to the Web once your online with America Online, choose "Go to the
Web" from the Internet icon, as shown here:
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If you've been given a particular Web address to visit (such as www. hamsters.com), you can also treat it as a keyword. (See Chapter 6 for instructions

on using keywords.) That is, type in that Web address into the Keyword box
(or the strip at the top of the AOL screen); it'll automatically open up a Web
window and take you to the appropriate page.

Gettin9 to the Web flia an ISP
If you've signed up for a direct Internet account (such as EarthLink, as

described in Chapter 6) instead of America Online, you'll be using a special
program for browsing the Web - called, with astounding originality, a Web

browser.
Most people use either the Netscape Navigator or Microsoft Internet Explorer
browser. Both are free; both are on your iBook's hard drive (in the Internet
folder).
How do you choose which browser to use? In a nutshell, Navigator is faster,
but doesn't have many features. Explorer is slower, but has a lot of nice features (such as the capability to turn off blinking animations on Web pages,
which otherwise drive you quietly mad).
To go a-browsing, launch your Web browser. If you have, in fact , signed up for
an Internet account (see Chapter 6), the iBook dials the phone automatically,
hisses and shrieks, and finally shows you a Web page.

Where to Go, What to Do on the Web
Once you're staring at your first Web page - whether via America Online or
an Internet access company- getting around is easy. (The picture below
shows Netscape Navigator, but you'll find the same basic elements in Internet
Explorer, too.) Just look at all the fun things to see and do on the Web!
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A. Click the Back button to revisit the page you were just on - or the

Forward butto n to return to the page you were on before you clicked the
Back button. (Does that make sense?)
B. Type a new Web page address into the thin horizontal strip at the top of
the browser window and press Return to go to the s ite. A Web address,
jus t so you know, is known by the nerds as a URL - prono unced "U. R. L."
And where do you find good Web addresses? From friends, from articles,
o n television, and so on. Look for http:// o r www at the beginning of the
address - a gua ranteed s ign that the address points to a Web page.
C. Enjoy the little animated meteor s hower in the upper-right-corner logo. It
means "Wait a sec, I'm not done painting this Web page picture for you.
As long as I'm animating, you'll jus t have to wait."
D. Clicking a picture or a button often takes you to a new We b page.
E. Clicking blue underlined phrases (called links) always takes you to a different Web page. (As a handy bonus , these links change to some other
color when you see them next. That's to remind you that you've been
that way before.)
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F. Click in a Search blank and type what you're looking for. (Click the
Search button when you're finished typing.) Similar blanks appear when,
for example, you're asked to fill out a survey, type in your mailing
address, and so on.
G. When you see a picture you'd like to keep, point to it, hold down the
mouse button, and watch for a pop-up menu to appear at your cursor
tip. From this pop-up menu, choose "Save this Image As" (in Navigator)
or "Download Image to Disk" (in Explorer). After you click the Save
button, the result is a new icon on your hard drive - a graphics file containing the picture you saved.
H. Use the scroll bar to move up and down the page - or to save mousing,
just press the spacebar each time you want to see more. (If that Space
bar trick doesn't work, first click any blank area of the Web page.)

Walls to search for a particular topic
Suppose you're looking at the Kickboxing Haiku Web page. But now you want
to check the weather in Detroit. Because the World Wide Web is indeed a big
interconnected web, you could theoretically work your way from one Web
page to another to another, clicking just the proper blue underlined links,
until you finally arrived at the Detroit Weather page.
Unfortunately, there are about 200 million Web pages. By the time you actually arrived at the Detroit Weather page, the weather would certainly have
changed (not to mention Detroit). Clearly, you need to be able to look something up - to jump directly to another Web page whose address you don't
currently know.
For this purpose, the denizens of the Web have seen fit to create a few very
special Web pages - whose sole function is to search all the other Web
pages. If you're on the Web, and don't know where to look for, say, information about Venezuelan Beaver Cheese, you can use the Find commands at any
of the following sites:
V' www.google.com
V' www.yahoo.com
V' www.altavista.com
V' www.infoseek.com
V' www.hotbot.com

All of these search pages work alike. Here, for example, is what it would look
like if you used the search page called Yahoo! (the second address listed
above) to find information about Venezuelan Beaver Cheese.
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After clicking the Search button, you'd be shown a brand-new Web page listing hits - that is, Web pages containing the words "Venezuelan," "Beaver," or
"Cheese."

b_HoOf·
.riSEARCH
PoW1d 108650 mo.tche• containing nnezuela.n beanr chee•e. Displaying mat:hes 1-20.
• Chee•• collec!QI'• cheeklist - Che••• colltctir' • checklist. !led Leice•ter. Bo=in. Tiliit. Bresse-Bleue.
Caerphilly. Perle de ChAmpagno. Bel Pae•e. Camemben !led Wmd•or. Camemben ..
--lJrtp.tlVVIY. ,,, tuki.1..1<1..C. <'111t' •lfillJJ'.1JJ1.1Jlf11'.YtiJ<V111::1JtJtl..""1.iJIJJJ
• Venezuelan Cr!minol J!J3tice Ll!W - Venezuelan Criminal J!J3tice Related Sites. There ore currently ro
lnternot re•oWte• In Venezuela devoted to criminal ju.stice. What follo"", insteM., 1' a.
--lJrtp.YIVVIY. <•(/I. IW<1i i~m'ORR71Pi'JLiJIJJJ/

• AP Labf Venezuelan RcP. - Venezuelan Representative. Corporation: von Suckow Gavea Representaciones
Av El Empalme Ed. Pedeco.mm:i Piso 4 OfflctnaCH41!1Bosque, Caracas Venozuela. . .
--lJrtp.$11. ,"lfl).lfl..~ t>w.VAPL,•fl..<tl.111)ll.1J>WJi111UJA<IJi.1JA"fllf\'Jlt'.3ll!'.hiJIJJJ/

• Vl!Nl!ZUl!LAN PILM YIDl!O COLLECTION - llevie"" of 1he TiUe• held In 1he Venezuelan Video
CoU.ctlon (Pan II) GOLPl!S A Ml PUl!IITA (1993) Direccl6n: Ale)Mdro Sadermo.n. Con. . .
··iJrtp.tlVVIY. 1:k/1{Jt>111J1<W t>wY..,hft"'""<lf\'Jlt'.311>'.!WJilt>.~c iJIJJJ

See how useful a search page is? This handy Yahoo! thing narrowed down our
search to a mere 108,650 Web pages! You're as good as home!
Not. You can see here, in a nutshell, the problem with the Web: There's so
much darned stuff out there, you spend an awful lot of your time trying to
find exactly what you want. In this case, we probably should have clicked the
little Help button on the main Yahoo! screen . It would have told us that to find
a page containing the three words "Venezuelan Beaver Cheese" together, as a
phrase, we should have put quote marks around them. That would have
ruled out all the "hits" containing sentences like, "The beaver population has
been halved by pollution. In this photo, Venezuelan cleanup engineer Jose
Sanchez says 'Cheese!' for the camera."
Who ever said these things were user-friendly?

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ Chapter 7: The Weird Wild Web

Searching from multiple angles
Here's a hair-whitening fact I'll bet the friendly
stockholders at Yahoo.com don't want you to
know: no single Web search page searches
more than about 10 percent of the World Wide
Webl Yahoo!, Hotbot, lnfoseek, whatevereach knows about only a tiny fraction of the
world's Web pages. The task of reading or list·
ing every Web page on earth is simply too
overwhelming, especially when you consider
that hundreds of thousands of Web sites come
and go every day.

If you're having no luck finding a certain piece of
information online, therefore, try more than one
of the search pages listed in this chapter - or
just search using a Web site like Mamma.com
or MetaCrawler.com, which send your request
to ten other search pages simultaneously. Or
use Sherlock, described in this chapter, which
can also search many sites at once.

Searchin9 usin9 Sherlock
When trying to locate a certain piece of information on the World Wide Web,
most of the world's citizens use a searching Web page like Yahoo! or InfoSeek.
You, as an iBook owner, however, are more fortunate. You can search for stuff
on the Web exactly the way you search for files on your own hard drive: by
using the machine's built-in Find feature, better known as Sherlock.
It works exactly the way you'd expect: From your ti menu, choose Sherlock.
Click the tab called Search the Internet. Type what you're looking for - in
plain English - like this:
0
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In the lower part of the window, you'll see an assortment of search engines
(which is geek-speak for "Web pages that search the Internet"). If you were
stranded in a desert condominium without Sherlock, you'd have to search
each of these Web sites individually. Thanks to Sherlock, however, you can
search several search engines simultaneously for a certain morsel of info.
(You may find a number of shopping-oriented Web sites listed here, too, such
as Amazon.com. No, you won't find much about emu farming or medieval politics at Amazon.com. On the other hand, it may sometimes be handy to
search for a certain book or CD from within Sherlock.)
Just turn on the appropriate checkboxes, as shown in the illustration above,
and then click Find. Your iBook now connects to the Internet (if it wasn't
already), sends your request to the search engines you selected, and displays, in a new window, a list of Web pages that match your search, like this:
D

E!l8

Items Found: terms contain " emu farming" llerM found: 70
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g
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http://...........emUQ19$.COm/em~/lndex.htm

As you'll quickly discover, an advertisement also appears in the results
window. On one hand, you may find that the ad slightly dampens the pure
giddy joy of searching the Web with such ease. On the other hand, now you
know why the Sherlock service is free.
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At this point, you can proceed in any of several ways:
V' Click one of the results once to read, in the lower pane of the window,

the firs t several lines' worth of text from that Web page (as shown in the
previous illustration). Doing so gives you a quick ins ight into whether or
not the Web site Sherlock turned up is actually what you were looking for.
V' Double-dick one of the results to launch your Web browser program

(Internet Explorer or Netscape Navigator), which opens directly to the
corresponding Web page.
V' Drag a row of the results directly out of the window and onto your desk-

top, s trange as that gesture may feel.
The iBook automatically creates an icon on your desktop. At any time in
the future, you can double-click this icon to open the corresponding
Web page. Handy hint: Create a folder full of these icons, each representing one of your favorite We b sites. Leave this folder either sitting on
your desktop for easy access - or better yet, add it to your ti menu for
quick and easy access at any time. ( Instructions for Apple-menu surgery
are in Chapter 13.)

Not just Sherlock - new,
improtled Sherlock!
Every year, Apple makes improvements and additions to the Macintosh operating system (the underlying software that lets you turn the thing on, open
menus, use windows, and so on). The original iBooks came with the delightful
version of this software known as Mac OS 8.6; soon after, however, came Mac
OS 9. No matter what your iBook came with, you can buy and install newer
operating-system software at any time. (See Chapter 18 for details on such
upgrades.)
If ou're used to Mac OS 8.6, you'll find only two dramatic n

ures in
Mac
. ne of t em
1 y to share yourcoinputer in a family or
~lasSl'oom , such that each person who usesTt sees only his or her stuff on
the screen. Details on this multiple-user scenario in Chapter 13.
The other major Mac OS 9 feature i~Sherlock 2, a makeover of the Internetsearching feature described in this chapter. It works exactly as described in
the previous section, with two exceptions. Firs t, Sherlock 2 has a handsome
new stainless-steel look, guaranteed never to rust, flake, peel, or tarnish:
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Sherlock 2

ra rs r&:f1f rmrInew Madonna hairstyle
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CMI CNN lnterec1ive

(if
[if
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~ Motley f ool

Second, each icon button at the top of the window searches the Internet for a
different kind of information. (Apple calls these icon buttons channels; I call
them icon buttons.) When you click the twentysomething brunette's head, for
example, you can actually type in a person's name; Sherlock searches the
Internet for that person's e-mail address or phone number. ( In theory, this
icon button gives you a worldwide White Pages right on your screen. In practice, Sherlock often comes up empty-handed. Could be that it's wired only to
find twentysomething brunettes.)
Anothe r example: Click the shopping cart button to search s hopping We b
sites for a particular item. Note, as you click the various icon buttons, that
the columns of information in the results window actually change - when
She rlock shows you the results of We b shopping sites, for example, you get a
Price column that doesn't normally appear.
She rlock 2, in fact, is hours of fun for the whole family. Here's what each of
the icon buttons does:
Search the entire World Wide Web
Search shopping and auction Web sites
Search Apple Computer's Web site
Make your own collection of search sites
Shorlockl

~ ~~

1

~r"
,- n
Search dictionaries and encyclo pedias

Search for news and financial reports
Search for phone numbers and e-mail addresses
Search your hard drive
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When you click the rightmost icon, you get an empty list of Web search pages.
That's because this "channel" is one that you're supposed to build yourself.
Click the News icon button, for example; drag the CNN item in the checkbox
list up and to the right, until your cursor is on top of the Sherlock hat. You've
just installed that search page onto your very own customizable list.
Nor are you limited to the search pages that show up when you first use
Sherlock, by the way. Point your Web browser to www.apple.com/sherlock/
plugins.html. There you'll find an enormous assortment of additional Web
pages that can be searched using Sherlock. You'll find instructions on the
Web page for installing your newly downloaded plug-ins, as they're called.

Useful Web pa9es: The tip of the iceber9
But there's more to the Web than getting meaningful work done (as millions
of American office workers can attest). Here are some good starting places
for your leisure hours. Technically, each of their addresses begins with
http://, but you and I can both leave that off. Your Web browser will supply
those letters automatically when you're finished typing.
(Disclaimer: Web pages come and go like New York City restaurants. I guaran-

tee only that these pages existed the day I typed them up.)

v

mistral.culture.fr/louvre - The Louvre museum home page, where you
can actually view and read about hundreds of paintings hanging there.

v

amazon.com -An enormous online bookstore, with three million books

available, all at a 20 percent discount (or better). Reviews, sample chapters, the works. Don't freak out about typing in your credit-card number
online; you're far more likely to be ripped off by handing your Visa card
to the gas-station attendant or restaurant waiter.

v

www.dilbert.com - Today's Dilbert cartoon. And a month of past issues.

v

www.clicktv.com -

v

www.shopper.com -

v

pathfinder.com - The electronic editions of popular magazines like
People, Time, Money, Fortune, and more. Lots of graphics - nice, if

Free TV listings for your exact area or cable company. You can customize it to color-code various kinds of shows, to hide
the channels you don't want, and so on. Like TV Guide, but cheaper.

Here, you can comparison shop among hundreds of
computer-stuff mail-order catalogs instantaneously - with the results
listed in price order.

you're willing to wait for the pictures to arrive.
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Y" efax.com -

An amazing free service that assigns to you a private fax
number. When anybody sends a fax to your number, it's automatically
sent to you by e-mail. You read it on your iBook screen with a s pecial
free program called EfaxMac, delighted that you've saved the cost of a
fax machine, phone line, paper, ink cartridges, and the Brazilian rainforest.

Fill in the blank with your favorite major company:
Honda. Sony. ABC. Apple. CBS. Dis ney. NY Times. Macworld. McDonald's.
Try it -you'll like it.

Y" www.__.com -

The charming, attractive, and highly ente rtaining Web page of your eminently modest author.

Y" www. davidpogue.com -

Nat1i9ator tis. Explorer: The Tip-0-Rama
Unless you're an America Online subscriber, you s pend much of your
Internetting time using the Netscape Navigator or Microsoft Internet Explorer
browser.
Their makers, Netscape and Microsoft, are bigger rivals than Rocky Balboa
and Apollo Creed (or whatever his opponent's name was). Each company has
vowed to keep beating up the othe r until it crawls out of the ring with puffy
black eyes screaming, "ADRJANNN!"
Anyway: Unlike your America Online-subscriber comrades, you, 0 Inte rnet
subscriber, swallowed hard and opted for a hard-core, bona fide ISP account,
as described in Chapter 6. One of the perks of doing so is a raft of cool features in your Web browser. Here, for example, are some time-savers and
little-known features that work in both major browsers.

Choose IJ.Our weapon
Ever wonder a bout the icon on your desktop called Browse the Internet? It's
been there s ince the mome nt you turned on your laptop.
When you double-click that icon, your favorite Web browser launches.
Question is, which is your favorite? Is it Navigator or Internet Explorer? Here's
how you tell the iBook which browser you prefer.
From the ti menu, choose Control Panels, and then choose Internet. Click the
Web tab. See the pop-up menu at the bottom? That's where you choose your
browser-of-choice. Close the window, save your changes, thank me later.
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TIJ.pe almost nothin9
As you may have read earlier in this chapter, most Web addresses take the
form http://www.Spam.com, where Spam is the name of the company or
place. Thank goodness, you don't have to type all that! Whenever the desired
address takes that form, you can type (into that top strip where the address
goes) just the name of the company - such as Apple, Microsoft, IBM, Snapple,
Mentos, Pepsi, McDonalds, Spam, and so on. The browser fills in all the
http:// . . . com junk for you automatically.

Web browsers can show you text and pictures. But every now and then,
you'll stumble onto some page where a sound or a movie is the main attraction. Unfortunately, Navigator and Explorer don't know how to play these
multimedia morsels - but they know somebody who does!
What I'm driving at is plug-ins - small add-on programs that, after installed in
the Plug-Ins folder on your hard drive, teach Navigator or Explorer how to play
those extra goodies like sounds and movies. Plug-ins are free; you just must
know where to go to get them on the Web. Lucky you: I'm about to tell you.
Go to the Web address www.plugins.com or, if you feel like typing today,
http://home.netscape.com/ plugins/ index.html. There you'll find all the little
plug-ins looking for a home on your iBook.
I'm not saying you can't live a long, healthy, fulfilling life without any of this
stuff. I'm just pointing them out in case you try to visit some Web page and
get nothing but an error message saying something like, "Sorry, you can't
visit this page until you spend all afternoon downloading and installing SuchN-Such plug-in."

Where's home for IJ.OU}
Every time you sign onto the Web, your browser starts by showing you the
same darned starting page - let me guess: a very complex and dauntinglooking Apple page. Wouldn't it be great if you could change the startup page?
You can! From the Edit menu, choose Preferences. Click the icon at the left
side of the screen that says Navigator (in Navigator) or Home/Search (in
Internet Explorer), as shown here:
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Internet Explorer Preferences • -v
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Now just change the Web address in the Home blank to a more desirable
starting point. For example, you might prefer www.dilbert.com, which is a
daily comic strip ... or www.macintouch.com, which is daily news about the
Mac ... or even your own home page, if you've made one.

Faster - please, make it faster!
If the s lug-like speed of the Web is making you sob quietly into your late-night
coffee, despair no more . .You can quadruple the speed of your Web surfing_
~ties - by turning off the pictures.

Yes, I realize that graphics are what make the Web look so compelling,..6u.LaJl
pictures are ~~n ~at takes Web pages so darned long to
arrive on the screen.
---

c:lh~se

You owe it to yourself to try, just for a session or two, turning graphics off.
You still get fully laid-out Web pages; you still see all the text and headlines.
But wherever a picture would normally be - wherever you would have had
to wait for eight seconds -you'll see an empty rectangle containing a
generic "graphic goes here" logo.
Here, for example, is the Macworld magazine page (www.Macworld. com, of
course) with all its graphics gone:
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If you like the sound of this arrangement, here's how to make it so:
Y'

Netscape Navigator: From the Edit menu, choose Preferences. Click the
Advanced button and then turn off Automatically Load Images.

Y'

Internet Explorer: From the Edit menu, choose Preferences. Click Web
Content and then turn off Show Pictures.

I

( The speed yo~ gain is incrediblV And if you wind up on a Web page that
seems naked and shivering without its pictures, you can choose to summon
them all - just on this one page - by choosing Load Images or View Images
from the View menu.

Bookmark it
When you find a Web page you might like to visit again, you're not condemned to writing the address on the edges of your monitor, like some kind
of geeky bathroom graffiti. Instead, just choose Add Bookmark from the
Bookmarks menu (in Navigator) or Add to Favorites from the Favorites menu
(in Internet Explorer).
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Add Page to Favorites
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You're rewarded by the plain-English appearance of that page's name in the
Bookmarks (or Favorites) menu! Thereafter, the next time you want to visit
that page, you're spared having to remember http://www.madmansdream.com
or whatever; you can just choose the page's name from your menu.
To get rid of something in your Bookmarks menu, choose Bookmarks from
the Window menu (or choose Open Favorites from your Favorites menu).
Click the page's name and then press the Delete key. While this bookmarkorganization window is open, you can also rearrange (by dragging) or
rename (by clicking) your various bookmarks or favorites.

Stop the blinkin9!
The citizens of the Internet quietly endure the advertising that fills the top
inch of almost every Web page. We understand these ads pay for our free TV
listings, free New York Times, free Internet backup storage, and so on.
But there's a big difference between a calm banner across the top of the
screen and a seizure-inducing, blinking, flashing, looping, animated advertisement that's so distracting, you can't read the actual Web page itself.
-\-- If blinking ads make you, too, itch for a sledgehammer, then Internet

E~er

...shou ld he your browser. From the Edit menu, choose Preferences. Click the
Web Content icon; on the right side of the screen...y~
..Ani..InateEi-CIEs Turn off the Looping option to prevent animated ads frail!_
cycling over and over agam; turn off Animated GlFs to play no animated ads.
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Keepin9 the Net safe for kidlets
If you're worried that the Net's seedy underbelly isn't appropriate for certain

people who use your iBook, rest easy. Thanks to Apple's generosity, your
iBook came with the EdView Internet Safety Kit - Family Edition, a piece of
software that restricts your iBook's surfing to safe, pre-approved Web pages.
The Safety Kit also blocks all e-mail and even considers America Online offlimits. (Of course, you, the Person of Maturity, can override these blockades
as you see fit.) Step-by-step instructions await in Chapter 10.
(Note: Ironically, some versions of the Internet Safety Kit conflict with
Sherlock, the Internet-searching feature described in this chapter. If you discover that your iBook gives you the big bomb-Ola whenever you use Sherlock,
use the EV menu-bar command to temporarily disable the Safety Kit.)
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Chapter 8

E-mail for He-males and Females
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
How to get, read, and write e-mail
..,.. How to enjoy getting, reading, and writing e-mail
111Jo- The Anti-Junk-Mail Handbook
111Jo-

•••••••••••••••••••••••••••••••••••••••••••••••••

l

f you have any intention of getting the most from your expensive high-tech
appliance, you gotta get into e-mail. E-mail has all the advantages of the telephone (instantaneous, personal) with none of the disadvantages (interrupts
dinner, wakes you up). It also has all the advantages of postal mail (cheap, written, preservable) with none of its drawbacks (slow speed, paper cuts).

Chapter 6 covers the glorious world of e-mail on America Online. If you're on
the Internet courtesy of an Internet access company (an ISP) like EarthLink,
however, read on.

Gettin9 into E-Mail
To read and write electronic mail, you need an e-mail program. Microsoft
Outlook Express, for example, is sitting right there on your iBook's hard drive
(in the Internet folder). There's also a Mail function that's built right into the
Internet Explorer Web browser (see Chapter 7), but Outlook Express is a
much superior e-mail program. It's the one that opens when, for example, you
double-click the Mail icon that's sitting out on your desktop when you first
turn on the iBook.
The grisliest part of joining the e-mail revolution is setting up your account
for the first time. Fortunately, the Internet Setup Assistant (described in
Chapter 6) does all of that setup for you. You're all ready to go a-mailing. (If
you didn 't use the Setup Assistant before trying to use Outlook Express, the
program asks you to fill in a bunch of evil-looking blanks. Don't say I didn't
warn you. Call up your ISP company and ask for help filling them in - or just
run the Internet Setup Assistant.)
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Sendin9 e-mail
To write an e-mail, choose New Message from the Outlook Express File menu.
An empty e-mail message appears, filled with blanks to fill out. (The To,
Subject, and message areas are the only mandatory ones.) Here's what your
finished message might look like:
This person gets
the message.

These people
get copies.

These people get copies that
nobody else knows about.

Click here --tt-'il.:.I
when you're
finished.

The next meeting of the Adorable Fluffy Animo.l Union will be Thursday, January
4 on the Sesame Street set. No spouses. Open bar. No smoking except in the outer
, lobby. please.

1

The actual
message

Topic: "When Cloying Im ' t Enough: Handling Internal Rage on the Set."
1

Yer pal.
Bamz

As you'll quickly discover, e-mail addresses can't include any spaces, always
have an @ symbol in them, and must be typed exactly right, even if they look
like cc293fil@univ_amx.intermp.com. Capitals don't matter.
When you're finished writing, click one of two buttons at the top of the message window:
Y' Send: Click this button to send the message immediately. If everything's

set up right, your modem now dials, connects to the Internet, and sends
your e-message.
Y' Send Later: Click this button if you'd rather write several messages that

you intend to send, later, in a single batch. Each time you click Send
Later, the program files your newly typed message into its Outbox.
When you're finally ready to send the pile of Outbox messages, click the
Send & Receive icon at the top of the Outlook Express window. (If you
don't see the Send & Receive icon, choose Outlook Express from the
Window menu.)
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Gettin9 IJOUr mail
If the messages you send out to your friends are witty and charming enough,

you may actually get a few responses.
To check your e-mail, click the Send & Receive icon on the Outlook Express
toolbar. (Can't find it? Then you must have rearranged your windows. From the
Window menu, choose Outlook Express to bring the standard toolbar back.) In
a spasm of hideous shrieking, your modem then dials cyberspace's home
number and fetches any waiting mail. You'll see it in a list, as shown here:
OUtloolc Express

et

Rtpl\I All

~

for'W'ard

fl-.
Add

Cont~ct

w

Delete Contacts

~

Ftnd

•
w;;;;;i
~ Outbox (4)

@n

0

Sent Mail

~ Or•fts

LJJ
!e
@

From

Deleted Mtsu9ts
(I)

Contacts

Microsoft Nt"WS Serv...

Adorable- Fl uffy Anima l Union meeting

F'our11

From : "011vfd P09ue"' <dpogut@ibm.net >
Subject : Jokts du Joor

Hi there·· I thought you'd enjoy these jokes that were sent to m e:

A guy just died and he's at the Pearly Gates, waiting to be
admitted, while St. Peter is leafin' through this Big Book to see if
the guy is worthy. St. Peter goes through the Book several times,
furrows his brow, and seys to the guy, "You know, I can't see that
u ever did anythin~ really bad in your life, but you never did
~

2 mnsago(s), 2 dlsplayod

To read one of your messages, just click its name once (to view the incoming
memo in the lower pane of the main window, as shown above) or twice (to
open it into its own, larger window).

1

Processin9 a messa9e 1JOU fle read

,.
I

When you're finished reading an e-mail, you have five choices:
Write a reply. To do so, click the Reply button on the toolbar. Now you're
back into l'm-Writing-An-E-mail-Message mode, as described in "Sending
e-mail," a couple of pages back. (Your e-mail software thoughtfully pretypes the e-mail address of the person you're answering- along with the
date, time, and subject of the message. If I had a machine that did that for
my US. mail, I'd be a much better paper correspondent.)
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If you drag your mouse through some pertinent portion of the original

message before clicking the Reply button, your e-mail program prepastes that passage into the reply window, like this:

Hello there! I have a Macintosh b100CD with lb meg:: of
RAM <lnd a floppy drive and a keyboard and a mouse and a
screen and a printer. It's co.sed in bei~ plastic, roughly
rectangular, with an Ap.l'le lo~ on t e front and 9:_p_ower
cord on the back. Ki\YWay, myquesttorfll tlliS:

Ik ow do I Insert a cm~

...
Re: beslc: Mac: question~

1!118

ID ~
tntnu Slgn•t..-• Cont•ou Chock Harnos
..I

]

•vldPO<M! ~

...

i;;;a;: 000.00t\'l

lr:Jll
Label side up, hole in the middle. Hope this helps!

J

H

J?
~

--David

········-·
>From: HSmitherson@ranco.com
>To: David Po81'\e
>Subject: basic Mac question
>Anyway, my question is this:
>
>How do I insert a CD?

I-

~

This common Internet technique helps your correspondent grasp what
the heck you're talking about, especially since some time may have
passed since he or she wrote the original note. As in the illustration, when
the original e-mail contains a lot of irrelevant background material, this
kind of bracketing helps both of you focus on the actual point (if any).

v

Forward it. If you think somebody else in your cyber-world might be
interested in reading the same message, click the Forward button at the
top of the window. A new message window opens up, ready for you to
address, that contains the forwarded message below a dotted line. If you
like, you can type in a short note of your own above the dotted line
("Marge - thought this might annoy you") before clicking the Send or
Send Later button.

v

Trash it. Click the Delete icon on the toolbar, which sends the message

to the great cyber-shredder in the sky.

v Print it. From the File menu, choose Print.
v Save it for later. To do so, close the message window. If you want, you
can file the message away by dragging its name into one of the folders at
the left side of the screen.
By the way: You can, and should, create your own specially named folders. Do that by choosing New Folder from the File menu.
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Three ways not to be loathed online
Like any foreign country, the Net has its own
weird culture, including rules of e-mail etiquette
that, if broken, will make nasty comments and
snideness rain down upon the offender. If you
wantto be loved online, read up:
V' Don't type in ALL CAPITALS. They'll murder

you for that.
V' Don't ask what LOL means. It stands for

ulaughing out loud." And while we're at it:
IMHO is "in my humble opinion," ROTFL is
"rolling on the floor laughing," and RTFM is
"read the freakin' manual."
V' Quote what you're responding to. If someone

e-mails you with a question, don't just write
back, "No, I don't think so." The questionasker may have long since forgotten his/her
own query!

Instead, begin your reply with the question
itself. (On the Net, people generally put this
quoted portion in <brackets> like this.) Then
follow it with your actual answer.
Oh, yeah, one more thing: You'll see these little
guys all over the place:
:-)

Turn your head 90 degrees to the left, and you'll
see how it makes a little smiley face. That's to
indicate, of course, the writer's facial expression (which you can't otherwise see). A
thousand variants of that punctuation-face are
available - and an equally large number of
people who absolutely can't stand those little
smileys.

Attachin9 Files to E-Mail
Fortunately, there's more to e-mail than just sending typed messages back
and forth. You can also send files from your hard drive - in the form of
attachments to your e-mail messages.
Companies use this method to exchange design sketches, movie clips, and
spreadsheets. Authors turn in chapters (written in Microsoft Word or
AppleWorks) to publishers this way. And families send baby pictures this
way, to the eternal boredom of most recipients.

Sendin<J a file
To pull this off, start by writing a normal e-mail message, making sure that
you include a phrase like: "By the way, I've attached an AppleWorks file. It's a
drawing little Cindy did of a tobacco-company executive in a paroxysm of
self-loathing and doubt."
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Then locate the icon of the file you want to send. (This may involve opening
some folders and rearranging some windows on your screen.) You need to
adjust the windows on your screen so that you can see both your e-mail message and the icon of the file you want to send, like this:

a ·---_-

Pictures 4 UI ·

To: l !3P-!ld9ti:~urth Unlcntt

Ce: ~======================~

Boo: ~======================~
816jfft: IP icturu 4 U!
Ht Dad. TholJ9h t you · d enjoy these cu te c:Tawinos Ci ndy

did in her f ourth-grade ar t c lass . She ' s becol\e quite
a litt l e polHlcal c OU1en to t or , don" t you th ink"?

m--~u.._

Tob1eoo E'..:.f-1:'

~

J ane t Rtno in r epose

~

TV Guide back Issue index

Drag the icons straight into the e-mail window. As in the preceding figure, the
icons show up at the bottom of the window to indicate that your dragging
was successful.
That's it! When you send the message, the attached iBook files go along for
the ride.

Sendin<J. files to Windows people
If one aspect of e-mail causes violent gnashing of teeth, it's sending file

attachments, as described in this chapter, to Windows computers.
WARNING: As you may have heard, Windows is a more technical computer
system than Macintosh. Therefore, the following discussion is by far the most
technical one in this book. Fear not, however: This page has been reinforced
with invisible microfilaments for added strength.
When you're sending files to Windows PCs, you have to worry about three
conditions:
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v

You must send a file Windows can open. Jus t as Betamax VCRs can't play
VHS tapes, so Windows programs can't always open files from your
iBook. Here are some kinds of files that Windows can open: documents
created by Microsoft Word, Excel, or PowerPoint; graphics in JPEG or
GIF formats; We b pages you've created or downloaded; FileMaker and
Photoshop files; and othe r files where the same application is sold in
both Macintos h and Windows formats.

Windows PCs probably can 't open AppleWorks documents, by the way. If
you want to send an AppleWorks document, convert it to Micros oft
Word format before sending. To do that , choose Save As from the File
menu; from the Save As pop-up menu, choose Microsoft WinWord before
clicking the Save button.
If you want to send a picture, such as a scanned photo, to a Windows

pers on, first save it in a format that Windows can understand (JPEG or
GIF), us ing your scanning program's Save As or Export command.

v

You must add a three-letter code to the file name. Every file on every
Windows computer has a three-letter computer code that tells the computer what sort of file it is. Without this code, your poor suffering
Windows friends won't be able to open what you send them. This table
shows a few of the most common codes you might add:

Kind of file

Code

Example

Microsoft Word

.doc

Thesis.doc

Microsoft Excel

.xis

Quarterly results.xis

FileMaker Pro

.fp3

Databa se.fp3

A JPEG photo

.jpg

Picture of Mom.jpg

A GIF picture

.git

Banner ad.git

A Web page

.htm

HomePage.htm

v You must send your file in a format Windows e-mail programs can understand. The Internet, technically s peaking, can't transmit files at all -

only pure typed text. Behind the scenes, anything else that you transmit,
such as photos or AppleWorks documents, must first be converted into
a stream of text gibberis h that's reconstructed at the other end. Every
e-mail program - Mac or Windows - uses a different scheme for converting file attachments into codes that can be sent via the Internet.
Unfortunately, Macs like the iBook use one format (called Stufflt or
BinHex), and Windows uses another (called AppleDouble, MIME, or
Base64). (I'm perfectly aware that this stuff is technical gobbledygook to
you - hey, it's technical gobbledygook to me - but it's all for a good
cause. Just s mile and play along.)
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So where do you make such settings? Depends on what e-mail program
you're using. Outlook Express, praise be, generally uses the correct
format automatically. (To check: From the Edit menu, choose Preferences.
Click Message Composition; consult the pop-up menu at the lower-right.
If it says AppleDouble, you're all set to send files to both Mac and
Windows users.)
America Online, unfortunately, always compresses files using Stufflt
format, which Windows users can't read (unless they have a special
program called Stufflt Expander for Windows). Your only option is to
send files one at a time, making sure that the "compress Attachments"
checkbox isn't selected after you click the Attach File icon. (If you try
to send more than one file at once, America Online automatically compresses them.)

Gettin9 a file
You may receive files as part of an e-mail message, too. The sign that you've
received some picture or other file is a paper-clip icon in your In Box list.
If you double-click the name of the message, it opens up into a window of its

own. At the bottom, you'll see the attachment file's icon, like this:
Re : Te~ti n u

D
¢:'

r;.,.,., NU!
J-l(lol l o therel
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f· ...1y
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u
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In some cases, you can double-click the file icon to open it. For best results,
though, drag it out of the window and onto whatever part of your colored
Desktop you can see. Doing so turns the file into an icon on your Desktop;
from here, see the section "When You Can't Open Your Downloaded
Goodies," in Chapter 7.
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The Anti-Spam Handbook
No doubt about it: Unsolicited junk e-mail, better known as spam, is the ugly
underbelly of e-mail paradise. You'll know it if you've got it - wave after
wave of daily messages like "MAKE EZ MONEY AT HOME CARVING TOOTHPICKS!" and "SEXXXY APPLIANCE REPAIRMEN WAITING FOR YOUR CALL!"
Unfortunately, we can't hunt down the lowlife scum that send out these billions of junk e-mails. Their e-mail doesn't include a phone number or postal
address; you're generally expected to visit a Web site or respond by e-mail.
Meanwhile, our e-mail boxes fill up with useless crud that makes it harder to
find the real messages among them.
Whatever you do, never reply to a piece of spam e-mail - even if the message
says that you can get off the e-mail list by doing so! Ironically, your response
to the e-mail will simply flag your e-mail address as a live, working account
manned by somebody who takes the time to read the stuff. Your name will
become much more valuable to junk e-mailers, and you'll find yourself on the
receiving end of a new wave of spam.
You may have wondered: How did you wind up on these junk lists to begin
with? Answer: They get your e-mail address from you. Every time you post a
message on an online bulletin board, chat in a chat room, or even put your
e-mail address up on your Web page, you've just made yourself vulnerable to
the spammers' software robots. These little programs scour America Online,
newsgroups, and the Web, looking for e-mail addresses to collect.
"But if I can never post messages online," I can hear you protesting, "I'm
losing half the advantages of being online!"
Not necessarily. Consider setting up a second mailbox - that is, a second
e-mail address for your same America Online or Internet account. (That's
easy to do on AOL; go to keyword names to set up a new one. If you have an
Internet account, call your ISP's help line to arrange an additional mailbox.)
Thereafter, the game is easy to play: Use one e-mail address for public postings, chats, and so on. Use your second, private one for e-mail only. Spam
robots can't read private e-mail, so your secret e-mail address will remain virginal and spam-free.
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Part Ill

Software
Competence
'===:·

f:

Oka~ -yo\J were ~iffiht 1
1 was w.ron~. 'F5 orew;,

{ t'he. 1fara.ge <loo~, ~tul
::;: F6 backs the
·:: caY- out..

In this part ...
~e next five chapters introduce you to the software

~hat crune with (or can be added to) your iBook.
Including not just AppleWorks, Palm Desktop, games, and
that stuff, but also the system software, the heart that
beats within your System Folder.

f

After all, without software, your iBook is little more than
an art object - cool-looking and translucent, to be sure,
but not much help when it's time to write a letter.

'!

Chapter9

Putting AppleWorks to Work
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
.,.. Using AppleWorks as a word processor
.,.. Using AppleWorks as a graphics program
.,.. Using AppleWorks as a database
.,.. Using AppleWorks as a spreadsheet

•••••••••••••••••••••••••••••••••••••••••••••••••

A

pple Works is Swiss Army Knife software. (AppleWorks, by the way, was
formerly known as Claris Works - a useful piece of trivia the next time

you start describing your favorite program and get funny looks from Macintosh
old-timers.) Just look at all you get, even if you don't know what they are yet:
a word processor, a database, and a spreadsheet. But wait - you also get a
graphics program that can even serve as a basic page-layout system. And if
you order now, you even get a little telecommunications program absolutely free!
All these modules are neatly bundled into a single integrated program, which
came neatly bundled on your iBook's hard drive at no extra charge. You can
write a letter and put a graphic in it, or design a flyer that has a little spreadsheet in it, and so on. Chances are good that you and AppleWorks will get to
know each other very, very well in the coming months.

Launchin9 AppleWorks 1
To start up AppleWorks, double-click your hard drive icon to open it. Now
you should see a folder called Applications; double-click to open it. Inside is a
folder called AppleWorks, and inside that folder is the actual AppleWorks
icon, which you should now double-click. (If you use AppleWorks regularly,\
you'll be able to launch it much more directly from now on. Choose its name '
from the Recent Applications item in your S menu.)
After the logo disappears, the New Document dialog box, shown below, asks
you what you want to accomplish. Because you'll face this decision every
time you use this program, a rundown may be in order here. If my Executive
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Summaries don't quite do the trick, don't sweat it; you'll be introduced to
each of these modules in this chapter.
!==--

__ . New Document

AppleWorks
A Wor d Processing
4J DrHwlng
J Painting
II Spread sheet
~ Dotobose '-:
~ Communications

~C reole New Document

O Use Rsslstont or SIHtlonery

Cnal• a M'W databu• documf'nt.

C1mcel

DK

I

Word Processing: You know what a word-processing document is: something

that you type: a memo, a novel, a ransom note.
Drawing: This is a drawing program. In this kind of document, you toy around

with lines, shapes, and colors to produce such important visuals as logos,
maps, and Hangman diagrams .
Painting: This is a painting window. Painting is another way of making graph-

ics. But unlike the Drawing mode, where you can create only distinct circles,
lines, and squares, the Painting tools lets you create shading, freeform spatters, and much more textured artwork. If you have a scanner or a digital
camera, you can use this program to touch up the photos.
Spreadsheet: A computerized ledger sheet designed to help you crunch num-

bers: You can use it to calculate your car's mileage per gallon, your bank
account, how much of the phone bill your teenage daughter owes, that kind
of thing.
Database: An electronic index-card file. You type in your lists - household
expenditures; record collections; subscriber list to Regis & Kathie l ee! magazine - and the program sorts them, prints them, finds certain pieces of info
instantly, and so on.
Communications: This rarely used kind of program is useful primarily for dial-

ing up local "electronic bulletin boards" (a ra pidly fading memory, thanks to
the much zestier Internet) and hacking your grades on the school's computer.
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To make AppleWorks strut its stuff, I'll show you how to create a thank-you
letter. But not just any thank-you letter - this is going to be the world's most
beautiful and personalized form letter. You're going to merge a list of addresses
into a piece of mail, creating what appear to be individually composed letters;
thus the technoid term for what you're about to do is mail merge.
Even if form letters aren't exactly what you bought a laptop to create, follow
along. This exercise will take you through most of AppleWorks, and you'll
brush up against some features that will be useful to you.

Your first database
Suppose that you just got married. You were showered with lovely gifts. And
now it's your task to write a charming thank-you note to each of your gift
givers. You'll begin by typing a list of the gift givers. The ideal software for
organizing this kind of information is a database. Therefore, double-dick the
word Database, as shown in the previous illustration.
Define Data1111se Aeldsl
Fie l d Type:

Fiel d Name:

Fleld Name: 11-F_
lrs_t_N_am_e_
Create
~

lliMI

I

_ _ __,

Modify

Field Type: !Text
Delete

TvPf' • fitld n•me ind click Cr u t•, or ultoet • f if'ld, rmkf. eh•ngf's; Mld
thtn click Modifv .

TI
Options._
Done

Don't be alarmed. The screen that now appears may look complicated, but
it's actually not so bad - it simply wants to know what blanks you'll be wanting to fill in for each person in your list (name, address, gift type, and so on).
You're about to type names for these blanks (which the program calls fields).
As always, if you make a typo, just press the Delete key to backspace over it.
Here we go:
I. Type First Name and press the Return key.

Pressing Return is the same as clicking the Create button.
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2. Type Last Name and press Return.
3. Type Address and press Return.
See how you're building a list?
4. Type Gift and press Return.
5. Type Adjective and press Return.
In this blank, you'll eventually type a word that describes the glorious
present that this person gave you.
6. Finally, type Part of House (you'll see why in a moment) and press
Return.
Your masterpiece should look something like this:
Define Dat11base Fields
Field Name:
First Name
Last Name
Address
Gift
Adjectiv e
1
of House

Field Type:
Text
Text
Text
Text
Text
Text

Pilrt'

Field Name:

l!'art of House
Modify

Create
r.>l)

~

Field Type: !Text
Delete

Sf'l~t •fit Id ind click Opt ions t o chanQt attr lbutes 1 or changt tht name
or f it Id tvpe .and then click Modify .

•I
Options...

I

Done

7. Click the Done button in the lower-right corner.
The dialog box goes away.
When you see what you've created, things should make a little bit more
sense. You've just created the blanks (oh, all right, fields) to fill in for each
person in your list.
Flr.1t Nome
L...t Nome

Address
Gift
Adjective

Part or
House
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Data entru time
This is important: To fill in the fields of a database (like this one) , just type
normally. To advance from one field to the next - from First Name to Last
Name, for example - press the Tab key. Do not press the Return key, as every
instinct in your body will be screaming to do. You'll discover why in a
moment. (You can also move to a new field by clicking in it, but the Tab key
is quicker.)
So here goes:
1. Make sure that you can see a dotted-line rectangle for each field, like
the ones in the preceding figure; if not, press the Tab key.

The little blinking cursor should be in the First Name blank. ( If it's not,
click there.)
2. Type Josephine and then press the Tab key to jump to the Last Name
field.
Fir.it Name
La:ot Name

Posephlne

:r============~

Address

Gift

3. Type Flombebe and, again, press Tab.
(See the sidebar "Accent heaven" to find out how you make those cool
little accents.) Now you're in the Address blank.
4. Type 200 West 15th Street.
Ready to find out what the Return key does? Go ahead and press Return.
Notice that you don't advance to the next blank; instead, the program
thoughtfully makes this box bigger so that there's room for another line
of address.
fir.it Name
Last Name

Address

Girt

posephlne

Hoo west. 15th street

ewYor1<, NY 10010

Adjective
Part of

If you ever hit Return by mistake, intending to jump to the next blank
(but just making this blank bigger), press the Delete key.
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Accent heaven
Ah, mais oui, man ami. C'est vrai, c'est la vie,
c'est le resume.

ow

K~t•••

I

You COO l ype Umple leHI Up here, olOI

I know what you're thinking: What a smooth,
sophisticated guy to be able to speak French
like that! Thank you.
But you're also thinking: How did he get those
cool accent marks? Very easily- and you,
having been smart enough to choose an iBook
over all its inferior competitors, can do it, too.
The iBook has a ton of these special characters.
Look at your keyboard - I bet you don't see ©
or™, or•, or e, or any other useful symbols that
Mac people use all the time. That's because
they're hidden. The secret that unlocks them is
... the Option key.
It works like the Shift key: While pressing Option,
you type a key. Here are some popular ones:

So that's where all those little critters liveI
Anyway, there's one more wrinkle to all this. A
few symbols, called diacritical marks (that's not
a computer term; it's a proofreading one, I think)
can be placed over any letter. They include the
markings over this il, this e, this and so forth.
Because the iBook doesn't know ahead of time
which vowel you're going to type, creating these
marks is a two-step process:

e,

1. While pressing Option, type the key as
shown here:

To Get This. . . Press Option and Type This . . .

©

g

TM

2

c

To Get This . . . Press Option and Type This . . .

e
il

u

ii

n

4

£

3

•

8

®

t

t

What's nice to know is that you have a complete
built-in cheat sheet that shows these symbols'
locations on the keyboard. It's the Key Caps
desk accessory, which is in your S menu.
Open it up and take a look. Now try pressing the
Option key.

When you do this, nothing will happen. In
other words, no marking appears on the
screen - until you do Step 2.
2. Type the letter you wantto appear under the
diacritical marking.
Only now does the entire thing - letter and
marking - appear on the screen. So if you think
about it, typing the six-letter word resume
requires eight keystrokes. C'est formidable, fa/
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5. Go ahead and type New York, NY 10010 and then press Tab.
And don't worry that the second line of the address immediately gets
hidden. The information you typed is still there.
6. Type acrylic sofa cover (and press Tab); practical (and press Tab);
and living room (and stop).
You've just filled in the information for your first gift sender. So that this
won't take all day, let's pretend that it was what they call an intimate wedding, and you received gifts from only three people.
But let's see - we need a new set of fields, don't we? Come to think of it,
wouldn't life be sweeter if there were a computer term for "set of fields"? By
gumbo, there is! A set of fields is called a record.
I wouldn't bother with that term if it didn't crop up in the next instruction:
I. From the Edit menu, choose New Record.

A new record ("set of fields") appears, and you're ready to type the
second person's information.
2. Type anything you want, or copy the example below, but remember to
press Tab at the end of each piece of information.
(Oh, and if you want a second line for the address, press Return. Make
up a town and state; you're a creative soul.)
Fi~IName

:;;I
S,,.
uz=
le=========~

Gift

IKhlOu
~====;============~
11 Doormouse Ave.
IRarley

Adjective
Part of

l=
tga"ra
"=g=e=========~

L...t Name
Address

l==="=;=========~

~xpe nslYe

3. Choose New Record from the Edit menu again and type a third set of
information, perhaps typing Ming vase as the name of the gift.
Fabulous! You 're really cooking now.
4. As a final wise step, choose Save from the File menu and type Gift List
as the name of your database into the Save As text box.
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5. Click the Desktop button, and then the Save button to preserve your
database on the hard disk.
You've just created your first database. Having gone through the tedium of
typing in each little scrap of information the way the iBook wants it, you can
now perform some stunts with it that'd make your grandparents' jaws drop.
You can ask the iBook to show you only the names of your friends whose last
names begin with Z. Or only those who live in Texas. Or only those whose
gifts you've categorized as fabulous. See the sidebar "Finding and sorting in
AppleWorks databases" for details.

Formin9 the form letter
Next, you're going to write the thank-you note. At each place where you want
to use somebody's name (or other gift-related information), you'll ask
AppleWorks to slap in the appropriate info.
I. Choose New from the File menu.
Again, you're asked to choose the kind of document you want.
2. Double-click Word Processing.
You get a sparkling new sheet of electronic typing paper. You'll start the
letter with the address, of course. Yet the address will be different on
each letter! This is where mail-merging is handy.
3. From the File menu, choose Mail Merge.
When the little window appears, you'll see your database name, Gift List,
prominently displayed.
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Finding and sorting in AppleWorks databases
After you've got some data typed into an
AppleWorks database, you can manipulate it
in all kinds of fun and exciting ways. Choose
Find from the Layout menu to get what appears
to be a blank record. Type what you're looking
for into the appropriate blanks. For example, if
you're trying to find everybody who lives in zip
code 90210, you'd fill out the Find dialog box as
shown in the figure below. Then click the Find
button. After about one second, you'll be
returned to normal view, where you'll see the
results of your search.

This is important - Apple Works is hiding the
records that didn't match your search requirements. You haven't lost them; they're just out of
sight until you choose Show All Records from
the Organize menu. You can prove this to yourself by consulting the little book at the left side
of the screen. It will say "Records: 22 (194)."
That means that AppleWorks still knows there
are 194 addresses in your mailing list, but only
22 have zip code 90210 (and they're all attractive
teenage models on a major TV show).

Fir.st Name

~

Lui Name

po210

Addreos

Gill
R>qutSts:

Adi ectlv e

I

Part of

Find fr<>m
QY!oi>lo
@All

00m;1

4. Double-click Gift List to tell AppleWorks that it's the database you
want to work with.

Now a strange-looking window appears:

Ft•kl

•MM•

Addr•ss:
Gift
Adjootln
fP.iir-t of Haus• ..,.

I

lp1srt Figfjl . )

Ml'rg• O~bbu• :
Gift Lisi

0

Shov Field Data

I Syitch ptt~bass
I gr;tnt Msrgs...
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In the scrolling list you see the Field Names from your database. Here's
how it works.
5. Point to First Name and double-click.
See what happened? The program popped a placeholder for the First
Name right into your letter. When you print, instead of « First Name», it
will say Josephine.
6. Type a space; in the Mail Merge window, point to Last Name and
double-click; press Return to begin a new line of the address; then
point to the Mail Merge window again and double-click Address.

«First Name» «Last Name»

~::~t"~::· ~

«Address >j

~~rHS

tr J

Adj ~ctiv~

P Jirt of HOUR

I

!nsrrt.fjs!d.

11or. . o.t-.:
Gift lis t

CJ SMw Ft.W D•t•

C
...

I

l1Sxjt sb Databag

I

PrinSMt m

.

Before you continue typing, you may want to drag the little Mail Merge
window off to the right of your s creen as best you can. (To move the
window, drag its title bar.) You're going to want to see both it and your
typing simultaneously.
7. Press Return a couple of times and then type Dear, followed by a
space.
8. Point to the words First Name in the Mail Merge window, as you did a
moment ago; double-click; then type a comma.
Your letter should look something like this.

Dear «First Name»,

This is where it gets good.
9. Press Return a couple of times and then type I nearly cried when I
unwrapped the incredible, followed by a space.
10. Double-click the word Gift in the Mail Merge window.
11. Continue typing the following: you gave me for my wedding. It is far
and away the most (and now double-click Adjective in the Mail Merge
window) gift I will ever receive.
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«Fi"st Name» «Last Name»
r Adcress»
Dear«Fi"stName»,

I

nearly cried when I unv.rapped the incredible «Gitt» you gave me ror my wedding. l
1s far and away the most «Adjective» gilt I will ever receive.

1

Are you getting the hang of this? At each place where you want
AppleWorks to substitute a piece of information from your Gift List database, you insert a little « placeholder» .
To see the last field name, Part of House, you may need to use the Mail
Merge window's scroll bar. Then finish the letter as follows.
12. Type It will look sensational in the (double<lick Part of House in the
Mail Merge window) of our new home.
13. Press the Return key twice and finish up like this: I had to write this
personal note to you and you alone, so you'd know how much I
treasure your gift above all the others. Love, Marge

< irst Name» «Last Name»
<Address»

I nearly cried when I unwrapped the Incredible «Gilt» you gave me rormy wedding. t
is far and away the most «Adjective» gilt I will ever receive.
It will look sensational in the «Part or House» or our new hOme.
I had to ¥Ifie this personal note to you and you alone, so you'd know how much I
easure your gilt above all the others.
ove,Marge.

Miss Manners would go instantly bald in horror if she thought you were
about to send out a letter that says Dear First Name. But through the miracle
of computers, when these letters are printed, it'll be impossible to tell that
each one wasn't typed separately.
Save from the File menu. Type Thank-You Letter in the Save As text box and
click Save.
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Specifying your favorite type
Wherever the Intergalactic Committee for
Frequently Asked Questions keeps its master
list, I'll bet that the first item on the list is this: "I
hate having to set up my favorite type style and
size every time I open a new AppleWorks word
processing document. How do I specify my
favorite font once and for all?"
The answer is easy, although you'd never figure
it out on your own. From the File menu, choose
New; in the New Document dialog box, doubleclick Word Processing. Now, from the Format
menu, choose the font, size, and style you prefer.
(If you're into such advanced kinky stuff as

double spacing, margin adjustments, a logo in
your header, and so on, you can make these
changes now, too.)
Finally, from the File menu, choose Save As.
Click the Stationery button. Type this name
exactly- Apple Works WP Options - and
then click Save, and finally click OK.
From now on, every time you indicate that you'd
like to begin a new word -processing document,
your preferred font (and other formatting
choices) will be in place before you even type
a word.

The 9raphics zone: Desi9nin9 a letterhead
To show you how AppleWorks can tie everything togethe r, let's whip up a
quick letterhead in the Drawing module.
Choose New from the File menu. Our friend, the New Document dialog box,
appears. This time, double-click the word Drawing.
_ _ New Document .,,-

AppleWorks
A Word Processing
4J Drewing~
A Pointing
Iii Spreadsheet
~ D11tobose

e

Create New Documen t

O

Use Assis t ant or Stationery

~ Communications

AppleWorks shows you its drawing window. The grid of dotted lines is there to
give things a nice architectural look; it won't appear in the finis hed printout.
See the tool icons on the left side of your screen? They're pretty much covered in the section on drawing programs in the preceding chapter. Now then:
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I. Click the Text tool - it looks like a letter A - and release the mouse

button; then move your cursor onto the drawing area and drag across
the screen, as shown here.
2. Use the Font menu and choose Times; use the Size menu and choose
24 Point.
j Untitled 6 (DR)

: Then click about here. and dra9 to here. :

l Y

•\

100

3. Type three spaces and then a long dash (to make a long dash, hold
down the Shift and Option keys and type a hyphen); type A Very
Personal Note; type another long dash and then three more spaces.
4. Press the Enter key so that handles appear around your text; using the
Alignment submenu of the Format menu, choose Center.

- A Very Personal Note-

Finally, you'll add that elegant white-lettering-against-black look that
shows up on so many corporate annual reports. At the left side of your
screen, there's a set of odd-looking icons. Find the one immediately
below the tiny pouring paint can icon, as s hown by the arrow in this
illustration (left) .

~
,~,

•••D••••••
••••DOD
•••••
••o••••••
•lilo••••••
•111000111••c
CJt;;JOOODB•EI
DEDDDDDDD
DDDDDDCIDD
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This icon is actually a pop-out palette (right).
5. Click the paint-can icon but keep the mouse button pressed so that the
palette appears (preceding figure, right); drag carefully to the right
until the pointer is on the solid black square; release the mouse.
You've just used the Fill palette to color in the entire text block with
black. Which is just great, except that now the text is a solid black rectangle! To fix the problem, you need to make the text white.
6. From the Text Color submenu of the Format menu, choose White.

.·

-A Ver 7 Personal Note-

·.

Of course, while you're in the Drawing mode, you could actually do some
graphics ... you could use any of the other drawing tools to dress up your
logo. You could draw a box around this letterhead. You could rotate the
whole thing 90 degrees. You could make all kinds of insane diagonal stripes
across it. You could choose, from the File menu, Library - and select any of
the "libraries" full of ready-to-use graphics (flags, stars, flowers, and so on)
worthy of dragging into your drawing as an aid to the artistically challenged.
Keep those creative possibilities in mind when it comes time to design your
real letterhead.

The return of CoplJ. and Paste
All that remains is for you to slap this letterhead into your mail-merge letter:

I. Using the Arrow tool, click your letterhead; from the Edit menu,
choose Copy.
Now you need to return to your word-processing document. Here's a
quick way to pull it to the front.
2. From the Window menu, choose Thank-You Letter (WP).

(WP stands for Word Processing document; DB stands for Database; DR
stands for Drawing; PT stands for Painting; and SS stands for
Spreadsheet.)
Your letter springs to the fore.
3. From the Format menu, choose Insert Header.
(A header is an area at the top of every page, above whatever text you've
typed. In this case, it looks like an empty text area.)
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4. From the Edit menu, choose Paste.
Et voila ... your graphic pops neatly into the header.

You've actually done it: combined a database, a word processor, and a drawing program in a single project! For a real kick, click the Print Merge button.
It's on the little floating mail merge windowette that should still be on the
screen. Watch how the program automaticaJly replaces actual names for the
« placeholders» on the screen.
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AppleWorks: The Other Spreadsheet
When most people talk about spreadsheet programs, they usually refer to
Microsoft Excel, the $300 program that's universally adored by accountants
(especially those who work at Microsoft). Fortunately, AppleWorks comes
with a handy spreadsheet program that does most of what Excel can do,
requires much less learning, and doesn't add a nickel to the personal fortune
of Bill Gates.
A spreadsheet program is for doing math, tracking finances, figuring out which
of two mortgage plans is more favorable in the long run, charting the growth
of your basement gambling operation, and other number-crunchy stuff.

The not-so-9rand total
Suppose, for example, that you're still recovering from the wedding for which
you've just sent out handsome thank-you form letters. After enjoying a
delightful honeymoon in sunny Tampa, you return home to find a stack of
bills reaching to the moon and back six times: from the wedding caterer, from
the wedding band, from the wedding photographer, and so on. Before long,
the question that has occupied your attention for ten months now - "Is this
the person with whom I want to spend eternity?" - has been replaced by a
new one: "Is eternity long enough to pay off all these bills?"
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For control freaks only: The View buttons
Before you leave the drawing window, cast your
eyes upon the lower-left corner of the screen.
There you'll find this odd-looking array of
controls:

As you can tell, AppleWorks makes blowing up
your work extremely easy. (I mean magnifying
it; destroying it is up to you.) A quick click on
either of those little mountain buttons makes the
artwork smaller or larger. Or jump directly to a
more convenient degree of magnification by
using the percentage pop-up menu (where it
says 100 in the figure to the left). You're not
changing the actual printed size - only how it's
displayed on the screen.

Hide palette
Pop-up menu Split the screen

l

L100

t

L 1 _r

1~

ZooJin;~m out

As is so often the case in life, software can provide the answer. Start by
launching AppleWorks, as you did at the beginning of this chapter. If you see

the word AppleWorks in the upper-right corner of your screen, then you're
already running AppleWorks; in that case, choose New from the File menu.
Either way, the New Document dialog box now takes center stage on your
screen. This time, double-dick Spreadsheet.
A blank spreadsheet now appears on your screen. It's a bunch of rows and
columns, like a ledger book. The columns are lettered, and the rows are numbered. Each little rectangular cell is called, well, a cell. It's referred to by its
letter and number: Al , for example, exactly as in a game of Battleship. Here,
for example, is how you might calculate your potential for solvency after
paying for the wedding:
I. Click in cell A3. Type EXPENSES: and then press Return.

Notice that as you type, no letters actually appear in the cell. Instead, all
the action takes place in the strip above the top row. Only when you
press Return or Enter does your typing jump into place in the spreadsheet itself.
D
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You should now see that the next cell down, A4, shows a faint colored
border, indicating that your next typing will appear there.

2. Type each of the expenses shown in the illustration below (Caterer,
Photographer, and so on); after typing each, press the Return key to
jump down into the next cell. In the last cell, type TOTAL: and then
press Return.
B

3

OCPENSCS :

.,...
7

rlorist

9

.....
to htnttUll

II TOTAL ·

12

Having written down everyone to whom you owe money, you should be
feeling better already.
3. Click in cell 84, to the right of the Caterer item. Type dollar amounts

for each wedding-money recipient, as shown in the next illustration,
again pressing the Return key after each amount.
AppleWorks can do far more than just display bunch of numbers - it
can also add them up.
4. Carefully drag your cursor straight down the column of numbers,
beginning in cell 84 (where the first number appears) and ending in
the empty cell at the bottom of the column (to the right of the word
TOTAL:).
8
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3
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12

'"
You've just told AppleWorks which numbers you want added up. By
including a blank cell at the end of your drag, you also told AppleWorks
where you wanted the grand total to appear.

5. Click the I. button on the toolbar at the top of the screen, as highlighted here:
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.J File Edit Fo rmat Caltulote Options Window '(:. flelp

If you don't see the toolbar, choose Button Bar from the Window menu.
If you see a downward pointing black triangle at the left end of the tool-

bar but you can't find the L. button, click the black triangle, and then
click Default to make the correct toolbar reappear.
When you do finally click the I button, an amazing thing happens:
AppleWorks adds the correct total of the highlighted numbers in the
empty cell at the bottom of the column.
D
Bl I

11

TOTAL :

17018 .4 5

Even more amazing, this number is live - that is, it checks its own addition thousands of times per second. If you change one of the numbers in
the column, the total updates instantaneously. Try it yourself:
6. Click the cell that shows the Photographer fee. Type a different
number, and then press Return.

In the blink of an iBook, the Total cell changes to show the new sum.

The 9ood news
So you owe a few thousand dollars. But life does n't have to end. Surely you
have a few assets you could sell to cover the cost of your recent nuptial festivities. Let's see if you could get out of hock by selling, for example, your
wedding gifts.
I. Click in column D3. Type ASSETS and then press Return.

You're a bout to begin typing a new column of information.
2. Type acrylic sofa cover, and then press Return; Harley, and press
Return again; Ming vase, and Return. Fmally, type TOTAL:, and press
Return last time.
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You might have noticed that "acrylic sofa cover" is too long to fit in the
column without spilling over into the next cell. No problem - just make
the column wider. Do so by positioning your cursor carefully on the
dividing line between the D and E column headings - and dragging to
the right.
Now you need to specify the approximate value of each of your gifts.
3. Click the cell to the right of acrylic sofa cover. Type a dollar amount
for each item, remembering to press Return after each one. The result
should look like this:
A

• :r

f

4. Drag through the column of numbers you've just typed, taking care to
include one blank cell at the bottom of the column. Click the I button
on the toolbar.
As you could have predicted, AppleWorks adds up the newly typed numbers, showing your total assets at the moment. Once again, this total is
"live" and continually updated. If you change one of the numbers above
it, the total changes, too.

The fin al anallJ.sis
The automatic addition you've established is fine when you're stranded on a
desert island without a pocket calculator. True spreadsheet nerds, however,
don't content themselves with simple totals. In the real world, people use
spreadsheets to create totals of totals, like this:
I. In a blank cell beneath all the other numbers - cell Cl5, for

example - type GRAND TOTAL, and then press Tab.
The Ta b key works just like the Return key, except that it jumps to the
next cell to the right, instead of the next cell down.
The idea here is that you want AppleWorks to combine your two subtotals - to subtract the total amount you owe from the total value of your
assets - so that you can see whether or not you'll break even from this
wedding deal. To create this elaborate calculation, you'll build a formula,
which is basically an equation exactly like the ones you used to build in
junior high school. Formulas in a spreadsheet always began with an
equal sign.
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The bold accountant
Your spreadsheets aren't limited to the bland
and tiny typeface you've been looking at so far.
You're welcome to spice up your numbers by
formatting them with boldface, italic, different
sizes, colors, and so on.

AppleWorks add the dollar signs and decimal
points automatically to highlighted cells, too:
From the Format menu, choose Number, and
then double-click Currency. Of your toolbar is
visible, you can also apply all of these formatting options by clicking toolbar buttons or
pop-up menus.)

For example, in the wedding-cost example in
this chapter, you might decide to show the
grand total you owe in boldface red type. To do
that, click the cell where the total number
appears. Now use the commands in the Format
menu, such as Style (to apply boldface) or Text
Color (to apply red). You can also make

All the automatic-adding features still work, but
now whatever number appears in that total cell
will always be red and bold - a cheerful
reminder of just how desperate your financial
situation is.

2. Type an equal sign(=). Click the cell that represents your total assets
(cell E7 in the preceding illustration).
Up in the formula bar, AppleWorks automatically writes in the name of
the cell you clicked.
3. Type a minus sign or hyphen (-), and then click the total amount you
owe (cell Bl I in the preceding illustration). Fmally, press Return.
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AppleWorks subtracts the second cell from the first, displaying the
grand total. This time, you lucked out: selling your gifts will earn you
just enough money to cover the costs of the wedding - with enough left
over for a bottle of sunscreen.
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Amazingly enough, this grand total is also interactively linked to all the
other numbers in your spreadsheet. If you change the price of the Ming
vase, for example, both your assets total and your grand total cells
change automatically.
If you study this example, you'll see that the best way to build formulas in a

spreadsheet is say what you're doing out loud. "The number in this cell..."
(you click the cell where you want the grand total to appear) "equals" (type
an = symbol) "this number" (click the assets total) "minus" (type the - sign)
"this number" (click the debts total). Muttering softly to yourself as you work
may not be the best way to pass yourself off as a financial genius, but you will
get your formulas straight.

Other Cool Stuff AppleWorks Does
The little post-wedding mop-up example was only one example of AppleWorks'
power. It left plenty of features unexplored, however. For example ...

A little paint
If you've been following along, you haven't yet tried the Painting window. By

this time, I trust that you know how to get there: Choose New from the File
menu and then double-click the word Painting.
Suddenly, you're in a pixel-blitzing wonderland , where you can create all
kinds of "painted" artwork. This kind of artwork has pros and cons. The pro
is that you can change the color of every single dot on the screen (instead of
just making circles, lines, rectangles, and text, which is all that you can do in
the Drawing window). The con is that you can't move or resize something in
a painting after you've laid down the "paint" (which you can do in the
Drawing window).

A little slide show
One of the strangest and most delicious things people can do with an iBook is
make slide shows. These can be either self-running (a new "slide" every four
seconds, say) or controlled by you (a new s lide every time you click the
mouse button).
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Stationery; and double-click the Assistant called Presentation. Now
AppleWorks asks you a series of questions, such as what kind of message you
want to present, what style of slide background you want, and so on. When
you're finished answering, you've got a terrific-looking slide show on the
screen. Use the scroll bars to move among the slides, changing the (ahem)
dummy text on each slide to say what you want it to say.

Mailin9 labels
AppleWorks is great at mailing labels; the program even walks you through
the process. To get started, choose Frequently Asked Questions from the
Help menu. Click Continue; double-click the "How do I" item called "make
mailing labels?"

Other assistants
While we're on the topic of Assistants, remember that AppleWorks beats the
pants off most other programs when it comes to creating certificates, press
releases, address books, to-do lists, and so on. The key, after choosing New
from the File menu, is to select the Use Assistant or Stationery button, as
shown here:
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Experiment with the pop-up menu at the top of this screen; some of the most
useful ready-made documents (which they call stationery) are hiding in here.
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Faking Your Way Through the
Other Free Software
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Jn This Chapter
llli- Simulating mastery of Palm Desktop
llli- Pretending you know how to play Bugdom and Nanosaur
llli- Feigning wisdom with the World Book Encyclopedia CD-ROM
llli- Appearing to know what you're doing with the Internet Family Safety Kit

•••••••••••••••••••••••••••••••••••••••••••••••••

A

ppleWorks, the five-headed goddess of productivity described in the
previous chapter, may be the entree in the feast of free software that
came with your iBook. But the other programs on your hard drive aren't to
be sneezed at, either. If purchased separately, they would have cost you literally dozens of dollars. They include:
~

Palm Desktop - A calendar and address-book program

~

Nanosaur-A computer game of the you're-stranded-in-the-Jurassic-eratrying-to-outrun-dinosaurs variety.

~

Bugdom -Another computer game. Just in case the dinosaurs of
Nanosaur cowed you, this time you don't encounter anything bigger
than a bug. You're a noble pillbug-man on a quest to rout the evil Red
Ant empire, thus freeing the helpless ladybug hostages. (Politically correct? Forget it.)

~

World Book Encyclopedia - The electronic, CD-ROM version of the
famous 26-volume book set. Better than the printed version in some
ways - weighs a lot less, features occasional movies and sound clips,
and is free.

~

EdView Internet Safety Kit, Family Edition - A piece of software
designed to prevent your iBook from connecting to Web sites considered
inappropriate for impressionable minds.

As you may have noticed, none of these extra programs come with full

printed manuals. Let this chapter be your guide.
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Palm Desktop: Your Life Is Jn Its Hands
Don't worry the fact that your friends may say - "Oh my gosh, why are you
using that program? That's only for people with PalmPilots!"
Such comments arise because this same software, Palm Desktop, is also
included with the PalmPilot, a tiny, incredibly popular $200 or $300 handheld computer about the size of an audiocassette. (You can see a photo in
Chapter 19.) When you connect a PalmPilot to your iBook, all of your names,
addresses, calendar appointments, notes, and to-do lists are automatically
sucked into the handheld computer. You can then slip the PalmPilot into your
shirt pocket, sock, or undergarment, secure in the knowledge that your electronic little black book is with you at all times.
That convenient arrangement does not, however, mean that you must own a
PalmPilot to get mileage out of Palm Desktop. Far from it! Palm Desktop is a
perfectly good calendar/phone book program even if you never use a PalmPilot
your entire life. It can dial the phone automatically, create reminders that pop
up on the iBook screen at specified times, print mailing labels and portable
phone books, and save you a lot of time when it comes to typing in your
Rolodex.

lnstallin9 Palm Desktop
Palm Desktop is on your iBook hard drive, but the software hasn't yet been
installed; Apple figured that not everybody would want a calendar/phone
book program.
If you do, here's what to do: Open Macintosh HD, then the Applications

folder, then the Palm Desktop folder. Double-click the icon called Install Palm
Desktop. Click every Continue, Install, Agree, or Okie-Dokie button you see.
(When you're asked if you want to set up Palm Desktop to sync with a Palm
organizer, click Setup Later.) Finally, the iBook restarts, and you're in business.

The Calendar
When you first launch Palm Desktop, you're asked to register the software. If
you enjoy getting junk mail, click Next; if not, click Cancel, and then Never
Register.
Now you' re shown an empty daily calendar. Unless you are the proprietor of
a wedding hall, however, you may not necessarily Jive your life in one-day
chunks. Fortunately, the tabs on the right side of the screen (Daily, Weekly,
Monthly) let you see one day, one week, or one month at a time, respectively.
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Enterin9 appointments in WeekltJ, or Daill}, flieu/
If Palm Desktop were a traditional paper calendar, you'd write appointments

down on the little squares using, for example, a felt-tip pen. But writing on
your iBook screen in permanent ink has two disadvantages - first, appointments you record that way are extremely difficult to change; second, you
have to buy a new iBook every month.
Therefore, you jot down events in Weekly or Daily view like this:
1. Navigate to the day and time of your appointment.

To view a different week or day, click the arrow buttons in the upperright corner of the window. To see the time slots earlier or later in the
day, use the scroll bar at the right side.
2. Using your trackpad and clicker, drag vertically through the time slot
to be consumed by your appointment.
For example, to schedule a meeting from 1 P.M. to 3 P.M., click carefully
at the 1 P.M. slot - and then, without releasing the clicker, drag down
the trackpad to the 3 P.M. slot.
You've just created an empty rectangle.
3. Type a description for the appointment - for example, "Meet with
Janet about impending bankruptcy" - and then press the Return key.
That's all there is to it: you've just scheduled an appointment. If your schedule later changes - it's been known to happen - you can edit an
appointment in any of the following ways:
Y"

Delete an appointment by clicking once on its block, and then pressing
the Delete key on your keyboard.

Y"

Shift an appointment to another time on the same day by dragging the
block up or down. In Weekly view, you can also shift the appointment to
another day by dragging it sideways.

Y"

Adjust an appointment to make it longer or shorter by clicking the block
once to make the funny pointy handles appear at the top and bottom.
Then drag these funny pointy handles up or down to stretch the
appointment block.

Y"

Shift the appointment to a completely different time - for example, an
entirely different month - by double-clicking its block. A dialog box,
cleverly titled the Appointment dialog box, appears:
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You'll be seeing a lot of this dialog box, so make your peace with it early
on. Click the tiny icon to the right of the date (indicated by the cursor in
the picture above) to summon a miniature calendar, which you can use
to specify the new date for your a ppointment. (In this box, you can also
type in a different time.) Click OK to close this dialog box.

v

Edit the description for an appointment by clicking once on its block or by double-clicking the block to open the Appointment dialog box.

~

Schedule this appointment to repeat (for example, every week or every
month) using the Repeat Appointment checkbox. Set up your iBook to
remind you about this appointment using the Set Alarm checkbox.
Instructions for both of these techniques are in "Fancy Appointment
Tricks," later in this section.

Enterin9 appointments in Monthl1J. View
If you're used to working with paper calendars, you'll probably feel most

comfortable in Palm Desktop's Monthly view. (Click the Monthly tab at the
right side of the screen to see it.)
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The squares in the monthly calendar are too small to create new appointments by dragging, as you do in the Monthly or Daily views. Instead, create a
new appointment by double-clicking a calendar square. A funny little question box like this appears:

What do you want to create?

~
TMk

[;]

Appointment

Ill

(vent Benner

What the iBook is asking is: what kind of thing would you like to add to the
calendar square you just double-clicked? You can read about Tasks and
Banners in the next section; to add an Appointment (''8 P.M.: Final 'ER'
Episode" or "1:30 P.M.: United Flight #001 to Buffalo"), double-click the
Appointment button.
Now the Appointment dialog box appears, as shown three illustrations ago.
Type the name of your appointment, and then press Return (or click the OK
button) to close the window. Like magic, your new appointment appears on
the appropriate calendar square.
You can change such a Monthly-view appointment in all the usual ways:

v Delete an appointment by clicking once on its name, and then pressing
the Delete key on your keyboard.

v Shift an appointment to another date by dragging it onto the appropriate
calendar square.

v

Change the appointment's time by double-clicking its block. The
Appointment dialog box appears; type a different time into the starting
or ending time blocks, as you see fit.
(If you're trying to adjust the time while writing in the back of a bounc-

ing taxi with the iBook on your lap, forget a bout typing numbers - just
press the + and - keys to adjust the hour; add the Shift key to adjust the
minutes.) By clicking the tiny calendar button, you can also move this
appointment to a very distant date, such as one in a different month.

v

Edit the description for an appointment by double-clicking the block to
open the Appointment dialog box. Change the text in the top box.

Before leaving Monthly view, here's a tip about leaving Monthly view. If you
double-click the date number in the corner of a calendar square, you open
Daily view for that particular day. In other words, you can use Monthly view
to get an overview of your schedule, but then jump to a day's Daily view to
actually create an appointment (by dragging vertically through a time slot).
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Banners
Appointments - in the Palm Desktop sense of the word - are all well and
good. But at what time would you schedule, say, Enid's Birthday or
Venezuelan Muskrat Festival? Clearly, you'd feel foolish indicating a starting
and ending time for such events. Fortunately, Palm Desktop offers a special
kind of notation for these events, one that doesn't require a starting and
ending time: a banner. A banner appears on a calendar square, or across several calendar squares, as a colored horizontal strip.
In Monthly view, you create a banner by double-clicking a calendar square
and then choosing Banner from the "What do you want to create?" dialog
box. In Weekly or Daily view, you create a banner by double-clicking the date
header (shown here at left).
After

Before
0

_ Weekly Calendar- l

April 2000

0

Weel<IY Calent

Apr112000

No matter what view you're in, the Banner dialog box now appears, in which
you can type a description for this special day. Note, too, the "For_ days"
box - by typing a number into this box, you can make your banner stretch
across more than one day. People use banners, therefore, to indicate when
they're going to be away. For example, you could create a seven-day banner
that says "To Cleveland for International Ribs Cook-Off" or "Liposuction
recovery in Acapulco."
When you click OK, the banner appears as a strip across the appropriate
days (shown above at right).
You manipulate banners exactly the way you manipulate other kind of
appointments - you can delete one by clicking it and then pressing the
Delete key, reschedule one by dragging it, or change its name or date by
double-clicking it.

FanclJ. appointment tricks
Your deluxe fruit-flavored laptop wouldn't be fulfilling its Computercratic Oath
if it didn't exploit your electronic calendar by, for example, reminding you
when appointments come due. Fortunately, pop-up alarms are only one of the
ways Palm Desktop can harness the power of your computerized calendar.
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To set up Palm Desktop's three fancy appointment options, double-click an
appointment on your calendar. The Appointment dialog box appears, offering
these three features:

v

Repeat Appointment. When you turn on this checkbox, a new pop-up
menu magically appears, listing commands like Every Day and Every
Friday. Using this pop-up menu, you can make this particular appointment write itself into your calendar over and over again according to a
regular schedule - the perfect setup for appointments like iBook club
once a month, parole-officer visits every week, or trips to the laundry
once a year. (Click the tiny calendar next to the "Until" box to specify an
ending date for these repeating events.)

v

Set Alarm. When you turn on this checkbox, a new pop-up menu
appears. Using the pop-up menu and the blank next to it, you can indicate how much advance notice you want for this appointment - 5
minutes prior (perfect for reminders to watch a certain TV show), 2
hours prior (perfect for driving to the airport for a certain flight), or 3
days prior (perfect for shopping for an anniversary present for certain
someone). When the designated moment arrives, your iBook will beep,
and a message will appear on the screen, alerting you of the upcoming
appointment. (The message box even contains a Snooze button, for
your procrastination pleasure.)

Using this reminder feature, you can set up your iBook as an alarm clock
when you're traveling. You wouldn't be the first. (The iBook will beep
and show the reminder message even if it's asleep - not if it's shut
down, however.)

v

Categories. Using these pop-up menus, you can assign different calendar
appointments to certain categories, such as Personal, Business, or None of
Your Business. (To add a new category to this list, choose Edit Categories
from the Categories pop-up menu.) Later, when you become a big, experienced techno-geek, you can hide certain categories of appointments so
that every snooping coworker can't see what you've got planned.

The Contact List (Address Book)
As your popularity and circle of friends grow, you'll find it extremely easy to
type their names and addresses into Palm Desktop. The program uses several
tricks to make such data entry less time-consuming. (And if you already have
your phone book in some other computer program, for goodness' sake, don't
do any re-typing! Palm Desktop can import the entire list in one fell swoop.
For instructions, open the Help menu. Choose Search Index For, and search
for the topic called Importing.)

Gettin9 readlJ to t1Jpe in neul addresses
Before you begin typing, take the following detour to turn on Palm Desktop's
assorted time-saver features. Doing so will save you hours in the long run:
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1. From the Edit menu, choose Preferences. In the list of icons at the left
side of the new window, click Contacts.
This window appears:
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2. In the Default Area Code box, type your home area code.
If your local phone number area code is 212, for example, type that into

the box. In the future, whenever you type a new phone number into
Palm Desktop, you won't have to type the area code at all for people in
your own area code. If you type only seven digits for a phone number,
the program will automatically add your area code.
3. From the Phone pop-up menu, choose an automatic formatting pattern
for your phone numbers.
For example, if you choose"(###)###-####," then the program will automatically add parentheses, spaces, and dashes whenever you type a
telephone number. You type 3129394884, and you get (312) 939-4884.
4. Make sure the checkboxes for Auto-Capitalization and Autocompletion are turned on.
Auto-Capitalization means that you don't have to use the Shift key when
typing in your names and addresses - the program automatically capitalizes first names, last names, and the words in the mailing address.
Auto-completion means that, after you've already typed in a few names
and addresses, the program will start guessing the city names after you
type a couple of letters. If you type AL into the City blank, for example,
Palm Desktop might suggest Albuquerque. (If it guesses right, just press
the Tab key to jump into the next blank; you just saved a lot of typing. If
it's wrong, just keep typing; Palm Desktop's guess disappears.)
5. Click OK to close the Preferences dialog box.
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Printing your calendar
The Palm Desktop program is extremely flexible
when it comes to printing out your calendar. You
can specify how many miniature pages you
want printed on each sheet of actual paper;
whether you want single-sided or double-sided
pages; special formats for Franklin, DayRunner,
Day-Timer, and other commercial organizers;
whether you want daily, weekly, or monthly calendars; the typeface and size you prefer; and
much more.

Fortunately, patient, detailed instructions are
built right into Palm Desktop. To see them, from
the Help menu, choose Search Index For, and
then do a search for Printing. The resulting
instructions appear in your screen, complete
with illustrations.

T1J.pin<J in names and addresses
To create a new "index card" for your computerized phone book, click the
very first icon on the toolbar at the top of the screen. (Alternatively, you can
choose New Contact from the View menu.) The Contact dialog box, with
which you'll be getting extremely friendly before long, now appears:
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You're ready to begin typing in names and addresses. As you go, keep these
points in mind:
~

Press the Tab key with your left pinky to jump from blank to blank from
First Name to Last Name, for example). You can jump to a previous blank
by pressing Shift-Tab. That's much more efficient than using the trackpad
to click.

~

If you've taken the advice described in the previous section, remember
that you don't have to press the Shift key to get capital letters, and you
don't have to put parentheses and dashes into your phone numbers. As
soon as you press the Tab key to jump out of a blank, the program formats your typing automatically.
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v

When you're finished filling in one block of information, such as the
Phones section, press the Return key twice. Your cursor jumps all the
way down to the next block (such as the Primary Address block). So, for
example, when you want to record only somebody's name and telephone
number - not their title, company, division, and all that jazz - type the
first name, and then press Tab; type the last name; and then press the
Return key twice. You land in the Work Phone blank, ready to type the
phone number.

v

When you're finished recording somebody's information, click the first
icon on the toolbar again. You're presented with a new, empty phonebook card, ready to accept the next name. When you're finished typing
names and addresses, click the close box of the Contact window to make
it go away.

Lookin9 up a phone number
Palm Desktop shows your world of names and phone numbers in a tidy list.
To see it, choose Contact List from the View menu - or click the second icon
on the floating toolbar the top of the screen.
You can find somebody in this phone book extremely quickly: just type the
first couple letters of the person's las t name. Palm Desktop jumps exactly to
that spot in the list, highlighting the resulting name, like this:
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To edit this person's information, double-click his or her row in the list. The
familiar Contact window opens up, ready to accept your changes.
You can do a lot more in the contact list than just looking someone up, however. For example:

v

I

You can sort the list by name, city, company, or any other criterion. To
do so, just click the title (Company, City, or whatever) above that
column.
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v

You can adjust the widths of your columns by dragging the thin gray
dividing Jines between them.

v You can rearrange the columns of information - putting the phone
number before the address, for example - by double-clicking the gap
between column titles. The Column dialog box appears, in which you
can click to make checkmarks appear or disappear (which makes the
corresponding columns appear or disappear), or drag column names up
or down to change the order in which they appear.

The Task List
Palm Desktop can keep track of your to-do list at no extra charge. To open
your to-do list, click the fourth icon on the toolbar at the top of the screen or choose Task List from the View menu. Either way, a list like this appears:
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When you finish a task, click the checkbox - or just delete the item entirely
by clicking it once and then pressing the Delete key on your keyboard. You
can also manipulate the list of to-do items - sort it, change the column
arrangement, and so on - exactly as described in "Looking up a phone
number" in the previous section.
You can create a new to-do item in several ways:

v

I

From the View menu, choose New Task (or click the third icon on the
toolbar). This dialog box appears, in which you can type a name, category, reminder, repeat schedule, and other information for your task:
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You can also create to-do items when you're looking at your calendar,
which is frequently a handy feature. In Monthly view, just double-click
the calendar square that represents the deadline for your to-do item; in
the "What do you want to create?" dialog box, click Task; and then type
the description for your task.
In Weekly or Daily views, double-click in an empty spot at the bottom of
the window (where the other to-do items appear) to open the Task
dialog box.

The Note List
Thanks to its Notes feature, Palm Desktop can also accommodate driving
directions, grocery lists, song lyrics, Shakespearean insults copied from the
Web, and other random brainstorms.
You create a new empty note by clicking the seventh icon on the toolbar or by choosing New Note from the View menu. Give it a title, if you like, and
then press the Tab key until you're in the big empty part of the window.
After you've finished pasting or typing your note, click the close box in the
upper-left corner of the window. Now you're ready to open the master note:
click the sixth icon on the toolbar (or by choose Note List from the View
menu). As us ual with Palm Desktop lists, you can sort this one by clicking its
column titles, adjust the column widths, search for a memo by typing a few
letters of its name, and so on.

The Ma9ic of Instant Palm Desktop
Ever since you installed Palm Desktop, you may have wondered about the
tiny green icon at the upper-right corner of your screen. It may not have
occurred to you that this tiny icon belongs to Palm Desktop. In fact, this tiny
green thing is a quick-access menu that lets you look up phone numbers and
check your schedule without having to launch the Palm Desktop program.
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Checkin9 IJ.OUr schedule
After you've spent some time typing in your calendar and to-do list, for example, quit Palm Desktop - and then click the tiny green icon. There, in a
convenient list, is your entire schedule for the day, like this:
[

Frt~:ll9PM

•

llfillll tJ;!_Flnder

Switch to Palm• Desktop
HotSynce (None)

~

And ContactCreate

~

J

Events r. Appointments
12 PM Lunch at Chez Taco
7:30 PM O.nce Recital @>school gym
9".30 PM "lltanlc II" on Onemax

Tents
PalmCOurse
RedeemT•blll
~te Macwor1d a>
(Ont arts
Biiiy Budd W: (203) 331-7702
Sir 8111 Gates W: (206) 555-9872

Beneath the dividing line is your to-do list. Delightfully enough, this list is
always available, no matter what program you're using, no matter what else
you're doing on the iBook.

Findin9 and dialin9 a number
After you've put a few phone numbers into Palm Desktop, furthermore, an
even more delightful feature is available: the Find Contact command. When
you choose this command, type a few letters of somebody's name, and then
press the Return key, you're instantly shown a list of names that match what
you typed, like this:

Find Contact

I

Storts With u•t

I Add to Menu I

And now, the piece de resistance ( French for "piece of resistance"): Your
iBook can actually dial the number you've found. Just double-click the name
you want. In the next window, click the tiny telephone icon next to the
number. After confirming that you want to dial, Palm Desktop instantly produces the correct touch-tones through your iBook speaker. Just hold up your
telephone mouthpiece to the speaker, and presto: you're connected.
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Dialing through the modem
Note to the technical: Palm Desktop's automatic
dialing feature works even faster and more efficiently if you let the iBook dial through its
modem rather than its speaker. This delightful
arrangement requires, however, two preparatory steps.
First, you need to raid your local Radio Shack on
a quest for a line splitter, a cheap plastic box
that lets you keep your iBook and your telephone plugged into the same telephone wall
jack simultaneously. Second, launch Palm
Desktop. From the Edit menu, choose

Preferences, and click the Dialing icon of the left
side of the screen. Finally, from the Dial Through
pop-up menu, choose Modem Port. Click OK.
Now, when you wantto dial number, just pick up
the telephone handset as soon as you hear the
iBook finish its dialing. You'll be connected to
the number the computer dialed, exactly as
though you had dialed the number yourself except that your index finger, of course, has
been free to continue stroking the cat the whole
time.

Nanosaur
The next iBook software masterpiece is called Nanosaur. This stunning, 3-D
dinosaur shoot-' em up is all about noise, violence, and wiping out endangered species. Kids adore it.
Don't be alarmed when you can't find Nanosaur in the Applications folder
with all your other software. Turns out you have to install it yourself. It's on
the iBook lnstaJI CD, in a folder called Applications, in a folder called
Nanosaur. Run the Nanosaur installer you'll find within; drag the little
Dinosaur head onto your Macintosh HD icon. When the installation is over,
you'll find a Nanosaur folder on your hard drive. Double-click the Nanosaur
icon inside that to play the game, if you're not already worn out for the day.
Just press the arrow keys to move your little dino around, and press the
space bar to fire little dino-bullets. (I'm resisting a pun about dino-might
here.) Check out the help screen (which appears just after you launch the
program) to view the complete keystroke list. You can turn off the sound (or
press the + and - keys to adjust the volume) - an excellent idea if you intend
to play Nanosaur while in church.

You can just hear Bugdom's programmers trying to describe this action game
to the committee at Apple Computer: "Well, picture this: it's 'A Bug's Life'
meets 'Rocky Ill' ... "
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Sure enough, once you launch the game (in your Applications folder), you'll
recognize the colorful, 3-D, gigantic backyard setting of l 998's popular animated bug movies. You're a cute, cartoony bug in a world of other cute,
cartoony bugs - except that these bugs are violent and ruthless. The bug
world has been overrun with evil red ants who've locked all the ladybugs in
cages, and who now seek to beat you senseless with lethal blades of grass.
Fortunately, having read the Bugdom Instructions file that comes in the
Bugdom folder, you know that you're not completely helpless. You move
through ten levels of the gamescape, encountering increasingly interesting
bug species and situations, kicking red ants and rescuing ladybugs as you go,
using these controls:

This control

Does this

Shift key

Makes you move forward.

Trackpad

Turns you (drag your finger left or right).

Space bar

Changes you from a standard, walking pillbug into a balled-up
pillbug (hence your name, which is Rollie).

Clicker

Makes you kick. (If you're rolled up into a ball, makes you roll
into something instead.)

Option

Same thing as clicking.

Tab key

Every now and then, you'll discover that some loyal little winged
bug is hovering above you wherever you go. It's a Buddy Bug think of it as an airborne pit bull that you can sic on an enemy
bug by pressing the Tab key.

Other than the increasingly oppressed Red Ant minority group, what, exactly,
are you supposed to kick or roll into (by clicking the clicker or pressing the
Option key)? First, you kick walnuts: When you find one in your path, crack it
open. Inside is some kind of clover or other magical amulet that improves
your little pillbug's health or weaponry. (After cracking the nut open, move
forward to "collect" the treasure inside.) Second, you kick cages: When you
spot a ladybug, kick or roll into her cage to shatter it, thus freeing the damselbug in distress.
As rescue plots go, high-tech it ain't. But what do you expect? You're a pillbug.
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World Book Enc1Jclopedia
When I was a kid, my parents forked over big dollars every few years for a
bookshelf full of blue, hardbound books: the World Book Encyclopedia. These
books were great for homework-writing, debate-settling, and curiosityslaking. They had only two drawbacks: first, they got out of date quickly;
second, we got in trouble when we drew in them.
Your iBook comes with a much, much better version of the World Book - an
electronic version that comes on a CD. It's better because it's in color, it's
modern, it's got sounds and movies, you can search it electronically, and the
articles are beautifully written. And you won't get in trouble for marking it
up - in fact, the program includes electronic sticky notes and yellow highlighting pen just for that purpose.

lnstallin9 the World Book pro9ram
Begin your World Book exploration by inserting the Disc 1 CD into your
CD-ROM drive. When the WB Dis k 1 window appears on the screen, doubleclick World Book Installer. On successive screens, click Continue, then Agree.
Now type in the serial number from the back of the CD envelope; use all capital letters and no spaces. Click OK. In the next window, click Install; finally,
click the Desktop button and then Install.
When it's all over, you'll find a new folder on your desktop called World Book.
Inside is the actual World Book program; double-click its icon when you want
to look something up.
Note, by the way, that the World Book disc must actually be in the iBook if
you hope to look up any actual articles.

lookin9 up a topic
As you'll soon discover, the World Book program lets you look up information
in a million different ways. On the main screen, for example, you'll find two
columns of buttons: Browse, which offers various ways to sample the articles, pictures, sounds, and movies on the CD-ROM, and Search, which lets
you type in a topic you're looking for.
If you're used to using a traditional encyclopedia, you flip through the alpha-

betical listings of the CD version like this:
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1. Click the World Book button (in the Browse column).
You're shown a little doodad (shown in the upcoming picture).
2. To jump to a topic, type the first few letters of its name into the white
blank.
For example, type ROD to see if there's an article on Rodents.
3. To scroll through the list of every topic in the World Book, click the
pop-up triangle at the right side of the empty white blank.
A little popup list appears:

AARDYOl.F is Mi
WIUSUtl t)lfH' of hyfllt that
Hnsonthotp1'ins:of
s.outhtrn ~ U $ ttrn

Scroll through it using the scroll bar, if you like.
4. When you see an article you'd like to read, click its name once.
A little poster version of that article appears, revealing the first part of
the entry (such as "Aardwolf," as shown in the preceding picture).
5. Click the little poster to read the article.
In some articles, by the way, you'll get lucky: the Article Media icon (to the
left of the text) is joined by a down-pointing arrow. That's your cue to click
the Article Media icon - a movie, picture, sound, or map lies in store.
Some of them are really neat. Look up Colosseum, for example; when you
open the accompanying photograph, you'll find that you can actually change
the camera angle by dragging your cursor up, down, left, or right inside the
photo. You Are There, baby!

Usin9 the toolbar
You may wonder about the row of icons at the top of the screen. Point to an
icon without clicking to read the button's name. Among the most useful are:
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v

Dictionary: Use this to look up a word's definition. Yes, another valuable
hardback reference book - yours free!

v

Home: You return to the startup screen, complete with the Browse and
Search buttons.

v

Around the World: Click to make a world map appear. By clicking
repeatedly, you can enlarge the map until it shows you only a single
country.

v

Time Frame: Use this very cool feature to serve up details of a particu-

lar year, decade, century, or millennium of history.

v

What's Online: Pity the poor saps who spend $500 every few years for a

new printed World Book set! You, on the other hand, can just click this
icon, and then Update Now, to retrieve updated and additional articles
for free from the Internet! The new stuff is automatically incorporated
into your existing software. In other words, your copy of the World Book
CD will never go out of date, and you'll never have to buy another edition.
Not much of a business model, but it sure is convenient.

Gettin9 more help
You can learn more a bout the World Book by reading the "World Book-Mac
Users Guide" document on the CD, or by choosing Help Topics from your
Help menu. In essence, though, you won't find the World Book difficult to
figure out. As I always tell my kids: click long enough, and everything good in
life will come to you.

Edf/ieuJ Internet SafetlJ. Kit,
FamillJ. Edition
In addition to news, sports, jokes, and the Denny's Restaurant Home Page,
the Internet also depicts the belly-button lint of the human condition: violence, sex, and other stuff you might not want your eight-year-old reading.
The EdView Safety Kit is designed to shield your students, kids, employees,
or spouse from such unsavory Internet material. It offers a list of wellorganized, certified-safe Web sites - and prevents your iBook from
connecting to any Web page not on the list.
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lnstallin9 the SafetlJ. Kit
Insert the iBook Install CD-ROM. In the Internet folder is the EdView folder,
and inside that is an Install EdView Family icon. Double-click it; then, in successive windows, click Continue, Agree, Install, Continue, and finally Restart.
Your iBook turns off, and then on again.
During the installation, you'll be asked to make up a password. (I'm assuming
that you, dear reader, are the Person In Control. If you, dear reader, are
instead the Young Person Who Shouldn't Be Exposed to Internet Naughtiness,
please take this opportunity to assist your parent or teacher in setting up a
password. Then close your eyes while reading the following pages.)
When it comes to, you'll see a tiny red EV icon at the top right of your screen,
like this:

6:45 PM

HI

~j ~ Finder

J

We'll get to that icon shortly. In the meantime, there's one more step to
sanitizing the Internet for your protection. From the ti menu, slide down to
Control Panels, and then out onto Internet. When the Internet control panel
opens, click the Web tab. In the Home Page blank, type http://home.
edview.com, exactly. Close the window; save changes when you're asked.

Usin9 the SafetlJ. Kit
You're ready to roll. Launch your Web browser (Internet Explorer or
Netscape Navigator). The first thing you'll notice is that you're taken automatically to EdView's Web page, which is nothing more than a list of
approved Web sites, organized by category:
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To look up, say, Web sites about basketball, you'd start by indicating (using
the three buttons above the list) an age range: Elementary, Middle, or High
School. Then, on successive screens, you'd click Sports Central, Basketball,
and finally the name of the Web site that interests you.
So what happens if you try to visit a Web site that's not on EdView's evergrowing list of safe sites? Boom! -you get a screen that says:

Sorry, the rcquL'skd site
is

Ill )t

in thL'

EdViL'w Sm,wt

Zl)f1l'

+

Your only alternative is to mutter, "Drats! Foiled again!" - and click the
underlined words "EdView Smart Zone" to return to the list of OK'ed Web
pages.

B1J.passin9 the SafetlJ. Kit
The Safety Kit is clearly doing its job. But what about you, the Person In
Control? What if you want to visit a Web page not on EdView's list - such as
your own page? Even if there's not a breath of smut or ugliness on such
pages, they probably aren't on the Master List.
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In such cases, you have two alternatives. You can turn off the Web-page
blocking for your Internet session - from the EV menu at the top of the
screen, choose Disable Channel Lock, confirm your maturity by typing the
password, and click OK. Now you can use your browser as usual, without limitation. (Remember to choose Enable Channel Lock from that EV menu when
you're finished.)
You can also inform your software that a particular Web page is okay for your
kids to visit. Doing so involves a number of geeky steps, but it'll build
character:
1. From the EV menu, choose Edit Preferences. Type your password and
then click OK.
2. Click the Sites tab. Click the blue underlined "Go To NSLookUp"
button.

Your iBook goes online now, if it wasn't already. You're taken to a special
Web site, where you're supposed to type in the address of the Web page
you want to permit.
3. In the blank, type the Web address and then click "Get IP Address."

After a moment, you'll be shown a small blob of text like this:

Se:r"ttr :
l,da~..; :

M . IPJ . CC..
1~.215.:4..l

i..~ ~ou t hO "l

tut\ve <J'lS<ler :

~:
ctov1~.CU9
A".kJ1·its~ :
165 . 254 . l.SB . 39
/..lta':"el : ww . dovtq>ogue:.c~

The second Address number (underneath the Name line), shown in
black type in the picture above, is a number you're about to require.
Write it down.
4. Click Add. Type the string of numbers and periods into the IP Address
blank. Type the Web site address (www._.com) into the lower
blank. Click OK; click OK.

That's all there is to it: you'll now be allowed to visit the Web site you've
specified.

E-mail, America Online,
anti other blockades
The Safety Kit not only blocks out unsavory Web sites - it also prevents
your iBook from getting any e-mail and doesn't let you get onto America
Online!
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If you decide to permit access to these Internet features, you'll have to tiptoe

through some technical tulips, like this:
1. From the EV menu, choose Edit Preferences. When asked, type the

password and click OK.

The Preferences dialog box appears.
2. Click the Sites tab.

You're shown a strange-looking list of Ports. Each one represents a particular Internet feature that can be blocked by the Safety Kit.
3. Turn on the Port options for the Internet features you want.

For example, turn on the Port 25 checkbox to permit your iBook to send
e-mail; turn on Ports 109, 110, 143, and 220 to receive e-mail; and turn
on Port 5190 to permit access to America Online (and its chat rooms,
by the way).
4. Click OK.

Your preferences are now in place. The Internet is once again safe for children, students, and small furry animals.

Chapter 11

Living on DC
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
..,_ Maximizing your iBook battery life
..,_ What happens when the battery dies
..,_ How to change the battery
..,_ How to preserve what's in memory even when you shut down the computer

•••••••••••••••••••••••••••••••••••••••••••••••••

L

et's face it: Many of the chapters in this book would be equally useful to
people with desktop computers. When you're running AppleWorks or
Palm Desktop, for example, you press the same keys and click in the same
places as you would if you weren't using a laptop.
Sooner or later, however, you'll sit up, look around, and hear your flight
announced. Suddenly, you'll remember that you've been doing all your work
on 6.6-pound portable; that you're about to get on an airplane; and that at
some point in the next few hours, the iBook will run out of battery juice. This
chapter's purpose is to help you understand where the iBook's power comes
from - and where it goes.

Meet Mr. BatterlJ
~~S-ON

(ID

Here's an educational little field trip for you: Plug in the iBook's power cord.
Close the iBook. Now turn the machine upside-down. Underneath, you'll see
two very large, shiny silver screws. The plastic panel that they hold in place
is the cover for the iBook's battery compartment. You can use a nickel, butter
knife, or other blunt instrument to turn these screws one-quarter turn to
loosen them. Remove and set aside the battery-compartment door.
See the long, shiny, rounded, Star Wars prop inside? That's the battery. Take
it out (use the little plastic tab as a grip strip) and fondle it. Duracell it
ain't-what would you call this size, EE? - but this battery is among the
most advanced in the world. It's a lithium-ion battery, which must mean that
it's made of lithium ions.
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Char9in9 the batterlJ
The iBook doesn't need a battery charger. Whenever the laptop is plugged into
the wall (via the power cord), the battery is charging. Examine the connector
where the power cord plugs into the laptop: It lights up when the laptop is
plugged in and receiving power. The connector glows orange when the battery is charging, and green when the battery is fully charged. (A lightning-bolt
icon appears at the top or the screen when the charging is going on, too. The
lightning disappears when the battery is full, or when you're running on battery power.)
When the laptop is asleep or shut down, its battery charges completely in
about two hours. You can also recharge the battery while you're actually
using the iBook, but the charging takes twice as long.
If you're in charge of a whole gaggle of iBooks - if you're a teacher, a corpo-

rate technology person, or an especially prolific parent - it may interest you
to know that you can buy a mass charger, such as the one sold by VST
Technologies (www.vsttech.com). Do you see the small, circular, metal contacts on the bottom of the iBook? They snap onto such a charger, making it
easy to recharge a lot of iBooks in a hurry without having to fool around with
power cords.
The iBook battery doesn't suffer from the "memory effect," the unfortunate
battery tic that's loathed by camcorder nuts. (When you repeatedly charge
some camcorder or laptop batteries before they're completely empty, you
convince the battery that its halfway point is actually its empty point. From
that moment on, a battery charge lasts only half as long.)
The iBook battery does, however, have a limited lifespan - about 500 chargings. After that point, you'll begin to notice that a battery charge doesn't last
very long, and you'll have to buy a new battery. (You're supposed to return
the old battery to an Apple dealer - throwing away laptop batteries can
introduce incredibly toxic chemicals into your friendly neighborhood landfill.) Therefore, it's a good idea to use the iBook's power cord whenever
possible. Run the laptop on battery power only when necessary if you want
to postpone the purchase of a new battery for as many years as possible.

What happens when the batterlJ runs drlJ
About 15 minutes before the battery is completely empty, the iBook beeps
and shows you a warning message. It says that you're running on "reserve
power," and that your work session will soon be coming to an end. You
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should start thinking about saving your work, using the Save command in the
File menu, and hunting for either a power outlet (if you're on the ground) or a
magazine (if you're on the plane).
A few minutes later, you get one final message: "No reserve battery power
remains. Your computer will go to sleep in ten seconds to preserve the contents of memory." Sure enough, your screen now goes black, and the iBook is
silent, sleeping, and mysterious.
This sudden coma is nothing to fear, however. Everything you're working on
is perfectly safe, even if you didn't have a chance to save your work. The battery may not have enough juice left to light up the screen, but it has enough
juice to keep the machine's memory alive for two more weeks. (Even longer,
if you use the trick described later in this chapter under "Preserving what's
in memory.") That's how long you have to find a power outlet. The iBook can
run just fine with a dead or even missing battery, as long as it's plugged in.
And if you're traveling someplace so remote that the nearest power outlet is
more than two weeks away, you have bigger worries than waking up your
laptop.

How to saf/e batter11. power
As you may have already discovered, real people using real iBooks don't
actually get six hours of battery life per charge, as advertised by Apple. You
can get close, however, if you follow these suggestions:
""" Turn down the screen brightness. The screen consumes half of the
iBook's power. Therefore, the dimmer you set it, the longer a battery
charge lasts.
To make the screen dimmer, hold down the Fl key. To make it brighter,
press F2.
""" Put the laptop to sleep whenever you're not using it. That doesn't mean
that you should close the lid every time the phone rings. But if, upon
answering the phone, the first thing you hear is: "Hi, it's me. We have to
talk," close the iBook. You're going to be occupied for some time.
""" In the interest of saving battery power, you can set the iBook to shut
down various parts of its body after it notices that you're not there anymore. For example, when the machine notices that you haven't done any
typing or trackpad-tapping for ten minutes, the screen goes dark; if you
still haven't used the laptop ten minutes later, the hard drive inside
stops spinning; and if the iBook still hasn't heard from you five minutes
later, the whole machine goes to sleep.
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To make these adjustments, from the S menu, choose Control Panels.
Open the control panel called Energy Saver, which looks like this:

Energy Sover _
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By turning on the checkboxes and dragging the sliders, you can specify
when you want each of those three power-hungry components to go to
sleep - the screen, the hard drive, and the entire computer. (Actually,
the factory settings are just fine; what most people do with the Energy
Saver control panel is to make the machine take longer before it goes to
sleep, having found that the thing goes to sleep too often in everyday
use.)

v

If your iBook has an AirPort card (see Chapter 15), you get a tiny bit

more life out of each battery charge by turning off the antenna when
you're not using the wireless-network feature. To do so, click the tiny
gray Control Strip tab that peeks out from the left edge of your screen,
as described in Chapter 13. Each little tile on this strip is actually a popup menu.
To turn off the AirPort card and antenna, click the AirPort tile (the one
showing the five signal-strength dots), and choose Turn Off AirPort from
the pop-up menu.

v You can squeeze out a few more minutes of battery juice per charge by
slowing your computer down. (You won't notice the slowdown if you're
just reading or typing.) To do so, choose Control Panels from the Apple
menu; open the control panel called Energy Saver; click the Advanced
button; and turn on the option called Allow Processor Cycling.
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I

Remember to turn this option off, however, when your plane lands and
you're once again plugged into the wall. No point in s lowing down your
ultrafast machine unnecessarily.

Chan9in9 batteries
You can certainly turn down your screen, adjust your power-saving settings,
and otherwise tie yourself into knots trying to save battery juice. After a certain point, however, it may dawn on you that there's a simpler way to get
from New York to London without running out of iBook power: Buy a second
battery. They cost about $130, and are available from the kinds of mail-order
outfits listed in Appendix A.
To change the battery, make sure the laptop is plugged in. (If that's not possible, shut it down completely by pressing the On/Off button and then clicking
Shut Down.) Use a coin to turn the big thumbscrews on the bottom of the
iBook one-quarter turn. Take off the compartment cover, put the new battery
in, replace the cover, and re-screw the screws. Assuming you remembered to
charge the second battery before leaving home, you're good to go.

Eflerl)thin9 You Efler Wanted
to Know about Sleep
The iBook's s leep feature is so delicious and so useful that I described it in
the very first chapter of this book. The scheme is simple:
~

To put the machine to s leep (thus saving battery power), close the lid.

~

To wake the machine up, open the lid.

~

For the happiest life, never shut the iBook down unless you plan to store
it for more than two weeks without being plugged in. Instead, whenever
you're not using it, just close the lid to make the machine sleep.

Since you've read this far, however, I think you're ready for this news flash:
There's actually more to learn about the sleep feature. For example:

Turnin9 off the auto-wakeup feature
Most iBook fans like the way the machine wakes up whenever they open the lid. After all, opening the lid usually means that you intend to use the computer - and therefore, the auto-wakeup feature saves you a step.
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without waking it up. Suppose, for example, that you keep yellow sticky notes,
bearing important phone numbers, stuck to the edges of the screen. Or
maybe you're a plastics sales rep who frequently wants to show off the
iBook's fruit-flavored, transparent casing but doesn't actually need to use the
computer. (Okay, I'm reaching here. Gimme a break.)
If you're in one of those situations, turn off the auto-wakeup feature like this:

I. From the Apple menu, choose Control Panels. Open the control panel

called Energy Saver.
2. Click the Advanced button.
You see a screen like this:
0

Energy Saver

rml Sleep

~Setup

[J'.0

I

Schedule

rr:7l Advanced
~ Setti ng!

Settings for: [ Power Adapter

~I

Sleep Options

0

Preoerv• memory cont•nt' on sleep

Woke Options

0

Wa~e ..,hen the modem detectu ring

I !if Woke ..,hen the computer Is opened.

_J

3. Click to turn off the option called "Wake when the computer is
opened." Close the window.
From now on, just opening the iBook doesn't wake it up. To wake the computer up, you must press one of the keys on the keyboard. (Closing the iBook
still puts it to sleep, however.)

1

Preserflin9 what s in memorlJ
Under normal circumstances, when you close the iBook's lid, whatever you
were working on remains on the screen, frozen in a state of suspended animation. Even if you had written 50 pages in AppleWorks without saving your
file - ordinarily a risky proposition - when you next wake up the laptop,
you'll find your document on the screen exactly as you left it. As long as the

- - - - - - - - - - - - - - - - - - C h a p t er 11: Living on DC
iBook has power, whatever programs you were using remain open, and your
work in progress is kept alive. Technically speaking, a sleeping iBook preserves what is in memory. (See Chapter 1 ~ for a refresher if you need
refreshing.)
If the iBook is completely deprived of power, however - if the battery gets

removed when the power cord isn't attached, or the laptop sits for two
months in your closet - the story doesn't end as happily. The next time you
turn on the machine, you'll have to sit through the very long startup process,
only to find, when the computer is fully on, that the work you were in the
middle of is gone forever. Without power, a laptop can't preserve the contents of memory.

Or can it?
Your iBook offers a safety net to prevent the disappearance of what's in
memory in the event of a complete power loss. Technically speaking, the
iBook can copy what's in memory- at the instant you put the machine to
sleep - into a big invisible file on your hard drive. And as you know from
Chapter 1 ~. what's on the hard drive is safely safe even if the computer is
deprived of electricity.
To turn on this feature, follow these steps:
I. From the Apple menu, choose Control Panels. Open the control panel

called Energy Saver. Click the Advanced button.
You see the options shown in the previous illustration.
2. Turn on the option called "Save memory to disk before sleeping."
Close the window.
From now on, your iBook takes longer to blink into sleep; Apple even recommends that you not move the machine for 20 seconds after closing the lid.
But you'll feel good, knowing that you've established a safety net that will
preserve your work in progress, even if you haven't saved it, and even if you
lose both your power cord and your battery.
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Chapter 12

System Folder: Trash
Barge of the iBook
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
..,_ What the System Folder is for
..,_ All the stuff in your Apple menu
..,_ All the stuff in your Control Panels folder
..,_ What junk you can throw out of your System Folder

•••••••••••••••••••••••••••••••••••••••••••••••••

~ere it sits. Only one folder on your hard drive looks like it -

or acts like

f ;t. It's the System Folder, which holds software that the iBook needs for

itself. Every Mac has a System Folder. (Correction: Every functioning Mac has
one.) Yours probably looks like any other folder, except that it's called
System Folder and its icon has a tiny, special logo in the middle:

~

System Folder

Do it right now: Double-click your System Folder to open it. (Your System
Folder is in your main hard-drive window.) Now click the zoom box, the tiny
square in the inner top-right corner of the System Folder window, so you can
see as much of the System Folder contents as possible. As a matter of fact,
move your mouse up to the View menu and choose "as List." That should put
everything into a neat list.
Just look at all that junk! You sure as heck didn't put it there -what's it
doing there?
Who else would be utterly mad enough to say the following in public? Half the
stuff in your System Folder is worthless. It's designed for power users, or people
in big corporate networks, or superweenie jet-propulsion scientists and their
Mensa-qualifying 8-year-old offspring. Meanwhile, these files are taking up
room on your hard drive.
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The Sv.stem Folder Trashfest
Here's a wonderful, worth-the-price-of-the-book-right-there list of everything
in your typical System Folder, item by item. I'll tell you which of these things
you can safely trash or turn off.
Don't have a cow about eliminating stuff, either. The fewer items you have in
your Control Panels and Extensions folders, the quicker your iBook starts
up - and the less likely your machine is to crash. Besides, this is not like
cleaning your attic, where if you toss that box of your drawings from elementary school, you've wounded your inner child forever. No, this stuff you can
always get back again if you need it. It's all on the Software Install CD-ROM
that came with your iBook.
As a bonus, as you go along, I'll try to point out some handy little treasures
you didn't know you had. (Jeez, this is getting to be more like an atticcleaning with every passing moment.)

Appearance, Application Support
The Appearance folder contains pictures you can use to decorate your desktop; Application Support is for your software's use only. It's where your
favorite programs stash their own internal data files.

The Apple Menu Items folder
You'll recall that anything in this folder also appears in the ti menu at the left
side of your screen.
(If you have Mac OS 9, by the way, many of the items described here are not,
in fact, in the ti menu. Instead, they now come in one of two folders on your
hard drive: the Applications folder or the Apple Extras folder. If you sort of
miss seeing them in your ti menu, you can always move them there - see
the instructions for adding things to your ti menu in Chapter 13.)
Most of the Apple menu items are also desk accessories like the ones you
worked with in Chapter 3. So now you'll get to find out what exactly those
things in your ti menu are ... acquire a deep and abiding appreciation of
their importance and value .. . and then throw them away.
Apple System Profiler - A neat little program that gives all kinds of mindnumbing technical details about your iBook. You'll probably never use it. But
someday, when you're calling Apple in a desperate froth about some problem
you're having, they may well ask you to consult the System Profiler to answer
a couple of questions.
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AppleCD Audio Player - It has Play, Stop, and Rewind controls for playing
regular music compact discs in your CD-ROM drive; see Chapter 20 for
instructions. (If you have Mac OS 9, your copy of this is in the Applications
folder on your hard drive.)
Automated Tasks - Automated Tasks isn't a program at all. It's merely an
alias, dropped by Apple into your S menu for convenience. It lists several
handy AppleScripts - mini-programs, each of which performs one simple
timesaving step when opened. For example, Add Alias to Apple Menu puts an
alias of a selected icon into your S menu. Most of the others, such as Share a
Folder and Start File Sharing, have to do with networking. (If you have Mac
OS 9, your copy of this is in the Apple Extras folder on your hard drive, in the
AppleScript folder.)
Calculator and Note Pad - You already know about these desk accessories
(see Chapter 3). Leave them for now. (The Mac OS 9 copy of the Note Pad is
in the Apple Extras folder of your hard drive.)
Chooser - You need this if you have a printer, as you can find out in Chapter 5.
Control Panels- This folder is simply a shortcut (an alias) to opening your
real Control Panels folder. More on control panels later in this chapter.
Favorites - This command gives you quick access to files or folders you use
a lot. See "More special folders," later in this chapter.
FaxStatus - Here's a little program that lets you monitor the status of faxes
you're sending or receiving, as described in Chapter 20.
Graphing Calculator - Puts fancy moving 3-D graphs on your screen, so you
can show your friends how high-tech and brilliant you've become. And if
you're into math, it's actually pretty darned good at graphing little equations
like y = x - 1. (Moved to a new address in Mac OS 9 - it's in your
Applications folder.)
Internet Access - This set of handy Net-related commands includes:
i.""

Browse the Internet - This command launches your Web browser,
such as Netscape Navigator or Internet Explorer. And it opens to your
preferred home page. (You use the Internet control panel to choose
both which browser you prefer and which home page you like, as
described later in this chapter.)

i.""

Connect To - This tiny program-ette brings up a simple dialog box into
which you can type an Internet or Web address. When you click Connect,
your iBook dials and connects to that address, launching your e-mail
program or Web browser. (See Chapter 6 for more on Internet connections.
This little program is for people who have direct Internet accounts, not
America Online.).
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v

Internet Setup Assistant - Walk through this series of screens while your
Internet access company's tech-help agent is on the phone with you, and
you'll save yourself a lot of grief in establishing an Internet account for the
first time. (See Chapter 6 for details.)

v Mail - This command launches your e-mail program. (Applies to people
with direct Internet accounts, not America Online.)
Key Caps - Another desk accessory. It helps you find out which combinations of keys you're s upposed to press when you want to type wacky symbols
like ¢ or¥ or © (see Chapter 9).
Network Browser- For people with multiple Macs networked together, as
described in Chapter 14. If that means you, use this program to see which
other Macs are turned on and available. If that doesn't mean you, throw this
thing out.
Quicken.com - An ad for the Quicken (checkbook software) Web site.
Throw it away.
Recent Documents, Recent anything-A very handy shortcut! These s ubmenus list the last few documents, applications (programs), and servers
(other Macs in your office network) you've had open, so that you can get to
them again conveniently.
If you're not on a network, you can do without Recent Servers. Open your

Apple Menu Items control panel and put a zero where it says Servers; the
Servers item will disappear from your el menu.
Remote Access Status - This handy mini-program offers Connect and
Disconnect buttons to help you get on and off the Internet (assuming you've
signed up for a direct Internet account, as described in Chapter 6). And while
you're connected, this window shows how long you've been tying up the
phone.
Scrapbook - This desk accessory is worth keeping. Using Copy and Paste,
you can put pictures, sounds, movie clips, or blocks of text into it for later
use. For example, after you spend three weekends designing an a bsolutely
gorgeous logo for yourself, paste it into the Scrapbook. Thereafter, whenever
you need that logo again, open the Scrapbook and copy it, so that it'll be
ready to paste into your memo or package design.
Sherlock or Sherlock 2 - A turbocharged file-finding feature. Worth its
weight in the precious metal of your choice. Just type in what you're looking
for, and the iBook finds it ... fast. (See the end of Chapters 4 and 7 for a complete demonstration.)
SimpleSound - A mini-program that Jets you record sounds (using your
iBook's built-in microphone). See Chapter 20 for details. (Mac OS 9 fans: Look
for this one in your Applications folder, not your el menu.)
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Stickies - How did we live before Stickies? Sheer, purest genius. Stickies are
electronic Post-It notes. That's all. Just choose New Note from the File menu,
jot down what you want, and maybe pick a new pastel hue from the Color menu.
When you try to close Stickies (by choosing Quit from the File menu), you'll
be asked nicely if you want the Stickies to reappear each time you turn on the
iBook. Say yes, and you'll never forget another dog-grooming appointment.

The Contextual Menu Items folder
You can read about the fascinating contextual pop-up menu feature at the end
of Chapter 2. For now, know ye that this feature provides shortcut menus when
you click things (like icons and windows) while pressing the Control key.
It's technically possible to add more commands to these Control-key pop-up
menus, and many Web-surfing power users do. If you become one of that special breed, this folder is where you put the additional commands (in the form
of special icons).

The Control Strip Modules folder
You can read about the Control Strip in "The Control Panels folder" section to
follow. There, you'll learn that the Control Strip is an ever-present floating
strip of tiles that offer quick access to iBook settings (such as the speaker
volume). This folder is where those tiles are stored.

The Control Panels folder
Control Panels is another folder inside your System Folder. As you can read
in Chapter 3, a control panel is a tiny miniprogram that changes some aspect
of the iBook's behavior.
Appearance - This beefy Appearance control panel lets you change the look

and feel of your iBook's screen image in radical ways. For example:

v

Appearance - These options let you choose a highlighting-pen color
(for use when you drag your mouse across some text) and an accent
color (for scroll bars and other tinted on-screen accessories).

v

Fonts - Click the Fonts tab to view three pop-up menus that let you
change the typefaces your iBook uses for menus, labels, and lists.

I
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Note especially the option called "Smooth all fonts on screen." When
you turn it on, the edges of your on-screen type gets softer and
smoother (or antialiased, as the geeks would say). See the Top 10 list at
the end of Chapter 5 for an illustration.

v

Desktop -

v

Sound - If you click the Sound tab and choose Platinum from the popup menu, you get crisp, cheerful little sound effects as you do anything
on your iBook, like using scroll bars, menus, icons, the Trash, windows,
disks, or almost anything else that requires mouse manipulation.
(Health warning: Don't turn on sounds when using your iBook at the
public library, at international chess matches, or during microsurgery
on a relative.)

v

Options -

By clicking the Desktop "tab," you can choose a photo or
pattern with which to plaster the backdrop of your screen. (See
"Hanging your own background wallpaper" in Chapter 13 for step-bystep instructions.)

This panel offers a fascinating new option (on the Options
tab) called Smart Scrolling. It puts both scroll-bar arrows to one end of
the scroll bar, as shown here:
Smart Scrolling

On

Off

That option also makes the scroll box (the square handle you drag)
larger or smaller to reflect the amount of the document that's visible in
the window. That is, if the scroll bar handle is one-third the height of the
scroll bar, you're seeing one-third of the document in your document
window.
If you're splurting your Sprite, exclaiming, "Why, by gum, my iBook
always does those things!" well, you're right. The iBook comes with
Smart Scrolling turned on. If you turn it off, the scroll box is always

small , and the arrows are at opposite ends of the scrollbar, as shown
above at right.
1' Themes -After you've visited all of the various tabs (Appearance,

Desktop, Fonts, Sound, and Options) to get the iBook behaving just the
way you like it, you can preserve the particular combination of settings
you've just established as a Theme.
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B
Themes

Options

!i1

I

Current S.ltif"l•
Current Theme: Current Settings
To create e nN theme, modify the settings In the foll wlf"l •ectlons.

I.Save Theme._ ) :

To do so, click the Themes tab, where you'll see a new entry called
Current Settings. Click the Save Theme button, give your new "theme" a
name, and call it a day. From now on, you can jump to your newly established theme (or any of the predefined ones) by clicking it whenever you
feel the need for a change of scene.

How to ditch the crud you don't need
In this chapter's blow-by-blow descriptions of
your Control Panels and Extensions contents,
you'll be reading about many items that serve no
purpose on your iBook. In fact, they take up
memory, may increase the likelihood of system
crashes, and make the machine take longer to
start up. Some people simply throw these away
by dragging them to the trash.
Ifs safer, however, to simply turn them off. That
way, if, God forbid, three months from now, you
install some obscure program like Fridge
Repairman Pro 3.4.2 that happens to require the
software morsel you tossed, you' ll be able to
turn it back on and get on with life.
The key to turning off System Folder items is the
Extensions Manager control panel. Open it like

this: Click the S menu; slide down to Control
Panels; slide over to Extensions Manager. As
you'll read in this chapter, Extensions Manager
is nothing more than a list of almost every extension and control panel on your machine.
To turn something off, click the check box
beside its name so that the X no longer appears.
Then click the Restart button.
Now your iBook starts anew, without the
memory-grubbing, speed-slowing software lint
that you just turned off. This may seem like an
intimidating procedure to you, but ifs a healthy
exercise that will leave you filled with feelings
of technical prowess - and give you a faster,
more stable iBook.
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Apple Menu Options - This little gizmo provides the submenus in your ti
menu, so that you can (for example) open a specific control panel from the
Control Panels command. It also creates, in your ti menu, folders that track
the last bunch of documents and programs you used, which is handy.
AppleTalk-An important item if you're on a network. It lets you specify
how your iBook is connected to other Macs (or laser printers); with Ethernet

cables, LocalTalk wires, using the iBook's AirPort transmitter, and so on. See
Chapter 14 for more on hooking the iBook up to other Macs.
ATM - Adobe Type Manager. A control panel that makes certain fonts look
smoother on the screen and in inkjet-printer printouts.
ColorSync - Software that tries to make colors consistent among scanners,
monitors, and color printers. If you don't print in color and don't have a scanner, turn these off (see "How to ditch the crud you don't need" earlier in this
chapter).
Control Strip - All this control panel does is hide or show the Control Strip.
Trouble is, nobody ever bothers to explain the Control Strip to the average
iBook fan - but it's a terrific time-saver that's worth meeting.

The Control Strip starts out as a tiny gray tab hugging the edge of your
screen, like this:

Click that little tab (and let go) to make the Control Strip stretch out to its full
length, like a python sunning itself on the beach. Here's what some of the typical tiles on the Control Strip do (your ass ortment may be s lightly different):

Sound source

Networking
on/off
Power-saving
sleep settings

Hides the Control Strip
Plays or pauses music CDs

File sharing
(networks)

Internet connect/
disconnect

Screen controls Speaker
(color/zoom)
volume
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Each tile, as you can see by the Speaker volume example in the picture, is a
little pop-up menu; click a tile to view a menu of choices. You can muddle
through life without ever using the Control Strip, of course - most of the
tiles' functions are duplicated by the various gizmos in your Control Panels
folder. But the Control Strip lets you adjust these settings much more conveniently. And if your iBook has an AirPort card, as described in Chapter 15,
you'll use the Control Strip a lot.
If you click the little end tab, the Strip collapses so that only the tab appears,

at the very edge of your screen. Another click expands it again. You can also
shrink the Control Strip to any length by tugging - dragging - its little end tab.
Furthermore, if you press the Option key, you can drag the entire strip up or
down the side of your screen, or across to the opposite edge. (You can't drag
the Strip to the middle of the screen, however; it must hug the right or left
side.) The Option key has another handy effect on the Control Strip: If you
drag one of the little tiles while pressing Option, you can slide that tile horizontally to a new position.
If there's a tile you find yourself never using, feel free to get rid of it. While

pressing the Option key, drag the tile to the Trash.
Date & Time - Lets you set the iBook's clock. Also controls whether the
time appears at the top of your screen. If you have an Internet account, you
can even make your iBook set its own clock by dialing into some high-tech
atomic clock out in cyberspace somewhere. Now that's progress.
Dial Assist - Lets you create and store complicated dialing instructions for

making calls with your modem. Unless you work at a company where somebody has told you otherwise, turn this off.
Energy Saver - This control panel is terrifically important on a laptop like
yours. It lets you set the iBook to shut itself down, or go to sleep, automatically after you haven't used it for, say, half an hour, to save battery power.
Pretty useful, really.

You can use the pop-up menu to create one set of settings when you're
plugged in, and different settings when you're running on battery. For example, if you're like most iBook people I know, it drives you flippin' nuts when
your laptop goes dark when you're in the middle of a phone call. Choose Power
Adapter from the pop-up menu, in that case, and set the computer not to
sleep until after, say, 30 minutes of inactivity on your part - or never - when
it's happily plugged into the wall.
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Extensions Manager - You can open this by choosing its name from the
Control Panels command in your ti menu. You can also open it as the iBook
is starting up by holding down your space bar. Either way, you'll be shown a
list of almost everything listed in this chapter - all the control panels and
extensions. By clicking their names, you can decide which of them you'd like
to use during the work session that's about to begin. If you're a pack rat, for
example, you could simply turn off the ones you don't need instead of throwing them away. Great for troubleshooting (see Chapter 17).
File Exchange - This little doodad gives your iBook two magical powers.
First, if your iBook has a floppy drive, Zip drive, or SuperDisk drive, you can
insert a disk from DOS or Windows computers and see its icon appear on the
desktop, just as though it's a normal Macintosh disk. (Whether your programs can open the files on those disks is a topic for a book like Macworld
Mac Secrets - but at least you'll be able to see their icons.)
Second, if there's one thing that frustrates novices and old iBook salts alike,
it's seeing that infernal "Application not found" message when you doubleclick an icon. Thanks to File Exchange's second feature, when you
double-click an icon, you don't get an error message - you get a dialog box
that lists the programs you own that can open the mystery file.
File Sharing - The central control for file sharing (making your iBook's harddrive contents available to other people on your office's network). If your
iBook isn't on an office network, turn this sucker off.
File Synchronization - This fascinating doodad is , in effect, a backup program. It's designed to make the contents of one folder on your hard drive
up-to-date with another folder (usually on a different disk or another computer on a network). Most people use it to keep the iBook's hard drive
up-to-date with the hard drive of a desktop Macintosh; after returning from a
trip, they run File Synchronization to make sure that all the work they've
done while travelling is copied back to the main computer.
Here's how you set it up: Launch the File Synchronization program. Indicate
the two folders you'd like kept up-to-date with each other, by simply dragging
them one at a time directly onto the pictures of folders in the File
Synchronization program's window, like this:
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1.

0

2.

::G:lme Synchronization

From now on, whenever you open this control panel and click Synchronize,
the iBook analyzes each folder and makes them match, copying the most
recent files to each, as necessary.
I realize that's a lot of ink to describe one little control panel. But the day
your hard drive croaks and only your backup Zip disk saves you from aging
IO years on the spot, you'll thank me.

General Controls -A useful control panel. Sets your cursor-blinking speed,
turns System Folder Protection on or off (which prevents marauding preteens
from dragging anything out of your System Folder), and so on.
And have you ever noticed how, after a system crash and you turn the iBook
on again, a message scolds you for not having shut down the machine correctly (as though it's your fault)? Turn off the "Warn me if computer was shut
down improperly" checkbox if you'd prefer the iBook not to rub it in your
face. On second thought, don't; as you also may have noticed, after scolding
you, the iBook automatically begins to repair any hard drive damage that may
have occurred during the system crash. If you turn off the "Warn me" checkbox, you also turn off this handy self-fixing feature.
The General Controls control panel offers a few other goodies, too; see the
sidebar "Secrets of the General Controls" for a quick tour.
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Secrets of the General Controls
For many people, the purchase of an iBook is a
primal attempt to get their lives, so full of traffic
and turbulent relationships and scraps of paper,
into some kind of order.
Little do they know what awaits them on the typical iBook: Their important documents get every
bit as lost as their paper-based counterparts
once did. Even the great Mac gurus of our time
have, at one time or another, saved some document - and then found themselves unable to
find it again because it got arbitrarily stashed in
some hidden folder somewhere.
Enter the Documents folder - one of the features you can turn on in the General Controls
panel. This special folder appears in your main
hard drive window the first time you try to save
a file, as shown below. Thereafter, the iBook
shows you the Documents folder's contents
every time you use a program's Open or Save
command.
0

o

Macintosh HO

08

B items, 1.86 GB 8valloble

Apple

£xtre~

Applications

rot

Documents

In theory, you'll never lose anything again;
everything you do will always be in one place.
(That feature makes backing up your work
simple, too; you now have only one folder to
copy to a different disk.)
The other great feature of General Controls is
what I call self-hiding programs. To explain, let
me show you what might happen when you
reach for the scroll bar on a regular iBook.

dripped from his
wiping the
! , a cat h owled. This
~g ho.rd,

le fingered the gun.
o be the same this

As you can see, a beginner - and we were all
beginners once - might wind up accidentally
clicking outside the word-processor window, as
shown above. Immediately, the desktop (Finder)
jumps to the front, showing files and folders, and
the word-processor window gets shoved to the
back, apparently vanishing, causing (in the
beginner) distress, unhappiness, and occasionally hair loss.
Now then, suppose you open General Controls
and turn off the "Show Desktop when in background" option. When you open a document
now, the world of the Finder (icons, windows)
disappears, as shown below. Now, if you click
outside the word-processor window, absolutely
nothing happens. In fact, you can't return to the
desktop without choosing Finder from the
Application menu in the upper-right corner of
your screen.
12;21 PM !
Hide Cla rlsWorks

6

dripped from his
~g h ard, wiping the
!, a cat howled. This
le fingered the gun.
9 be the same this
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Internet - Shortly after you start hooking up to the Internet (see Chapter 6),
you'll discover why only 35 percent of Americans are online: There are too
many technical codes to type in when setting up an online account. In each
one of your Internet programs (your Web browser, your e-mail program, and
so on), you have to type your name, address, e-mail address, SMTP codes,
social security number, junior-high math teacher's nickname, and so on.
The Internet control panel provides a central place to type in every conceivable shred of Internet-related information - right down to the signature at
the bottom of your e-mails - once. Thereafter, each of your Internet-related
programs can refer to that information (instead of making you retype it).
For example, in Netscape Navigator (see Chapter 7), choose Preferences from
the Edit menu. Click the Identity icon, and you'll see the "Use Internet Config"
check box. (The name of that check box means "Use the info I typed into the
Internet control panel," in case you were wondering.) Netscape Navigator
then fills in all the necessary blanks for you, based on your Internet control
panel information.
The Internet control panel is also the place where you indicate which e-mail
program, and which Web browser, you like to use. You'll find this choice at
the bottom of the E-mail and Web screens. After you've made your choice,
double-clicking the Mail icon or Browse the Internet icon on your desktop
launches the program you've selected.
Keyboard - Use this control panel to change how a key behaves when you
keep it pressed. Does a held-down key start repeating like thisssssssssss?
And how fast?
Many first-time iBook users fare better if they turn the repeating-key feature
off. That way, if a book happens to lean on the spacebar while you're on the
phone for 20 minutes, you won't hang up to find 536 pages of blank space in
the letter you were working on.
This control panel also lets you change your keyboard's personality, making
it type the correct funny symbols corresponding to Swedish, Italian, Dutch,
and any of 18 other languages. People who can fluently speak 21 languages
find this a handy feature, although they annoy the heck out of the rest of us.
Finally, the Keyboard control panel is the command center for programming
your function keys (see "Fun with Function keys" in Chapter 13).
Keychain Access - The Keychain concept, new to Mac OS 9, is a good idea,
but extremely complex. If your iBook is connected to a big sprawling office
network, you might get tired of typing in your password every time you connect to another Mac on this network; the Keychain Access control panel lets
you store your password for each remote Mac once. After that, you won't
have to type passwords when you connect to those networked machines.
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If such a central storage location for all networked-Mac passwords appeals to

you, use your Mac Help command (in the Help menu). Search for "Keychain"
to read all about it - or just ask the geek who set up your network to begin
with.
Launcher - The Launcher displays a handy, in-your-face window containing

jumbo icons for the programs and files you intend to use the most often. For
details, see"All about big fat Launcher buttons" in Chapter 4.
Using this complex control panel, you can change a
slew of settings - the time zone, local Internet access phone number,
speaker volume, choice of printer, and so on - with a single click of the
mouse. I'd walk you through the 20-minute setup procedure, but Apple's
already done a much better job. From your Help menu, choose Mac Help.
Search for Location Manager and click the option called "Creating groups of
settings (locations)."

Location Manager -

And if you don't quite need that additional complexity in your life, turn this
thing off (see "How to ditch the crud you don't need" earlier in this chapter).
Map - This control panel is primarily useful for people who do business with

different geographical locations. (In both Mac OS 8.6 and Mac OS 9, it's in the
Apple Extras folder, not your Control Panels folder.) You type a major city's
name and click Find, and the Map shows you where that city is. It also tells
you how far away it is, and what the time difference is. (Want to see Apple's
sense of humor at work? Type MID and press Return ...)
Memory - As the French say, Ne trashez pas! You'll need this one. Details on

memory, and Memory, in Chapter 16.
Modem - This simple control panel is where you specify the exact brand

and model of the modem your iBook has. (Hint: It should say "Apple Internal
56K Modem.") Pick the wrong one, and your ability to explore the Internet,
send faxes, and attain Nirvana will be extremely limited.
Use this control panel to switch between different color settings
for your monitor (such as colors or grays) and different resolutions (degrees
of magnification for the whole screen). If you want Internet photos to look
half-decent, use the Thousands or Millions of Colors setting. And if you don't
want blurry edges, use the 800 x 600 settings. (For details on this Resolution
business, see "Zooming Into Your Screen" in Chapter 13.)
I

Monitors -

Mouse - "Ahem," you might be saying. "I have an iBook. I have a trackgad. I

do not have a mouse. Why waste my time with a control panel that conrols a
nonexistent piece of gadgetry?"
A valid question - after all, you also have a control panel called Trackpad,
whose job it is to adjust the trackpad. Well, you may someday decide to add a
mouse to your iBook, like the ones described in Appendix B. In that event,
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you'll be glad Apple gave you a control panel that governs how quickly the
cursor moves across the screen when you move the mouse quickly across
the desk. The Mouse control panel also lets you decide how fas t two clicks
must be to count as a double-click.
Multiple Users - This Mac OS 9 feature lets you set up a single iBook to
accommodate different people who might be using it. For a tutorial, see
Chapter 13.
Numbers - Lets you change the way the iBook punctuates numbers. For
example, the French use periods in large numbers instead of commas. You'd
say, "Bonjour! You owe moi $1.000.000, Monsieur." If you're satisfied with the
comma way of doing things, throw this away.
QuickTime Settings - This control panel lets you adjust various settings
pertaining to playing music CDs and CD-ROMs. You'll never need any of them
except one: If you turn off the AutoPlay CD-ROM option, your iBook is protected against the AutoStart virus (see Chapter 16).
Remote Access - This control panel is where you specify your Internet
name, password, and local phone number. No Internet account? Turn it off.
Software Update - OK, you're Apple Computer. You know that somehow,
somewhere in the 9 million pieces of software in Mac OS Whatever, there's a
bug - some little glitch left behind by a programmer. Don't you wis h, now
that 30 million people have installed your new system software, you could
sneak into everyone's house and fix that bug?
Now you can. This control panel's "Update software automatically" checkbox
makes your iBook dial the Internet according to a schedule that you specify
(using the Set Schedule button). In about two seconds, it sends out a query
to the huge humming master computers at Apple, seeking the answer to one
question: "Have you fixed or updated anything?"
If the answer is Yes, your iBook begins receiving the fix automatically from

the Internet (after asking your permission, of course). In just a few minutes,
the huge humming master computers will have finished sending you the new
goodies, and your iBook will be good as new. Scratch that - better than new.
(This feature works only for things like control panels and extensions - the
things described in this chapter. It doesn't update your non-Apple software,
such as Internet Explorer or Microsoft Word.)
Sound - At the left side of this window lurk four control centers. The Alerts
portion lets you choose which irritating sound effect you want to squawk at
you when you make a mistake. Input lets you specify what sound source the
iBook should use when making a recording (a delightful feature that's
described in Chapter 20) - a microphone you've plugged in, for example, or
your CD-ROM drive.
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Part Ill: Software Competence - - - - - - - - - - - - - - - - The Output section lets you set the volume for your speakers (although it's
more convenient to do that using the Fl and F2 keys on the keyboard). And
the Speaker Setup, the funnest one of all, works only if you have external
stereo speakers plugged into the speaker or USB connectors on the left side
of the iBook. By dragging the little sliders, you control the relative balance
between the two speakers; the iBook plays hissy sounds out of one speaker,
then the other, as you tweak the controls, until they sound exactly right.
(Hold down your clicker on one speaker image to freeze the hissing on that
speaker alone.)
0
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Alert Sounds
Input
Output
Spe11ker Setup

~

-

~
I~
--------~

= Sound

Select which spe11kers you w11nt to use. To adjust volumes,
click "Start Test" 11nd adjust the sliders until all speakers
sound equally loud.

@]

I Use Def11ult~ I

St11rtTest

Speech - Extremely cool for at least 15 minutes. Lets your iBook read, out
loud, what you have typed. Instructions in making it do so are in Chapter 20;
in the Speech control panel, the primary activity is deciding whether or not
you want the iBook to speak error messages that appear on the screen - and
which voice you want it to use when it does so.
You haven't lived until your laptop blurts out, in a nasal robotic voice during
a sensitive job interview, "No battery power remains. Your computer will go
to s leep in 10 seconds."
Startup Disk - You have one hard drive inside the iBook. Some people purchase another one, or a removable-cartridge thing like a Zip drive, that plugs
into the USB connector. Startup Disk lets you choose which hard drive's
System Folder you want to run the show when you next turn on the computer. If the hard drive in your iBook is your only hard drive, open your
Extensions Manager control panel and turn off Startup Disk.
TCP/IP - If you've signed up for an Internet account (see Chapter 6), this
control panel stores the complex numbers that identify the company you've
signed up with.
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Text- Mr. Pointless. Would let you choose a language software kit other than
English for your computer - if you had any installed. You don't. Throw this
away.
Trackpad - Adjusts the sensitivity of your trackpad; also lets you turn on
trackpad tappi~g, a feature described at the end of Chapter 3.
Users & Groups - See Chapter 14 for details of setting up an office network,
including what to do with this otherwise useless item.
Web Sharing- This control panel is primarily of interest to networked companies; it lets you make a particular folder on your hard drive available to
anyone who dials into your iBook. If you don't have an office guru who
explains how to use this, throw it away.

The Extensions folder
An extension is a little program that runs automatically when you turn on the
iBook. It usually adds some little feature to your iBook that you want available at all times: a screen saver, for example, that automatically blanks your
screen after a few minutes of inactivity on your part.
Extensions aren't the only thing in your Extensions folder, however - oooooh,
no; that would be far too logical. The Extensions folder also contains something called shared libraries, which are little blobs of computer instructions
that your various programs call on when necessary. (Any file ending with Lib is
one of these shared libraries. So don't go to a party and pronounce it "Open
Transport Libb." It's "lybe," short for library.) Anyway, shared libraries are far
less annoying than actual extensions, which make your iBook take longer to
start up, use up memory, and contribute to freezes and crashes. Shared
... libraries don't do any of that.
-About Apple Guide, anything-Guide - Remember, from Chapter 1, the electronic help desk we call the Help menu? These files contain the Help screens.
ActiveX Controls - Part of the Internet Explorer browser. You can throw it away.
AOL link-anything - These files are required by America Online. If you're
not an AOL member, turn these off.
Apple CD/DVD Driver, Foreign File Access, anything-Access - You need
these for playing CD-ROMs on your iBook.
~
Apple Color SW Pro CMM, anything-SW, LaserWriter anything - SW stands
for Apple StyleWriter, a discontinued printer. You'll find a whole bunch of
these in your Extensions folder, and you should throw all of them away
except the one that corresponds to the printer you actually use.
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Apple Enet - You need this doodad only if you connect to other computers
using your Ethernet jack, as described in Chapter 14.
0 p p l e IX3D anything, ATI anything - This cluster of icons controls the
\.
- • graphics circuitry. Your iBook works without them, but doesn't draw the
'\..._
screen as quickly.
Apple Monitor Plugins - Leave this. It adds useful options to your Monitors
control panel.

AppleScript, anything-Script - All components of a very technical feature
intended for the kind of person who wouldn't be caught dead reading this
book. However, even if you don't use these yourself, some of the iBook's best
features depend on these extensions, so leave them in place.
AppleShare, Network anything, F'tle Sharing anything - Still more doodads
for networking Macs together. If you're not on a network, off they go.
Application Switcher - This extension makes possible the iBook's Program
Switcher (see Chapter 13). It also lets you switch from one open program to
the next by pressing 3€-Tab. Try it -you'll like it!
ATI-anything - This software speeds up the appearance of images on your
iBook screen, which you'll find especially useful if you play Mac games.
CarbonLlb - You don't need this extension today. But maybe tomorrow, and
for the rest of your life. Before you're through with this computer hobby, Mac
os·x ("ten") will be on the market - and this doodad will let you run many
Mac OS X programs on your humble, Mac OS 9 iBook.
Color Pic.ker - The Color Picker is that dialog box that shows a big color
wheel, allowing you to choose a particular color. It appears, for example,
when you're in the Edit menu's Preferences command and you click a label
color to change it. This extension adds a More Choices button to that dialog
box, allowing you to choose some super-techie options. Switch it off.

--

......

ColorSync - See "ColorSync" in the Control Panels listing.
Contextual Menu Extension - Brings you the magical pop-up menus that
appear when you hold down the Control key and click something. See
Chapter 2 for the gory details.
Control Strip Extension - The Control Strip, described earlier in this chapter, is easy to modify. You can drag new tiles directly onto it (to install them)
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or Option-drag them to the Trash (to uninstall them). This extension makes it
all possible.
Default Calibrator - This extension adjusts your screen at startup to ensure
that it's colorifically perfect. If, by some fluke, you don't work in th«;,L>rofes....2.!_onal color printing industry, toss this one.
· Desktop Print anything - For people whose Macs are attached tq, multipl~
.minters (perhaps in a big office, for example). Adds printer icons to your
deskWp, so that you can decide which one should print your latest masterpiece (see Chapter 5 for details). If you have but one printer, turn these off
and have a happy li_!e.
v.i:srll~ =
~~~ DNSPlugin - No joke: Apple describes this as an extension that "allows your
~
·, ·
computer to receive listings of network objects from DNS directory services."
,
Turns out there's no such thing. Turn this off.
DrawSprocketLlb - An extension used by certain games.
EM Extension - See "Extensions Manager" in the Control Panels listing.
Epson Stylus - The software for an Epson inkjet printer. (More on printers
in Chapter 5.)
FaxMonitor, Fax anything - Software that lets your iBook send and receive
faxes (Chapter 20).
FBC Indexing Scheduler, Find, FindByContent - These extensions let you
search for words inside your files using the Sherlock finding program. For
details, read "Seeking wisdom in your own words - and on the Net" in
Chapter 4.
Folder Actions - For programmers. Off it goes.
Font Manager Update - Fixes a bug pertaining to fonts. Leave alone.
HID Library, InputSprocket-anythlng - These files let the iBook accommodate the USS-attachable game devices - joysticks, gamepads, anq so on described in Appendix B. If you control the cursor only with your track~
_you can turn all this stuff off.
HTMLRenderingLlb - Required by the Mac's Help command.
ICeTEe - This little gizmo makes possible a neat Internet feature almost
nobody talks about. Suppose you run across a Web address (such as
http://www.apple.com) in any document, even an e-mail or an AppleWorks
memo. Just by 3C-clicking it, you make your Web browser open and take to
the corresponding Web page. Neato!
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lndeo Video, Intel Raw Video - If you use Microsoft Internet Explorer (see
Chapter 7), these extens ions got dumped into your System Folder. They let
your iBook see movies (which, presumably, you find on the Web) that have
been prepared in Windows format (AVI ) .
• Instant Palm Desktop - This item puts up the tiny green icon at the upperright corner of your screen, as described in Chapter 10, that lists your
schedule for the day.

•

Internal v.90 Modem, Internet Access - Software for your built-in modem
and for connecting to the Internet, respectively.
Internet Config Extension - This extension goes with the Internet'control
panel, described earlier in this chapter.

19'
\.ii).
~OS9

Iomega driver- Lets your iBook work with Zip drives. If you didn't buy one,
out this goes.
,__.
"

-

IDAP-anything - These doodads let Shed ock 2 look up people's names and
phone numbers, as described at the end of Chapter 7.
Location Manager-anything - See "Location Manager," earlier in this chapter.
MacinTalk-anything - Lets your iBook speak. See Cha pter 20.
Macromedia anything - Required by certain Web pages for special animated effects. Turn it off if you don't s pend much time on the Web.
Microsoft-anything, MS-anythin g- ~l of this crud is required if you want to\
use Microsoft pro

-1

Modem Scripts - Before you go on line (either with America Online or an
Internet account), you're supposed to tell the iBook what kind of modem you
own. You choose your model from a long list in the Modem control panel. For
every corresponding modem name, a file s its here in your Modem Scripts
folde r.

MRJ Libraries - This folder (which stands for Macintosh Runtime for Java)
contains the software necessar y for your iBook to run Java programs - that
is, animated ads and little games that you find on Web pages as you surf the
Internet. You be the judge.
Multi-User Startup - Makes possible the Multiple Users feature described in
Chapter 13.
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Multiprocessing - This little guy awaits the day when Macs come with more
than one processor chip. Yours doesn't(!'urn this of.:_
NBP Plug-in, NSL UI library - Used to access other networked computers
over the Internet.
Open Transport, Open TPT-anything - This super-techie collection of
System Folder lint ( known as Open Transport technology) makes your iBook
• capable of connecting to the Internet, a network, or America Online.
OpenGL anything - These gadgets add speed to certain computer games. If
you don't play 'em, you don't need 'em.
PalmConnect-anything - These modules let your calendar/phone book program (Palm Desktop, covered in Chapter 10) exchange information with a
PalmPilot. If you don't have such a pocket organizer, turn these off.
Printer Descriptions - This folder contains one little file for each individual
printer model.......
o..,p..;.e.;.;n...:t.:..h.:.:
is_f:..:o..:.ld:_:e:_:r_a...n_d_-d_ i_s_c ..
ar__d_t__h__e_i.c:..
:. o.:.:.
n.:..
s .-fo:...;r_a..,t..,
t pnme
C:::::·::::'.
te~rss yyooJ.Iu
don't use.
~
Printer Share -..TurnjJ: off. Used to share StyleWriter printers (no longer
sold) over a network.
Printinglib - Makes laser printing faster. If yo1,1 have an inkjet printer like an
Epson, turn this off.
PrintMonitor - The genie that grants the miracle of background printing,
described in Chapter 5.
QuickDraw 30-anything- QD3D stands for QuickDraw 3D. This assortment
of a half-dozen extensions Jets your iBook show, create, and accelerate.;lll.
z.raghics. These extensions are required primarily for a few games, including
Nano~r (see Chapter 10).J! you don't play games, switch these babies off.

-

QuickTime-anything - You need these little jobbers for playing, or making,
digital movies on the iBook. Many games and CD-ROM discs require these
items.
Security-anything - Part of the Keychain password-storage mechanism
described in the Control Panels listing of this chapter. If you don't share your
iBook with other people, turn these off.
•
Serial (Built-in) - Still more Open Transport crud (see "Open TPT anything'').
Shared library-anything - You need these to manage your shared libraries,
described at the beginning of this section.
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ShareWay IP Personal Bgnd -A very technical option for people who set
up,!!_etworks. If you're not.on a network. turn it off.
SLPPlugin - Exactly like the delightful DNSPlugin described earlier in this
section.
Software Updates-anything - Makes possible the Software Update feature
described in the Control Panels listing of this chapter.
SOMobjects for Mac OS - Yet another shared library, as discussed at the
beginning of this section. This one is required to make your contextual menus
work (see Chapter 9).
Sound Manager - For sound recording and playback. Leave it for now.
Speech Manager- Makes possible the text-reading-out-loud feature
described in Chapter 20. If you aren't regularly talking to your iBookbesides just arguing with it - off this goes.

.

~

STF Toolbox, STFinit - More stuff for your built-in fax modem.
Stufflt-anything - Required by Stufflt, the program described in Chapter 6
that lets you open stuff you get from the Internet.
TCPack for AOL-::_ Leave this on only if (a) you are an America Online ..
;ne?lber, and_lb) you connect cu It through a table moctem or other pricey
high-speed connection. If you connect via built-in modem, off this goes.
Text Encoding Converter - All computers understand A through Z, but the
wackier symbols (such as curly quotes, foreign diacritical markings, and so
on) are internally summoned differently on each type of computer. Ever get
an e-mail in which all the apostrophes appear as capital Us? Or in which all
the quote marks have turned into weird boxes? Now you know the problem.
The Text Encoding Converter is designed to translate other computers'
wacky alphabet references into the iBook's system, so that fewer nutty boxes
and Us show up in your e-mail.
Time Synchronizer - The Date & Time control panel can set your iBook's
clock automatically by dialing into the Internet. This extension makes that
feature possible.
UDF Volume Access - Lets your iBook talk to DVD discs (which are like CDs,
but hold 14 times as much). ("Volume," in this case, doesn't mean "loudness;"
it refers to a disk.):!Qur iBook doesn't have a DVD drive, so turn this off,:_
URL Access - Required by the Sherlock program (see the end of Chapter 6)
to search the Internet.
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USS-anything- Lets your iBook communicate with various USB devices (see
Chapter 14).
Voice Verification - If you have Mac OS 9 and you've bought a microphone
for your iBook and you're using the Multiple Users feature described in
Chapter 13, this extension lets you speak your password to gain entry to your
laptop.

Web Sharing Extension - A companion to the equally useless Web Sharing
control panel. Turn it off.

-The Preferences folder

The Preferences folder is filled with information, and none of it's for you.
Every single file in this folder was put there by another piece of software.
Let's say you change a setting in your word processor: You always want it to
make your typing double-spaced, for example. Well, where do you suppose
the computer stores your new setting? It jots it down in a preferences file. And
this prefs file lives - wild guess - in the Preferences folder.
Prefs files are famous for frustrating beginners. Because they're for use by
your programs, and not by you, virtually every one of them gives you a rude
error message if you try to double-click it. You simply can't open a Prefs file;
only your software can.
You really can only do one good thing with the Preferences files: throw them
away. That is, throw away any that belong to programs you no longer use.

More special folders
In its noble (but hopeless) quest to neaten up your System Folder, Apple
offers you several other, specially-iconed holding-tank folders. Such as:

v

Application Support: Various Mac software companies wind up dumping all their programs' associated crud - dictionary files, file-conversion
stuff, and so on - into this folder.

v

ColorSync Profiles: As you can read earlier in this chapter, ColorSync is
a software scheme for ensuring that scanners, screens, and color printers all agree on what, for example, "red" is. This folder contains
individual color-description lists for every model of Apple scanner, monitor, and printer,)f color consistency is important to you, use the
ColorSync control panel to s pecify which models you own.

239

2 ll 0

Part Ill: Software Competence _ _ _ _ _ _ __ _ _ _ _ _ _ _ __
v Extensions (Disabled) - This explanation is tricky and techie, but I'll
do my best. Remember Extensions Manager, described in the sidebar
called "How to ditch the crud you don't need" earlier in this chapter?
When you click some extension's checkbox to switch it off, Extensions
Manager doesn't delete that extension; behind the scenes, it just moves
it into this Extensions (Disabled) folder. When the iBook next starts up, it
only "loads" the extensions that are in the actual Extensions folder.
To turn that particular extension on again, you can, of course, use
Extensions Manager again - but you could also, in a pinch, move the
file manually back into the regular ~xtensions folder. (Rival programs,
like Conflict Catcher, work the same way.)
And if you turn off a control panel, sure enough , it winds up in a folder
called Control Panels (Disabled).

v

Favorites: "Favorites" means "icons I'd like quick access to from now
on." To create a Favorite, click it and choose Add to Favorites fro
.. File menu. It instan appears in your avon es command (in the ti
menu), as s hown here:

1. Choose Add to Favorites . . .
' ~

2.... and from now on, your favorite icons
are available from the Apple menu.

Edit View Speclol Help
New Folder

rne Edit View
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Open
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Print
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Move To Trosh a<lll

ti

dii.
rutAwoy

af

Find-

• r

nnd
Global Vllloge fox Center
r.rAnhtnn ,.,.,,. 111 .,tn,-

Oownloods
Pix from Jennifer

Behind the scenes, the iBook has simply placed an alias of that icon into
the Favorites folder. (See Chapter 13 for a description of aliases.) In
other words, to remove something from the Favorites menu, remove it
from this folder.

v

Fonts folder: This folder contains your fonts. (Did you guess?) See
Chapter 5 for a detailed explanation of all this junk.

v

Help: Apple puts its own help files (which create what you see when you
use the Mac Help feature, for example) into this folder. Other software
companies sometimes follow suit.

v

Internet Search Sites: The Sherlock finding program is capable of
searching the entire, vast Internet, not just your puny little hard drive.
The files in this folder each teach the Find command how to talk to a different World Wide Web search page. (See Chapter 7 for more on Web
search pages.)
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Y' Language & Region Support: This folder contains files necessary to let

your iBook show other languages on the screen.J!_ you use your iB~k
only in one co~ yrn1 can throw away all the other c~ries' files.
Y' Launcher Items folder: The purpose of this folder is to let you specify

what jumbo icons you want to appear in your Launcher window, the
iBook's one-dick program-launching bay. See "All about big fat Launcher
buttons" in Chapter 4.
Y' Startup Items, Shutdown Items -

Fascinating, Captain. Anything you
put into the Startup Items folder (a program, a document, a sound, a
folder) gets opened with a mysterious automatic double-click whenever
you turn on the iBook. If you don't do anything but word process, for
example, drag the icon of your word processor into this folder. Thereafter,
every time you power up for the day, your word-processing program will
be on the screen awaiting your brilliance.
The Shutdown Items folder is the same deal, except anything in here
gets run automatically when you shut down the computer. Automaticbackup programs come to mind. A sound that says "Tb-th-th-th-th-that's
all, folks!" also comes to mind.

Y' Scripting Additions, Scripts Folder: Places for programmers to stash

their stuff.

Other files in the SIJ.stem Folder
Clipboard - Every time you use the Cut or Copy command in a program, the
iBook, according to what you read earlier, socks the selected material away
on an invisible Clipboard. Well, guess what: it's not actually invisible.
Technically speaking, that info you copied has to be put somewhere. This is
where: in the Clipboard file.
Little-known fact: You can double-click the Clipboard file to open a window
that shows the last thing you cut or copied . (Another little-known fact: The
last swallow of a can of soda is 69 percent saliva.)
Ander - This is the most important program on your iBook. Without it, a
System Folder is just a folder, and your iBook won't even turn on. The Finder
file is responsible for creating your basic desktop: the Trash, your disk icon,
windows, and so on.
System - This is also the most important file on your iBook. It contains all
kinds of other info necessary for the computer to run: reams and reams of
instructions for the computer's own use. Without a System file, the iBook
won't even turn on, either.
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Part Ill: Software Competence---------------Desktop Printers - The icons for your various printers (if you have more
than one). See the sidebar called "A shortcut for multiple-printer owners" in
Chapter 5.
Scrapbook file, Note Pad file - When you paste something into the
Scrapbook or Note Pad desk accessories, behind the scenes, the iBook actually stores it in these files.
Mac OS ROM-Whatever you do, don't fold , move, spindle, or mutilate this

one. Throw it away, and you've got yourself a see-through, $1,600 doorstop.
(Fortunately, a clean install, described in Chapter 17, can bring a thuscrippled iBook back to life.)

Chapter 13

Great Material that Didn't
Quite Fit the Outline
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
.... Forbidden secrets of the Option key
.... Interior-decorating your iBook
.... The weirdest keys on the keyboard
.... Function keys for fun and profit
.... Sharing the iBook using the Multiple Users feature
.... Wizzy window stunts

•••••••••••••••••••••••••••••••••••••••••••••••••

~is

chapter is filled with miniature iBook lessons. It reveals iBook feaures you'd be unlikely to discover on your own, unearths shortcuts and
slick tricks, and shows you how to tailor your laptop so that it perfectly fits
your personality.
In short, the following discussions are useful, surprising, delightful - but
utterly random. They just didn't fit tidily into any other chapter. That's a syndrome we writers try to avoid, but greatly prefer to writer's block. May you
find enlightenment even in randomness.

The Efficiencv Nut's Guide
to the Option Kev
Yeah, yeah, everybody knows that you can close a window by clicking its close
box. But you didn't fork over good money for this book to learn something
that's on page 1 of the iBook manual (if, that is, there were an iBook manual).
No, these tips are much choicer. They show you how to unlock the power of
that most overlooked of keys, the Option key. It's been placed closer to you
than any letter key on the keyboard - and that's no accident.
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ClosinlJ. all windows at once
Suppose you've opened a gaggle of folders. Their windows are lying open all
over the screen. And suppose that the niggling neatness ethic instilled in you
by your mother compels you to clean up a bit.
You could, of course, click the close box of each window, one at a time. But
it's far faster to click only one window's close box while pressing the Option
key. Barn, barn, barn - they all close automatically, one after another.

The silence of the Trash
Let's review: You drag an icon on top of the Trash can and the icon disappears. The Trash can icon overflows. You smile gently at the zaniness of it all.
Then you choose Empty Trash from the Special menu, and a little message
appears on the screen, saying something like this:

The Trash contains 4 Items, which use 176K
of disk space.Are you sure you want to
remove these items permanently?

@ilCill [I

OK

u

That's all very well and good, but busy people concerned with increasing
their productivity may not always have time for such trivial information.
Therefore, if you want to dump the trash, but you don 't want that message to
appear, press Mr. Option Key while you choose Empty Trash. (Option is also
the key for emptying the trash when the iBook tells you something is
"locked" in the Trash can.)
Smatterafact, you can shut up the Trash's warning permanently, if you're so
inclined. Click the Trash can. From the File menu, choose Get Info. Turn off
"Warn before emptying." What an improvement!

MultitaskinlJ. methods
As you discovered early on, the iBook lets you run more than one program
simultaneously. (Remember when you tried some tricks with both the Note
Pad and the Calculator open on the screen at once?) You can switch from one
program to another by choosing the program's name from the Application
menu at the top right of your screen, marked by the name and icon of
whichever program is currently in front.
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We haven't yet examined the other commands in this menu, such as Hide
Others and Show All. These commands help keep your s creen neat and clean.
For example, suppose you're trying to use the Calculator, but so many other
programs are running that your eyes cross.
• ;d

file

Edit

2:39PM

Help

Winks (1:2)

~ Calculator 1
Jigsaw Pt

!New York

ICh•pTitl•
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Before p lunging headfirst into the untamed crocodile swamp of opera, ·
like to take you •
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ra starts with words - th:>usandsof
called the st:ript in a mcvie they're
era they're called the h'br<tto.

n. and that's precisely what it is; yo1
hana TV Guide. But siru:e sinsing•
er than saying it, a "little book," wh
in the theater. (That's putting it mil
era, you may wind up wishing that

By choosing Hide Others from the Application menu, all windows that belong
to other programs disappear, leaving the frontmost window all by itself.
• ~ Fiie

Edit

2:39PM

Help

Calculator

Mocinlosh HO

•
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are now hidden. You can verify this by checking the Application menu, where
you'll see that their icons appear slightly dimmed.
2:54PM

Hide Calculator
Hide others
Show All

f!I AppleWorks

-' 6

Calculator

IQ Finder
Internet Explorer 4.5

1'J Palm.. Desktop
"

Sherlock

So how does the Option key play into all this? When you switch from one
program to another, you can make the program you're leaving hide itself
automatically. Just press Option while choosing the new program's name (or
clicking in its window). That way, you always keep nonessential programs
hidden.
You can even press Option as you click different tiles on your Application
Switcher palette (described at the end of this chapter). Once again, the program you were just in gets hidden as you switch to the next program.

Buried Treasures
Did you enjoy those obscure, Option key tricks? Then you'll really love these
equally scintillating techniques, not one of which requires the Option key.

Make an alias of a file
The File menu has a command called Make Alias. Although you might expect
this command to generate names like One-Eyed Jake or "Teeth" McGuire, the
term alias in the Macintosh world represents something slightly different - a
duplicate of a file's icon (but not a duplicate of the file itself). You can identify the alias icon because its name is in italics, as shown here, and because a
tiny arrow icon appears on the alias.
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What's neat about aliases is that, when you double-click an alias icon, the
iBook opens the original file. If you're a true '90s kinda person, you might
think of the alias as a beeper -when you call the alias, the actual file
responds.
So who on earth would need a feature like this? Well, there's more to the
story. An alias, for one thing, requires only a tiny amount of disk space (a
couple of K) - so it's not the same as making an actual copy of the full-sized,
original file. (And you can make as many aliases of a file as you want.)
Therefore, making an alias of something you use frequently is an excellent
time-saver - it keeps the alias icon readily accessible, even if the real file is
buried somewhere four folders deep.
Another very common trick: Place an alias of a program or a document into
your S menu, where you don't have to open any folders to get at it.
Here's the drill:
1. Click the real icon once.

2. From the File menu, choose Make Alias.
3. Open your System Folder.
4. Drag the alias into the folder called Apple Menu Items (within the
System Folder).

Cll System fo lder
37 items, 577.8 MB available
Name

I> Fc

Appeorance

Size
-

Dote Modified

"

B/ 14/98

I>

'L•11r11111~~---~To~d8Y("--l--il--1

I>

~ Application Support
Cieri•

-

B/ 14/ 98

-

Today

5. Now look in your S menu.

Sure enough - there's your file! Choose it from the S menu to open the
original file.
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File Edit View Special
About This Computer

Help

I' .

~Apple System Profiler
• Apple Video Player
® AppleCOAudlo Player

And yet, because you used an alias, the real file can be anywhere on your
hard disk or on a different disk. You can move the real file from folder to
folder or even rename it, and the alias still opens it correctly.
Sprin9~loaded

folders

For years, people wanting to move an icon into a folder that's inside a folder
that's inside another folder had to cancel all their meetings for the day and
lock the door. They'd have to open the first folder into a window; open the
folder inside it; drag the icon into place; and then close all the windows
they've opened in the process.
On the iBook, however, you can simply drag an icon onto a folder (below,
left)- don't let go!- and it will open automatically into a window ( below,
right).

Macintosl1 HO
4 rttms_, 759.9 MB 1utbb1it

M

System Foldt

4 lltm< . - - - - - - - - - ,
t - - - --1
291ttm:1, 759.6 MS av1uat

Bockup

Drag that icon on top of the next folder, and it, too, will spring open - don't
let go! - so that you can drop it on its final , target folder destination.
Now let go. All the windows that opened on your journey snap shut automati-

cally. Using this technique, you can actually place an icon into a folder within
a folder within a folder - with a single drag. Because one thumb must remain
locked down on the trackpad clicker, doing all of this not-letting-go business
can get awkward; but it's a skill that's highly prized in today's competitive job
market.
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Trash, aliases, and a word of caution
If you trash an alias, you're deleting only the
alias. The original file is still on your disk. If you
delete the original tile, however, the alias icons
will remain uselessly on your disk, rebels without a cause, babies without a mother, days
without sunshine. When you double-click an
alias whose original file is gone, you'll just get
an error message. (The error message offers
you the chance to attach this orphaned alias to

a different "real" file still gone forever.)

but the orig inal file is

Likewise, if you copy your inauguration speech
file's alias to a floppy disk, thinking that you'll just
print it out when you get to Washington, think
again. You've just copied the alias, but you don't
actually have any text. That's all in the original
file, still at home on your hard disk.

The i8ook's Pro9ram Switcher
The Application menu is the menu in the upper-right corner of your screen where you see the name of the program you're using at the moment. The
Application switcher is a secret feature that appears only when you drag straight
down the Application menu past the bottom and tear it off (below, left).

r
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3:44 PM i
Hide Image Grabber"'
Hide others
Show All

&

America Online
!'§ c111culator
~ aarlsWorks
Finder
Note Pad

l'1

3:44 PM

EH,;;; A ic:e••• l~l!Jl!!I
Amer Ice Onll ne

ii · Finder

1

Macintosh HD

&

~ C&lculotor

CJ
_Q

..

fJ Note Ped

The menu turns into a small floating rectangle that lists your running programs (above, right); just click a program's name to switch to it.
And if you find this floating palette too wide for your tastes, click carefully
just inside the right end of one of its buttons, as shown above - and drag to
the left. You've just made the entire palette skinnier. And if you're out horseback riding, bouncing so severely that you can't manipulate your trackpad,
use the Application switcher shortcut: while holding down the S€ key, press
the Tab key. This combo, 3€-Tab, automatically lets you switch from one open
program to the next - even if you haven't torn off the application menu.
Isn't technology wonderful?

2fl 9
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Zoomin9 into IJ.OUr screen
As you've no doubt noticed, the iBook screen is gorgeous. It's bright, vibrant,
and wide enough to show you two pages side by side. The propeller-heads
would remark that it's an 800-by-600 screen, which means that it's composed
of that many individual color dots across and down.

You're not locked into that setting, however. With a few judicious clicks, you
can magnify the screen image, blowing up your work for a larger view. (When
everything's bigger on the screen, of course, you see less overall area - you
don't see two pages s ide by side anymore - the same way a more close-up
map shows a smaller section of your town.)
To try this setting for yourself, open the Control Strip by clicking the small
gray tab that peeks out from the left edge of your screen, turning it into a horizontal tray full of useful gizmos. The one you want is the Screen Resolution
icon, which is shown here:

Click the Screen Resolution icon to make the tiny pop-up menu appear; click
the option called 640 x 480. Your screen instantly changes to show you the
magnified view. (As you'll notice right away, 640 x 480 mode is blurrier than
normal, but it's terrific for enlarging photos, movies, and games.)
To restore the zoomed-out setting, click the Screen Resolution tile again;
choose the 800 x 600 command from the pop-up menu.

Makin9 it Unmistakab/IJ Yours
The great thing about an iBook is that it's not some stamped-out clone made
in Korea. It's one of a kind - or it will be after we get through with it. These
tips illustrate some of the ways you can make the iBook match your personality, sensibility, or decor.

Haile it IJ.OUr UlalJ. -

at Icon Kin9

You don't have to accept those boring old icons for files, programs, and folders. If you want anything done around the iBook, heaven knows, you've got to
do it yourself:

_ _ _ _ __ _ Chapter 13: Great Material that Didn't Quite Fit the Outline
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I. Go into AppleWorks (the painting window) and make a funny little picture.

And I mean little - remember, you're drawing a replacement icon for some hapless file. Like this guy here, for example.

2. Copy your creation to the Clipboard.
3. Go to the Fmder and click the file whose icon you want to replace (as shown
here at left).
Backup Info

I

Show: General Information

~184ckup
lla folder
Sia: zen> Kon dl•k ( 0 byteo), for 0 ltemo

Wlltn: Meclntosh HD:

4. From the File menu, choose Get Info, so that the Get Info box appears (previous
picture, right).
(By the way: If you're in Simple Finder mode, which is described later in this chapter, then the Get Info command doesn't appear in the File menu. Turn off Simple
Finder before taking this step.)
5. See the folder icon in the upper left? Click that sucker - and then paste away!
From now on, that little picture is the new icon for the file (or folder or disk). To
restore the original icon, repeat the Get Info business, but this time, after you click the
icon, press the Delete key.

Han9in9 v.our own back9round wallpaper
In the earliest days of computer technology, you could make a few feeble attempts at
changing the way your Mac looked. You could, for example, fill your screen background
with a wall of patterned teddy bears.
But the iBook says, "Teddy bears? - Hah!'' Us ing the Appearance control panel, you
can fill your desktop with not just a repeating pattern, but a full-screen picture file!
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To do so, open the Appearance control panel. (From the S menu, choose
Control Panels, and then choose Appearance.) Click the Desktop tab, click
Remove Picture, and then click the Select Picture button.
You're now asked to locate the graphic file you want to use as a backdrop.
You' re offered several folders filled with sample graphics files; doubl~Iick to
open them, and then double-click to try out the different graphics. Most are
spacey, bubbly artworks that look as though they were created by an airbrush artist listening to new-age music; none are actual photos.
But it's much more fun to slap your own picture on your desktop. As for getting such a picture file, well, that's up to you. America Online and the Internet
are teeming with great pictures, from Planet Earth to Gwyneth Paltrow. It's
also easy enough to make your own, using (a) software like AppleWorks or
Photoshop, (b) a digital camera like those described in Chapter 19, or (c) a
scanner, also described in Chapter 19. (The photo of Earth from space shown
above came from the NASA Web site at http://photojournal.jp/.nasa.gou, for
example - your tax dollars at work!)
(Note to the hopelessly technical: You can use any JPEG, GIF, PICT, pictureclipping, or Photoshop file. Note to the frantically busy: Instead of clicking
the Select Picture button, as described a couple paragraphs ago, you can also
drag a graphics file directly onto the miniature desktop in the Appearance
control panel. There it shows up in miniature form, as shown in the previous
illustration.)
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Color-codin9 IJ.OUr icons
Here's a pretty neat feature that hardly anyone uses but is still worth knowing
about: color-coding. All you do is select an icon or a whole passel of them
(below, left), and choose a color from a menu. The color choices are hidden
in the File menu, as shown here (below, right).
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Find•••
Show Original
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Print Window••

Two questions, then: (1) How do you change the colors and labels into something more useful, and (2) what's the point?
Well, most people never bother with labeling their icons. You could argue,
though, that it makes life more convenient since you can use the Sherlock
command to search for a file that has a certain label. You might give one label
to everything related to, say, a certain book project - Saddam Hussein: The
Sensitive Side - and then, when it's time to back up your work, use the
Sherlock command to round up all files with the Hussein label so you can
copy them all at once. (Or, when the project is over, you could happily delete
them all at once.)
Anyway, if you do want to use this feature, you'll probably want to change the
labels Apple suggests (Essential, Hot, In Progress, and so on) to something
more useful. Here's how: From the Edit menu, choose Preferences. In the
window that appears, click the Labels tab. You'll see a list of the label
choices, something like this:
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To change the wording of a label (remember that you're actually changing the
wording of the Label menu), just double-click a label and type something new.
To change the color, click the color swatch; a dialog box appears where you
can select a new color by clicking.

Window--Mania
Your iBook doesn't run Windows; it runs the Mac OS. But that's ironic,
because even though the iBook's operating system software isn't called
Windows, it's really good at doing windows. How do we love them? Let us
count the ways ...

Views and window preferences
One famous aspect of the Mac is the degree to which you can tailor it to your
tastes. You can make it look user-chummy and kid-friendly, or you can make
it look high-tech and intimidating.
For starters, you can change the typeface used to display the names of your
icons. If your vision is going - or you're trying to demonstrate the iBook to a
crowd - make the font huge. If you want to fit as many icons as possible per
square inch, pick a tiny, compact type style.
To adjust this typestyle, open the Control Panels (from your ti menu); open
the one called Appearance. Click the Fonts tab. Now you get three pop-up
menus, including one that controls the fonts for your menus and your icons.

_ _ _ _ _ __
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Go wild with these options. A couple of possibilities are shown here.
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You might notice that the "look" in the second example is strikingly idiotproof: big bold icons. If you could actually click the page of this book, you' d
furthermore discover that one click on each of these "button" icons opens it,
instead of the usual two.
That window got that way only after judicious tweaking - somebody chose
the as Buttons command from the View menu.

Meet Mr. Window
Here's a map of a typical iBook window.
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Now, since I'm not exactly sure that "Secret tuggable edges" and "Clicky windowshade roller-upper" are the actual official computer terms for these
features, let me explain:
"' Secret tuggable edges: In the olden days, you could move a window
around the screen only by clicking its striped title bar. Today, however,
you can actually hold your mouse button down on the thickened edges
of each window - and move the window by dragging.
"' Clicky windowshade roller-upper: Click this tiny square in the upper
right of any window to make the window itself disappear - all except
the striped title bar. The effect is like the Cheshire cat in Alice in
Wonderland disappearing completely except for his smile, except that
this is actually useful. By judiciously clicking the clicky windowshade
roller-uppers, you can hide and unhide a bunch of windows with
aplomb, easily burrowing your way around without losing sight of the
big picture.
(If you press the Option key as you click this button, you roll up all of

the windows in the current program - a great technique if you're in a
hurry to hide what you're doing. Option-click again to restore them.)
"' Scroll bar handle for better icon scenery: You may remember from
Chapter 1 that the little square box inside a scroll bar lets you view
what's hidden in a window -what's above or below what you're seeing,
for example. (Man, I sure hope you remember - otherwise, you've been
using your iBook all this time without ever writing a memo taller than
three inches.)
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But on the iBook, if you drag this handle slowly, you actually see the
icons moving by, so you're much less likely to overshoot.
Scroll bars? You don't need no steenkin' scroll
bars! You can move around inside a window just by holding down the 3C
key while dragging anywhere inside. In other words, you can actually
shift your view in a window diagonally (instead of having to use one
scroll bar at a time).

Y" Handy 31:-draggy area:

See the tiny folder icon in the title bar (in the previous picture)? It's a handle. You can use it to drag the open window to
another place, such as your backup disk or (in the case of perfectionist
computer-book authors) directly to the trash.

Y" Title-bar mini-icon:

When you're looking at a window in a list
view, you can make the columns of information bigger or smaller by
dragging the tiny divider lines, indicated by A in this picture.

Y" Rearrangy columns 'n' things:

A

• 61 Help
I>
I>
I>
I>

Q

G1

ExteMIOns
Preferences

Ql Appeoro nce
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c
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Todty
Todoy
613/ 98

6 System
Gl Appl e Menu Items

In fact, you can even rearrange the columns - putting the Kind column
before the Size one, if that suits you - just by dragging the column
headings around, such as B in the preceding picture.
Okay, while we're engaged in dead-horse beating, one more thing: You
can click the tiny pyramid (marked C) to reverse the sorting order from Z to A, for example, instead of A to Z.
Now we can all get a good night's sleep.

Poppin 1 fresh windows
Windows do something else funky, too: They pop. lf you drag a window to the
very bottom of the screen, something bizarre happens.
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... and the window turns into a tab.

Sure enough, your little window turns into a tab. If you click this tab, the
window shoots up like a strawberry Pop-Tart; click the tab on top again, and it
crumbles back down into its former tab position. The point of this is that you
can turn several windows that you use a lot into bottom-feeding tabs, like this:
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And then you can rapidly switch among them just by clicking tabs. (You
don't have to collapse one popped-up windowette before popping up the
next - the iBook automatically closes one when you click the next tab.) Try
setting up frequently accessed windows this way, such as your Programs,
Launcher, and Documents folders.
Oh, by the way: To turn a bottom-hugging tab back into a full-fledged window,
just tug Its tab way high up into the middle of the screen. No problem.

The iBook Keuhoard: Not
Your Father's Tupewriter
If you've never used a computer before, you might be bewildered by the

number of keyboard keys. After all, a typewriter has about 50 keys; your
iBook has 77 of them.
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Only some of the bizarro extra keys are particularly useful. Here's a list of the
oddball extra keys and what they do.

The phantom ke1J.board
Normal, desktop-bound computer keyboards have a numeric keypad, a separate bank of number keys off to the right of the main keyboard. These
number keys do exactly the same thing as the number keys across the top of
the keyboard. But after some practice, typing stuff like phone numbers and
prices is much faster using this number pad than using the top keyboard row.
The iBook doesn't have a separate bank of number keys, jutting off into space
beyond the laptop's right edge; if it did, you'd give the airline passenger to
your right one helluva thigh bruise. Instead, the iBook's number pad is superimposed on the normal alphabet keyboard. If you've spent much time staring
mindlessly at the milky white iBook keys - during the final hours of a plane
flight, for example, after your battery has died -you may have noticed that
the keys on the right half of the keyboard have two labels each. In black lettering, you see normal letters (J, K, L, and so on); in blue or orange lettering,
you see numbers and other labels.

Fn: the temporarlJ number pad
You turn the right-side keys into a number pad whenever you're press the Fn
(Function) key, which is in the very lower-left corner of the keyboard. Look,
for example, at your letter U key. If you press it normally, you type the letter
U. But if you press it while the Fn key is down, you get a number 4.
But what if you have a whole long list of numbers to type? Certainly you don't
want to have to hold down the Fn key nonstop. Fortunate ly, the iBook is ready
for you: if you press the F5 key on your keyboard, you enter Num lock mode.

Num Lock: the permanent number pad
In Num Lock mode, the tiny light next to the F5 key turns on. At this point, all
of the normal letter keys stop working! You've turned your entire keyboard
into a number pad; only the color-coded keys work now. You can type numbers quickly and efficiently as you press these color-coordinated keys. Press
the U key, and you get the 4, and so on.
If, in the process of doing your number-crunching, you want to type a normal

letter key, hold down the Fn (Function) key in the lower-left corner of the
keyboard as you type just that one letter. Finally, to exit Num Lock mode for
good, press the F5 key again. The light goes out, and your keyboard works
normally.
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More Fun with Fn
You know now that the Fn key ( lower-left) is a temporary Num Lock trigger.
Here are some other keys that spring to life when you press Fn:

Home, End
"Home" and "End" are ways of saying "jump to the top or bottom of the
window." You trigger this function by pressing the left-arrow or right-arrow
key (at the lower-right cluster of the keyboard) along with the Fn key.
If you're word processing, the Home and End keys jump to the first word or
last word of the file, respectively. If you're looking at a list-view window full of

files in the Finder, they jump you to the top or bottom of the list.

P9 Up, P9 Down
These keys mean "Scroll up or down by one screenful." Once again, the idea
is to let you scroll through word-processing documents, Web pages, and lists
without having to use the mouse. To trigger this function on the iBook, press
the up-arrow or down-arrow keys in the lower-right keyboard cluster - along
with the Fn key.

The ··Just say no·· keystroke
There's a wonderful keyboard shortcut that
means no in iBook language. It could mean No,
I changed my mind about printing (or copying or
launching a program); stop right now. It could
mean No, I didn't mean to bring up this dialog
box; make it go away. Or: No, I don't want to
broadcast my personal diary over worldwide
e-mail/ Best of all, it can mean Stop asking for
that CO/ I've already taken ft out! Be gone!
And that magic keystroke is ac-period (.).
When you begin to print your Transcripts of
Congress, 1952-2000, and you discover - after
only two pages have printed - that you accidentally spelled it "Transcripts of Congrotesque"
on every page, ac-period will prevent the

remaining 14 million pages from prmttng.
Because the iBook has probably already sent the
next couple of pages to the printer, the response
won't be immediate - but it will be light-years
quicker than waiting for Congress.
Or let's say you double-click an icon by mistake.
If you press ac-period right away, you can halt
the launching and return to the Finder. And if the
iBook keeps saying, "Please insert the disk:
Purple Puppychow" (or whatever your CD,
floppy, or Zip disk was called), you can tell it to
shut up by doing that ac-period thing over and
over again until the iBook settles down with a
whimper. Show it who's boss.
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Clear
Clear means "get rid of this text I've highlighted, but don't put a copy on the
invisible Clipboard, as the Cut command would do." To trigger this phantom
key, hold down the Fn key, and then press 6.

Other kev.s v.ou'fle probablv.
ne'1er seen before
Once you're past the concept of a superimposed keypad, grasping the purpose of other, non-Fn-key keys should be a piece of cake. Here are the other
iBook keys not found on a typewriter:

,,_, Esc: Esc stands for Escape, and it actually means "Click the Cancel
button," such as the one found in most dialog boxes.
Wanna try? From the View menu, choose View Options. Then press Esc,
and marvel as the box goes away.
,,_, Delete: This is the backspace key, as described in Chapter 3.
If you're coming to the iBook with experience using Windows PCs, by the
way, you may wonder where the Del, or forward delete, key went. The

iBook doesn't have one. ( Maybe that's why it was so inexpensive.) If you
pine for that key, visit www.macdownload.com to download KeySwapper,
which lets you designate a key of your choice to serve as the Forward
Delete key.
,,_, Return and Enter: In general, these keys do the same thing: wrap your

typing to the next line. Be careful, though: Some programs distinguish
between the two. In AppleWorks, for example, Return begins a new paragraph, but Enter makes a page break, forcing the next typing to begin on
a fresh page.
,,_, Command (S8): This key triggers keyboard shortcuts for menu items, as

described in Chapter 2.
,,_, Control, Option: The Control key triggers contextual menus, as described

in Chapter 2; the Option key lets you type special symbols (see Chapter 9)
and access secret features (discussed earlier in this chapter).

Fun with Function kev.s
The keys across the iBook's top row, called F-keys or fun ction keys, are, shall we
say, differently abled. Instead of typing letters, these keys ( Fl, F2, F3, and so
on) adjust the screen brightness, make the speaker louder or softer, open your
favorite programs, and do lots of other compute r-controlly stuff. You could
write a whole book just about them. (Function Keys For Dummies, anyone?)
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do well, however, to cuddle up with your function keys some rainy Saturday
afternoon and explore them yourself.

Ke1Js that adjust iBook settin9s
Almost every keyboard has a row of function keys. However, most function
keys on most Macs don't do anything! To make them do anything useful,
you're supposed to program them, train them, which usually involves pliers
and a couple of trips to Sears.
Some of the iBook's function keys, however, come ready to perform useful
tasks - no programming required. Check it out:

v Fl, F2: These keys make the screen dimmer and brighter, respectively.
(Making the screen dimmer isn't much fun, but it makes your battery
last a lot longer.)

v F3, F4: These keys make your iBook's speaker softer and louder,
respectively.

v F5: This key puts you into Num Lock mode, where none of the letter
keys work, and the right half of the keyboard becomes a number-typing
pad, as described in the previous section.

v

F6: Press this Mute key to turn off your iBook's speaker completely, so
that no accidental beep or duck quack will disturb those around you in
the library or operating room. Press the key again to restore the speaker
to its original volume level.

KelJS that don't do an1Jthin9
The remaining function keys, F7 through F12, aren't preprogrammed to do
anything special. And on most Macs, pressing these keys does nothing more
than exercise your fingertip.
On the iBook, however, F7 through Fl2 are interesting indeed. When you
press one of those keys for the first time this message appears:

The F7through F12 keys can be set up to open an
application, document, server, or other Item, such
as an AppleScrlpt.
You can set up the F7 t hrough Fl 2 keys In the
Keyboard control panel.
Do you want to open t he Keyboard control panel now?

0

Do not silo.., this dl• i"'l 0901 n

I Cancel I II

Open

I

_ _ _ _ _ _ _ _ Chapter 13: Great Material that Didn't Quite Fit the Outline

Restoring your function keys' original personality
On a normal computer, function keys don't adjust
the screen or speaker, as they do on the iBook.
Instead, they do much more function key-ish
things. For example, on a standard Macintosh,
the first four function keys (F1 through F4) trigger the Undo, Cut, Copy, and Paste commands in
most programs.
It's remotely possible that you, 0 Reader, do
more Undoing, Copying, and Pasting than
Adjusting the Brightness or Volume. How, then,
can you restore the first five iBook function keys
to their original purposes as function keys? In
other words, how you can you change the Fl key
back to an Undo command instead of adjusting
the screen brightness?

keys temporarily, just hold down the Fn key (in
the lower-left corner of your keyboard) as you
press one of the keys from Fl to F6.
Some people prefer to swap the function key
arrangement permanently, so that the function
keys adjust the brightness and volume only
when the Fn key is also pressed. To make it so
on youriBook, open the Control Panels (choose
Control Panels from the Apple menu). Open the
control panel called Keyboard. Click Function
Keys. Turn on the option called "Use F1 through
F12 as function keys." From now on, Fl is always
Undo, but Fn-Fl makes the screen brighter; and
so on.

Easy. You can override the built-in brightness/
volume feature either on a one-shot or permanent basis. To let your function keys be function

This dialog box is s aying, in its charming geeky way: "Hey listen, bud. I'm a
function key, but I don't know what I'm supposed to do. But I'll make a deal
with you: Pick a program on your hard drive right now. And from now on,
whenever you press this function key again, I'll launch that program ins tantly!
No need to thank me."
In other words, your iBook is suggesting that you assign your favorite programs to your function keys. You might rig it so that F7 opens AppleWorks; F8
takes you to America Online; and so on. You can even la bel them with the
plastic stickers included with your iBook, so that you can remember which
key does what. (Put the stickers on the iBook case, not on the keys themselves.) This aH may sound unnecessarily nerdy, but trust me: being able to
jump to your favorite programs just by pressing function keys is a glorious
time-saver.
If I've managed to convince you, then click the Open button. Now this dialog

box appears:
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Hot function Keys
function Key Mnpplngs
Ciiek e button to choose en Item for the key to open or di'$) the Item Into the box.
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Click an F-key button (F7, for example). Now you're shown a list of every file
and program on your entire hard drive. Navigate to the one you'd like this
function key to launch, using the navigational skills you absorbed so completely in Chapter 4, and double-dick it. (Instead of doing all that, you can
also just drag the icon of a file or program from your desktop directly onto
the white blank that says "Nothing Assigned.") Click OK.
That's it: your function key is now programmed to open that file or program!

Un-teachin9 IJOUr function kelJS
There may come a day, of course, when you decide that you don't want acertain function key to launch a certain program anymore, or you decide that
you want it to launch a different program. To re-teach one of your function
keys in this way, do this:

S menu, choose Control Panels. Open the control panel
called Keyboard. Click the Function Keys button.

1. From the

The window shown in the previous illustration appears.
2. To de-assign an function key (so that pressing it does nothing), click
the name of the program it's supposed to launch, and then click Clear.
To associate a different program or file, click the F-key button next to
the slot you'd like to change.
When you're finished , click OK.

Multiple Personalities (Mac OS 9)
You can read about the vast, seething blob of software known as Mac OS 9 in
Chapter 18. If you're too weary to flip pages, here's the gist: An OS, or operating system , is the software inside your System Folder that controls your
computer. Mac OS 9 is a modern, state-of-the-art new System Folder that adds
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several new features to your iBook. Original iBooks - those sold before
November 1999, for example- came with something called Mac OS 8.6. You
can get Mac OS 9 either by (a) upgrading, as described in Chapter 18, or (b)
by buying a new iBook, after November 1999, that comes with Mac OS 9
already on board. After all, you can never have too many iBooks.
Anyway, Mac OS 9 offers two dramatic improvements over its predecessor:
Sherlock 2, described in Chapter 7, and the Multiple Users control panel. If
you're the only one who uses your iBook, feel free to daydream during the following pages; the Multiple Users thing is exclusively for situations where
several people might use the same iBook, such as in classrooms, families, or
monasteries.

The bi9 idea
The Multiple Users feature works like this: When you turn on the iBook, you
see a list of everyone who uses the machine, like this:

•

Welcon1e to Mac OS
,

dp

HAROLD
Kelly
,

Tia

pi

Shutdown

.....:::..___J
Oumge Password

Loo In

Using the trackpad, you click your own name. (If the system has been set up
to require a password, you must enter it correctly before proceeding.) And
now the iBook's ready to use - except that only your folders, programs, and
documents show up on the screen. The stuff that belongs to the other students/children/ monks is hidden from your eyes.
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In every multiple-user setup, one person is the owner and administrator of
the iBook master - for example, the teacher, parent, or monsignor. This
person sees all the files and folders , as befits his or her exalted status. This is
also the person who sets up the Multiple Users feature to begin with. In the
following discussion, let's pretend that the master is you.

Settin9 up Multiple Users
Suppose three other people in your monastery share your iBook: the easily
overwhelmed Brother Brian; Harold, the seven-year-old altar boy; and
Giuseppe, the cybermonk who manages the group's Web site. Suppose you
want to set up the iBook so that each person gets a perfect setup. Here's how
you'd do it:
1. From the S menu, choose Control Panels. Open the control panel
called Multiple Users.

A dialog box like this appears:
- 8

Multiple Users

~---.~

dp
O'W'ner

( NewUser

J

Open

I Duplicate I
Delete

: I

Options

~~~~~~~~~~~~..._.

Multiple User Accounts: f> On

Q on

2. Click New User.
Now this box appears:
D

-

Edit "New User"

13

I

I

User Name: HAROLD
Password:
Kind of User Account

l

J
G~
Nor mal

I> Show Setup Details

[jj] [ii
Limi ted

Poroelo

Im
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3. Type Harold. (If you want to require a password before Harold can
use the laptop, type a password into the appropriate blank, too.)
Specify how much of the iBook world you want Harold to see by clicking Normal, Umited, or Panels.
This is a biggie. Not only can you specify which files and programs
Brian, Harold, and Giuseppe can use, but you can also simplify their
worlds. For Brother Giuseppe, the expert, you'll probably want to
choose Normal mode, in which the iBook environment looks exactly as
you see it every day, except that he can't change any of the Multiple
User options, as you're doing now.
For Brother Brian, you might prefer the Limited choice. Brian probably
won't notice much difference between his world and the Normal oneexcept that no control panels show up in his S menu. Furthermore, two
folders show up on his desktop, one containing his documents and the
other containing the programs he's allowed to use. (You'll specify these
programs in Step 5.) This arrangement makes it easy for him to find his
own files.
For little altar boy Harold, on the other hand, you'll probably want the
Panels option. When Harold turns on the laptop, he'll see nothing but
two big windows - one containing his documents, the other his programs. It looks like this - his chosen programs listed in the left window,
the documents he's created in the right:
• •

6:11 PM A

m e Edit View specl•I Help

Items

Ill

HAROLD

HAROlO

A Zillion KaJlihon
Rhymes

Adobe
Photoshop® ...

Amenca Onhne

Apple Works

Picture I

Shared
Documents

Claris Emailer

Clans Home
Page
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The window expands to reveal an army of additional options. If you
click the User Info tab, for example, you can choose a small picture that
will appear next to Harold's name on the sign-on screen. For help
comprehending all these other options, use the built-in help screens
(which appear when you click the question-mark symbol in the upperright corner of the window).
Now it's time to specify which programs little Harold will be permitted
to use.

5. Click the Applications tab. From the list of programs that appears,
turn on the check boxes of those you want available for the person
whose account you're setting up.
If you think about it, this ability to include only Harold-appropriate programs can be a real blessing. He doesn't have to wade through a bunch
of software he doesn't use, and your stuff is protected from accidental
seven-year-old meddling.

6. Close the window.
You return to the Users list. To create a similar setup for Brother Brian,
click New User, and then start over from Step 3. ( In Step 3, you'll probably want the Limited option.)

7. Turn on the entire Multiple Users feature by clicking the On button at
the bottom of the window.
(If Harold, Giuseppe, and Brother Brian go off on an evangelistic mission
somewhere, by the way, you can turn off the entire Multiple Users apparatus by clicking the Off button here. When they return, you can turn the
feature back on again; your settings and setup will be restored.)

Usin9 the Multiple Users feature
At last, you're ready to roll. From now on, whenever you turn on or wake up
the iBook, you'll see the list of people with whom you share this iBook.
Double-click your own name; type in your password, if you set one up in
Step 3; and you're in your private, pre-established world.
People to whom you've turned on the Limited or Panels options will frequently encounter a message that mutters something about not having
enough access privileges. For example, Brother Brian will get that whenever
he tries to open a program that wasn't one of the ones you checked in Step 5.
And little Harold will find that he can't save new documents he creates anywhere except in the Harold folder on the desktop. And everyone will see only
his own files - even people to whom you've given Normal access - except
you, the master. You see every file on the computer. The power - the power!
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When you're finished working, by the way, don't shut the machine down;
instead, trackpad your way up to the Special menu and choose Log Off. The
list of iBook-sharers returns, and the cycle begins anew!

Simple Finder: An easier way to simplify the iBook
All of the Multiple Users stuff is a useful way of
setting up an iBook for a kid, student, or technophobe doesn't want to have, or shouldn't have,
full access to all aspects of your iBook.
If that someone is you, however, there's an easier
way to make the iBook easier. This option provides a streamlined, simpler Finder, where the
menus are shortened to bare technophobefriendly essentials, like Empty Trash and Shut
Down. (Some of the missing commands: Make
Alias, Close Window, Labels, Sleep, Get Info, and
so on. Their keyboard equivalents, such as pressing 'a'l.-W to close a window, don't work, either.)
To try out this Simple Mac view, choose the
Preferences command from the Edit menu; in

the dialog box that appears, turn on Simple
Finder. (Turn it off again the same way.) Even
though the Sleep command is missing from the
Special menu, you can still put the iBook to
sleep just by closing it
Once you've entered Simple Finder mode,
please don't forget that you've done so.
Because many standard iBook commands are
hidden from the menus in Simple Finder mode,
you won't be able to follow many of the lessons
in this book when in Simple Finder.
Put another way, sometimes Simple Finder isn't
so simple after all.
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Jn this part ...
iBook is a particularly gregarious little machine.
¥I lour
it likes nothing better than to sidle up to some other
piece of machinery and talk to it.
Fortunately, this baby's got more connectors than 1-95.
Take USB, Ethernet, and wireless AirPort hookups, for
example: you may not know what they are now, but you
will I 0 pages from now.

Chapter 14

USB, Ethernet, and Other
Impressive Connections
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
.... Connecting your iBook to one other computer using Ethernet
.... Connecting your iBook to other Macs in the same office
.... Plugging in add-on USB gadgetry

• •• •••••••• • • • • •••• •••• ••••••••• • ••• ••••••• ••••••

~e iBook doesn't have a floppy drive built in. But if the object of using

I

floppy disks is to transfer files from your iBook to another computer, the
lack of floppy drive is no big deal. The iBook can connect to other machines
in several different ways:
,,,,., By attaching a file to an e-mail message, as described in Chapter 8.
,,,,., By sending files through the air, using the AirPort radio transmitter (s ee
Chapter 15).
,,,,., By attaching a disk drive (such as a Zip drive, SuperDisk drive, or external hard drive) to the iBook's USB connector.
,,,,., By connecting your iBook and another computer using an Ethernet
cable.
This chapter shows you how to make connections using the last two methods.

USB Nimble, USB Quick
The 150 Macintosh models that came before 1998 had all different kinds of
connectors: a printer jack, a modem port, a SCSI connector, an ADB port, and
so on. They had all different shapes, and required all different cables. You
were s uppos ed to know what these jacks were for, what cable to use, what to
plug into each one - and when to plug things in (that is, only when the computer is turned off, to avoid damage). Life was complicated - even more so
than usual.
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In the place of all those connectors, the iBook offers one jack - called USB.
(USB stands for Universal Serial Bus, but that won't be on the exam.) When
compared to the older-style Macintosh jacks, USB offers a million advantages:

v You can safely plug and unplug USB gadgets from your iBook without
turning off the computer first. ( If you try that on a regular Mac's keyboard or SCSI jacks, you could turn your $3,000 computer into a $3
garage-sale item.)

v You don't have to know which jack gets which kind of gadget (printers,
floppy drives, modems, joys ticks, scanners, speakers, digital cameras,
keyboards, microphones, mice, and so on). On the iBook, they all go into
your USB jack. (Okay, only one at a time - but see "Attaching more USB
doodads" later in the chapter.)

v Many USB gadgets draw power from the iBook itself, sparing you the ugliness and hassle of power cords and plugs for all your external equipment.
For a sampling of USB-ready gadgets, see Appendix B.

lnstaltin<J a new USB doodad
Like most computer add-ons, many USB gadgets come with s pecial software to
place on the iBook itself. You'll find this software, if it's necessary, on a CD
that came with your USB gadget. Just insert the CD and look for an icon called
Installe r; double-click the icon and follow whatever instructions appear.
After you've installed the software, connect your gadget to the USB jack on
the iBook. It's a small, rectangular, horizontal connector on the left side of
the machine (as you look at the screen), marked by a three-pronged tree
symbol. If the circuitry gods are smiling, your USB device should now work
as advertised.

How to plug older Macintosh
equipment into your iBook
The question always comes up: "I've got a
favorite keyboard/mouse/printer/digital camera
that's designed for a pre-USB Macintosh. How
do I plug it into my iBook?"
Easy: By using USB adapters, little connectors
that translate between the Macintosh gadgets
you already own and the iBook's USB connectors. Appendix B lists a bunch of these.

Someday, however, no adapters will be necessary; from this day forward, all Mac models
include USB jacks, and therefore every kind of
add-on gadget alive will eventually be available
in a USB version.
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Attachin9 more USB doodads
If you use your iBook as your main computer at home, you may find only one
problem with your USB connector: There's only one of it. Maybe you've

plugged your printer in there - great - but now where are you supposed to
plug your scanner?
Easy: buy an adapter box that gives you more USB jacks. Those so-called USB
hubs multiply your USB jack so that you wind up with four, eight, or even
more jacks. Connect enough of these hubs to one another, in fact, and you
can have up to 127 USB gadgets connected to your iBook all at once. (There's
no need to fiddle with ID numbers, termination plugs, or cable flakiness, as
there is with SCSI. And if you have no clue what those things are, thank your
favorite deity -you missed a very unpleasant era.)
Appendix B lists a few of those hubs, along with their prices and photos.

Ethernet Made Eathtj.
Ethernet, a special kind of computer-to-computer connection, is fast, easy,
and fun to pronounce. It lets you copy files between your iBook and another
Mac just by dragging the files ' icons, which comes in handy when you want to
make backup copies, distribute your work to a coworker, or copy files from
your iBook to a desktop Mac.

Before you read on, grasp this: It's very, very easy to connect your iBook
directly to another computer, requiring only a single, inexpensive cable. It's
much, much more complicated to set up an entire network of Macs in an
office, requiring a $50 adapter box and a bunch of cables.
Nonetheless, you paid good money for this book (or visited a good library).
I won't let you down: I'll lead you by the brain, step-by-step, through both
scenarios.

Connectin9 to one other Mac
To connect your iBook to one other Mac (or even another iBook), you need
an Ethernet crossover cable. (It's not the same as a regular Ethernet cable.)
You can get such a cable for $10 or less at computer stores like CompUSA or
from a mail-order joint such as Global Computer Supplies, at 310-635-8144.
This yellow cable is an excellent item to stuff into your iBook's carrying case,
by the way. Having it means that wherever you may travel, you'll always be
able to connect to other computers.
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Step 1: Get the cable
Plug your Ethernet crossover cable into each computer's Ethernet jack.
That's the hole on the left side of your iBook that looks like an overweight
telephone jack.

Step 2: Set up the iBook software
Next, turn your attention to the software on the Macs involved. The Mac's
networking software is amazingly sophisticated. You could spend days setting up passwords, different degrees of access to different folders on each
Mac, and so on - and many professionals do.
But if you're the only person who uses your iBook, all that rigmarole is
overkill. If you have two Macs - an iBook and an iMac, let's say- then
you're probably more interested in some fast-and-easy system of transferring
files between them.
For clarity, let's pretend that you're seated at an iMac and want to bring the
iBook 's icon onto the screen. ( You could just as easily reverse the procedure.)
Fortunately, you have to go through all of the following steps only one time!
Thereafter, you'll be able to connect the computers with a quick double-dick.
Follow these steps on the iBook:
I. Open the AppleTalk control panel (from the Control Panels item in

your ti menu), choose Ethernet from the pop-up menu, close the
window, and save changes.
You may be asked if you want AppleTalk turned on; you do.
2. Open the Ftle Sharing control panel and, in the Owner Name and
Computer Name blanks, type your name and a name for the iBook.
If you're the only one who uses this iBook, use a short, easy-to-type

name for yourself, such as your initials or "me." (Leave the password
blank for this security-free scenario.)
3. Click the upper Start button, close the window, and save your
changes; when you're warned that you haven't specified a password,
just click OK and get on with your life.

Step 3: Set up the iMac
Your iBook is ready for action. Here's how you bring the iBook's icon onto the
iMac's screen (follow these steps on the iMac):
I. Open the AppleTalk control panel; make sure Ethernet is selected in

the pop-up menu; close and save.
Again, let the machine turn on AppleTalk if it proposes doing so.
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2. Open the File Sharing control panel; type the same name that you
used in Step 2 of "Set up the iBook software"; close the window, clicking OK if you're warned about the lack of password.
3. From the ti menu, choose Network Browser. In the window that
appears (below, left), double-dick the name of your iBook. A window
appears, showing your name (below, right); click Connect.
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The iBook's hard-drive icon now appears in the Network Browser
window. Double-click it to open the iBook's window - even though
you're seated at a different computer!
You can use the iBook's contents as usual. To copy a folder, for example,
just drag it from the iBook window into an iMac window, or vice versa.
To save time the next time, make an alias of the iBook drive icon, which is
now on your iMac's screen. (See Chapter 13 for details on making aliases.)
The next time you want to hook up, you won't have to bother with any of the
steps you've just read. Instead, just double-click the alias you just made and
click OK. The iBook's hard drive icon pops onto your screen.
Oh, and one more thing: If your machines aren't both turned on and connected by the Ethernet cable, you may see a mysterious message at startup.
Just click OK; if necessary, restart one or both computers. (Next time the
iBook is connected and turned on, no message will appear when you turn the
iMac on.)
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Creatin9 a real, Ihle, full-office
Ethernet network
You've been warned: The following setup isn't simple or inexpensive. It's not
technically difficult, but you'll do a lot of muttering about the number of steps.
Suppose you have an iBook, an iMac, a Power Macintosh, and a laser
printer - not to mention an office in which you'd like to wire all of this equipment together. Visit your local computer store (or computer-stuff Web site,
such as those listed in Appendix A) and buy an Ethernet hub, which will set
you back about $50, depending on the number of jacks it offers. (Ethernet
hubs usually offer between 4 and 24 jacks, or ports. You need one port for
every gadget you hope to connect.)
Also buy enough Ethernet (or "lOBaseT") cables, in long enough lengths, to
connect all your Macs and printers to the hub.

8i9 Step 1: Wire IJ,OUr office
Most people try to hide the hub and its ugly mass of wires by stashing it in a
closet. Some even hire an electrician to snake the Ethernet cables through
the walls, once again attempting to save themselves from the techno-ugliness
of exposed wires.
When the dust settles, however, every computer and laser printer should be
plugged directly into your hub box. The hub is the octopus body; the wires
are its arms; your computers are its fingertips. (Don't plug any computer
directly into any other machine.)

8i9 Step 2: Girle each computer an identit1J
Sit down in front of one computer. Turn it on. Follow these setup steps:
1. Open the AppleTalk control panel, choose Ethernet from the poJ>-up

menu, close the window, and save changes.
You may be asked if you want AppleTalk turned on; you do.
2. Open the control panel called Users & Groups. For each person who
works in your office, click New User, type that person's name and
chosen password; and close the New User window.
If you're not worried about security- that is, if it's okay for everyone on
the network to see what's on everyone else's computer - don't bother
with that second sentence. Instead, just double-click the icon called
Guest; from the Show pop-up menu, choose Sharing; and turn on the
option called "Allow Guests to connect."
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3. Open the File Sharing control panel. In the Owner Name blank, type
the name of the person who uses this computer. Also fill in the
Password and Computer Name blanks. Click the upper Start button,
close, and save.
The name and password should match what you typed in Step 2 for this
computer. In other words, if this is the computer that Jesse Ventura will
use, type that name exactly, and the same password you created for
Jesse in Step 2.
4. Highlight your hard-drive icon (Macintosh HD). Click the File menu,
slide down onto Get Info, and then click Sharing. Turn on the "Share
this item and its contents" check box; close the window; click OK to
save the changes.
Rather than making your entire hard drive available to other people on
the network, you could instead begin this step by highlighting only one
folder. Thereafter, your office mates would be able to access, over the
network, only what's in the folder.
5. Repeat Steps 1, 2, 3, and 4 for every computer.
Now you're set up. Rent a video; you've earned it.

8i9 Step 3: Connect
The setup is complete! Now you're ready to try the network you've created.
I. Invite your coworkers in to see your handiwork.

If it's just you, skip this step.

2. From the

S menu, choose Network Browser.

If you've properly prayed to the Ethernet gods, the names of your other

computers now show up in the list.
3. Double<lick the name of the computer to which you want to connect.
A window appears in which you're supposed to identify yourself.
4. Click Guest, if that button is available. If not, type your name and
password, as you've previously established them. Click OK.
The hard-drive icon of the computer you selected (or folder icon, if
that's what you highlighted in Step 4 of Big Step 2) now appears in the
Network Browser window. Double<lick to open it and play with the files
inside as usual.
You've made it through alive! If you had hired a consultant to set up your network, you'd have paid several hundred dollars.
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As a reward, you're now free to enjoy any of the following activities:
Y'

Open the distant computer's hard drive icon; you can open, trash, copy,
rename, or reorganize the files of that computer, even though it's down
the hall or across the room.

Y'

Make an alias of that distant computer's hard drive icon, as described in
Chapter 13. Put the alias on your desktop somewhere. Next time you
want to access its contents, just double-dick the alias, saving you several of the steps above.

Y'

Shut down the computers, cancel your subscriptions, and move to an
Amish community.

Chapter 15

Wireless Networking:
Your Ride to the AirPort
•••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
.... Connecting to the Internet from the comfort of your own car, backyard, or bathtub
.... Setting up a fleet of iBooks to share a single Internet connection using an AirPort Base
Station
.... Playing games or transferring files between two iBooks - through thin air
..,. Setting up an iBook or Power Mac G4 to serve as a base station

•••••••••••••••••••••••••••••••••••••••••••••••••

I Jou~asyoung
kids today-you don't know how lucky you are! Why, when I
¥
your age, I used to have to dial the Internet by plugging my computer
into a telephone jack in the wall!

As you may have heard, however, the iBook is considerably less restricted. If
you look closely into the translucent plastic on either side of the screen,
you'll see the faint dark lines of the built-in radio transmitter antenna that
gives the iBook its wireless smarts. Using these antennas, you can perform
any of these amazing stunts:
6"

Surf the Internet without any wires attached to your iBook. You can be
walking around, or sitting, anywhere within 150 feet of your desk.

6"

Play multiplayer Macintosh games with other iBook owners - without
having to physically connect them.

6"

Copy files between your iBook and other Macs - again, without any
wires.

6"

Let five, ten, or even more iBooks surf the Internet simultaneously over a single phone line.

6"

Share such pricey, high-speed Internet connections as cable modems or
DSL connections (if you had someone come over to install one of those,
you'd remember) among a bunch of iBooks, iMacs, or PowerMac G-4
machines.
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All of these miraculous features come courtesy of an Apple gizmo called an
AirPort Card. Once it's set up, this technology is simple to use. But before you

reach wireless Nirvana, you'll be nipped by the following Two Downsides of
the AirPort: first, going wireless requires that you buy some add-on gadgetry.
Second, each of the above-mentioned setups requires setting up - a task substantially more complex than programming your VCR. With time, patience,
and this chapter before you, however, wirelessness shall be yours.

lnstallin9 an AirPort Card
Your iBook can't do any of the wireless stunts described in this chapter without an AirPort Card, which costs $100. An AirPort Card looks like a Visa card
made of sheet metal. You can buy it from an Apple dealer, from the Apple
Web site (www. apple.com), or from any of the mail-order joints listed in
Appendix A.

Where to 9et instructions
You have three sources of instructions for installing an AirPort Card: the little
manual that comes with it; the instructions that appear when you choose,
from the Special menu, Mac Help, and then search for AirPort; or the following
paragraphs.
I. Shut down the laptop. Open the keyboard by pulling the latches

toward you.
These white, ridged, plastic latches are tucked next to the Fl and F9
keys. If the keyboard won't budge, it's because somebody has locked the
keyboard shut. Using a jeweler's screwdriver, turn the tiny screw to the
left of the FS key counterclockwise to unlock it.
2. Flip the keyboard toward you, taking care not to rip it off its cables,
and rest it, keys down, on the trackpad area.
See the zig-zaggy wire thing in the middle of the iBook's inner
compartment?
3. Pull the zig-zaggy wire's middle top part toward you to unhook it, and
then flip it up out of the way.
The diagram on the right side of the compartment shows you how to
install the AirPort Card.
4. Press the AirPort Card into place according to the diagram: face up,
connector toward the front of the iBook.
Finish by clicking the zig-zaggy wire back down into place. Then flip the
keyboard upright, tuck the near edge back where it belongs, and finally
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push the top edge back down where it belongs. Slide the Fl and F9-key
latches toward you and then under the iBook case, where they were
originally.
Your data is almost ready to fly. Now you must install the AirPort software,
which came on a CD with the card - insert the CD, double-click the installer
in the CD window, and then restart the computer when you're told - and
you're ready for prime time.

Master the Control Strip
Many of the AirPort technology's best features require you to use the Control
Strip, whose existence I've hinted at several times in this book. Because you'll
be reading about the Control Strip frequently in this chapter, here's a
refresher:
The Control Strip is a horizontal strip of individual tiles, or modules, that control various aspects of your iBook. You open the Control Strip by clicking the
tiny gray tab that's hugging the left edge of your screen, like this:
Airl'vrflln
Open Air Port
•

Computer to Computer
U~tel ro Office Bese Stetion
Mr. Klenkse's Meth Cless

Then you click the AirPort tile - usually the first rectangle at the left edge to view its pop-up menu of options, as shown above at right. To hide the
Control Strip again, click the gray tab again.
And if you don't see the Control Strip at all, perhaps somebody turned it off.
From the ti menu, choose Control Panels, and then choose Control Strip.
Turn on the Show Control Strip option.

Goin9 Online with a Base Station
The best-publicized benefit of installing an AirPort Card is that wireless
Internet business. You stroll casually through the leafy courtyard, beaming
peacefully as you cruise the Web and send e-mail - without being connected
to anything. All the while, a tiny receiver way back in your office does the
actual dialing.
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Getting Other Macs to the AirPort
The iBook isn't the only computer that can be
equipped with an AirPort Card. You can also
install an AirPort Card into certain Power
Macintosh G4 or iMac models.
You can't install an AirPort Card into a
PowerBook (Apple's professional laptop) - at
least not if it was sold in 1999 or earlier. You can
come pretty close, however: you can buy a
Skyline card for it (www.farallon.com). This
card uses a slower version of the same wireless

technology, thus permitting a PowerBook to join
in on the wireless fun.
Once those machines are equipped with an
AirPort Card (or equivalent), they can do exactly
the same things an iBook can do, as described
in this chapter: exchange files, play games,
share an AirPort Base Station, serve as an
AirPort Base Station, and so on.

The base station idea
The actual name of that tiny receiver is the AirPort Base Station, and it'll set
you back another $300. (Don't freak out; not all of the AirPort Card's wireless
features require this extra gadget, as you'll read later in this chapter.) The
base station looks exactly like a shiny, chrome, six-inch flying saucer, as
shown here:

Instead of tiny aliens inside, however, the base station contains a built-in
modem. You're supposed to connect this modem to a telephone jack. (Be
sure you connect the phone wire to the modem jack on the base station, not
the Ethernet jack. The modem jack is s lightly smaller.) Your iBook can then
communicate with a base station from up to 150 feet away, even through
walls and floors. If you've ever owned a cordless phone, you'll recognize this
relationship: the base station is always plugged in, and the cordless part - the
handset, like the iBook - is untethered and free to move around the house.
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Suppose you're sitting in the TV room, for example, and you launch your Web
browser. When you click Sign On, your base station, upstairs in your office,
silently begins to dial. Now your iBook is on the Internet, fully connected at
full speed, without actually being connected by wires to anything.
The only thing left to do is to call up your friends and invite them to witness
this technological miracle. Too bad your phone line is tied up by the base station's modem!

Multiple connections
Having trouble justifying $300 for a base station? Consider this, ye with large
families or classrooms to teach: a single base station can accommodate ten or
more iBooks, all s urfing the Web simultaneously. (The more iBooks online
simultaneously, the more slowdown you'll begin to notice.) If there's a printer
attached to the base station's Ethernet jack, as described in Chapter 14, all of
those machines can print, too.
In fact, ye in schools or corporations, you can set up multiple base stations,
too, each with its own name, each capable of handling Internet connections
from iBooks. As you move around the building, the names of new base stations coming into range are listed automagically in your Control Strip. You
can switch your Internet connection from one of these base stations to
another just by choosing its name from the Control Strip.

Settin9 up lJOUr base station
Before you begin to configure your base station for an Internet connection,
you must first confirm that your iBook can get online the normal way: when
plugged directly into a phone jack on the wall or when connected to a cable
modem, for example. (During the setup process, your iBook will send its
how-to-get-onto-the-Internet information - your name, password, phone
number to dial, and so on - into the base station.) If you haven't yet set up
your laptop for this kind of connection, flip immediately to Chapter 6.
Once you've confirmed that your iBook is Internet-ready, plug in your base
station's power cord; run a telephone wire from the base station's modem
jac k into a phone jack on the wall. ( If you have a cable or DSL modem, connect it to the base station's Ethernet jack instead.)
To prepare your base s tation, just follow this simple recipe:
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AirPort Wireless Network Surprise
ln9redients
1 iBook, raw, with Internet
account signed up already
1 AirPort Card, installed

AirPort Setup Assistant program (inside your Assistants
older)
Yield: One wireless
connection

1 AirPort Base Station, who le
and unpeeled
1 phone jack and 1 piece of
telephone wire (may substitute
a faster Internet connection,
such as cable m odem)
1. Open your hard-drive window. Open the Assistants folder. Double-

click the AirPort Setup Assistant.
You see a screen like this:
0

::o- """'51 AlrPort Setup Assistant -

i

¥

:3

Introduction

r-------~1-This ossistont hol ps you get set up to use Al rPor t for YI reless netYorkl ng
ond Internet occess.

Do you Yont to:

0

Set up your computer to join on existing Yirel oss netYork.

@)Set up on Air Port Boso Stotlon.

0

Set up your computer to be on AirPort Soft'w'ore Bose Stotion.

If the option you Yont Is not ovolloble, check to moke sure thet your
computer is In r onge of on AlrPort Bose Stotlon end thet the bose stotl on Is
turned on. Thon click Seen Agoln end see If the option becomes ovoiloble.

ScanAgaln
Click the right orro"' to conti nue.

I

2. Click "Set up a new AirPort Base Station." Click the Next button (the
right-pointing triangle).
You're about to click your way through several screens, answering one
question at a time. ( This kind of setup program should feel familiar; it's
the same kind of Assistant that appeared the first time you turned on
your iBook way back in Chapter 1.)
On the next screen, the iBook asks: "ls this computer currently set up to
access the Internet?"
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3. If you have indeed established an Internet account, click Yes. Then
click the Next button.
If you haven't yet set up an Internet account, click No, and then click the

Next button. The iBook automatically leads you by the hand into the
Internet Setup Assistant described in Chapter 6; remember, you can't
teach your base station how to go online until you've first set up your
iBook to do so.
Now the Assistant asks: How is your computer connected to the
Internet?
4. If your base station is connected to a phone line, click "Standard
phone line connected to the computer's modem port," and then click
the Next button.
If your iBook is instead set up to connect to a cable modem, DSL line, or

other high-speed Internet pipe, click the Ethernet option instead. You
lucky duck!
On the next screen, you're asked to choose the Internet account you
want to use. Most people, of course, have only one Internet account
(EarthLink, for example).
5. From the Internet Settings popup menu, choose the name of your

Internet account. Click the Next button.
You now arrive at the Network Name screen.
6. Type a name and password for your base station. Click the Next
button.
Most people name the base station for its location: "Upstairs Base
Station," or "Mr. Mullen's Math Class."
AlrPort Setup Assistant
Netvork N1,.e end P..avord

~

I

i--------~l--1
You now need to give your Air Port networ k e nemo end poosword that others
'W il I use 'w'hen they ....nt to Join you r net'WOrk.

l

Net'w'o rk name: Upstairs Base Station

I•_•_••_•_••________,

Hetvor k f>M.''w'Ord: ...

Ver ify

p~s'w'ord: ._I•_•_••_•_•·------~
11

Ti p: for maxi mum protection, c reate e pa'3word that is 6 charecters or
greater In length and contain• a combinat ion of numbers, letters end

punctuation.
Cl ick the right ar row to conti nue.
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wirelessly to your base station. If that sounds like a drag, you can leave
the password blank. A warning will appear if you do so. It's there to
remind you that without a password, there's a remote possibility that
your next-door neighbor will be able to get onto the Internet using your
base station. (This scenario assumes that you live in a very tightly
packed neighborhood, that your neighbor owns and iBook, and that he's
smart enough to try logging onto your base station without a password.)
The password you've just invented is required to connect to the base
station - to use its Internet connection. This page of the Assistant, however, also offers to let you create a second password - one that will be
required to change your base station's settings in the future. This option
is designed for people who manage an AirPort network in a school or
company, to prevent scurrilous little minds from attempting to reconfigure the base station wirelessly. If it's just you in your home, the one
password suffices.
7. On the screen where you're asked if you want to join the AirPort network, click Yes. On the Conclusion screen, click Go Ahead.
Congratulations -you've successfully configured your base station. Let
the astonishment begin!

Connectin91 and disconnectin91
from the Internet
Grab your iBook. Walk away with it. Find a couch from which you've never
before surfed the Internet.
Go online like this:
1. From your Control Strip, choose the name of the base station with
which you'd like to connect.
Most people have only one base station, so you'll s ee only one listed,
like this:
Alr.Pt>rftln

Open Air Port

2. When the password box appears, type your password and then press
the Return key.
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If you didn't set up your base station to require a password, no password box appears.
3. Launch your favorite Internet program: Internet Explorer (for the
Web), Outlook Expr~ (for e-mail), America Online, or whatever.
As soon as you try to connect, your base station dials the number. (The
base station has no speaker, so you're spared the usual screeching, hissing, and so on. The outer two lights on the base station blink instead.)
Once the connection is complete, you should notice no difference
between Web surfing wirelessly and surfing ... wirefully.
While you're connected, you can check the status of your connection in several
ways. First, choose AirPort from your S menu. The AirPort application opens,
where you should see your base-station status reported as "Connected."
Second, you can check the strength of your radio signal to the base station either in the AirPort application in your S menu, or using the AirPort tile of
your Control Strip. The five dots show you your signal strength; five dots is
the strongest. The farther away you go from your base station, the weaker
the signal, and the slower your Internet surfing speed gets.
As advertised, the radio signal sent between the base station and your laptop
isn't fazed by walls - much. Glass, paper, and wood are invisible to the
signal, but concrete walls slow it down substantially. Solid metal is almost
impenetrable, much to the disappointment of iBook fans on elevators,
subway trains, and meat lockers.
When you're finished with your online session, you should probably hang up
the base station, so that the phone line becomes available again for things like
normal phone calls. You can hang up the base station in either of two ways:
Y' Choose AirPort from your menu; in the window that appears, click Hang

I

Up AirPort Base Station.

Y' Wait. After IO minutes of your not doing anything, your base station

hangs up automatically.

If you want to eke out every last iota of battery power, meanwhile, you may
even want to turn off your AirPort Card. To do so, choose Turn AirPort Off
from your Control Strip.

Usin9 Another Mac as a Base Station
You don't necessarily need to buy an AirPort Base Station to enjoy wireless
Net surfing with your iBook (although it's a very cool-looking gadget to have
on your desk). Strange as this may sound, you can use a second iBook as a
base station. You can even use an AirPort-equipped Power Macintosh G4 or
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late-1999 iMac as a base station. In other words, one computer remains tethered to the phone jack in your office to do the actual dialing, pretending to be
a base station. You prance through the house with your iBook unplugged,
merrily Web surfing.
If this arrangement appeals to you, sit in front of the tethered Mac (the iBook,
iMac, or G4 that's hooked up to a phone line). After installing the AirPort software, run that AirPort Setup Assistant program again. (It's in your Assistants
folder on your hard drive.) This time, however, on the main Assistant screen,
select the Software Base Station option. Once again, you'll be asked to set up
a name and password for this wireless network- a password you'll have to
type each time you hook into this machine's invisible Internet connection.
When you reach the end of the series of Assistant screens, you're ready to
begin. Pick up the unwired iBook. Open the Control Strip. From the AirPort
tile, choose the name you gave your deskbound computer, type the password, and then launch your e-mail or Web programs. The tethered iBook (or
iMac or Power Mac) acts as the home base, doing all the dialing.

Communicatin9 i8ook-to-i8ook
Web browsing and e-mail-sending aren't the only things your built-in antennae - that is, your laptop's built-in antennae- are good for. Without buying
a base station, and without connecting any phone wires to the wall, two
untethered iBooks can communicate with each other through the air.
(Actually, any two AirPort-equipped Macs can do this: iBook, iMac, Power
Mac G4, what have you.)
This arrangement makes two exciting features possible: first, you can trans fer
files back and forth among AirPort-equipped iBooks. Second, you can play
games against your friends - a feat you'd ordinarily have to be connected
(by network cables) to accomplish.

Sharin9 files with another iBook
As it turns out, creating a wireless network between AirPortted computers is
exactly like creating an Ethernet network, which is described at the end of
Chapter 14. There you'll discover how to set up a network in either of two
ways:

The easlJ. UlalJ., usin9 just two computers
In this scenario, you own both computers, and don't care about security,
because you're the only person with access to these machines. The instructions for creating a wireless connection between the two are almost exactly

________ Chapter 15: Wireless Networking: Your Ride to the AirPort
like those in "Connecting to one other Mac" at the end of Chapter 14. You'll
make only a couple of changes to the steps listed there, like this:
I. After installing the AirPort software on both computers, follow Steps

2, 3, and 5 of "Connecting to one other Mac" at the end of Chapter 14.
In other words, skip the two visits to the AppleTalk control panel.
2. Open your Control Strip. From the AirPort tile, choose Computer to
Computer.
3. Finish up with Step 6 of "Connecting to one other Mac" at the end of
Chapter 14.
The other computer's hard-drive icon now appears in the Network
Browser window. Double-click it to see its contents, which you can now
copy, delete, rearrange, or otherwise manipulate.

The full-scale, multiple-computer wireless network
Exactly as described in "Creating a real, live, full-office Ethernet network" at
the end of Chapter 14, iBooks and other AirPort-equipped Macs can be connected more elaborately in classrooms, companies, and other multiplecomputer situations. Also as described there, hooking all this stuff isn't for
the technically weak-kneed. But if you're determined to become the town
hero, here's how you do it:
I. Install the AirPort software on each computer. Follow Steps 2, 3, and 4

of "Creating a real, live, full-office Ethernet network" at the end of
Chapter 14. Repeat for every computer.
2. Open your Control Strip. From the AirPort tile, choose Computer to
Computer.
3. Fmish up with Steps 7, 8, and 9 of "Creating a real, live, full-office
Ethernet network" at the end of Chapter 14.
Once all of this is over, and you've had a good night's sleep, you'll be able to
open the Network Browser program to see the names of all other AirPortequipped computers within range (about 150 feet). You'll be able to bring the
hard-drive icons of those other computers onto your own desktop, exactly as
though they're CD-ROMs you've inserted into your own iBook, and play with
their contents. Without stringing up a single wire.
And Dick Tracy thought his video-phone watch was cool?

America Online flersus AirPort
Officially, you can't connect to America Online via your AirPort Card. AOL's
special dialing software doesn't use the iBook's standard dialing system.
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If you're willing to take a few setup steps, however, you can connect to
America Online wirelessly. Doing so requires that you also sign up for a stan-

dard Internet account through a company like EarthLink (see Chapter 6). Make
sure your iBook can connect to the Internet via such an ISP account, and then
set up your base station as described earlier in this chapter.
Now launch your America Online software. On the Welcome screen, click
Setup; click the "Set up AOL to sign on from a new location" button; click
Next; type a name like "AirPort connection"; click Next; click "Add a TCP connection"; click Next; and click OK. From now on, when you try to connect to
America Online, you'll connect via your Internet account. Behind the scenes,
your iBook actually dials your Internet company's local access phone number
instead of AOL's. As a result, you can now use your AirPort to connect to
America Online.
Actually, once you've set this up, you can enjoy two more differences. First,
you'll virtually never get busy signals, because behind the scenes, you're no
longer dialing America Online directly. Second, you're entitled to a huge discount on America Online service. The company is so thrilled to have you
connecting via somebody else's local access numbers that it's willing to cut
your AOL bill from $22 per month down to $10 for unlimited service.
To receive the discounted rate, connect to America Online, use keyword
Billing, and click "Change Your Billing Method." Specify the BYOA (Bring
Your Own Access) plan, which is $10 per month.
That tip was worth this book's price right there, don't you think?

More AirPort Info
This chapter gets you AirPorting swiftly and
charmingly. If you crave more detail, troubleshooting tips, or updates, consider these
three additional info sources.

Finally, Apple maintains its own Web site
that seethes with AirPort information,
some of it technical, some useful. It's at

First, check out Chapter 16's "AirPort Problems"
section for troubleshooting tips. Second, from
your Special menu, choose Mac Help, and
search for AirPort. You'll uncover several pages'
worth of useful tips from Apple on making the
most of this wireless wonderdog.

And if you still need more information, go to
engineering school.

www.apple.com/airport.
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When Bad Things Happen
to Good iBooks
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In This Chapter
.... The top ten problems that beginners encounter and how to solve them
.... The next ten after that
.,.. The next ten after that

•••••••••••••••••••••••••••••••••••••••••••••••••

Introduction to Computer Hell
As a new computer owner, you probably aren't cheered up very much by the
fact that this troubleshooting guide is the fattest part of the book.
But let's face it: Computers are appliances. As such, they have minds of their
own. And like other expensive appliances (cars, homes, pacemakers), they
tend to get cranky at the worst possible times.
Now, when that happens , most beginners immediately suspect the circuitry. I
understand the instinct. I mean, when VCRs, lawnmowers, or electric razors
go on the fritz, you're right - you need a repair shop. But a computer's different; it has so~ware. When your iBook starts behaving oddly, it's probably a
software problem, not a mechanical one. That means that you can fix it yourself, for free. Almost always.
This chapter and the next show the steps you can take to restore your
iBook's software to health.
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About the cookbook
It turns out that about 90 percent of the things
that go wrong with your iBook can be solved
using the same handful of troubleshooting
steps. To save you reading and me writing, I've

consolidated them all into Chapter 17. As
you read through this chapte(s symptom-bysymptom listings, I'll refer you to one or another
of those steps.

The i8ook Freezes or Crashes
Two scary conditions are enough to make even pro iBook jockeys swallow
hard. The first of these conditions, a System crash, occurs when the following
message appears on the screen.

So rry, o system error occurred.
"Finder"
unlmplementea trop

Your current work session is over, amigo; you need to restart the computer.
(Safest way to restart is to use "The Restart Keystroke," as described in the
next chapter.) Anything that you've typed or drawn since the last time you
saved your work is gone.
A System freeze is different - and, as horrific computer nightmares go, it's
preferable. You get no message on the screen; instead, the cursor freezes in
place. You can't move the cursor, and nothing that you type changes anything. The iBook, as far as you can tell, has silicon lockjaw.

Escapin9 a S1J.stem freeze ri9ht now
First resort: Try the amazing "Force Quit" keystroke. (See the section "The
Amazing 'Force Quit' Keystroke," in the next chapter.) That should get you
out of the locked program, at least.
Last resort: If the Magical Force-Quit Keystroke doesn't work- and it often
doesn't -you have to restart the iBook. This time, see "The Restart
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Keystroke," in the next chapter. Anything you've typed up but haven't yet
saved is gone forever - which is a pretty good advertisement for saving
frequently.

Escapin9 repeated Sl}.stem freezes
Ninety percent of the time, freezes and crashes are related either to memory
or to extension conflicts.

First resort: Increase the amount of memory allotted to the program that you
were using, as described in the section "Giving More Memory to a Program,"
in the next chapter. Give the program 10 percent more, for example.
Second resort: Something, or several somethings, are clashing in your
System Folder. See "Solving an Extension Conflict" in the next chapter. If
you're in a hurry to get your work done and can't take the time, just restart
your iBook while pressing the Shift key. That turns all extensions off. For this
work session, of course, you won't be able to use your CD-ROM drive, send
faxes, or go online, but at least you can get into your iBook and do basic stuff
without the hassle of system crashes.
Third resort: Maybe one of your programs is either (a) buggy or (b) out-ofdate. You can't do anything but contact the software company and hope for
the best.
La.st resort: If the crashes still haven't stopped, something in your System
Folder may be gummed up. You're in for a 20-minute, but very effective, ritual
known as a clean reinstall of your System Folder. For instructions, see the section "Performing a Clean System Reinstall," in the next chapter.

The Amazing Self-Repairing iBook
A system crash on an iBook is just as emotionally wounding as it is on any computer. Yet the
feeling doesn't last, thanks to what comes next.
As soon as your computer starts up again after
the crash, it gets to work repairing itself.
You'll see a big dialog box on the screen and a
progress bar showing how long the self-surgery
will take. In brief, your iBook is checking out its
own hard drive to make sure nothing was damaged during the system crash. If it finds anything
wrong, the iBook fixes it automatically. Since

this is all taking place immediately following the
crash, newborn problems get nipped in the bud,
before they can grow up to be big, strong, meateating problems.
You can turn off this feature, if you like; open
your General Controls control panel (see
Chapter 12) and click to turn off the check box
called "Warn me if computer was shut down
improperly."
But whywould you want to do that?
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Problems in One Pro9ram
If your troubles seem to be confined to just one application, your trou-

bleshooting task is much easier.

First resort: Give the program more memory, as described the section
"Giving More Memory to a Program," in Chapter 17.
Second resort: First, some technical background: Whenever you launch a
modern software program, it generally consults the preference file in your
Preferences folder. This preference file is where the program stores its little
notes to itself about the way you like things set up: where you keep your toolbars on the screen (if it's Microsoft Word), what your favorite Web sites are
(if it's Netscape Navigator or Internet Explorer), whether your prefer list
views or icon views (if it's the Finder) , and so on. If that file is damaged, so is
your work session.
Now, what do we do when our government's malfunctioning? We throw out
the components that aren't working and elect new ones. That's exactly the
idea here: Open your System Folder, open your Preferences folder, and trash
the program's preference file. The very next time you launch that program, it
will automatically create a new preference file. Best of all - and here's where
my political analogy breaks down - your new preference file is guaranteed to
be uncorrupted.
This trick is especially useful in that most frequently used program of all, the
Finder. The Finder Prefs file stores all kinds of settings important to your
iBook work environment: the font and icon-layout settings used for Finder
windows; window settings; whether or not the "Are you sure?" message
appears when you empty the Trash; and so on.
Therefore, if you start noticing weird goings-on with your icons, windows, or
Trash, try discarding the Finder Preferences file. Restart the iBook to generate a fresh, clean copy. (Of course, you'll also have to set up your preference
settings in that program again - make your favorite toolbars appear, choose
your favorite font, and so on.)

Last resort: If all else fails, try reinstalling the program in question - an
updated version, if possible.
It's also conceivable that one of your extensions or control panels is causing
trouble for this program. See "Solving an Extension Conflict" in the next
chapter. Finally, accept that fact that some popular programs -America
Online, for one - are simply buggy, and may freeze occasionally no matter
what you do.
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Error Messa9es
Let's start the troubleshooting session in earnest with a few good old
American error messages. Yes, kids, these are the '90s equivalent of "DOES
NOT COMPUTE." These are messages, appearing in an alert box like the fictional one shown here, that indicate that something's wrong.

R serious and mysterious problem has
deueloped, deep Inside your computer where
you'll neuer get at It.

IDOJ

"Application not found 11
First resort: Not everything on the iBook is meant to be a plaything for you;
the iBook reserves a few files for its own use. Certain items, especially in
your System Folder, give you the "Application not found " message if doubleclicked because they're there for your iBook's use, not for yours - such as
icons in the Preferences folder, for example, or various other support-file
icons for non-Apple stuff.
Second resort: In Chapter 3, you can read about programs and the documents
that they produce (like parents and children). Sometimes, the "Application not
found" message means that you're trying to open a document (child), but the
iBook can't find its parent (the program used to create it).
So if you double-click an AppleWorks document, but the AppleWorks program itself isn't on your hard disk, the iBook shrugs and asks, in effect, "Yo how am I s'posed to open this?" To remedy the situation, reinstall the missing
program on the hard disk.
More often, though, you're double-clicking something you downloaded from
the Internet or America Online - something created by someone else, using a
program you don't have. For example, let's say I send you a word processor
file , but you don't have the same word processor program I do.
To read such files, launch your word processor first and then choose the
Open command from the File menu (next figure, left).
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The usual list box appears, and you'll see the text file listed there (above,
right). Double-click to open it.
The same applies to generic graphics documents. These files, in technicalsounding formats like PICT, JPEG, and GIF, can be opened by almost any
program. (America Online or Netscape Navigator, for example, can open all
three.) Yet if you try to double-click a generic graphics file, you may be told,
"Application not found." (That's because graphics files can be opened by so
many different programs that the iBook doesn't know which one you want to
use.) Again, the solution is to launch your graphics program first (America
Online or Netscape Navigator, for example) and then open the file via the
Open command.

Third resort: Are you, by chance, trying to open a file that you received via
e-mail? In that case, you may be out of luck. The Internet has this unfortunate
habit of garbling e-mail attachments. (See Chapter 8 for more on e-mail, and
the end of Chapter 7 for more on opening downloaded goodies.)
Last resort: Sometimes you get the "Application not found" message even if
you're sure that the document's parent program is on the disk. (You doubleclick an AppleWorks document, for example, and you're told that the
application -AppleWorks - can't be found, even though it's sitting right
there on the disk in plain sight!)
In a situation like this, the iBook's genealogical gnomes have become confused: The computer has lost track of which program is associated with
which kinds of documents. In the words of Mac gurus everywhere, "You gotta
rebuild the desktop." For instructions, see the "Rebuilding the Desktop File"
in the next chapter.
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The only virus worth worrying about
There are plenty of reasons to be glad you use
a Macintosh. Consider computer viruses (software written by some sociopath to gum up the
works of any computer it encounters): while
10,000 different computer viruses attack
Windows-compatible computers, until 1998,
there was not a single virus that could destroy
Macintosh files.
Nowadays, there is one Mac virus - called
Autostart. If your iBook "catches" this virus,
you'll notice three odd symptoms: first, the iBook
restarts itself just after you insert a disk of some
kind. (That's your iBook coming down with the

virus.) Second, your hard drive starts thrashing
and making noise about every half hour. Third,
some of the files on your hard drive may become
corrupted and un-openable.
Fortunately, it's easy to protect your iBook
against this virus: From the S menu, choose
Control Panels and open the control panel
called Quicklime Settings. Turn off the CD-ROM
Auto-Play option. That's it - you're protected.
(It's perfectly okay to leave "Enable Audio CD
AutoPlay" turned on. That option makes music
CDs start playing when you insert them into your
iBook, and it's completely safe.)

"You are runnin9 low on memor1J. 11
Believe it or not, this message appears even on iBooks with boatloads of
memory. It doesn't mean that your iBook is running low on memory; it means
that your program is gasping for air, even though the computer itself has gallons and gallons of memory just sitting around.
Each program, when it comes from the factory, has been given a memory
limit. It's not allowed to use more memory than its limit, even if there's lots

available on the iBook.
Fortunately, you can change this limit; if a program you use often is acting
flaky, crashing, or giving "running low on memory" messages, you should

raise the program's memory limit. Complete instructions are under "Giving
More Memory to a Program," in the next chapter.

"Application has uneJtpectedllJ. i{uit11
Your program has probably run out of memory. Again, see the section in the
next chapter called "Giving More Memory to a Program."
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"Port is in use 11
If you've installed Palm Desktop (described in Chapter 10), you get this cryp-

tic message when you try to use America Online for the first time.
To avoid it, click the tiny green icon at the upper-right of the screen to open
the Palm Desktop menu. Slide down to the HotSync Manager command, and
from there to the Setup command. In the resulting window, click Disabled.
Close the window. You should now be able to use AOL without problems.

"You do not hafle enou9h
access priflile9es 11
First resort: Open the General Controls control panel. If "Protect System
Folder" or "Protect Applications Folder" is turned on, then you get the
"access privileges" message whenever you try to move an icon into, or out of,
the System Folder or Applications folder.
Last resort: Could it be you're using Mac OS 9, and somebody has turned on
the Multiple Users feature described in Chapter 13? In such a case, you get
the "access privileges" message when you try to open anything that you
haven't been explicitly permitted to use by the person who set up the iBook.

"DNS EntrlJ. not found 11 or "Error "0~

11

You get these messages when using your Web browser (see Chapter 7). It says
that the Web page you're trying to visit doesn't exist. Usually this means
you've made a typo as you typed the Web address (sometimes called a URL),
or the page's address has changed and you don't know it, or the computer the
Web page is on has been taken off the Internet (for maintenance, for example).

Numbered error messa9es
This may strike you as hard to believe, but the numbers in some error messages (Type 11 , Type 3, Error 49, and so on) are no help at all. They're
valuable only to programmers - and even then, not very. A few examples:
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Error code

Message

Meaning

-1

qErr

Queue element not found during deletion.

-2

vTypErr

Invalid queue element.

-3

corErr

Core routine number out of range.

-4

unimpErr

Unimplemented core routine.

As an Apple programmer once explained it, it's like finding a car smashed
into a tree with its tires still spinning. All you can say for sure is that something went wrong. But you have no idea what led up to the crash. Maybe the
guy was drunk, or distracted, or asleep. You'll never know.
Same thing with your iBook. The machine knows that something happened,
but it's way too late to tell you what. Restart it and get back to business.

Out of Memor~
As a service to you, the Tremulous Novice, I've gone this entire book without
even a word about memory management, which is a whole new ball of wax. 1
hoped that you'd never need to think about it. Memory becomes an issue
only when you get the message "There is not enough memory to open
AppleWorks" (or whatever program you're trying to open), and that's why
you're reading about memory in a troubleshooting chapter.
Your iBook has a fixed amount of memory. Think of the iBook as a station
wagon. You can pack it with camping gear, or you can pack it with your kid's
birthday-party friends - but probably not with both. Even if you manage to
cram in the kids and the gear, if you then try to cram in the dog, somebody in
the family is going to say, "There is not enough room to take Bowser."
That's what the "not enough memory" message is trying to tell you.
Each program that you open consumes a chunk of the iBook's limited
memory. You're entitled to run as many programs as you want simultaneously- the Note Pad, the Calculator, your word processor, and so on provided that they all fit into the amount of memory your iBook has. If you try
to open one too many programs , you'll get that message about the dog. (You
know what I mean.)
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Before we begin, remember that there are two different kinds of memory
shortages. First, there's the "You are running low on memory" type, which
indicates that a program doesn't have enough memory; see "Giving More
Memory to a Program" in the next chapter.
Second, there's the "Not enough memory to open this program" problem,
which means that your iBook's memory is all used up. The following discussion applies to this second scenario.

First resort: Quit pro9rams
If you're told that you're out of memory, the easiest way out of the situation
is to quit one of the programs you're already running. ( You quit a program by

choosing Quit from the File menu.) So if you're running Word and you try to
open AppleWorks, and you're told that there's not enough unused (free)
memory, you'll just have to quit Word first.
Often, you may have programs running and not even know it. Remember that
just because a program has no windows open doesn't mean it isn't running.
When you're done working on something, did you just close the window, or
did you actually choose Quit from the File menu? If you didn't actually Quit,
then the program is still running and still using up memory.
To get rid of that program, choose its name from the Application menu (in the
very upper-right corner of the screen) . Then choose Quit from the File menu.

Second resort: Defra9ment IJ.OUr RAM
Imagine an obnoxious driver who parks on the divider line, thus occupying
two parking spaces. Half a parking space is wasted on either side. Those two
wasted gaps, when added up, equal one whole parking s pace - but that's of
no help when you want to park your whole car.
In the same way, your iBook's memory can get broken up into pieces as you
launch and quit various programs during the day. Suppose your System
Folder is using 12, then there's an empty block of 4, then America Online is
using 8, then there's an empty block of 4, and so on. You might try to launch,
say, AppleWorks - but even though your calculations show that you should
have enough memory to do so, you get the "out of memory" message. Your
iBook, it turns out, doesn't have e nough continuous, unbroken memory to run
that latest program.
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The solution to this problem (which is called, geekily enough, memory fragmentation) is to quit all your programs, and then launch all the programs that
are supposed to fit in your iBook's memory. This time, you won't leave holes
in your memory setup, and you'll be able to use all the memory you deserve.
(Restarting the iBook achieves the same purpose, often more effectively.)

Third resort: Get RAM Doubler
Here's a fascinating possibility for the RAM-shy iBook fan: Buy a $60 program
called RAM Doubler.
RAM Doubler uses several potent, deeply technical tricks to make your iBook
behave as though it has twice or three times as much memory as it really
does. The only fundamental understanding of RAM Doubler that you need is
this: It lets you run more small programs at the same time. It doesn't let you
run one big program that requires more real memory than you have.
So Billy Bob, who has a 32-meg iBook and who wants to run AppleWorks,
Nanosaur, World Book Encyclopedia, and America Online at the same time, is
made in the shade. He no longer has to quit one of those programs just to
free enough memory to launch another. RAM Doubler lets him keep all of
those programs going.
Jenny Sue, however, wants very much to run MindReader Pro, which requires
36 megs of RAM, on her 32-meg iBook. She's out of luck. RAM Doubler's
double-memory tactics don't let you run any big programs that you couldn't
run before.

Fourth resort: Turn up flirtual memorlJ.
As with RAM Doubler, virtual memory (a free, built-in feature) lets you run

programs whose combined memory requirements add up to much more than
your iBook should be able to handle.
Although you may not have realized it, the virtual memory feature has been
turned on since the day you bought your iBook. Here's how to adjust it:
I. From the S menu, choose Control Panels; in the resulting window,
double-click Memory.
The Memory control panel appears, like this:
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2. Make sure the Virtual Memory switch is On.
On an iBook, virtual memory should always be on, at least a little bit
(see Step 3). The technical details would curl your nose hairs, but let's
just say that having virtual memory turned on makes these models run
faster and use memory more efficiently.
(Geek disclaimer: The only time virtual memory should be off is if you've

bought RAM Doubler, described in the previous section. It replaces virtual memory.)
3. Using the little up- and-down-arrow buttons next to the words "After
restart," specify how much total memory you'd like to wind up with.
Virtual memory works by using a chunk of your hard disk to simulate
additional RAM.
For some mysterious technical reason, however, you can't just use the
Memory control panel to dial in the amount of additional memory you'd
like. The iBook must reserve hard-disk space equal to all the memory,
real and "virtual." ( That's why you won't be allowed to turn on virtual
memory if your hard drive is full.)
Now, the iBook should, at the very least , have virtual memory set JMB
higher than its actual installed RAM. If your iBook has 32 megs of RAM
(consult this book's Cheat Sheet), virtual memory should be set to at
least 33MB.
It's safe to crank your total memory, using the virtual memory controls,
up to double your real memory. But be careful : the higher you set this
number, the slower your iBook may run. If you have 32MB of RAM, your
total memory (including virtual) shouldn't exceed 64MB; things will get
so slow as to be unworkable.
4. When you're done with your virtual-memory setup, restart the iBook.
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Locking the keyboard
So there you are, attempting to install new
memory into your iBook - butthe keyboard just
won't open!
It turns out that Apple, intending the iBook to be
the ultimate classroom laptop, designed a keyboard lock. This mechanism is designed to
prevent little minds from trying to find out what
happens when apple juice meets Apple circuitry.

The lock is the tiny screw head tucked between
the F4 and F5 keys. Using a jeweler's screwdriver (the kind you'd use to repair your glasses),
turn the screwhead clockwise to prevent the
keyboard from being opened, or counterclockwise to unlock it

Last resort: Install more
After a certain point, knocking yourself out to solve out-of-memory problems
reaches a point of diminishing returns. You get so worn out from workarounds that they're not worth doing.
At that point (or much sooner), just spring for the $50 or $100 and buy more
memory. You can get it, in the form of a tiny circuit board called a DIMM, from
any mail-order company (see Appendix A). When you call, tell them that you
have an iBook; they'll tell you what kind of memory chip you need and in
what quantities they're available.
Note, by the way, that your iBook has only one empty slot for memory. If your
machine has more than 32 megabytes of memory already, then that extra slot
is already filled; to install more, you'll have to throw away the perfectly good
memory board that's in there. (To find out how much memory your iBook
has, from the Apple menu, choose About This Computer. The "Built-in
Memory" statistic is the one you want.)
You can install the new memory board yourself; the iBook's designers have
made it very easy to do so. You can even find step-by-step instructions, complete with illustrations, by choosing Mac Help from the Special menu and
searching for "installing memory." They lead you through the process of flipping your keyboard open like a trapdoor to reveal the memory slot. (The
booklet that came with your iBook has memory-installation instructions, too.)
Having lots of memory to kick around in is a joy. Your iBook runs faster, has
fewer crashes and glitches, and acts like a new machine. It's a situation I
heartily recommend.
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Startup Problems
Problems that you encounter when you turn on the iBook are especially disheartening when you're a new Mac user. It does wonders for your self-esteem
to think that you can't even turn the thing on without problems.

No chime, no picture
First resort: Chances are very, very, very good that your iBook simply isn't
getting electricity. The battery must be dead and the power cord isn't
plugged in. Confirm that the cord is plugged in, and that the socket on the
right side of the iBook is glowing. If not, maybe the laptop is plugged into a
power strip whose On/Off switch is currently set to Off.
Last resort: If those steps don't solve the problem, your iBook is as dead as
Elvis. Get it in for repair. But that's virtually never the actual problem.

A question mark blinks on the screen
The blinking question mark, superimposed on a System Folder icon, is the
iBook's international symbol for "I've looked everywhere, and I can't find a
System Folder."
The blinking question mark means that your hard drive's not working right or that it's working fine, but your System Folder got screwed up somehow. In
either case, here's what to do:

First resort: After ten seconds of panic, restart the iBook. (See "The Restart
Keystroke" in the next chapter.)
Second resort: Maybe somebody turned off virtual memory, which they
shouldn't have done. Restart the iBook (see "The Restart Keystroke" in
Chapter 17); as it lights up, hold down the Shift key until you see the words
"Extensions off" on the screen. From the S menu, choose Control Panels, and
the Memory. Turn the Virtual Memory feature on, if it's off, and then restart
the computer.
Third resort: Find the Software Install CD that came with your iBook. Put it
in the CD drive. Restart the iBook (see "The Restart Keystroke" in the next
chapter) while pressing the lette r C key until the smiling Mac appears.
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Once you're running, find the program called Disk First Aid. Run it and use
the Repair button. Most of the time, Disk First Aid can repair your hard drive.

Fourth resort: If the hard-drive icon still doesn't appear, perhaps the System
Folder is calling in sick. Reinstall the System Folder from your Software Install
CD, as described in the section "Performing a Clean System Reinstall," in
Chapter 17.
Last resort: If nothing has worked and you still can't make your hard-drive
icon appear on the screen, your hard drive is sick. Call your local dealer or
Mac guru, and do not freak out - chances are very good that all your files are
still intact. (Just because the platters aren't spinning doesn't mean that
they've been wiped out, just as your Walkman tapes don't get erased when
the Walkman runs out of batteries.)
In fact, if you've purchased an add-on disk drive (see Chapter 19), you may be
able to rescue the data from your disk yourself. Buy a disk-recovery program,
such as Norton Utilities or TechTool Pro. That'll let you grab anything useful
off the disk and may even help heal what's wrong with it.

The i Book takes forerler to start up
If your iBook does indeed start up after having been shut down, but seems to

stall, blank-faced, for a full minute or two before getting going with the
startup process, you may have fallen prey to a Random Startup Glitch.

First resort: Once the laptop has started up, choose Control Panels from your
ti menu. Open the control panel called Startup Disk. Click the name of your
hard drive, close the window, and restart. The problem should be gone now.
Last resort: You may have turned on the "Preserve memory contents on
sleep" option described at the end of Chapter 11. As you can read there, this
option makes the iBook memorize whatever was running at the moment you
put the thing to sleep, storing it on the hard drive as a big invisible file that
acts as a safety net.
In rare circumstances, however, the iBook can't read the big invisible file the
next time it starts up. The solution is simple. Restart the iBook. (If it's frozen,
press 3€-Ctrl-power key.) As it starts up again, hold down the Esc key. Doing
so makes the iBook ignore the big invisible "what was in memory" file, so that
the startup can proceed apace. Actually, it deletes that file, which means that
your safety net has just disappeared. (Yet another argument for using the
Save command every time you're about to put the iBook to sleep.)
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Some crazlJ. pro9ram launches itself
erlerlJ. time IJ.OU start up
In the words of programmers everywhere, "It's a feature, not a bug."
Inside the System Folder, there's a folder called Startup Items. Look inside it.
Somebody put a program or document in there.
Anything in the Startup Items folder automatically opens when you turn on
the iBook. This feature is supposed to be a time-saver for people who work
on the same documents every day. Open the Startup Items folder and remove
whatever's bothering you.

Yikes! It beeps weirdl1J. when startin9 up!
If your iBook beeps when you turn it on, count the beeps. They indicate just

how bad your iBook's problem is. (Almost all of these situations means that
your iBook requires repair.) One beep means that laptop has no RAM board
installed (in other words, yours has wiggled loose); two means that you've
installed the wrong kind of RAM. Three beeps means that the memory board
has gone bad.
Four beeps indicates that your System Folder is corrupted (see "Performing a
'Clean System Reinstall"' in the next chapter), and five means that the iBook's
central processing chip has gone up to the great Radio Shack in the sky.

Hardware Hassles
The iBook is designed to withstand the Backpack Torture Test: It's rugged,
heavy, and designed without external latches or doors that can catch or
break off. That doesn't mean that it's completely exempt from mechanical
trouble, however.

No sound
If your iBook isn't making any sound, only two problems could lie at the heart

of the matter.

First resort: You've muted your iBook. Press the F6 button, so that the "Mute
Off" sign appears, for a second or two, at the bottom of the screen.

_ _ _ _ _ _ _ _ _ Chapter 16: When Bad Things Happen to Good iBooks
last resort: You've plugged headphones or turned-off speakers into the miniplug on the left side of the iBook. Whenever you do, the built-in speaker is
automatically muted.

Ei1erythin9 1s bi<J. and blurry
You or somebody you love has switched the screen into what's called 640 x
480 mode. For details, see "Zooming into your screen" in Chapter 13.

The screen is 9ray instead of in color
It's a feature, not a bug. (Some people go for that black-and-white-TV look.)
To restore the color, open the Control Strip by clicking the tiny gray tab at
the left edge of the screen. ( What am I saying? Everything's gray right now.)
Choose one of the numbered color options.

General printin<J. problems
If you're using an inkjet printer from, for example, Epson or HP, your first

thought in times of printing trouble is to call the company (or visit the company's Web s ite). Such printers are famous for requiring periodic software
upgrades, which are available at no charge from the company or its Web site.
Such printers are also famous for being backed by companies that actually
answer the phone and help you troubleshoot at no charge.

Inkjet printers: Blank pa9es come out
It's your cartridge.

First resort: If you haven't used the printer in a while, try your printer's
"clean nozzle" command. (You'll need to consult the manual to find out
exactly how you invoke it.)
Last resort: Your cartridge is probably empty. Replace it.

The i8ook runs only on AC power
If your iBook turns on only when it's plugged in, and not when it's running on

battery alone, try these steps:
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First resort: Maybe the battery's good and truly dead. Plug the iBook into a
working outlet and give it a couple of hours to charge. (If the little ring on the
side of the iBook doesn't light up when you plug the power adapter in, try a
different power outlet or, in dire circumstances, a replacement power cord.)
Second resort: Remove the battery from its compartment and put it back in,
making sure that it's snug.
Third resort: Try resetting the Power Manager, as described in the next
chapter.
Last resort: Try a different battery.

The hatterlJ cofler is meltin9!
It happens to almost every iBook owner: You open the battery compartment

under the laptop to have a look at the big silver battery. And you see them:
wiggly, scarred-looking "heat marks" on the inside of the plastic battery cover.
Believe it or not, that's not melted plastic - it's art. The battery cover is supposed to have those mod little squiggles.

AirPort Problems
If you have occasional problems connecting to the Internet without wires,

don't expect much sympathy from your friends with lesser computers. They
can't connect wirelessly ever.
Your Mac Help command (in the Special menu of the Finder) contains several
long and fascinating troubleshooting articles, right there in the AirPort topic.
There you'll learn, among other things, that appliances like the new 2.4gigahertz cordless phones and microwave ovens can interfere with your
iBook's signal. (Trying to surf the Web while nuking popcorn and chatting on
the cordless phone, in other words, is asking for trouble.)
Most of the time, howeve r, the problem turns out to be much more
mundane -your software settings aren't correct, for example. See Chapter
15 for complete details on the AirPort software and how it's supposed to
work. Then:

First resort: Check your equipment setup. Is your base station's center light
turned on (which means it's getting power)? Is it connected to a working phone
line? Have you been through the setup process described in Chapter 15?
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Check the s ignal-strength indicator dots on your Control Strip. Are you within
range? Is your AirPort Card turned on? ( If you open the AirPort tile of the
Control Strip and see the words Turn AirPort On, then the card is off. Turn it
on.) Try restarting the iBook.

Second resort: From the ti menu, choose AirPort. In the resulting window,
you'll see some useful indicators: Whether or not the base station is turned on
and online, your signal strength, and so on. If this display indicates that you
are indeed online, but surfing seems to be very slow, remember that distance
from the base station can slow down your connection. (Also remember that
the more iBooks are sharing a single base station, the s lower the connection.)
Last resort: Consider repeating the whole setup. Confirm that your iBook
can get online directly (when it's connected by wire to a phone jack). If not,
call EarthLink or whatever your Internet company is, and request help getting running. Then run the AirPort Setup Assistant program again to tran~fer
the how-to-connect info to your base station again.

Onscreen Glitches and Foul-Ups
The Finder, you'll recall, is your home base. It's the desktop. It's the Trash
can and icons and all that stuff. It's where you manage your files, rename
them, copy them - and sometimes have problems with them.

You can't rename a file
The file is probably locked. Click it, choose Get Info from the File menu, and
deselect the Locked check box. Or maybe the file is on a locked disk, such as
a CD-ROM disc. You can't rename anything on a locked disk.

You can't rename or eject a disk
Well, you can't rename a CD, ever. A CD is permanently locked.
But s uppose you've equipped your iBook with one of the add-on disk drives
(such as a floppy-disk drive or Zip drive) described in Chapter 10. I'm gonna
take a wild shot at this one. I'll bet you've got File Sharing turned on (in the
File Sharing control panel). Right?
It's true: If you're using this feature (known as file sharing), you're not
allowed to change your hard drive's name. You'd wreak havoc with the other
people on the network, who are trying to keep straight who you are.
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Clean your screen
When fingerprints and smudges start to make
your beautiful iBook screen look a little gooky,
clean it with water, using paper towel or a soft

cloth. Glass cleaner is OK, too, as long as it
doesn't contain ammonia or alcohol.

If you really want to bother, open your File Sharing control panel and turn off

File Sharing. Now you can rename your disk. (You're often not allowed to
eject CDs or Zip disks when File Sharing is on, either.)

All lJour icons show up blank
If you get zapped by the "generic icons" problem, where every document

looks like a boring blank sheet of paper, your invisible Desktop file has
become corrupted. See "Rebuilding the Desktop File" in the next chapter.

It's JanuarlJ 1, 190ll
Ever wonder how your iBook always manages to know what time it is - even
when it's been unplugged?
Turns out the iBook's own power source - battery or power cord - keeps
the clock alive. When the computer is deprived of all power, the machine forgets the date within about 10 seconds. The iBook's clock resets itself to
January 1, 1904, which is the earliest date allowed on a Macintosh. ( Look at
the bright side: at least Macs don't have a Year 2000 bug. They're good until
the year 29,499.) As a matter of fact, when deprived of all power, you lose
other settings besides the clock: your trackpad, network, and sound volume
settings.
Now you know why Apple recommends that you change the iBook's battery
only when the machine is plugged in.
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Wake up, little Susie
As the first few hundred thousand iBooks
wended their way from Taiwan, where iBooks
are built, to their final destinations, troubleshooting experts grew worried about a
strange occasional problem: the iBook goes to
sleep just fine when you close the lid - but it
won't wake up. You press a key from now till
doomsday, but the laptop slumbers on.

solved it Some people report that when they
open the Energy Saver control panel, click
Advanced Settings, and turn off »Reconnect to
servers on wakeup," the problem vanishes.
Various other reports traced the refusal to wake
up to having America Online, Bugdom, or
VirtualPC running atthe time of sleep, or possibly staying up too late the night before.

As this book wended its way to the printing
plant. nobody had pinpointed the source of the
problem. Apple suggests avoiding putting the
machine to sleep after having started it up from
your iBook Software Install disc. Others found
thatturning off the UP reserve contents of RAM
on sleep" option (in the Memory control panel)

If your iBook exhibits this problem, may the solutions here - or some future Apple software
patch - cure what ails it In the meantime, if
you try to wake your iBook and can't get a rise
out of it, press the magic Restart Keystroke:
00-Ctrl-power button. That restarts the machine,
no matter how drowsy it is.

E11er1J.thin9 1s slow
If the iBook has begun acting slower since you've owned it, something may

indeed be wrong.

First resort: Alter several months of using an iBook, it actually does s low
down. The problem is a bloated Desktop file; the solution is described in the
section "Rebuilding the Desktop File" in Chapter 17.
Last resort: If your hard drive is rather full, perhaps it needs to be defragmented. See "Defragmenting Your Hard Drive" in the next chapter.
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The Problem-Solving Cookbook
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.... Clean heart, clean installations
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f you've read the previous chapter, you've now heard about everything

that can possibly go wrong, and you're thoroughly depressed.

Here, then, is therapy: a chapter containing everything you can possibly do
to fix the problem. Remember, you'll almost never find out what caused the
problem to begin with; just be happy that the following techniques are almost
magical in their ability to cure things.

Rebuildin9 the Desktop File
The Desktop file is a very important file on your disk. How come you've never
seen it? Because the Desktop file is invisible. ( Yes, iBook icons can be invisible. Remember that fact if you eve r get involved in antiterrorist espionage
activity.) The file is something that the iBook maintains for its own use.
The iBook stores two kinds of information in the Desktop file: the actual pictures used as icons for all your files; and information about the parent-child
(program-document) relationships that you're having trouble with.
If the Desktop file becomes confused, two symptoms will let you know: the

"generic icon" problem, where all your icons show up blank white, and the
"Application not found" message that appears when you try to double-click
something.
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Another desktop-related problem: over time, this invisible file gets bigger and
bigger. Remember, it's having to store the pictures of every little icon that
crosses your iBook's path. And just because you throw some icon away after
using it doesn't mean that its image gets cleared from the Desktop file - it
doesn't. And the bigger your Desktop file gets, the slower your iBook becomes
in its efforts to open windows, display icons, and start up in the morning.
Resetting your Desktop file, therefore, has two delightful benefits. First, it
cures the generic-icon syndrome and the "Application not found" problem
( because it re-learns the relationships between files and their pictures).
Second, it makes your iBook faster (because it purges all the unnecessary
leftover icon images from its invisible database).
Here's how you do it:
1. From the Special menu, choose Restart.

2. As the iBook starts gearing up, press and hold the Option and 3€ keys.
Don't let go. Keep them down until the iBook explicitly asks you whether
you want to "rebuild the desktop." Click OK.
After that's done, your document double-clicking will work, your icons will
return, and your iBook, having been cleansed of all obsolete icons, will run
faster and more smoothly.

Resettin9 the Power Mana9er
The Power Manager is the tiny piece of electronics that's responsible for your
iBook's power smarts. When you're plugged in, the Power Manager directs
the iBook to stop drawing juice from the battery (and, in fact, starts charging
it). When you're unplugged, the Power Manager automatically switches to the
battery as its power source. And so on.
Like the best of us, in rare circumstances, the Power Manager becomes confused. The result: Your iBook may run only from the battery, but not from the
power cord. Or vice versa. Or the battery may not charge when plugged in.
When one of these screwy power-related crises strikes, you must help the
Power Manager to sit up, blow its nose, and snap out of its funk. To do so,
shut down the machine completely. Insert an unfolded paper clip into the
reset hole that's just above the power button ( hidden inside the vents). Keep
the paper clip in there for five seconds, then release. When you turn the
iBook on again, you'll have reset its Power Manager circuit.
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Zappin9 the PRAM
The PRAM ("PEA-ram") is a tiny piece of special memory that's kept alive as
long as your iBook has power, whether from the battery or the power cord.
The PRAM stores the settings you make in your control panels, such as the
sound volume, trackpad speed, memory, network, and screen settings.
Rarely, rarely (but still sometimes), this tiny bit of memory gets corrupted
somehow. Typical symptoms: Your control panels don't retain their settings;
you can't print; or you have strange networking problems.
To reset the PRAM, turn off the iBook. When you turn it on again, hold down
the 31:, Option, letter P, and letter R keys until you hear the second or third
startup chord. Release the keys.
Afterward, you may have to reset your iBook's trackpad-tracking speed,
desktop pattern, speaker volume level, clock, network connections, and so
on. Still, it's but the work of a moment to reset them using your control
panels.

The Amazin9 "Force Uuit 11 Ke1J.stroke
Here's the amazing keystroke for escaping a frozen program: 31:-0ption-Esc.
(This is about the only time that you'll ever use the Esc key.)
You get a dialog box that says, "Force [this program] to quit?" and warns you
that any work you've done since the last time you used the Save command
will be gone forever. Click Force Quit, and - when this trick works - you exit
the program you were working in.
So what's the big whoop? Well, if you had several programs running, this
technique dumps only the one that you were working in - the one that
crashed. You now have a chance to enter each of the other programs that are
still running and save your work (ii you haven't done so). Then, to be on the
safe side, restart the iBook.
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The Restart Kel)stroke
To restart your iBook when it's frozen or crashed, press the 3C and Ctrl keys.
While they're down, press the power button above the keyboard. That's the
"Command-Control-power" keystroke much revered in Mac computer clubs;
it instantly restarts the computer, no matter how badly it's frozen.
There's another way to restart a frozen iBook, too: Unfold a paper clip, and
insert the straight part into the tiny hole located directly above the power
button on the edge of the laptop, hidden in the ventilation grille. But who'd
bother - unless they forgot "Command-Control-power"?

Solt1in9 an Extension Conflict
Okay, here it is - the long-awaited extension-conflict discussion.
See, each extension (a self-loading background program, such as a screen
saver, that you install in your System Folder) was written by a programmer
who had no clue what other extensions you'd be using. As a result, two extensions may fight, resulting in that polite disclaimer "Sorry, a System error has
occurred."
These things are easy to fix, once you know the secret. Shut off your iBook
(choose Shut Down from the Special menu), and then turn it on again. But as
the iBook is starting up, hold down the Shift key and keep it down until (1) you
see the message "Extensions off" or (2) you arrive at the desktop, whichever
you notice first.
Your iBook probably won't give you any more trouble - but now, of course,
you're running without any of your cute little extension programs. No
CD-ROMs, no fax software, no Internet access, and so on.
If the point of this exercise is to pinpoint which extensions aren't getting
along, you have two choices. One is free but takes a lot of time. The other
way costs $70 but works automatically.

I
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The hard way: Turn off the iBook and then turn it on again. While the
iBook is starting up, press and hold the space bar down. Eventually,
you'll be shown a complete list of your extensions, like this:
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The point here is that you can tum off selected extensions and control
panels just by clicking their names. (The little X means on.)
Special bonus feature! In the previous picture, see the tiny triangle
where it says Show Item Information? Click that to see a top-secret panel
that tells you exactly what each extension is for. Click an extension's
name in the list, and you'll be shown a little caption for it, such as
"Warranty Minder Pro: This extension keeps track of how long it's been
since you bought your iBook, and it makes sure nothing goes wrong until
after the warranty period is over."
But I digress. Using your Extensions Manager list, turn off the first few
extensions and control panels. Then restart the computer (click the
Restart button at the bottom of the window).
If the iBook doesn't exhibit whatever unpleasant behavior you've been

having, you can pretty much bet that one of the extensions you turned
off was the guilty party. If the iBook does crash or act balky again, repeat
the whole process, but this time turn some more extensions off.
Through trial and error, you eventually should be able to figure out
which pair of extensions doesn't get along.

v The easy way: Buy a program called Conflict Catcher. This program
does many useful things for managing your extensions, but its main
virtue is catching conflicts. It can figure out, all by itself, which extension (or extensions) caused your iBook's problems. All you have to do is
sit there, restarting the iBook over and over, each time telling Conflict
Catcher whether or not the problem has been solved yet. By the time
the process is over, the program will emblazon the name of the errant
extensions on your screen; you then can dismember, disembowel, or
trash them as you see fit.
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(You can get a free, seven-day Conflict Catcher demo version from
America Online or on the Internet at www.casadyg.com. It lasts just long
enough for you to figure out which extensions were driving you crazy.)

Git1in9 More MemorlJ to a Pro9ram
When you turn on your iBook, several megabytes of its available RAM
(memory) get used up by your System Folder's contents -your operating
system. Then, every time you launch a program, a little bit of the leftover free
RAM gets used up.
Here's how to find out where your memory is going at any particular moment:
Go to the Finder. From the Wmenu, choose About This Computer. This helpful dialog box appears, showing several important numbers about your use of
memory:
This is how much real memory your Mac has, not counting
"fake" memory contributed by RAM Doubler or virtual memory.

p

AboutThls Computer•

-

.~ I ""'i.11
Mac C>S computer ~
- .. -- - -· ~

Mac OS 8.6
Mac OS ROM 2.3.1

:~1;-

"' & ©App le Computer, Inc. 1983- 1999
2.5 MB

~ Colculo

(I

MocOS

r

85 K
17. 5MB

I:]

IJJ

========:I

This is the largest chunk of memory you have left, into which you
can open more programs. (There may be smaller chunks available, too.)

In the bottom part of the box, you can see what's already taking up memory
and how much memory each program is taking up (see those bars?).
You may find it useful, however, to change the amount of memory that each
of your programs uses. If you're experiencing a lot of System crashes, for
example, the program may need a bigger memory allotment. If memory is at a
premium, you may occasionally be able to give a program less memory, freeing some for other purposes.
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Here's how:
1. Quit the program whose memory appetite you want to change and
then click its icon.
This step frequently confuses beginners; for help in quitting a program,
see in Chapter 16. And don't be fooled into clicking the folder a program's in, either - open the folder and click the program icon itself
(Classic example: America Online. If you highlight its folder, these steps
won't work. Instead, open that folder and click the actual, triangular,
America Online program icon.)
Don't be fooled into clicking a program's alias, either. An alias is a file
whose name appears in italics, like this; see Chapter 13 for details. If
your program's name does appear in italics, open the File menu and
choose Show Original. Now you can proceed to Step 2.
2. From the File menu, choose Get Info.
If you don't see the Get Info command, then you may be in Simple Finder
mode, or you may be using the Multiple Users feature. Both are
described in Chapter 13; exit Simple Finder mode, or turn off Multiple
Users, before proceeding.

When you choose Get Info, a dialog box appears.
3. Choose Memory from the Show: pop-up menu.
If you don't see a Memory command, see Step 1: You're probably trying
to Get Info on a folder or an alias, as described in Step 1.

In any case, you should now see a window like this:

AppleWorks Info

~

lAppleWorks
AppleWor b S.O

l

I ~}t=====rtt-- Choose Memory from

r-Show: Memory

this pop-up menu.

Kl nd: application pr09rom
Memory Requirements ____,

I

~

SUCJQe3ted size( zsoo
Minimum Size: [2000 } K
Prererre11s1ze([2soo ]

3>---___,__

Noto: Memory requl roments .... ill lncreose by 2, 123 K If
virtual memory Js turned off.

0

Locked

This is the amount of
memory suggested by the
!---software company ...
. . . but most programs work
better if you make this
number slightly higher.
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4. Change the number in the Preferred size box.
This number is the amount of memory that the program will actually
consume when you run it. If your aim is to make this program stabler or
faster, try increasing this number by, for example, 10 percent.
Unless System crashes make your life more interesting, don't set the
Preferred size below the Suggested size, though.

Performin9 a "Clean Sv.stem Reinstall"
This procedure is just a wee bit technical. But it's amazing how many problems it solves. Font problems, crash problems, freeze problems, glitch
problems, weird bad vibes that you can't even describe very well - all of
them go away when you do a clean install.
As the gears of your System Folder grind away day after day, little corruptions and rough edges can develop. The following procedure replaces your
old, corroded System Folder with a brand-spanking-new one. It's nearly guaranteed to wipe out any erratic, bizarre crashes or freezes that you've been
having; after all, it restores the !Book to the exact condition It was in the day
it left the factory.
This process requires the Software Install CD that came with your iBook.

Step one: Install the fresh so~ware
Turn on the iBook. Open the CD tray (on the right side of the iBook) by pressing the capsule-shaped button in its center. Pull the tray open; insert the
Software Install CD (or the Mac OS 9 CD, if you bought Mac OS 9 since buying
your iBook).
Double-click the Mac OS Install icon. After you've clicked the Start button on
the Software Installations screen, click the Options button on the regular
Installer screen. You'll be offered a "Create additional System Folder (clean
install)" option - that's the one you want.
Then click whatever OK, Continue, or Install buttons you're offered, until the
installation process is complete. The whole deal takes about 10 minutes.
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Step two: Restore IJ.Our
personal belon9in9s
The result of all these shenanigans is a virgin, clean System Folder, free of any
corruptions. Your iBook will run smoothly, fast, and trouble-free - I guarantee it.
Unfortunately, all your customized fonts, control panels, preferences, Web
bookmarks, and • menu items are stranded back in your old System Folder!
That includes the settings necessary for you to get onto the Internet, by
the way.
Ideally, you should install each of these items from their original, storebought disks, and manually enter your preference settings anew. If that's too
much hassle, set up your old System Folder and your new System Folder
side-by-side in tall, skinny, list-view windows. While pressing Option, drag
anything that's not in your new System Folder, item by item, from your old
System Folder to your new System Folder. (Key folders to compare with their
newer counterparts: the Preferences; Extensions; Control Panels; Apple Menu
Items; and Fonts folders.) Do so with care, however, so that you don't simply
reinstate whatever problems you were having.
To restore your Internet settings, open the Preferences folders of your
Previous System Folder (left) and new System Folder (right), side-by-side,
like this:

tt;j Acrobat"' Reede r Prefo

Iii Adobe Photoohop 5 Patho
l!l Al phoManl• Pref._D&
I>

Cl Apple Help Pref•

[i3. Apple Menu Options Prei

Ill Apple Video Playe r Pref•

ffil, Appl.CD Audio Pleyer Pr
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Going back in time
Suppose you've just done a clean system install.
In the unlikely even that your iBook behaves
even worse with the new System Folder than
with the old one, you can always go back to
using the old System Folder. Do so by throwing

awaythe new System Folder; opening and closing the Previous System Folder; and then
restarting the iBook. (You can take the word
Previous off the System Folder's name, if
you like.)

While pressing the Option key, drag the following preference files from the
left window (the old System Folder) into the right window:
Y' America Online (a folder)
Y' Explorer (a folder)

Y' Internet Preferences
Y' Modem Preferences
Y' Remote Access (folder)

Y' TCP/ IP Preferences

With each item, you'll be asked if you're sure you want to replace the newer
item with the older; yes, you do. The Remote Access folder, by the way, will
tell you that it can't be replaced "because it is in use." Outsmart it by throwing away the Remote Access folder from the right-side window before
dragging the Remote Access folder again from the left-side window. (That sentence really does make sense; you may have to read it slowly.)
(P.S. - If you bought Conflict Catcher, as described earlier in this chapter, you
don't have to do this comparison manually. Use its Clean-Install System Merge
command to compare your old and new System Folders automaticallyand, at your option, to copy any of your personal belongings into the new
System Folder.)

Other ulalJ.S to restore lJ.OUr iBook
In addition to the CD called Software Install (described in the previous steps),
your iBook also came with a CD called Software Restore. This second CD is
useful in more dramatic circumstances, such as your deciding to erase your
iBook's hard drive and start over (which might be useful if you plan to sell
the iBook or when the FBI bursts through your door).
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To use this CD, try this. While the iBook is on, press the CD-ROM tray's eject
button. Carefully put in the Software Restore CD and close the tray. Now
restart the iBook while pressing the Jetter C key continuously. Release the C
key only after you see the message "Welcome to Macintosh" on the screen.
The Apple Software Restore icon (in this Software Restore CD's main window)
can perform two kinds of surgery on your System Folder: one called a Restore
in Place, the other called Erase "Macintosh HD " Before Restoring.

The "Restore in Place" option
This procedure gives you fresh, clean copies of everything that came with
your iBook - including the System Folder and all the free programs - without touching any of the stuff you 've added, such as your hard-won
AppleWorks documents, e-mail, and so on.
Unfortunately, Restore in Place also replaces a few useful files in your System
Folder: the ones that tell your iBook how to connect to the Internet, and the
ones that store your bookmarks for Web browsing. To avoid losing them,
follow these awkward but necessary steps:
I. Open the System Folder. Open the Preferences folder. Drag the follow-

ing items out of the Preferences window and onto the desktop: the
America Online, Explorer, and Remote Access folders; and the
Internet, Modem, and TCP/IP Preferences files.
If you like, close all the windows you've just opened.

2. Open the Software Restore CD. Double-click the Apple Software
Restore icon. Choose the Restore in Place option.
The Software Restore program goes about its business; when it's finished, you'll be asked to restart the iBook.
3. When the iBook restarts, open the hard drive, then the System Folder,
then the Preferences folder. Throw away the Remote Access folder.
Finally, drag the six items from Step 1 from your desktop back into the
Preferences folder.
When you're asked if you want to replace newer items with older ones,
click OK each time.
You've just given yourself a spotless, fully functioning System Folder and new
copies of all the pre-installed iBook software, while preserving your Internet
settings at the same time.
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The 11Erase before restorin9 11 option
When you double-click the Apple Software Restore icon, the second option,
"Erase 'Macintosh HD' before restoring," is extremely extreme. It wipes out
everything you've ever created on your iBook, erasing the hard drive completely and restoring the iBook (and its pre-installed software) to the way it
was the day you opened its box. All of the work you've done is deleted.
Use this trick only under dire circumstances.

Defra9mentin9 Your Hard Drifle
Your hard drive, if you'll indulge me, is like a closet maintained by a guy
who's always in a hurry. When guests are coming over, he cleans up the living
room by throwing everything into the closet, not particularly neatly. Every
now and then, when he gets time, he unpacks the closet and repacks it neatly,
putting everything in a tidy, organized place.
The hard drive, too, is in a hurry. When you ask it to save a file, it doesn't
wait around: It shoves that file wherever it can find space. Sometimes, that
even means sticking the file in two places, splitting it as necessary. Over time,
more and more files are stored on your hard disk in pieces. It's no big deal:
When you need that file again, the hard drive remembers where all the pieces
are and is perfectly able to bring the file back to the screen.
But all this hunting for pieces slows the drive down, especially when your
drive gets 80 percent full and stays that way for awhile. And like our busy
closet keeper, you'll find it very satisfying, every six months or so, to reorganize the files on your disk so that they're each in one piece, neatly placed end
to end on the hard-drive surface.
You can defragment your drive (which is the term for it) in two ways. First,
you can copy everything onto other disks (such as SuperDisks or Zip disks, if
you've bought one of those add-on drives), erase the hard drive, and copy
the files back onto it. Second, you can buy a program just for defragmenting
your drive. These programs are called things like Norton Utilities and
DiskExpress. (Back up your work before using these programs, however; if
you're into living dangerously, go skydiving.)

Chapter 18

Beyond the iBook:
Where to Go from Here
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In This Chapter
.... Moving up to Mac OS 9, Mac OS X, and beyond
.... Where to turn when things go wrong
.... Facing the future, credit card in hand
.... Now get outside for some fresh air
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~e first 17 chapters of this book are the crash course; now, Grasshoppa,

f

;t's time for you to venture forth into the world by yourself. Go for the
gold. Do the right thing. Use the Force.

Before I send you from my book to iBook, however, a few parting words of
wisdom.

Where to Turn in Times of Trouble
You own the world's most forgiving, self-explanatory laptop. But things will
go wrong. And not even this astoundingly complete book can anticipate the
problems you may encounter while running BeeKeeper Pro or No Namo
Scanner Doodad Plus. Fortunately, the world is crawling with help possibilities.

Your 15 minutes of free help
For example, during the first three months you've owned your iBook, you can
call Apple's delightful toll-free hotline at (800) 500-7078 and ask your questions of the gurus there. (Hint for the budget-<:onscious: Apple doesn't know
when you bought your iBook. They measure your 90 days, therefore, from
your first call, not really from the day you bought your machine.)
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Beyond those 90 days, Apple charges you nosebleed-inducing fees for your
use of their experts (unless the computer actually turns out to need fixing, in
which case the fee is waived). The toll-free number for this service is (888)
275-8258, and you can choose to have your wallet milked in either of two
quantities: One problem solved for $50; ten for $290.
The bottom line: Try to have all your problems in the first 90 days.

$230 for three IJ.ears
If you anticipate needing phone help at least three times, you're far better off
buying AppleCare. It's an extended-warranty program that covers all iBook
troubles for three years, including mechanical problems. (I don't usually fall
for this kind of extended-warranty sucker bet - but on a laptop that gets
banged around a lot, it's a very good investment.)
During these three years, you can call Apple's help line all you want at no
extra charge. Keep in mind, however, that you must sign up for this program
during the first year you own your iBook.

Free help sources
If spending money isn't your way of problem solving, consider these allexpenses-paid avenues:
Y" www.apple.com/support/iBook: Part of Apple's Web site (see Chapters

6 and 7). You can get software updates, ask questions in electronic bulletin-board discussion areas, and access the Technical Information
Library - a searchable electronic encyclopedia of all things Macintosh.
All kinds of common iBook questions and answers are listed there for
your perusal pleasure.
Y"

www.apple.com/support/airport: More of Apple's Web site, this one is
dedicated to the wireless networking technology called AirPort (see
Chapter 15).

Y" AppleFax: Call 800-505-0171 by telephone, listen to the instructions,

punch in your own fax number when you're asked for it, put in a fresh
roll of fax paper, and stand back. They'll fax you a list of pretyped
answers to common questions.
Y" SOO-SOS-APPL: This phone number brings you to a voicemail labyrinth

that would freak out Theseus. Dig deep enough into the maze and you can
find automated, prerecorded tips, tricks, and troubleshooting techniques.
Y" No Wonder Web page: Visit this page for free, 24-hour, personal computer help at www.nowonder.com. Did you get that? Free, personal help
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from a live human being. If you got rich from the Internet stock boom of
the 1990s, go ahead and call Apple for $50 a shot- but otherwise, you'd
be crazy not to try the No Wonder service.

v The IBook mailing list: The Internet at its finest. Us ing your Web
browser, go to www.themacintoshguy.com/ lists/iBooklistFAQ.shtml. Plug
in your e-mail address, and presto: You'll be getting 25 e-mail messages a
day, just about the iBook. Send a question to this group of enthusiastic
iBook owners, and without hours, you'll find answers from the multitudes. (Don't lose the instructions for getting off the list, unless you
really love reading messages about the iBook.)

v

MacFixlt Web page: You get hundreds of discussions of little tweaky
specific iBook problems at www.macfixit.com.

Otherwise, your next resort should be a local user group, if you're lucky
enough to live in a pseudometropolitan area. A user group, of course, doesn't
exist to answer your personal ques tions; you still have to do some phoning
and hobnobbing and research. But a user group is a source of s ources. You
can call up and find out who will know the answer to your question. ( To find
the nearest user group, call Apple's referral service at (800) 538-9696.)
The other great source of help is an electronic meeting place like America
Online, where you may get your question answered instantly - and if not, you
can post your question on a bulletin board for somebody to answer overnight.
Try keyword MOS, for example. (See Chapter 6 for details on keywords.) If
you're Internet savvy, you can visit a newsgroup called comp.sys.mac for similar assistance. (See Chapter 6 for information on newsgroups.)
As for your continuing education - after you spend a month's s alary on a
computer, I'll bet you can afford $20 more for a subscription to Macworld,
MacAddict, or MacHome Journal magazine. Agreed, huge chunks of these rags
may go right over your head. But in every single issue, you'll find at least one
really useful item. You can learn all kinds of things just by reading the ads.
And if you're not in touch with the computer nerd world at least by that tenuous thread - via magazine - then you might miss stuff like free offers, recall
notices, warnings, and other consumer-oriented jazz.

Up9radin9 to Mac OS 9 - and BetJ.ond
If you bought your iBook before November 1999, it came with the System

Folder version called Mac OS 8.6 - a splendid operating system, without a
doubt. Subsequent iBooks (and other Mac models), however, come with the
newer Mac OS 9. You can read about Mac OS 9's most attractive new features
in this book- see Chapter 7 for details on Sherlock, and Chapter 13 for info
on the Multiple Users feature. Many other, much smaller features lurk, all
designed to make the iBook faster, easier, and trouble-freer.
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If your iBook didn't come with Mac OS 9 on board, you can buy Mac OS 9 for

$100 or less from any of the mail-order outfits listed in Appendix A.
Fortunately, installing it onto your iBook isn't terribly complicated: you just
insert the Mac OS 9 CD-ROM, launch the Installer program, and follow
instructions. When the process is complete, you'll be asked to click a Restart
button to turn your iBook off and then on again. When it comes to, Mac OS 9
will be running your machine.
Whenever you upgrade your operating system in this way, however, you run
the risk that any add-on programs - that is, software that didn't come from
Apple - might develop quirks and tics. Your big, everyday, came-with-theiBook programs like AppleWorks and Outlook Express probably won't be
affected. But stuff you've bought, or downloaded from the Internet, may occasionally behave oddly after a system-software upgrade.
In that event, you have three choices:
Y' Contact whoever made the software in question -

or visit the corresponding Web page. Check to see if an upgrade is available. (It almost
always is.)

Y' Do without the software.
Y' If you can't live without the software in question, and there's no fixed

version in sight, you can always go back to your old system-software
version. To do that, grab the system-software CD-ROM that came with
your iBook and do a clean install, as described in Chapter 17.

Sat!e Chan9es Before Closin9?
If you decide to get more into this Macintosh thing, I've listed major magazines, Web s ites, and mail-order businesses in Appendix A.

But wait a minute - the point of this book wasn't to convert you into a fulltime iBook rabbit. It was to get you off the ground. To give you just enough
background so you'll know why the computer's beeping at you. To show you
the basics and help you figure out what the beanie heads are talking about.
Don't let them intimidate you. So what if you don't know the lingo or have the
circuitry memorized? If you can turn the thing on, get something written up
and printed, and get out in time to enjoy the suns hine, you qualify as a real
iBook user.
Any dummy knows that.
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The Part of Tens
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Ten More Gadgets to
Buy and Plug In
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n this chapter, you'll find out about several impressive high-tech gadgets
you can spend money on - yes, it's Credit Card Workout #4. These
devices give the iBook eyes and ears, turn it into a national network, and turn
it into an orchestra. You're not obligated to purchase any of them, of course.
But knowing about some of the amazing things your computer can do will
help you understand why the iBook is such a big deal.

A Scanner
If the point of a printer is to take something on the screen and reproduce it

on paper, a scanner, then, is the opposite - its function is to scan an image
on paper and throw it up on the iBook screen. After the image has been
scanned and converted into bits and bytes that the iBook understands
(meaning that it's been digitized), you can manipulate the image any way that
you want. Erase unwanted parts, make the background darker, give Uncle Ed
a mustache, shorten your brother's neck- whatever. The more dignified use
for a scanner is grabbing real-world images that you then paste into your own
documents, particularly in the realm of page layout and graphic design. Got a
potato-industry newsletter to crank out? Scan in a photo of some fine-lookin'
spuds, and you've got yourself a graphic for page one.
So how much is all this gonna cost you? A middle-of-the-line color scanner,
such as the Umax Astra pictured here, costs around $130 - including software that can do a decent job of converting scanned articles into typed-out,
editable word-processor documents. (When shopping, be sure to request an
iBook-compatible scanner - one with a USB connector, such as a Umax Astra
1220U or Agfa SnapScan 1212u.)
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A Di9ital Camera
Ordinarily, the concept of paying $500 for a camera that lacks any way to
insert film would seem spectacularly brain-dead. Yet that's exactly the point
of digital cameras, like those from Kodak, Casio, Olympus, Sony, and others.
They store between 10 and 150 photos without film - actually, in RAM, now
that you know what that is - and when you get home, you can dump the
images into your iBook (after connecting a cable), thereby freeing your
camera's RAM for another round of happy-go-lucky s hooting.
For people who need instant, no-cost developing (doctors, people needing
pictures for World Wide Web pages, real-es tate hounds, fraternity party animals, and so on), these cameras are a godsend. As a matter of fact, jus t to
prove the point, I took the photos in this book using a little Olympus jobber.
The results aren't pro quality-you'll have to pay $5,000 or more for digital
cameras that take magazine-quality photos - but they're great for, say, illustrating computer books.
Incidentally: Be sure to buy a camera with a USB connector. If you buy one
that has a serial cable, you'll have to buy a serial-to-USS adapter, such as
those listed in Appendix B.
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A Mouse
The iBook's trackpad is ·delightful, silvery, and fun to touch. It is not, however, a mouse.
An actual mouse (a USB mouse, to be exact, which plugs into your iBook's

USB jack) is a little plastic domed box. Inside, a rubber ball rolls as you move
the mouse, which tells the iBook how to move the pointer on the screen.
The mouse is a profound improvement over the trackpad when it comes to
doing artwork. In fact, it's easier to use than the trackpad no matter what
you're doing, as long as you're doing it at a desk and not on the airplane.
The USB mice sold by Ariston, Macally, Belkin, or iMaccessories are translucent, just like the !Book. (See Appendix B for their contact info.) You
shouldn't have to spend more than $25 for a good mouse, either.

A Jo11stick
The iBook, with its high-speed G3 chip inside and superb graphics, makes a
great game-playing machine. But how can you get the feeling of soaring over
the fields of France in a fighter plane using a trackpad to control the action?
You can't. You need a joystick. It works just like a real airplane joystick, controlling your movement in flight simulation, driving simulators,
shoot-'em-ups, and other games. They cost between $20 and $50, and they're
listed by the dozens on the Internet at www.imacintouch. com.

Speakers or Headphones
When you listen to the !Book's tinny, tiny built-in speaker, there's very little
chance you'll mistake the sonic experience for Carnegie Hall. But if you get a
pair of miniature speakers designed for the purpose, you're in for a tintinnabulating treat. If you play iBook games, particularly CD-ROM discs, you won't
believe what you've been missing; the sounds are suddenly CD-quality, much
richer and deeper - and in stereo.
But not just any old speakers work. They must be self-powered, and they must
be shielded. In other words, buy speakers designed for the purpose; Apple,
Yamaha, Sony, and many other companies make lines of computer-ready
speakers.
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extremely rich sound by popping a pair of Walkman headphones into the
iBook's left-side headphone jack. ( When you do so, the iBook's built-in
speaker automatically shuts up.)

Music and MIDI
MIDI, pronounced like the short skirt, stands for Musical Instrument Digital
Interface. What it means is "hookup to a synthesizer." What it does is let your

iBook record and play back your musical performances using a synthesizer
attached to it. When you record, the iBook makes a metronome sound - a
steady click track - and you play to the beat. Then, whe n you play back the
music, your keyboard plays exactly what you recorded, complete with feeling,
expression, and fudged notes; you'd think that Elvis's ghost was playing the
instrument, except that the keys don't move up and down. Then you can edit
your fudged mistakes and wind up sounding like [insert your favorite musician here].
All you need is a little box called a MIDI interface (about $50) that connects
your iBook to the synthesizer. (Be sure to buy a USB version of it, such as
those described in Appendix B.) You also need a program that can record and
play back the music, called a sequencing program. Some easy-to-use and inexpensive ones are MusicShop and Freestyle. And, of course, you need to get
your hands on a synthesizer. Or, for making sheet music, investigate Encore,
Overture, or Finale. Check out a music store and get jammin'.

A Projector
If you use your iBook to give slide shows or classroom lectures, you may

sometimes wish you could project images onto a TV or movie screen. With
the addition of a vide0-0utput adapter, such as the USB Presenter
(www.aver.com) , you can hook your iBook up to a TV or LCD projector so
that all the world may enjoy your creativity.

Zip, SuperDisk, & Co.
As I'm sure you're aware by now, the iBook comes without a floppy-disk

drive. In truth, that's no big deal; floppies are embarrassingly old, slow, and
low-capacity.
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On the other hand, many people need some kind of disk to store stuff on;
backing up your work on the Internet (see Chapter 6) or onto another Mac on
the network (see Chapter 14) isn't for everybody.
So what are you supposed to do? Go back to writing on Post-it notes? Well,
you could always buy an add-on disk drive for your iBook - one that plugs
into the iBook's USB jacks~ Your choices are:
'\

Y'

A floppy drive: For $80\or less, you can equip your iBook with the missing limb it's always dreamed of: a true-blue, bona fide floppy disk.

Y'

A SuperDlsk drive: Spend a little more; get a little more. The $140,
translucent, iBook-colored SuperDrive accepts both floppy disks and
SuperDisks, which look, smell, and act exactly like floppies - except
that they hold about 83 times as much. Additional SuperDisk disks cost
about $10 each, and they hold 120 megabytes each. A handy double-duty
solution, though s low.

Y'

A Zip drive: Here's yet another add-on disk-drive attachment. This one
comes in translucent blue. It accepts Zip disks, which look like floppy
disks that have been hitting the Ben & Jerry's a bit too often. Each holds
250MB and costs about $15; the Zip drive, the player, costs $200 or $100,
depending on whether you get the 250-meg or 100-meg versions. Zip
disks, like SuperDisks, are convenient, sturdy, and easy to work with; the
advantage here is that hundreds of thousands of people already own Zip
drives. You can carry your project around on a Zip disk in your pocket,
for example, confident that your friendly neighborhood Kinko's, corporate office, or print shop is likely to have a Zip drive that can accept it
(the disk, not your pocket).

Y'

A rewritable CD-ROM drive: Yes, Virginia, the impossible has become
possible: You can now make (or bum, as the geeks like to say) your own
CD-ROMs. You attach one of these special CD drives (about $350) to
your IBook's USB jack; you insert a blank CD (they cost about $2 each);
and you specify what you'd like preserved forever by dragging it off of
your hard drive.

For details on all of this stuff, see Appendix B.

A MocJie Camera
The QuickCam (see Appendix B) is a golf-ball-sized movie camera. It plugs
into your iBook's USB jack and lets you make smallish - but genuine - digital movies, recording whatever you point it at. There's no less expensive way
to try your hand at filmmaking.
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A Microphone
Adding a mike to your iBook brings you a lot of fun for not much money. You
can use a USB microphone, of course, or any microphone at all with the addition of an adapter, such as the iMic (www.griffintechnology.com).
Once you're all adapted up, you can record sound from any source - the TV,
a baby, a blindfolded informant - using the SimpleSound program in your ti
menu. See the next chapter for instructions.
Mac fans have used this feature for years to replace the standard beeps and
boops that usually serve as the error sound. Using the Sound control panel,
however, you can designate that one of your own home-ground sounds
should be that error beep - which is handy if you've got a local infant who's
just learned to say, "Uh-oh!"

Chapter 20

Ten Cool Things You Didn't Know
Your iBook Could Do
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t's fast, it's hip, and it complements any decor. But the iBook does more much more. Try these some lazy Saturday afternoon.

PlalJ. Music CDs
Yup, it's true. Pop your favorite music CD - Carly Simon, the soundtrack to
Lethal Weapon XIV, or 10,000 Maniacs Smashing Pumpkins - into the iBook's
CD-ROM drive. Some iBooks are set up to begin playing such music CDs automatically; others you have to command to begin playing.
Either way, if you'd like to control your music CDs the way you would on a
$300 CD player, use the "front panel" in your ti menu called AppleCD Audio
Player. It should look familiar.

Hunt around long enough, and you'll figure out how to make your CD play,
stop, skip randomly among the songs, play louder or softer, and so on.
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In fact, if you click the tiny down-pointing triangle (below the NORMAL
button), you'll expand the panel so that you can view the names of the individual songs on the CD. Unfortunately, they start out being called "Track l,"
"Track 2," and so on - it's up to you to click such names and type the correct song titles. (Press Return after each title to move down to the next blank
or Shift-Return to move upward. While you're at it, click the words Audio CD,
just above the track list, and type the name of the disc, too.) After you do all
this, the Player will automatically remember the album and song titles the
next time you insert the disc.
But here's the best part: Click the PROG button. Now you can drag any title
on the left side to any slot on the right side. (Drag it back to the left if you
change your mind.) You also can drag titles up or down on the right side.
What's great about this feature is that you can drag your favorite songs into
the "playlist" on the right side more than once - and leave the annoying
songs out of the playlist completely.
Your iBook can also play the super-popular song files known as MP3 files,
which are available by the quadrillion on the Internet. You need a shareware
program (such as Mac Amp) or a commercial one (such as SoundJamp MP,
which also plays music CDs, and can magically fill in their track names by
connecting to the Internet).

Talk
It's been said that we spend the first year of a child's life trying to get it to
talk, and the next 18 years trying to get it to shut up. Well, with the iBook, getting it to talk is fantastically easy.
Lots of programs are capable of talking. Word 98, AppleWorks, America
Online, and WordPerfect are some examples. But the program that requires
by far the least manual-reading (when it comes to talking) is the delightful,
bargain-basement word processor known as Simple Text.
Find one of your copies of SimpleText (use your Sherlock command). Launch
it and then type up something you've always wanted to have said to you,
such as, "You are such a god! Holy smokes - everything you do turns out fantastically! I'd give anything to be more like you."
Then trackpad on up to your Sound menu and choose Speak All. Aren't computers great?
Now: For added hilarity, go back to the Sound menu. There you'll find a
Voices command that lists as many as 18 different voices to choose from.
They're great: male, female, kids, deep voices, shaky voices, whispered
voices. You'll spend hours, I predict, making up funny sentences for each
character voice to say.
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Of course, Apple didn't create a talking iBook just for you to fool around
making up silly sentences. This technology has some actual, useful uses. For
example, there's no better way to proofread something important than to
listen to it being read to you.

Sin9
Although it's a little humbling that your iBook may be more talented than you
are, it does indeed sing. It has a somewhat limited repertoire - in fact, it
knows only four songs - but it can use any lyrics you want, and it never even
stops to take a breath.
To make your iBook sing, you s imply need to get it talking, as described in the
preceding section. Then choose one of these voices from the Voices menu:
1' Pipe Organ: Sings to the tune of the Alfred Hitchcock theme.
1' Good News: Sings to the tune of "Pomp & Circumstance," otherwise

known as the graduation march.
1' Bad News: Sings to the tune of the funeral march.
1' Cellos: Sings to the tune of "In the Hall of the Mountain King," from Peer
Gynt, by Edvard Grieg. Such culture!

Hint: Punctuation marks make the iBook start over from the beginning of the

melody. Sample lyrics for the Good News graduation-march melody, for example, should look like this:
You just won the jackpot good luck and God bless
Now give half of it to the IRS!

PlalJ. Mo'1ies
Your iBook is quite handy with movies. It can make them, record them, and
show them.
The cornerstone to all this is a technology bundle called QuickTime, which
takes the form of some files that are probably s itting in your System Folder at
this very moment (in your Extensions folder).
Getting movies to play on your screen is simple: Just double-click a movie
file's icon to open it. It'll probably launch good old SimpleText and appear as
a smallish rectangle, as shown here.
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Drag this doodad to
jump around in
the movie

Click here to
start or stop
playback

Click to move one
"frame" of the movie
forward or backward

To play the flick, click the little "play" triangle to make it play back. Drag the
little tiny diamond to jump around in the movie. You'll quickly discover a few
disappointing facts about digital movies: They often play back kind of jerkily;
they're small (playing in a s mall window); and they're generally short. That's
because QuickTime movie files take up obscene amounts of hard drive space
for each minute of footage.
The bigger challenge, the refore, is simply getting a movie you want to watch.
Several sources spring to mind: You can download movies from the Internet
or America Online (see Chapter 6) , although these enormous files take enormous amounts of time to transfer to you by modem.

Send Faxes
Because your iBook has a built-in fax modem, you're in for a delicious treat.
Faxes sent by an iBook come out looking twice as crisp and clean when
they're received by a real fax machine. And sending faxes couldn't be more
convenient for you - no printout to throw away, no paper involved at all.
Your iBook sends the thing directly to another fax machine's brain. (The
iBook can receive faxes, too, if you've given it its own personal phone line.)

_ _ _ _ _ Chapter 20: Ten Cool Things You Didn't Know Your iBook Could Do
Here's what you do. Begin by typing (or opening) whatever it is you want to
fax. Usually, this means a letter you've written in, say, AppleWorks. Make sure
it's in front of you on the screen.
Now take a look at your File menu and notice where it says Print. Got it?
Okay, let go of the mouse now. With one hand, press and hold down the
Option and 00 keys on your keyboard. With the other, go back up to the File

menu and look at the word Print. If all went well, that word Print has now
changed to Fax!
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If you choose the Fax command, you'll be shown a window like this.
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From the Fax Numbers pop-up menu, choose Temporary Address to specify
your lucky recipient's fax number. When you're finished, you'll see that
person's name on the right s ide of the window; click Send to send the fax.
If, by the way, you plan to send faxes to the same person more than once in
your lifetime - a distinct possibility - you may wonder how to avoid having
to use the Temporary Address feature every time you fax.
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Easy. Find the progr am called Fax Browser on your hard drive (in a folder
called FAXstf, in your Applications folder). Launch it. From the Window
menu, choose Fax Numbers; in the next window, click the New Contact
button and then type your correspondent's name, fax number, and other info
(pressing Tab to jump from blank to blank). Repeat until you've input all your
fax numbers.
From now on, whenever you send a fax, specifying the recipient is as easy as
dragging the recipient's name from the left-side list to the right-side list , as
show n here.
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Oh, and one more thing. Suppose you fax a lot, and you find it a royal pain in
the sacrum to have to launch the Fax Brow ser program every time you want
to add a fax number to your permanent list. Wouldn't it be easier, you're
thinking, to be able to add a fax number to your permanent fax book when
you send the fax, right in the FaxPrint box (as shown in the previous picture) ?
If so, a few dollars buys you the full, professional version of FAXstf. See the
upgrade information in the FAXstf folder.

Receit/e Faxes
If you promise not to tell anyone, here's a little secret: Your iBook can receive
faxes, too.
Now, if you want to be able t o get faxes, you must treat your iBook like a fax
machine: th at is, dedicate a second phone line t o it - or live with having to
plug it into your phone jack ( thus blocking normal voice calls) every time
you're expecting a fax.

_ _ _ _ _ Chapter 20: Ten Cool Things You Didn't Know Your iBook Could Do
Here's how to do it: First, find the folder on your hard drive called FAXstf. In
there is a program called Fax Browser. (Fax Browser is probably in your S
menu, too.)
Launch Fax Browser. From the Edit menu, choose Settings. On the left, scroll
until you see the icon for Fax Modem; click it. You'll see a pop-up menu that
lets you make the fax/modem answer the phone when it rings (and how many
rings). If it says Never, then yours won't answer the phone.
When the fax comes in, your Apple menu blinks. Launch Fax Browser to read
and, if you like, print the fax.
There. I just saved you $200.

Fit in Your Pocket
It happens to the best of us: You've truly integrated your iBook into your life.
It's got your calendar, your phone numbers, your to-do list - everything you
need. But you're about to leave the house on an occasion when the iBook is
too big or too interesting-looking to be practical. What's an iBook fan to do?
Your options are:
~

Stuff your iBook into your pocket before each trip. Shred your clothes
and look like an imbecile as you walk into business meetings with
unsightly bulges.

~

Get a PalmPilot.

I

A PalmPilot is one of those amazing handheld compute rs, about the size of an
audio cassette. You can buy various models from various companies, from
the Handspring Visor (about $180) to the Palm V ($400). It comes with a little
stand that plugs into your computer and sucks out a copy all your critical
information: your calendar, phone book, to-do list, memos, and even e-mail.
(The Handspring Visor plugs straight into your iBook's USB jack and comes
with all the software you need; the Palm devices require the addition of a $40
USB adapter, as described in Appendix B.)
You can't run iBook programs on a PalmPilot, but you can keep your life's critical information with you without buying a second computer or new
wardrobe. If, as suggested in Chapter 10, you keep your appointments and
phone book in the Palm Desktop program that came with your iBook, you
have no further steps to make. Suppose you return from a meeting with several new phone numbers you've written into your PalmPilot. You just place it
in the cradle, press the Sync button, and your PalmPilot and your copy of
Palm Desktop (on the iBook) automatically update each other. (Now you
know why it's called Palm Desktop.)
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Record Sounds
If you connect a USB microphone -

or any old microphone via an !Mic
adapter, as described in Chapter 19 - the iBook stands ready to record any
sounds you're capable of producing. That's a perfect arrangement for changing the little beep/ding sound the iBook makes (when you make a mis take)
into some other sound, like "Oops!" or a game-show buzzer or a burp or
something.
To record a sound, do this:
1. From the

S menu, choose SimpleSound.

You get something like this.
D

-=~AlertSounds
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Quack
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Add-
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_ _ _ _ _ Chapter 20: Ten Cool Things You Didn't Know Your iBook Could Do

A sound-playing fact for the detail-obsessed
Here's a way to play a sound that doesn't even
involve opening a control panel: If you're a
double-clicking kinda person, open your System
Folder and then double-click the System file,

whose icon looks like a suitcase. It opens into a
window showing all your fonts and all your
sounds. Just double-click any sound's icon to
hear it played.

2. Click the Add button.
Now you see this.

c ~[DJ[IJ

Record Stop

P~st

<]

Pl~

:01
0

seconds

:38

I Cancel J
I! Save R

3. To record, just click Record and speak into the microphone.
Be ready to click Stop when you're done, or else you'll accidentally
include a bunch of silence and fumbling at the end of your sound.
You can play back your new sound in a plethora of ways. You could, mnemonically enough, click the Play button. Then again, you could click Save and give
the sound a title so that you'll be able to preserve it for your grandchildren.
When you return to the list of sounds in the Sound control panel, click your
new sound's name to play it. If you leave it selected in the list, though, you've
just selected it to be your new error beep.

Run Windows Pro9rams
It's true: Never again must you feel game-deprived . The iBook can run almost
any Windows program alive. All you need is a program like SoftWindows or
Virtual PC. No, your Windows programs won't run quite as fast as they would
on the fastest actual Windows computers - but you, 0 lucky iBook owner,
will find it fast enough.
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Print Photos
Armed with a d igital camera (see Chapter 19) and a color printer (see
Chapter 5), there's no reason for you to spend money and time waiting for
your photographs to get developed. Now you can s pend money and time
printing them from your iBook, instead.
The bad news: The glossy photo paper costs $1 per letter-sized sheet. You
can't make enlargements - if you try to enlarge your digital photos, they
start to look grainy. The d igital camera (but not the printer) is expensive.
The good news: The printing is fairly fast. It looks amazing, especially on the
$1-a-sheet glossy paper. And you can edit your photos before you print them,
correcting the color tint, adding or removing bushes, adding or removing
unwanted family members.
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The Resource Resource
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User 9roups
MacHome Journal

For beginners, students, athome Mac users. Visit the
Web site and sample the
articles to judge the tone.
800-800-6542
415-957-1911
www.machome.com
Macworld

News, reviews, analysis;
more advanced. You can
always read the articles
and reviews, for free, at the
Web site, so that you can
try before subscribing.
800-288-6848
303-447-9330
www.macworld.com
MacAddict

Fun, irreverent, lots of
games and gadgets; every
issue comes with a CD-ROM
filled with goodies. The articles aren't on the Web site,
however.
800-666-6889
415-468-2500
www.macaddict.com

Apple User-Group Info Line
800-538-9696 ext. 500
Call to get the number of
the nearest Mac club.

Deep-discount
mail-order
joints
Contact these outfits when
you're interested in buying
any of the programs or addons described in this book.

Shopper.com
www.shopper.com

A Web site that compares
prices of computer add-ons
and software from every
mail-order firm on the Web.
You'd be crazy not to comparison shop here before
buying anything; you can
save major money on
everything you buy.

Great iBook
Web pa9es
Apple
www.apple.com/ iBook

800-248-0800

The mother ship: Apple's
own page of iBook information. Contains links to the
all-important Support
pages, where you'll find
software updates, "technical notes" that describe
any glitches Apple has discovered, and how to solve
them.

Cyberian Outpost

MacSurfer

MacConnection
www.macconnection.com

800-800-4444
MacWarehouse
800-255-6227
Mac Zone
www.maczone.com

www.outpost.com

(800) 856-9800
(860) 927-2050

www.macsurfer.com

A daily roundup of articles
about the Mac from
newspapers and magazines
around the country. Click a
listing to read that article.
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www.imacintouch. com

SiteLink
www.sitelink.net

Sounds like it would cover
only iMac stuff, but devotes
equal time to the iBook.
Includes a fantastic, alwaysupdated listing of add-on
gadgets (scanners,
adapters, and so on).

A Web page that links to
other Web pages about
the Mac (and the iBook).
You'll be on the Web until
you're 90.

O'Grady's Power Page
www.ogrady. com

News, updates, tricks, and
prod uct announcements all about the Apple laptops.
Quite a large chunk of it is
devoted to iBook s tuff.

MacOS Rumors
www.macosrumors.com
The National Enquirer of the

Macintosh world - wild,
juicy, sometimes erroneous, but always
entertaining rumors about
Apple's secret plans for the
future.

Lots of Homegrown Web

sites

The Web is full of additional
iBook-related Web sites.
Generally, they're unproofread but entertaining, each
run by one or two people.
You might scope out, for
example, iBook2day
(www.iMac2Day.com/ ibook),
iBookOnline
(www. ibookonline.com),
The iBook Zone
(www.ibookzone.com),
iBook Planet
( www.iBookplanet.com) ,
and so on.
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The Ultimate iBook Buyer's Guide
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~is appendix lists dozens of gadgets and accessories. Most plug into the

I

;Book's USB jack, and many match the iBook's striking translucent tangerine-or-blueberry looks. Get out your Visa card, read the details using the
Web-page addresses I've included here, and go wild.
As for the prices - consider them rough guides. Not only do they rise and
fall like John Travolta's career, but some companies list "street" prices (what
you'll actually pay) and others list list prices, which nobody actually pays.

One more thing: Unless you mail me your front-door key, it's going to be a
little tough for me to keep the following pages updated. On the Web, however,
various lists of iBook-<:ompatible products are updated constantly. Try, for
example, these two authoritative lists of iMac- and iBook add-ons:
Y" Apple's list of USB-<:ompatible products at http://guide.apple.com/

I

uscategories/ usb.html. Includes clickable links to the Web pages of every
company listed here.

Y" iMacintouch, which is at www.Macintouch.com/ imacusb.html. It's a simi-

larly up-to-date listing of add-ons for iMacs and iBooks.

Printers & Printer Adapters
With the proper cables, you can plug your iBook into any of - get this over 1,500 different printer models. For example, the following companies
make iBook-ready printers:
Chapter 5 describes the most common kind of printers:
inkjets and laser printers. There's a third kind, though: dye sublimation, which
is less common because it's usually astronomically expensive. This photoquality dye-sub printer, however, is only $400 - and unlike inkjets, the color
printouts from this baby don't smear or fade.

Alps MD-1300 -
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Alps also makes an even higher-res photo printe r, the $600 MD-5000 Desk Top
Print Shop, shown here, which lays down a staggering number of dots per
inch (2,400 dpi). A $99 USB adapter cable is required for both printers.
www.alps.com.
Epson - The Stylus Color line of inkjet printers are incredibly popular with
iBook and iMac fans. They're inexpensive, but produce gorgeous color printouts; the bestselling model, the 740i, even comes with a translucent
blueberry plastic cover to match your iBook (you can order a tangerine one
to replace it). The 740 prints five pages per minute up to 1,440 dots per inch,
and costs about $240; models 750, 900, and 1,200 are fas ter and higherquality. A few older models (440, 600, 640, EX, 700, 800, 850, 1520, or 3000)
can work, too, but only if you also buy the $50 USS/Parallel Printer Adapter
Kit. www.epson.com/printer.
GCC Technologies- Inkjet, schminkjet: if you're in business for yourself,
you really should have a laser printer for top-quality, smudgeproof, blackand-white printouts. GCC makes several under $1,000, which you can attach
to your iBook either with a USB cable or an Ethernet cable (see Chapter 14).
www.gcctech.com.
Hewlett-Packard - HP has bee n making great printers for decades; the color
inkjets in the DeskJet series, such as the 810C, 812C, 880C, 895Cse, and
895Cxi all connect directly to the iBook's USB jack. (Remember, the USB
cable is almost never included with printers.) www.hp.com/ cgi-bin/
peripherals/pandi.pl.
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iPrint - Farallon makes two $110 adapters that accommodate pre-USB
Macintosh printers. One, the iPrint LT, is for Loca/Talk printers (usually laser
printers); also requires a PhoneNet connector (see Chapter 5) for the printer.
The other adapter, the iPrint SL, is for injket printers like Apple StyleWriters
(models I, II, 1200, 1500, 2200, 2400, and 2500). Each iPrint plugs into your
iBook's Ethernet jack. www.farallon.com.
Lexmark - Lexmark, the printer division of IBM, designed this very inexpensive ($400), compact laser printer (8 pages per minute, 600 dots per inch) to
connect to the iBook's USB port. (If you're planning to set up an Ethernet network, as described in Chapter 14, you can also consider any of Lexmark's
other laser printers, which connect to the Ethernet jack instead.)
www.lexmark.com/ printers/ laser/ index.html

PowerPrint USB to Parallel-Talk about mind-blowing choices: This $100
adapter kit lets your iBook hook up to any of 1,500 different IBM-compatible
printers - every conceivable kind, price, and model. Comes with software
and a cable that hooks up to one of your USB jacks. lnfowave,
www.infowave.com.

Multifunction Printers
These machines combine several functions in a single gadget- ideal if you
work out of a very small office. Canon, for example, makes the $380 MultiPass
C635 includes a scanner, fax machine, color copier, and color printer
( www.ccsi.canon.com/prodfact/c635. html).

Epson (www.epsonamerica.com), meanwhile, makes the Stylus Scan 2000,
Stylus Scan 2500, and Stylus Scan 2500 Pro - $350, $500, and $700, respectively - which vary by scanning quality and features. Each is primarily a
scanner, copier, and printer; however, these machines don't include a fax
modem. (Your iBook, however, does.)

Adapters for Older Mac Gad9ets
Serial, ADB, and SCSI are three kinds of jacks not found on the iBook. (Serial
means "modem or printer jack," ADB means "keyboard or mouse jack," and

SCS/means "external hard drive, Zip drive, or scanner jack.") But because all
150 previous Macintosh models had them, thousands of older, pre-iBook addon gadgets are alive, well, and kicking around the offices of the world.
Fortunately, they can connect to an iBook with one of these adapters.
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Serial adapters
A serial port is the small round connector on old Macs - where you used to
plug in your modem, printer, PalmPilot, digital camera, or digital drawing
tablet. The following adapters hook into your iBook's USB port; you plug your
old Mac gadget into the adapter.

USB serial adapters
This kind of adapter box accommodates many StyleWriter, Epson, or HP
printer models; the PalmPilot cradle; certain digital cameras; and even
Wacom drawing tablets. Read the compatibility lists on the corresponding
Web sites before buying, however; this kind of adapter doesn't work with
MIDI, GeoPort, LocalTalk, or some printer models. Keyspan's USB Twin Serial
Adapter is $80, offers two serial ports, works with all StyleWriter models, and
is pictured here (www.keyspan.com); Entrega's is made of translucent plastic,
costs $80, and is called the CON-USB-08 (www.entrega.com).

ADB (mouse and ke1J.board) adapters
The iMate is a little translucent adapter that lets you plug old-style (ADB)
Macintosh keyboards and mice into the iBook's USB jack. $40 from Griffin
Technology, www.griffintechnology.com.

_ _ _ _ _ _ _ _ _ __ Appendix B: The Ultimate iBook Buyer's Guide

Microphone adapters
The iMic adapter lets you plug any microphone or RCA-jack line input into
your iBook's USB jack. $25 from Griffin Technology,
www.griffintechnology.com.

SCSI adapters
SCSI (pronounced "scuzzy") technology can be a royal headache, sometimes
requiring much fiddling and experimenting. It's a type of connector and fat
cabling found on all pre-iBook Macintosh models. But if you've got some
aging SCSI gadget (such as a Zip drive, Jaz drive, hard drive, or scanner) that
you want to mate with your iBook, a USB-to-SCSI adapter will fit the bill.
You can choose the $80 USB SCSI Converter from Entrega (www. entrega.com),
the $80 ScUSBee from Second Wave (www.2ndwave.com), the $80 USB
XpressSCSI from Microtech (www.microtechint.com), the $80 iSCSI from
Ariston (www.ariston.com), or the $80 uSCSI from Newer Technology
(www.newertech.com).

Di9ital Cameras
As you can read in Chapter 19, as expensive gadgetry goes, these babies are
pretty wonderful.
QuickCam VC - This $80 golf-ball-sized USB-jack camera can take still pictures
(352 x 288 dots, which is pretty small) and even digital movies (at about 15
frames per second). It's got an adjustable focus lens and a six-foot cable. (The
QuickCam itself is sold for Windows computers only. But with the addition of
the free software located at www.logitech.com/Cameras/ quickcamvcmac.html,
it'll work with your iBook, too.) Logitech, www.logitech.com.
iSee Camera - This archrival to the QuickCam looks nearly identical: It's a
two-inch gray sphere. But its picture-taking quality is better (640 x 480 resolution), and the price ($110) isn't bad. iSee plugs directly into your iBook's USB
jack, and it can even make low-res digital movies. From Ariston,
www.ariston.com.
Digital Cameras - These digital cameras don't use film. Instead, you get a
TV-style display built into the camera to see your pictures. You can delete the
ones that didn't turn out and try again; when the camera's memory is full,
you dump the pictures onto your iBook for viewing, editing, and sending over
the Internet. All of these cameras plug directly into your iBook's USB jack.
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DC280, DC290, and so on), is pictured below, and is described at
www.kodak.com/ US/en/ nav/ digital. shtml; for Toshiba's line, try
www.toshiba.com/taisisd/dsc/products/cameras/index3.htm.

ImageMate - Many digital cameras use, as "film," a removable memory card
called a CompactFlash card. This $90 gadget is an external reader/writer of such
cards, so that you can rapidly transfer pictures from thus-equipped digital cameras to your iBook. From SanDisk, www.sandisk.com/cons/ imagemate-USB.htm.
PC Card Reader or CameraMate USB - These machines accept PC cards, yet

another form of "electronic film" used by today's digital cameras (including
the abovementioned Kodak models). Fill up a PC card with pictures, slip it
into a PC Card Reader, and it's transferred to your iBook. $150 for Ariston's
card, www.ariston.com, or $90 for the Microtech CameraMate,
www. m icrotechint. com.

Disk Dri<les
The iBook doesn't come with a built-in floppy drive. Although there are
plenty of ways to back up your work without disks (see Chapter 4), most
people prefer to be able to carry their stuff around on a disk. These gadgets
plug into your USB jack.
External floppy drives - Buy one of these, and now your iBook has a floppy
drive that you can detach and leave behind when you're traveling. Compare
the styling and features of, for example, the $100 uDrive (Newer
Technologies, www.newertech.com) , the $80 iFloppy (iDrives,
www.idrives.com), the $85 SmartFDD (Microtech, www.microtech-pc.com), or
the $90 USB Floppy Drive (VST, www.vsttech.com).

None of these devices require a power cord; they get electricity from the
iBook itself. (The uDrive comes with a power cord, though, if you'd prefer
that the drive not sip juice from the laptop itself.)

_ _ _ _ _ _ _ _ _ _ _ Appendix B: The Ultimate iBook Buyer's Guide
SuperDisk drives - A SuperDisk drive looks just like an external floppy
drive - many are made of iBook-colored translucent plastic - but it's a twoin-one disk drive. It accepts both floppy disks (from Macs or Windows
machines) and SuperDisks, which look like floppies but hold 83 times more
(120 megs). Those bigger-capacity disks are $65 for a five-pack.

SuperDisk drives (pictured here) are sold by Imation ($140,
www.imation.com), Winstation ($150, www.winstation.com/ ssdspec.htmQ , or
Global Village ($170, www.globalviflage.com).
USB Zip Drive -A Zip drive is another kind of external disk drive. It doesn't
accept standard floppies drives, but it does accept Zip disks that hold 100 or
250 megabytes, depending on the model you buy, just like the millions found
in Macs and PCs worldwide. You can get, for example, the Anaconda Zip 250
(from EZQUest, www.ezq.com/z250.htm0, the regular Zip drive from the
maker, Iomega (about $130 for the lOOMB version, more for the 250MB,
www.iomega.com), or the extremely sleek, small Mil Zip 100 ($200,
www.microtech-pc.com/ products_imac.shtmO. Zip disks cost about $12 each.
Rewriteable CD-ROM drives - Using one of these gadgets, you can actually
make your own CDs , filled with either music (for your stereo) or information
(for your iBook). Note, however, that actually figuring out how to use them is
not a task for the weak of stomach (or the new to computing). They're sold
by LaCie ($300, www.lacie.com), Mitsumi ($380, www.mitsumi.com), and QPS
($275, www.qps-inc.com).
Additional hard drives - Your iBook's hard drive is immense by 1995 standards, but not so huge by today's. If you're heavily into graphics, digital
sound, or digital movies, your 3.2 gigabytes will fill up quickly.
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Most people solve the "out of space" problem by buying a Zip or SuperDisk
drive, as described in the previous paragraphs. A few, however, prefer to add
another hard drive. An external USB hard drive is about the size of a deck of
cards, and could not be more convenient - it requires no power cord, and its
cable pops right into your USB port. VST, for example, makes sleek, hard
drives in capacities of 4 and 6 gigabytes ($330 and $430, www.vsttech.com),
and with both tangerine and blueberry cases. If you need even more space
than that, and don't care so much about looks, visit www.fantomdrives.com,
where you'll find hard drives from 4.3 gigs ($260) all the way up to a mindblowing 25 gigs ($530), almost eight times the size of your built-in hard drive!

]01J.sticks and Game Pads
As far as its circuitry is concerned, the iBook is a great gadget for games.
What's lousy, however, is the experience of trying to fly a Falcon fighter jet by
dragging your finger across a trackpad. Flying your plane/spaceship/ laser
destroyer is far more enjoyable with a joystick or gamepad instead.
You can choose from dozens of these USB devices - if I tried to describe
them all here, I'd waste enough paper to tear down half the Brazilian rain
forest. Begin your quest, therefore, at one of the Web sites listed at the beginning of this chapter - www.imacintouch.com or
http://guide.apple.com/ uscategories/ usb.html. Each has a special category listing for joysticks, game pads, and other gaming gadgets.

Ke1J.board and Mouse Replacements
The iBook keyboard is terrific, as laptop keyboards go. When you're at home,
however, if you're an accountant or a person who types a lot of phone numbers, you may quietly wish you had a separate number pad off to the right of
the letter keys - and other niceties of "real" keyboards.
As for the trackpad, well, it's no mouse. If you do graphics, word-processor
editing, Web page design, or other pointer-intensive work, a mouse is a far
better tool. Unfortunately, the iBook's USB jack is on the left side of the iBook
machine, which means that - if you're right-handed - you'll have to wrap
your mouse's cord around behind the laptop. Fortunately, the included cord
is generally plenty long.
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Mice
Most iBook mice are made of translucent blue plastic. Some have two or
three "clicker" buttons on top - they all, oddly enough, do exactly the same
thing as the button on a one-button mouse. You can choose from the Podiki
mouse, which is transparent right down to its power cord (Ariston, $25,
www.ariston.com); the translucent blueberry Compucable USB mouse
(www.compucable.com); the smoothly sculpted, see-through iMaccessories
mouse ($20, www.imaccessories.com); MacAlly's iSweet mouse, which comes
with five translucent snap-on fruit-colored shells ($40, www.macally.com);
and many others. ( MacAlly's iMouse is pictured below.)
You might be particularly intrigued by Microsoft's $75 lntelliMouse USB,
which is an optical mouse. It doesn't have a ball underneath to detect motion
(a magnet for lint, cat hair, and other crud); instead, it detects motion using a
tiny electronic eyeball underneath. You can program its two mouse buttons
to perform different functions - and the smoothly turnable fingerwheel
between the buttons lets you scroll down Web pages or word-processor documents without having to use the actual scroll bar.

Trackballs
A trackball is another alternative to a trackpad or mouse. It looks like an 8ball in a pedestal; you control the mouse pointer by rolling the ball with your
hand. The clickers are buttons on either side.

Some people adore trackballs because they (the trackballs) sit in one place
and don't require a lot of desk space, as a mouse does. Others find trackballs
difficult to control. If you're a trackball kind of person, however, here are
some to consider: The offering by Mousetrak has six big, programmable
buttons around the ball, which you can set to click, double-click, or drag, for
example (www.mousetrak.com). The one from iMaccessories ($40, www.
imaccessories.com) actually lights up. And the MacAlly iBall, pictured above,
is made of cool see-through blue plastic ($30, www.macally.com).
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Kev.boards
The world teems with great USB add-on keyboards, like those from MacAlly
(www.macally.com), iMaccessories (www.imaccessories.com), and Cherry
(www.cherrycorp.com). Each has its own charms and features - for example,
the Cherry keyboard is both a keyboard and a USB hub! Get this clever keyboard, and you also get four empty USB jacks, suitable for plugging in aU the
other gadgetry in this chapter. (Read about USB hubs at the end of this
chapter.)
Because the iBook keyboard is already so good, you may also want to consider adding only the number pad portion. You can get such a pad in the form
of the $40 iPad (www.imaccessories.com); you can plop it to the left or right
side of the iBook itself, as befits your handedness.

Scanners
As described in Chapter 19, a scanner is eyeballs for your iBook: It captures a
flat image (usually a photo) and turns it into a graphics file (or even text file)
on your computer. Once it's on the iBook, you can edit it, mail it to friends ,
and so on.
You'll find a complete line of USB scanners, starting at about $120, from Umax
(www.umax.com), Agfa (www.agfa.com), Microtek (www.microtek.com),
Epson (www.epson.com), and others.
As a laptop owner, however, you might be particularly intrigued by the NEC
PetiScan (www.petiscan.com). It's a tiny little thing, 8.5 by 5.5 inches (and 1.4
inches tall), weighing only 1.3 pounds, and it doesn't need a power cord. It's
too small to scan full-sized pages - the max scanning size is 5.8 by 3.9
inches - but as a portable photo scanner, there's nothing like it.

Speakers
Yeah, sure, the iBook has a built-in speaker already. But it's pretty small, and
nowhere close to being able to shake the rafters. That's why you might consider plugging a pair of these into the speaker jack on the left side of your
laptop. You can find deliciously designed, translucent blueberry- or tangerine-encased speakers from, for example, Pele ($50, www.pelezone.com) or
Ushischiba ($90, www.cozo.com).

_ _ _ _ _ _ _ _ _ _ _ Appendix B: The Ultimate iBook Buyer's Guide
If you're willing to forgo translucent fruit colors, you might also want to con-

sider flat-panel speakers ($90, www.benwin.com/ fpmain.htm) or 30-spatially
enhanced ones ($40, www.ariston.com). (Your local computer store stocks
many other brands of computer speakers that aren't necessarily iBookish in
design.)

USB Hubs
Once you've read this chapter, you'll no doubt be salivating, shouting: "All I want 'em all!"
Assuming your credit line can, in fact, handle such extravagance, only one
more obstacle stands in your way: Your iBook has only one USB jack. When
your scanner's hooked up, your floppy drive can't be.
No matter - that's the beauty of USB. Buy one of these hubs, and you've got
yourself four or seven additional USB jacks, ready to accept a world of add-on
gadgetry. You can even plug one hub into another hub, thus expanding the
number of free ports available, up to 127 (or your credit limit, whichever
comes first) .
There are close to 34 trillion different USB hubs for sale; even USB hubs not
designed for the iBook work with the iBook. Many of them, like the Interex
model (www. interex.com) model pictured here, are made of translucent fruitcolored plastic, like the iBook.

Expect to pay about $50 for four USB jacks, and $80 for seven. Note, incidentally, that a few USB gadgets described in this chapter - especially scanners,
CD-ROM makers, and SCSI adapters - require a lot of power. They work only
when they're plugged directly into the iBook's USB jack or into a powered USB
hub. Shop accordingly.
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• S1Jmbols •
<> (angle brackets), 123, 157
*(asterisk), 51, 119
@(at sign), 122
, (comma), 134
3€ (command symbol), 37
(} (curly braces), 119
. (decimal point), 184
$(dollar sign), 184
"(double quotes), 93-94
=(equal sign), 184
- ( hyphen), 184
- (minus sign), 184
. (period), 63, 260
#( pound sign), 194
' (single quote), 93- 94

About Apple Guide extension, 233
About This Computer, 28-29, 30, 33
AC power, 311-312
accents, 170
Access keyword, 117
access privileges, 302. See also Internet
Safety Kit; Multiple Users control panel
accessories, 50-57. See also specific
accessori es

Acrobat (Adobe), 129
Acrobat Reader (Adobe), 129
ActiveX Controls extension, 233
adapters, 96, 134,355-359
Add Bookmark command, 149
Add to Favorite Places command, 118
Add to Favorites command, 149
address books (contact lists), 193-197
Adobe Web site, 129
Advanced button, 149, 214
advertisements, blinking, 150

AirPort Cards
AOL and, 291- 292
base stations, 283- 289
basic description of, 281- 292
Control Strip options for, 283, 285,
288- 289, 290
iBook-to-iBook communication with
290-291
•
installing, 282- 283
problems, troubleshooting, 292, 312- 313
pros and cons of, 282
saving battery power and, 212
AirPort Setup Assistant, 286-288, 290, 313
Aladdin folder, 128
alarms, 192-193
alerts, 231
aliases
creating, 219, 246-248
deleting, 249
Allow Processor Cycling option, 212
Amazon.com Web site, 142, 145
America Online (AOL). See AOL (America
Online)
angle brackets (<>), 123, 157
Animated GIFs option, 150
antennae, radio transmitter, 212, 281, 290
antialiasing, 222
AOL (America Online)
access numbers, looking up, 130-131
AirPort Cards and, 291-292
basic description of, 111-134
chat, 119, 120
compression formats, 160
downloading fonts from, 105
downloading software from, 127
e-mail, 11 4, 118-119, 122, 153-162
extensions, 233
favorites feature, 117
finding free software with, 120-121
finding wallpaper on, 252

AOL (continued)
navigating, by keywords/ icons, 116, 117
newsgroup access, 123-124
overseas access with, 134
parental controls and, 207-208
pros and cons of, 114
quitting, 125
screen names, 115, 119
setup, 115-116, 131
technical support resources, 331
Web access, 126, 136-146
Appearance control panel, 59, 106, 221
customizing icons with, 254-255
customizing your desktop with, 222,
251- 252
Appearance folder, 218
Apple Color SW extension, 233
Apple Computer Web site, 144, 235, 282,
330, 354
Apple Extras folder, 51, 218, 219
Apple IX3D extension, 234
Apple LaserWriter printers, 98. See also
printers
Apple (S) menu
About This Computer command, 33
basic description of, 28- 29, 50
Control Panels command, 62
identifying the program that you are in, 82
Remote Access Status command, 126
Sherlock command, 129, 141
Apple Menu Items folder, 218-221
Apple Menu Options, 224
Apple Monitor Plugins extension, 234
Apple StyleWriter printers, 97- 98
Apple System Profiler, 218
AppleCD Audio Player, 219, 233, 341
AppleCD extension, 233
AppleDouble, 159
AppleEnet extension, 234
AppleFax, 330
AppleQD3D extension, 234
AppleScript extensions, 234
AppleScripts, 219, 234
AppleShare extension, 234
AppleTalk, 98, 100, 224, 276, 278

AppleTalk control panel, 98, 100, 276, 278
AppleWorks
basic description of, 48, 165-186
drag-and-drop with, 68, 70
draw features, 166, 176-178, 188
error messages, 299, 300
format, file attachments in, 159
formatting text with, 70-75, 107- 108
Fractional Character Widths option in, 108
launching, 165-166
painting feature, 166, 185
retrieving documents with, 82- 84
saving files with, 75-81, 84-85
spreadsheet features, 166, 179-185
AppleWorks folder, 165
application(s)
allocating memory to, 301 , 322-324
currently active, identifying, 82
which launch themselves every time you
start up, 310
Microsoft Windows, running, on your
iBook, 349
self-hiding, 22
use of the term, 4 7
"Application has unexpectedly quit" error
message, 301
Application menu, 53- 57, 80, 81- 82
"Application not found" error message,
299,317- 318
Application Switcher, 234, 246, 249
Application Switcher extension, 234
Application Support folder, 218, 239
Applications folder, 188, 302
Applications tab, 268
Appointment dialog box, 189-191
appointments, 189-193
Ariston, 337
Around the World feature, 204
Arrow tool, 178
arrows, downward-pointing, 38
As List command, 21 , 43
assistants
AirPort Setup Assistant, 286- 288, 290, 313
Internet Setup Assistant, 121-122, 153, 220
Mac OS Setup Assistant, 10-11
Presentation Assistant, 186
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asterisk(*), 51, 119
at sign(@), 122
AT! extensions, 234
ATM (Adobe Type Manager), 224
Attach File icon, 160
attachments
basic description of, 157-160
opening, 127, 160,300
receiving, 160
sending, 157-160
Auto-Capitalization option, 194
Auto-completion option, 194
Automated Tasks, 219
Automatically Load Images option, 149
AutoStart, 301
auto-wakeup feature, 213-214
Aver Web site, 338

Background Printing option, 102
Back.Jack.com Web site, 125
backup operations, 26, 125
basic description of, 85-89
with the File Synchronization control
panel, 226-227
Banking area, of AOL, 117
Banner dialog box, 192
banners,48, 150, 192- 193
Base Stations, 283-289. See also
AirPort Card
Base64 format, 159
batteries. See also Energy Saver control
panel
basic description of, 209-215
changing, 209-210, 213, 314
charging, 8
life span of, 8, 210
compartments for, 209, 312
power of, conserving, 211-213
problems with, troubleshooting, 308,
311-312
sleep mode and, 14, 210-211, 213-215
warning messages for, 210-211
Beginners area, of AOL, 11 7

Belkin, 337
Billing area, of AOL, 117
BinHex format, 159
Bold command, 73
boldface font, 72-74, 108. See also fonts
bookmarks, 149-150
Bookmarks command, 150
booting. See restarting; startup
Browse button, 125
Browse the Internet command, 219
Bugdom, 187,200-201

•C•
cable modems, 113, 281. See also modems
cables,96,275-277,278
Calculator, 50-56, 219, 245
calendars, 188-191, 195, 199
cameras, digital, 336-337, 339, 350,
359-360
cancel action, 102, 260
capitalization, 157, 194
CarbonLib extensions, 234
CD-ROM Auto-Play option, 301
CD-ROM drives. See also CDs (compact
discs)
auto-play options for, 301
basic description of, 42
rewritable, 339, 361
CDs (compact discs). See also CD-ROM
drives
ejecting, 42, 88-89
inserting, 42
music, playing, 341-342
Software Install CD, 315
Software Restore CD, 326-328
channels (icon buttons), 144-145
character formatting, 72-73, 74. See
also fonts
chat rooms, on AOL, 119, 120
children, safety features for. See Internet
Safety Kit
Chooser, 97, 100, 103, 219
clean reinstall, 297, 309, 324-328
clear action, 261
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ClickTV Web site, 145
Clipboard, 53-55, 93, 241
clock, 11, 314
Close box, 18
Collapse box, 18
color. See also ColorSync control panel
of highlighting, 221
of icons, 253- 254
of letterhead, 177-178
palettes, 177-178
on your screen, 311
Color Picker extensions, 234
ColorSync control panel, 224, 234, 239
ColorSync Profiles folder, 239
columns, rearranging, 257
comma(,), 134
commands
Add Bookmark command, 149
Add to Favorite Places command, 118
Add to Favorites command, 149
As List command, 21, 43
Bold command, 73
Bookmarks command, 150
Browse the Internet command, 219
Configurations command, 132
Connect To command, 219
Contact List command, 196
Control Panels command, 62
Copy command, 52- 53, 55, 56, 178
Disconnect command, 126
Duplicate command, 43
Eject Disk command, 42, 89
Empty Trash command, 42, 43
Favorites command, 219
Find command, 173
Find Contact command, 199
Get Info command, 43, 251, 324
Help command, 22
Hide Others command, 245-246
HotSync Manager command, 302
Instant Message command, 119
Load Images command, 149
Mac Help command, 22- 23, 230
Mail command, 220
Mail Merge command, 172-173
Make Alias command, 246- 248

New Folder command, 35, 36
New Note command, 198
New Record command, 171
Open command, 17, 83, 85, 129
Outlook Express command, 155
Page Setup command, 106
Paste command, 54, 55-56, 179
Preferences command, 108, 124, 149
Print command, 100, 156
Quit command, 125, 304
Recent Documents command, 220
Refresh Message List command, 124
Remote Access Status command, 126
Save command, 31-32, 75
Select All command, 93
Sherlock command, 129, 141
Show Rulers command, 74
Shut Down command, 15
Sleep command, 14, 15
Task List command, 197
Undo command, 56, 57
View Images command, 149
compression, 127-129, 159-160
CompUSA, 275
computer names, 11
Computer to Computer option, 291
Configurations command, 132
Conflict Catcher, 103, 240, 321-322, 326
Connect To command, 219
Contact dialog box, 195
Contact List command, 196
contact lists, 193-197
Contextual Menu extension, 234
Contextual Menu Items folder, 22 1
contextual (pop-up) menus, 44-45, 78, 221,
234, 26 1. See also menus
control panels. See also specific control
panels

basic description of, 57-58
top ten, 58- 60
Control Panels command, 62
Control Panels folder, 20, 57, 219, 221- 223
Control Strip, 126, 212, 224-225
AirPort options on, 283, 285, 288- 289, 290
color options, 31 1
extension, 234-235
zoom settings, 250
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Control Strip Modules folder, 221
Control-clicking, 44-45
Copy command, 52-53, 55, 56, 178
copying
to/from the Clipboard, 52-56
to/from disks, 88
files , basic description of, 43
letterhead, 178-179
Courier font, 105, 106
.cpt file extension, 128
crashes,296-297,322
Create button, 167
curly braces ({}), 119
curly quotes feature, 93-94
Currency option, 184
cursor(s)
basic description of, 12
blink rates, 60
I-beam cursor, 64-65
cut-and-paste, 93
Cyberian Outpost, 35~

• D•
Daily view, 189-190, 191, 198
databases
building, 167-168
data entry time for, 169-170
handling, in AppleWorks, 166, 169-170, 173
finding and sorting in, 173
Date & Time control panel, 11, 57-58, 225
dates and times
incorrect, problems with, 314
settings for, in the Date & Time control
panel, 11, 57-58, 225
decimal points (.), 184
Default Calibrator extension, 235
Define Database Fields dialog box, 168
defragmention, 304-305, 328
Delete icon, 156
deleting
aliases, 249
appointments, 189, 191
e-mail, 156
fonts, 105

preference files, 298
tasks, 197
text, 63, 65-66
desk accessories, 50-57. See also specific
accessories

desktop
background wallpaper for, 222, 251-252
basic description of, 15-16
display options for, 222, 228, 251-252
downloading files to your, 127
moving items on, 15-16
Desktop button, 79, 121, 127, 172
Desktop file, 314, 317-318
Desktop Printers file, 242
Desktop Printing extens ions, 103, 235
Desktop tab, 222, 252
diacritical marks , 170
Dial Assist control panel, 225
Dialing icon, 200
dialog boxes. See also specific dialog boxes
basic description of, 75-76
using the Tab key in, 101-102
Dictionary feature, 204
digital cameras, 336-337, 339, 350, 359-360
Dilbert Web site, 145
DIMMs (Dual lnline Memory Modules), 307
Disconnect command, 126
disk(s). See also floppy disks; hard drives
ejecting, 42, 88-89, 313-314
initializing, 87
locked , 313
renaming, 313-314
SuperDisks,86-89,226,338-339,361
Zip disks, 26, 86-89, 226, 338-339, 361
Disk First Aid, 309
DiskExpress, 328
"DNS Entry not found" error message, 302
DNSPlugin extension, 235
.doc file extension, 159
documents. See also files
use of the term, 82
working with, 75 -82
Documents folder, 79, 228
dollar sign ($), 184
Don't Save button, 81
Done button, 168
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DOS (Disk Operating System), 226
double quotes ("), 93- 94
double-clicking, 18-19, 143
downloading
files from AOL, 105, 127
opening files after, 126-129, 299-300
shareware, 121
dpi (dots per inch), 98, 108
Drag Lock option, 59
drag-and-drop, 58-60, 67-70
Dragging option, 59
drawing features, in AppleWorks, 166,
176-178, 188
DrawSprocketLib extension, 235
DSL (digital subscriber lines), 113, 281
Duplicate button, 133
Duplicate command, 43
DVD Driver extension, 233
dye sublimation printers, 355. See
also printers

•£•
e-mail
addresses, 122
with AOL, 11 4, 118-119, 122, 153-162
basic description of, 122, 153-162
deleting, 156
etiquette, 157
fonts and, 105- 106
forwarding, 118, 156
junk (spam), 161, 188
messages, processing, 155-156
parental controls and, 207-208
printing, 118, 156
reading, 155
replying to, 155-1 56
saving, 118, 156
sending, 119, 154
Earthlink, 11 3, 122, 292
access numbers, looking for, 132-134
newsgroup access with, 124
overseas access with, 134
Earthlink Web site, 132
Edit menu
Copy command, 52-53, 55, 56, 178
New Record command, 171

Paste command, 54, 55-56, 179
Preferences command, 108, 124, 149
Undo command, 56, 57
Edit New User dialog box, 266-267
Efax.com Web site, 146
EfaxMac, 146
Eject Disk command, 42, 89
EM extension, 235
emoticons, 157
Empty Trash command, 42, 43
Enable Audio CD AutoPlay option, 301
encyclopedias, 117, 187, 202-204
Energy Saver control panel, 59, 212,
214-215,225,315
Epson printers, 95-98, 100, 235, 356-357
Epson Stylus extension, 235
equal sign (-), 184
"Erase before restoring" option, 328
"Error 404" error message, 302
error messages. See also troubleshooting
basic description of, 299-303
beep sound accompanying, 340
numbered, 302- 303
Ethernet. See also networking
basic description of, 275-280
cables,275-277,278
connecting to one other Mac with,
275-277
creating a full-office network with,
278-280
hubs, 278
jacks,98,99
printing and, 98-100
software setup, 276-277
etiquette, 157
Excel (Microsoft), 48, 159, 179
.exe file extension, 129
executable files, 129
exiting. See quitting
extension(s). See also Extensions Manager
control panel; specific extensions
accessing lists of, 233-239
conflicts, 297, 320-322
Extensions (Disabled) folder, 240
Extensions folder, 233-239
Extensions Manager control panel, 103,
223,226,240,321-322
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•F•
Farallon,96,98,284
Farallon Web site, 284
Favorite Places menu, 117
Favorites command, 219
Favorites folder, 240
Fax Browser, 346, 34 7
fax transmissions, 104, 146, 344-347
FaxMonitor extensions, 235
FBC Indexing Scheduler extension, 235
file(s). See also documents
closing, 80
compression of, 127-129, 159-160
locked, 313
naming/renaming, 75-76, 313
opening, 31, 82-84, 126-129, 299-300
sharing,226,234,276-277,279,313-314
File Exchange control panel, 59, 226
File menu
Configurations command, 132
Duplicate command, 43
Get Info command, 43, 251, 324
Mail Merge command, 172-173
Make Alias command, 246-248
New Folder command, 35, 36
Open command, 17, 83, 85, 129
Page Setup command, 106
Print command, 100, 156
Quit command, 125, 304
Save command, 31-32, 75
File Sharing control panel, 226, 276-277,
279, 313-314
File Sharing extensions, 234
File Synchronization control panel,
226-227
FileMaker, 48, 159
Find button, 173
Find command, 173
Find Contact command, 199
Find dialog box, 173
Find extension, 235
Find feature, 141-143. See also searching;
Sherlock
Find tab, 91
FindByContent extension, 235

Finder
basic description of, 16, 79-80
display options for, 228
file, in the System Folder, 241
preferences, 11, 298
Simple Finder mode for, 269, 324
floppy disk(s). See also disks
copying data to, 88
drives, 86, 226, 338-339, 360
ejecting, 88-89, 313-314
in Microsoft Windows format, using, 59
folder(s)
basic description of, 35-36
creating, 35-37, 156
dragging, to the Trash, 40-43
naming, 36
opening/closing, 20, 39, 248
retrieving files from, 80, 83-84
saving files in, 76-78
"spring-loaded," 248
storing downloaded software in, 126-127
storing e-mail in, 156
Folder Actions extension, 235
font(s). See also text
Appearance control panel settings for,
221-222
AppleWorks settings for, 176
basic description of, 72-73
buying new, 104
downloading, from the Internet, 105
foricons,254-255
installing new, 105
keyboard shortcuts for, 74
for letterhead, 177
monospaced, 105
point size, 72
printing and, 104-108
proportional, 105
removing, 105
serif/sans serif, 107
size, 177
in spreadsheets, 184
suitcases, 105
symbol, 107
system, 221-222
ten free facts about, 104-108
using multiple, 93
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Fonts folder, 105, 240
Fonts tab, 221, 254
"Force Quit" keystroke, 296, 319
foreign countries, Internet access from, 134
Foreign File Access extension, 233
form letters
creating, 167-176
designing letterhead for, 176-178
formatting, 172- 176
saving, 175
formulas, 183-185
Forward button, 156
.fp3 file extension, 159
Fractional Character Widths option, 108
Freeback.com Web site, 125
Freestyle, 338
freezes, 296-297, 322
function keys, 259, 261-264
Function Keys button, 264

•G•
game pads, 362
games, 187,200-201,362
GCC Technologies, 356
General Controls control panel, 60, 62, 79
access control settings in, 302
basic description of, 227-228
system crashes and, 297
Geneva font, 107
Get Complete Newsgroup Lis t option, 124
Get Info command, 43, 251, 324
.gif file extension, 129, 159
GIF (Graphics Interchange Format), 129,
159,252, 300
gigabytes, 27, 32
Global Computer Supplies, 275
Go Ahead button, 11
Go to the Web option, 136-137
graphics
disabling, 148-149
designing, 176-178
files, opening, 300

GIF (Graphics Interchange Format), 129,
159,252,300
JPEG (Joint Photographies Expert
Group), 129, 159,252,300
letterhead, 176-178
sending, as file attachments, 159
Graphing Calculator, 219
Griffin Technology Web site, 358

•H•
Handspring Visor, 347
hard drive(s)
basic description of, 25-26
buying, 32, 360-362
defragmenting, 328
size of, 27-28
space, viewing available, 33
viewing the contents of, 16-18
headers and footers, 94, 178
headphones,337-338
help
accessing, 22-23, 230
for AOL, 117
basic description of, 22-23
topics, 22-23
for the World Book Encyclopedia, 204
Help Center, 22-23
Help command, 22
Help folder, 240
Help menu, 22-23, 230
Helvetica font, 107
Hewlett-Packard printers, 95- 98, 356. See
also printers
HID Library extension, 235
Hide Others command, 245-246
Hide palette, 180
highlighting
color of, setting, 221
folder names, 36
menu commands, 14
paragraphs, 73-74
text,52,65-67, 73- 74,92-94
home page settings, 147-148
Homework area, of AOL, 117
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Hotbot Web site, 141
HotSync Manager command, 302
HP (Hewlett-Packard) printers. See
Hewlett-Packard printers
.hqx file extension, 128
.htm file extension, 129, 159
HTML (HyperText Markup Language), 129,
159,235
HTMLRenderingLib extension, 235
hyphen (-), 184
hyperlinks, 135-136, 138. See also URLs
(Uniform Resource Locators)

• 1•
I-beam cursor, 64-65
IBM.net, 134
iBook Planet Web site, 354
iBook Zone Web site, 354
iBookWorld Web site, 136
icon(s)
already opened, grainy silhouette of, 39
AOL, 116
arranging, 45
basic description of, 10, 16-17
blank ("generic"), 317-318, 314
buttons (channels), 144-145
color-coding, 253-254
creating your own, 250-251
double-clicking, 39
dragging/dropping, 15-16
labeling, 253
renaming, 43
selecting multiple, 40, 41
tips for handling, 43-46
typeface for, 254-255
used in this book, 3
for Web pages, 143
iMac, 290, 354
iMac2Day Web site, 354
iMacBackup.com Web site, 125
iMaccessories, 337
iMacintouch, 354, 355, 362
iMate, 358
images. See graphics
iMic adapter, 340, 348

lndeo Video extension, 236
indexing, 91
lnfoseek Web site, 141
information superhighway, 112
inkjet printers, 95-98, 311. See also
printers
lnputSprocket extension, 235
insertion point, 63-65, 68
installing
Airportcards, 282-283
fonts, 105
the Internet Safety Kit, 205
the Palm Desktop, 188
printers, 96-98
re-, system software, 297, 309, 324- 328
USB devices, 274-275
the World Book Encyclopedia, 202
Instant Message command, 119
Instant Messaging (AOL), 119-120
Instant Palm Desktop extension, 236
Intel Raw Video extension, 236
Internet. See also World Wide Web
access commands, 219-220
access via AirPort cards, 288-289
backing up data using, 125
basic description of, 111-134
downloading fonts from, 105
history of, 112
navigating, with hyperlinks, 135-136
parental access controls for, 151, 187,
205- 208
searching, with Sherlock, 91
settings, restoring, after a clean system
reinstall, 325-326
Internet Applications folder, 127
Internet Config extension, 236
Internet control panel, 146, 229
Internet Explorer browser (Microsoft). See
also Web browsers
basic description of, 124, 146-171
bookmark feature, 149-150
disabling blinking banners with, 150
home page settings for, 147-148
speeding up access with, 148-149
viewing downloaded HTML files with, 129
Internet folder, 121, 128
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Internet Safety Kit
basic description of, 151, 187, 205- 208
bypassing, 206-207
installing, 205
using, 205-208
Internet Search Sites folder, 240
Internet Service Providers ( ISPs). See ISPs
(Internet Service Providers)
Internet Setup Assistant, 121-122, 153, 220
Internet Utilities folder, 128
invisible characters, displaying, 72
Iomega driver extension, 236
ISPs (Internet Service Providers)
access numbers for, looking for, 132-134
AirPort and, 292
basic description of, 113- 114
chat features offered by, 120
downloading software with, 127
e-mail services provided by, 122, 153
newsgroup access with, 124
overseas access with, 134
pros and cons of, 114
signing up with, 121-122
Web access provided by, 126, 137-146
italic font, 72-73, 74. See also fonts

•]•
joysticks, 337, 362
JPEG (Joint Photographies Expert Group),
129, 159,252,300
.jpg file extension, 129, 159
justification, 74

•K•
Keep Arranged option, 45
Key Caps, 170, 220
keyboard(s). See also Keyboard control
panel; keyboard shortcuts
adapters, 358-359
basic description of, 258-264
Fn key tricks, 259-261
locking, 307
Option key tricks, 243-246
replacements, 362-364
settings, restoring original, 263, 264

Keyboard control panel, 59, 229, 263-264
keyboard shortcuts
assigning, 263-264
basic description of, 36-39
Keychain Access control panel, 229
keywords, navigating AOL with, 117

• L•
Labels tab, 253-254
Language & Region Support folder, 241
Largest Unused Block, 33
laser printers, 98-100, 106. See also
printers
Launche~62,230,241

Launcher Items folder, 241
LDAP extensions, 236
letters, form
creating, 167-176
designing letterhead for, 176-178
formatting, 172-176
saving, 175
libraries, shared, 233, 237-238
Limited option, 267, 268
links, 135-136, 138. See also URLs
(Uniform Resource Locators)
list view, 21 , 43
Load Images command, 149
local access numbers, 115, 130-134
Location Manager, 230, 236
Locked check box, 43
locking
disks, 313
files, 43
keyboards, 307
Looping option, 150
Louvre Museum Web site, 145

•M •
Mac Help command, 22-23, 230
Mac OS ROM file, 242
Mac OS Setup Assistant, 10-11
Macally, 337
MacConnection, 49, 353
MacDownload.com Web site, 49
MacFixlt Web site, 330
Macgame area, of AOL, 117
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MacinTalk extensions, 236
Macintosh operating system software
basic description of, 30, 264- 269
upgrades,331- 332
versions of, 30, 51, 143, 331-332
Macintouch Web site, 354, 355, 362
MacOS Rumors Web site, 354
Macromedia extensions, 236
MacSurfer Web site, 354
MacWarehouse,49,353
Macworld Web site, 148
MacZone, 49, 353
magazines, 48, 145, 331 , 353
Mail command, 220
Mail Merge command, 172-173
Mail Merge window, 172-1 75
mail-order vendors, 49-50, 353
mailing labels, 186
mailing lists, 353
Make Active option, 133
Make Alias command, 246-248
Make Default button, 124
Make New Location option, 131
Mamma.com Web site, 141
Map control panel, 59, 230
megabytes, 27-28,32
memory. See also Memory control panel;
RAM (random-access memory)
adding more, 81, 297, 307, 322-324
allocating, to programs, 301, 322-324
available, viewing, 28-29, 322, 307
batteries and, 210, 211, 214- 215
basic description of, 25-27
chips/slots, 307
cost of, 32
"effect," 210
error messages, 301
hard disks and, differences between,
27-28, 32
saving files in, 31
sleep mode and, 309, 315
virtual, 29, 305-306, 308
word processing and, 75, 81
Memory control panel, 230, 305-306, 308
menu(s). See also specific menus
arrows on, 38
bar, 13
grayed out items on, 14
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identifying the program that you are
in by, 82
keyboard shortcuts on, 36- 39
opening, 13
pop-up (contextual), 44-45, 78, 221,
234, 261
MetaCrawler.com Web site, 141
microphones, 231, 340, 348- 349, 359
Microsoft Excel, 48, 159, 179
Microsoft extensions, 236
Microsoft Internet Explorer browser. See
also Web browsers
basic description of, 124, 146-171
bookmark feature, 149-150
disabling blinking banners with, 150
home page settings for, 147-148
speeding up access with, 148-149
viewing downloaded HTML files with, 129
Microsoft Outlook Express
basic description of, 153
downloading software with, 127
newsgroup features, 124
reading e-mail with, 155
sending attachments with, 160
sending e-mail with, 154, 160
Microsoft Windows
customizing e-mail attachments for,
158-160
format, handling files in, 128- 129, 226
programs, running, 349
Microsoft Word, 48, 108, 159, 298
MIDI (Musical Instrument Digital
Interface), 338
military research, 112
MIME (Multipurpose Internet Mail
Extensions), 159
minus sign (-), 184
Modem control panel, 230
Modem Scripts extensions, 236
modems, 112-113, 200,230,236
modifier keys, 37
Monaco font, 105
monitors. See Monitors control panel;
screens
Monitors control panel, 58, 230
monospaced fonts, 105. See also fonts
Monthly view, 190-191, 198
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adapters, 358-359
advantages of using, over a trackpad, 337
basic description of, 12-13
buttons, 13
control panel settings for, 230-231
drag and drop with, 15-16
optical, 363
shopping for, 363
shopping for a replacement for, 362-364
Mouse control panel, 230-231
movies, 147, 343-344
MP3 files, 342
MRJ Libraries extensions, 236
Multi-User Startup extension, 236
Multiple Users control panel, 231,
265-268,324
Multiple Users dialog box, 266
Multiprocessing extensions, 237
multitasking methods, 244
music. See also sound
CDs, playing, 341-342
hardware for handling, 338
MusicShop, 338
MyDocsOnline.com Web site, 125

•N•
Nanosaur, 187, 200
NASA Web site, 252
NBP Plug-in extension, 237
Netscape Navigator browser. See also
browsers
basic description of, 124, 146-151
bookmark feature, 149-150
disabling blinking banners with, 150
home page settings for, 147- 148
speeding up access with, 148-149
viewing downloaded HTML files with, 129
Network Browser, 220, 277, 279
networking. See also Ethernet
AppleTalk and, 98, 100, 224, 276, 278
batteries and, 212
iBook-to-iBook, 290-291
printing and, 99
wakeup settings and, 315
wireless, 281-292

Never Register option, 188
New Document dialog box, 165, 176, 180
New Folder command, 35, 36
New Note command, 198
New Record command, 171
New Server option, 124
New Task dialog box, 197
News icon, 124
Newsgroup List icon, 124
newsgroups, 122-124, 331
No Wonder Web site, 330
Normal option, 267
Norton Utilities, 42, 328
"Not enough memory" error message,
303- 307
Note List, 198
Note Pad
basic description of, 51-54
drag-and-drop with, 67- 70
files, in the System Folder, 219, 242
using, 61-70
Note Pad icon, 53
NSL UI Library extension, 237
Num Lock mode, 259, 262
Numbers control panel, 231
numeric keypad, 259

•O•
O'Grady's Power Page Web site, 354
Old Mail folder, 118
On/Off button (power button), 8-9, 14, 213
online services, 114. See also AOL
(America Online)
Open command, 17, 83, 85, 129
Open dialog box, 75- 80
Open TPT extensions , 237
Open Transport extension, 237
OpenGL extensions, 237
operating system software (Macintosh)
basic description of, 30, 264-269
upgrades,331-332
versions of, 30, 51, 143, 331-332
options
Allow Processor Cycling option, 212
Animated GIFs option, 150
Auto-Capitalization option, 194
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Auto-completion option, 194
Automatically Load Images option, 149
Background Printing option, 102
CD-ROM Auto-Play option, 301
Computer to Computer option, 291
Currency option, 184
Drag Lock option, 59
Dragging option, 59
Enable Audio CD AutoPlay option, 301
"Erase before restoring" option, 328
Fractional Character Widths option, 108
Get Complete Newsgroup List option, 124
Go to the Web option, 136-137
Keep Arranged option, 45
Limited option, 267, 268
Looping option, 150
Make Active option, 133
Make New Location option, 131
Never Register option, 188
New Serve r option, 124
Normal option, 267
Panels option, 267, 268
Power Adapter option, 225
"Preserve memory contents on sleep"
option, 309, 315
Protect Applications folder option, 302
Protect System Folder option, 302
"Restore in Place" option, 327
Shared Folder option, 11
Show All Records option, 173
Show Control Strip option, 283
Show Desktop when in background
option, 228
Show Invisibles option, 72
Show Pictures option, 149
Show User Details option, 268
Smooth all fonts on screen option, 106
Stationary option, 186
Turn Off AirPort option, 212
Use Assistant option, 186
"Warn me if computer was shut down
improperly" option, 297
Options tab, 222
Outlook Express (Microsoft)
basic description of, 153
downloading software with, 127

newsgroup features, 124
reading e-mail with, 155
sending attachments with, 160
sending e-mail with, 154, 160
Outlook Express command, 155
Outlook Express folder, 127
Outlook Express Temp folder, 127
Outpost.com Web site, 49
overseas access, 134

•P•
page breaks, 261
Page Setup command, 106
Page Setup dialog box, 106
painting feature, in AppleWorks, 166, 185
Palatino font, 107
Palm Desktop
address book (contact list), 193-197
bannerfeature, 48, 192-193
basic description of, 187, 188- 200
calendar, 188-1 91, 195, 199
error messages and, 302
installing, 188
instant, magic of, 198-199
Note List, 198
using PalmPilot with, 347
PalmPilot, 32, 347- 348
Panels option, 267, 268
paper, for printers, 96, 106
paper-clip icon, 160
paragraphs, 71 , 73-75
parental controls. See also Internet Safety
Kit; Multiple Users control panel
password(s)
for AirPort access, 287- 289, 290
for AOL, 115
for the Internet Safety Kit, 207
for ISPs, 122
for networking, 11
Paste command, 54, 55-56, 179
Pathfinder Web site, 145
.pdf file extension, 129
period (.), 63, 260
Personal Finance button, 116

379

380

The iBook For Dummies _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ __
phone jacks, 112, 113
PhotoDeluxe (Adobe), 129
photographs. See also graphics
downloading, 129
printing, 96
scanned, backing up, 125
viewing, 129
Photoshop (Adobe), 129, 159
PICT format, 252, 300
PictureViewer, 129
pixels, 185
plug-ins, 145, 147
Plug-Ins folder, 147
Plugins Web site, 147
point size, 73
pop-up (contextual) menus, 44-45, 78, 221 ,
234, 261. See also menus
"Port is in use" error message, 302
Postscript fonts, 104
Postscript laser printers, 98-100. See also
printers
pound sign(#), 194
Power Adapter option, 225
powercords,8, 134,209-210,308
Power Manager, 312, 318
Power Macintosh, 284, 289-290
power (On/Off ) button, 8-9, 14, 213. See
also startup
PowerBook, 284
PowerPoint format, 159
PRAM, 319
preference files, 239, 298
Preferences command, 108, 124, 149
Preferences dialog box, 194, 208
Preferences folder, 239, 298, 325-327
Presentation Assistant, 186
"Preserve memory contents on s leep"
option, 309, 315
Print button, 101, 102
Print command, 100, 156
Print Merge button, 179
Print Monitor extensions, 237
Print tab, 108
printer(s). See also printing
basic description of, 95-108
buying, 355-357

extensions, 233, 237
cost of, 96
inkjet printers, 95-98, 311
installing, 96-98
laser printers, 98-100, 106
multifunction, 357
options for, during setup, 11
using multiple, 103
Printer icon, 103
printing. See also printers
background, 102
basic description of, 100-103
calendars, 195
canceling, 102, 260
e-mail, 118, 156
fonts and, 104-108
photographs, 350
problems with, troubleshooting, 311
by sending yourself a fax, 104
problem-solving. See troubleshooting
processors, 212
programs, use of the term, 47. See also
applications
projectors, 338
proportional fonts, 105
Protect Applications folder option, 302
Protect System Folder option, 302
punctuation, 119

•O•

-

question-mark icon, 10, 308-310
QuickCam, 339
QuickDraw 30 extensions , 237
Quicken.com Web site, 220
QuickTime, 231 , 237, 301, 343-344
QuickTime extensions, 237
QuickTime Settings control panel, 231, 301
Quit command, 125, 304
quitting. See also shutdown
with the "Force Quit" keystroke, 296, 319
Inte rnet access, 125-126
programs, when low on memory, 304
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•R•
Radio Shack, I I2, I34, 200
radio transmitter antennae, 2I2, 28I, 290
RAM (random-access memory). See also
memory; RAM Doubler
basic description of, 28-3I
defragmenting, 304-305
digital cameras and, 336
RAM Doubler, 29, 305, 306
Recent Documents command, 220
recording, 348-349
Refresh Message List command, I24
regional preferences, I I
Remote Access control panel, I26,
I32-I33,23I
Remote Access Status, I26, 220
Remote Access Status command, I26
Remote Access tile, I26
Repair button, 309
Reply button, I55-I56
Research & Learn button, I I6
reset hole, 3I8
resolution, of your screen, 108, 250
Restart button, 223
restarting. See also startup
to get out of a system freeze, 286- 287
keystroke for, 3I5, 320
rebuilding the Desktop file when, 3I8
"Restore in Place" option, 327
Return character, 7I-72
robots, I6I
rulers, 74
running headers, 94

Save As text box, I 7I
Save button, 76, 8I
Save command, 31-32, 75
Save dialog box, 85
Save File dialog box, 75-80
saving
basic description of, 75-81, 84-85
databases, 171-172

e-mail, 156
form letters, I 75
scanners,335-336,364
Scrapbook, 220,242
screen(s)
brightness s ettings , 211, 262, 263
cleaning, 3I4
problems with, troubleshooting, 311
resolution, 108, 250
screen names, 1I5, 119
Screen Resolution icon, 250
Scripting Additions folder, 241
Scripts folder, 241
scroll bars, 18, 256-257
scroll boxes, 222
SCSI (Small Computer Systems Interface)
devices, 273- 275, 357, 359
Search All Newsgroups button, 123
Search button, 22-23, I40
Search by Content tab, 91
searching. See also Sherlock
AppleWorks databases, 173
for files, 89-92
for particular topics, 139-140
with search engines, 142-143
for shareware, I20-121
for topics in the World Book
Encyclopedia, 202- 203
the World Wide Web, 139-146
Security extensions, 237
Select All command, 93
Select Location menu, 132
self-hiding programs, 22
Send & Receive icon, 155
Send button, 154
Send Later button, I54
Send New Message button, 123
Send Now button, I I9
sequencing programs, 338
serial adapters, 357, 358
Serial (Built-in) extensions, 237
serif/sans serif fonts , 107
server(s)
addresses, 124
reconnecting to, on wakeup, 3I5
viewing a list of, 220
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Shared Folder option, 11
shared libraries, 233, 237- 238
shareware, 49, 105, 120-121
Shareware.com Web site, 49, 105
ShareWay IP Personal Bgnd extension, 238
Sherlock
basic description of, 89-92, 220
improved version of, 143- 145
Web searches with, 91, 141-143
Sherlock command, 129, 141
Shopper.com Web site, 145, 353
Show All Records option, 173
Show Control Strip option, 283
Show Desktop when in background
option, 228
Show Invisibles option, 72
Show Pictures option, 149
Show Rulers command, 74
Show User Details option, 268
Shut Down command, 15
shutdown. See also quitting; Shutdown
Items folder
automatic, settings for, 59
improper, 297
with the Shut Down command, 15
Shutdown Items folder, 241
Sign On button, 132
Simple Finder mode, 269, 324
SimpleSound, 220, 348-349
SimpleText, 342-343
sing, making your iBook, 343
single quote ('), 93- 94
.sit file extension, 127-128
SiteLink Web site, 354
Sites tab, 207, 208
Size box, 18
SkyLine card, 284
Sleep command, 14, 15
sleep mode
auto-wakeup feature and, 213- 214
basic description of, 13- 15, 59, 213-215
batteries and, 14, 210-211, 213-215
memory and, 214- 215
slide shows, 9- 11, 185 - 186

SLPPlugin extensions, 238
Smooth all fonts on screen option, 106
Software Install CD, 315
Software Restore CD, 326- 328
Software Update control panel, 231
Software Update extensions, 238
SoftWindows, 349
sound(s). See also microphones; speakers
control panel settings for, 60, 231, 340
made when errors occur, 340
plug-ins for, 147
problems, troubleshooting, 308, 310-312
recording, 348-349
singing, 343
startup, 308, 310
talk features, 342-343
volume settings, 262- 263
Sound control panel, 60, 231, 340
Sound Manager extension, 238
Sound tab, 222
spam (junk e-mail), 161 , 188
speakers,200,262
basic description of, 337- 338
buying, 364- 365
problems with, troubleshooting, 311
Sound control panel settings for, 232
special characters, 170
Special menu, 13, 14
Eject Disk command, 42, 89
Empty Trash command, 42, 43
Shut Down command , 15
Sleep command, 14, 15
Speech control panel, 59, 232
Speech Manager extension, 238
splitters, 112, 200
spreadsheet features, in AppleWorks, 166,
179- 185
Star Trek area, of AOL, 117
startup. See also power (On/Off) button;
restarting
memory and, 26- 27
problems with, troubleshooting, 308-310
slide show, 9-11
sounds, 308, 310
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unusually slow, 309- 310
Startup Disk control panel, 232, 309
Startup Items folder, 241 , 310
stationery, 176, 186
Stationery button, 176
Stationery option, 186
STF Toolbox extension, 238
STFinit extension, 238
Stickies, 221
Stocks area, of AOL, 117
Stufflt format, 159-160
Stufflt Expander, 127-128
Stufflt Expander folder, 128
SuperDisks, 86-89,226,338-339, 361
symbol fonts, 107
System file, 241
System Folder
access control settings for, 302
basic description of, 217- 242
clean reinstall of, 297, 309, 324- 328
creating aliases in, 247-248
disabling items in, 223
Mac OS 9 and, 264-265
viewing the contents of, 18- 21
System reinstall, 297, 309, 324- 328

•T•
tab stops, 92
talk features, 342-343
Task List, 197-198
Task List command, 197
TCPack for AOL extension, 238
TCP/ IP control panel, 232
technical support, 47, 329-330
TeleAdapt Web site, 134
telephone lines , 112- 113, 126
telephone numbers
dialing, with Palm Desktop, 199-200
local access numbers, 115, 130-134
text. See also fonts; word processing
clippings, 70
formatting, 70-75
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highlighting/selecting, 52, 65-67, 73-74,
92-94
Text control panel, 233
Text Encoding Converter extension, 238
Text tool, 177
Themes tab, 222-223
time. See dates and times
Time Frame feature, 204
Time Synchronizer extension, 238
Times font, 107, 177
title bar
basic description of, 18, 256-257
selecting/ moving windows by clicking,
19- 20,50
to-do lists , 198, 199
toolbars, 203-204
totals, in spreadsheets, 179-182
trackballs, 363-364
trackpad. See also mouse
basic description of, 12-13
buttons, 13
settings, 58-59, 233
stroking the, 12
Trackpad control panel, 58-59, 233
Trash, 15-16,40- 46,244
Trash icon, 15- 16, 40-44
triangles, 20, 38
TrueType fonts , 104
Turn Off AirPort option, 212

•U•
UDF Volume Access extension, 238
UMAX scanners, 335
underlined font, 72-73, 93, 136
Undo command, 56, 57
"Update software automatically" check
box,231
upgrades, 331-332. See also Macintosh
operating system software
Upload File button, 125
URL Access extension, 238
URLs (Uniform Resource Locators), 138,
147, 238. See also links
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adapters,274-275,336,338
basic description of, 273-275
cable, 96
compatible products, list of, 355
devices, installing, 274-275
extensions, 239
hubs, 275, 365
microphones, 340
printers, 96-97, 356-357
mouse, 337
ZIP drives, 361
USB Presenter, 338
Use Assistant option, 186
user groups, 330, 353
Users & Groups control panel, 233, 278
.uu file extension, 128

..
(/

video cameras, 339
video-output adapters, 338
view buttons, 180
View Images command, 149
View Menu
As List command, 21, 43
Contact List command, 196
Load Images command, 149
New Note command, 198
Refresh Message List command , 124
Task List command, 197
View Images command, 149
View Options command, 45
virtual memory, 29, 305-306, 308
VirtualPC, 315, 349
viruses, 301
Voice Verification extensions, 239
voltage converters, 134
volume settings, 262-263
VST Technologies Web site, 210

•W•
"Warn before emptying" check box, 43
"Warn me if computer was shut down
improperly" option, 297
Web browser(s). See also Internet Explorer
browser; Netscape Navigator browser
AirPorts and, 289
basic description of, 124, 137-146
choosing, 146-147
e-mail and, 153
home page settings for, 147-148
Sherlock and, 143
speeding up access with, 148-149
viewing downloaded HTML files with, 129
Web Content icon, 150
Web Sharing control panel, 233
Web Sharing extension, 239
Web sites
Adobe Web site, 129
Amazon.com Web site, 142, 145
Apple Computer Web site, 144, 235, 282,
330,354
Aver Web site, 338
BackJack.com Web site, 125
ClickTV Web s ite, 145
Dilbert We b site, 145
Earthlink Web site, 132
Efax.com Web s ite, 146
Farallon Web site, 284
Freeback.com Web site, 125
Griffin Technology Web site, 358
Hotbot Web site, 141
iBook Planet Web site, 354
iBook Zone Web site, 354
iBookWorld Web site, 136
iMac2Day Web s ite, 354
iMacBackup.com Web site, 125
lnfoseek Web site, 141
Louvre Museum Web site, 145
MacDownload.com Web site, 49
Mac Fixlt Web site, 330
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Macintouch Web site, 354, 355, 362
MacOS Rumors Web site, 354
MacSurfer Web site, 354
Macworld Web site, 148
Mamma.com Web site, 141
MetaCrawler.com Web site, 141
MyDocsOnline.com Web site, 125
NASA Web site, 252
No Wonder Web site, 330
O'Grady's Power Page Web site, 354
Outpost.com Web site, 49
Pathfinder Web site, 145
Plugins Web site, 147
Quicken.com Web site, 220
Shareware.com Web site, 49, 105
Shopper.com Web site, 145, 353
SiteLink Web site, 354
TeleAdapt Web site, 134
VST Technologies Web site, 210
Yahoo! Web site, 139-141
Web tab, 146
Weekly view, 189, 198
"What do you want to create?" dialog
box, 192
What's Online feature, 204
white space, 68
window(s)
basic description of, 17-18, 255-257
closing, 39, 80, 244
edges of, 17-18
moving, 50
"pop effect" for, 257-258
sizing, 43-44
tips for handling, 19-20, 43- 46
working with multiple, 19-20
Window menu
Add to Favorite Places command, 118
Bookmarks command, 150
Outlook Express command, 155
Show Rulers command, 74
Windows (Microsoft)
customizing e-mail attachments for,
158-160
format, handling files in, 128-129, 226
programs, running, 349
windowshade effect, 256
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wireless networking, 281-292. See also
networking
Word (Microsoft), 48, 108, 159, 298
word processing. See also AppleWorks;
Note Pad; Word (Microsoft)
basic description of, 31, 61- 94
editing text, 65~7
formatting text, 70-75
software, 48
tips, 92- 94
rules for, 62-63, 68, 85
word wrap, 63
World Book Encyclopedia
basic description of, 187, 202-204
installing, 202
looking up topics in, 202-203
World Wide Web. See also Internet;
Web sites
access to, through AOL and ISPs, 126,
136-146
basic description of, 124-126, 135-152
parental access controls for, 151, 187,
205-208
searching for topics on, 91, 139-146

.xis file extens ion, 159

•Y•
Yahoo! Web site, 139- 141
"You are running low on memory" error
message, 301
"You do not have enough access
privileges" error message, 302

Zip disks, 26, 86- 89, 226, 338-339, 361
.zip file extension, 128
zooming, 18, 44, 180, 250
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